Contents

Chapter 1: Before you begin
Resources ................................................................. 1
What’s new ............................................................... 2
Using Adobe Help ..................................................... 2

Chapter 2: Connect Enterprise basics
Adobe Connect Enterprise ........................................... 5
Enterprise Manager How To Topics ................................. 6
Adobe Connect Enterprise Manager ................................ 7
Managing permission access for library folders and files ............ 13
Managing library folders and files .................................... 17
Managing content in the Content library ........................... 21

Chapter 3: Adobe Acrobat Connect Professional meetings
Acrobat Connect Professional How To topics ....................... 29
Adobe Acrobat Connect Professional basics ......................... 29
Acrobat Connect Professional work area ............................ 33
Working with meeting room templates ............................... 39
Creating and attending meetings ...................................... 42
Updating existing meetings ............................................. 46
Viewing data about meetings .......................................... 52
Sharing content during a meeting ..................................... 53
Managing attendees .................................................... 63
Using audio conferencing in a meeting ............................... 66
Recording and playing back meetings ................................. 69
Taking notes in a meeting .............................................. 73
Chat options in a meeting .............................................. 75
Broadcasting audio and video ......................................... 81
Polling attendees ........................................................ 86

Chapter 4: Adobe Connect Training
About Adobe Connect Training 6 ...................................... 88
Working with Courses ................................................ 91
Working with Curriculums ............................................. 99

Chapter 5: Adobe Acrobat Connect Professional Seminars
About Adobe Acrobat Connect Professional Seminars ............ 116

Chapter 6: Adobe Connect Events
About events ........................................................... 126
Creating and editing events ........................................... 129
Managing events ....................................................... 144
Chapter 1: Before you begin

Begin here to get information about Help documentation for Adobe® Connect™ Enterprise. You can also find out about the tools Adobe offers to help you get started, find system requirements for your software, and get an overview of resources available at Adobe.com.

Resources

Help components

Help  The documentation is available in Help, browser-based content you access through the Help menu of your Adobe product. For information about Help and its accessibility features, see Using Adobe Help.

How To topics  The How To topics provide a brief overview of the most common tasks. If you need more information, just click the links in the How To topic.

PDF version of Help  To view all the Help topics in a single PDF document, open the PDF file in the Help folder where the application is installed (for licensed customers) or on the Documentation Center at www.adobe.com/go/connect_documentation_en.

Adobe Connect Enterprise resources

More information is available from the following sources:

Quick Start  Adobe offers Quick Start demos for Connect Enterprise. These short demos show you visually how to do common tasks. To view Quick Start demos, select Help > Quick Start from a Connect Professional meeting room.

Resource Center  This site, at www.adobe.com/go/resources_connect_en, is updated regularly with tutorials, simulations, best-practices information, and links to procedures.

Support Center  This site, at www.adobe.com/go/support_connect_en, contains current support information, including technical notes, helpful presentations, and support program details.

Developer Center  This site, at www.adobe.com/go/devnet_connect_en, is updated regularly with tutorials and articles about extending Connect Enterprise.

Documentation Center  This site, at www.adobe.com/go/connect_documentation_en, contains documentation for all Acrobat Connect products, answers to frequently asked questions, articles about specialized topics, and presentations.

System requirements

The most complete listing of system requirements for Connect Enterprise can be found at www.adobe.com/go/connect_sysreqs_en.

Adobe.com

These resources are available on the Adobe website:

Adobe Design Center  Offers articles, tips, and tutorials in various formats, including video, Adobe PDF, and HTML. The content is authored by industry experts, designers, and Adobe publishing partners, and new content is added
monthly. You’ll also find Adobe Studio Exchange, where users download and share thousands of free actions, plugins, and other content. Adobe Design Center is available in English, French, German, and Japanese.

Adobe Developer Center Provides information for advanced users, including software and plug-in developers. You’ll find tutorials, SDKs, scripting guides, and sample code, in addition to forums, RSS feeds, online seminars, and other technical resources.

Communities Features forums, blogs, and other avenues for users to share technologies, tools, and information; ask questions; and find out how others are getting the most out of their software. User-to-user forums are available in English, French, German, and Japanese; blogs are posted in a wide range of languages.

What’s new

New features in Adobe Connect Enterprise
Here are some of the new features in Connect Enterprise:

Enhanced support for integrated audio conferencing Acrobat Connect Professional now offers enhanced support for accounts with an audio conference bridge installed, to enable synchronized telephonic audio conferences as part of Acrobat Connect Professional meetings. For meetings with international attendees, Acrobat Connect Professional can now display multiple dial-in numbers, so that attendees in each country can see the dial-in number they should use. Hosts can also block incoming attendees, and can turn on or off notifications when attendees enter or exit an audio conference.

Improved audio conference recording You can now start and stop audio recording when you are recording a meeting (if your Acrobat Connect Professional account has an audio conference bridge installed). This makes it possible to test the audio recording, then restart the recording, or to record only selected segments of the audio during a meeting.

Ability to turn Connect Event guests into users If you invite guests to your Adobe Connect Events, you now have an easy method for turning those guests into full users. Once guests are full users they can have custom field values in reports and they can access administration pages.

Adobe Presenter audio quality You now have the option to compress audio in presentations created with Adobe Presenter. Compressing the audio reduces the size of audio files. To retain settings in high-quality audio, you can choose to keep the audio uncompressed.

Custom fields in User reports In Connect Enterprise user reports, you can now include up to eight custom fields for individual users. This feature enables you to track information about users that is important to your organization.

Using Adobe Help

Browse Help topics
1 In the navigation pane, do one of the following:
   • To browse by topic, click Contents.
   • To browse alphabetically, click Index, and then click a letter.
2 Expand items in the navigation pane until you reach the desired topic.
3 Click items in the navigation pane to view content in the reading pane.

**Search Help topics**
1 In the navigation pane on the left, click Search.
2 Type one or more words in the text box, and click the Search button.
Topics matching the search terms appear in the navigation pane, listed in order of relevance.

**Search tips**
These tips can help you improve your search results in Help:

- If you search using a phrase, such as “screen sharing,” put quotation marks around the phrase. The search returns only those topics containing all words in the phrase.
- Make sure that search terms are spelled correctly.
- If a search term doesn't yield results, try using a synonym, such as “web” instead of “Internet.”

**Navigate Help**
- Navigate Help by doing any of the following:
  - Expand items in the navigation pane until you reach the desired topic. To view a topic, click its title, either in the navigation pane or the reading pane.
  - Click the navigation links that appear above the topic title in the reading pane.
  - Click Previous or Next in the reading pane.
  - Click Back or Forward on the toolbar.
You can also navigate Help using accessible keyboard shortcuts.

**Adobe Help and accessibility**
Adobe® Help Center is designed so that it is accessible to people with disabilities, such as mobility impairments, blindness, and low vision. Adobe Help supports standard accessibility features and alternative keyboard shortcuts for toolbar controls and navigation.

**Supported accessibility features**
Adobe Help supports the following standard accessibility features:

- Standard HTML tags define content structure.
- Style sheets control formatting (no embedded fonts).
- Each frame has a title to indicate its purpose.
- Graphics without captions include alternate text.
- If link text doesn't match the title of the destination, the title is referenced in the Title attribute of the Anchor tab. For example, the Previous and Next links include the titles of the previous and next topics.
- Content supports high-contrast mode.
- Text size can be changed with standard context menu commands or standard menu commands for Mac OS.
Keyboard shortcuts for toolbar controls
Each control in the toolbar for Adobe Help has a keyboard equivalent in Windows:

**Back**  Alt-left arrow

**Forward**  Alt-right arrow

**Print**  Ctrl-p

Keyboard shortcuts for navigation
To navigate Adobe Help, use the following keyboard combinations in Windows:

- To move between the navigation pane and the reading pane, press Control-Tab and Shift-Control-Tab.
- To move through links within a pane, press Tab or Shift-tab.
- To activate a selected link, press Enter.
Chapter 2: Connect Enterprise basics

Adobe Connect Enterprise Server 6 is associated with a suite of applications for hosting and managing online meetings, seminars, presentations, training, and events. Your organization may have purchased the entire system or a subset of these applications. If certain functionality is not available to you, your organization may not have purchased that application, or your administrator may not have granted you the necessary permissions.

Adobe Connect Enterprise

About Connect Enterprise applications
The Adobe Connect Enterprise system is composed of the core Adobe Connect Enterprise Server 6 and four applications.

Adobe Connect Enterprise Server 6 offers scalability, with support for single server or clustered environments, and it provides reliable redundant deployment that supports thousands of concurrent users. Adobe Connect Enterprise is designed as an open platform and can be extended and integrated with other systems through a comprehensive set of APIs.

The four associated applications give a full range of functionality:

Adobe Acrobat Connect Professional lets users conduct online meetings, events, and seminars in which hosts can show multimedia presentations, share their screens, and broadcast live audio and video to attendees in real time.

Adobe Presenter is a plug-in application for Microsoft PowerPoint that lets users create rapid e-learning prototypes, e-learning content, and on-demand presentations. The finished presentations are AICC and SCORM compliant.

Adobe Connect Events 6 lets users manage the full life cycle of events, from event registration and invitations, to reminders and generating event reports.

Adobe Connect Enterprise Manager is the web-based application that lets users manage account-related information and content. It is the primary interface where users create meetings, manage presentations, create curriculums and events, customize applications, and more.
**Connect Enterprise terms and concepts**
If you are new to Connect Enterprise, you may find the following definitions helpful.

**Meetings and seminars**
An Acrobat Connect Professional *meeting* is an online real-time meeting in which a presenter can show slides or multimedia presentations, share pages, chat, and broadcast live audio and video. A meeting takes place in an Acrobat Connect Professional *meeting room*, a Macromedia Flash from Adobe application that you run in a browser window by using Adobe Flash Player. The meeting room continues to exist even after the meeting is over.

In addition, depending on the pricing model your organization has chosen, you may or may not be able to enter a meeting if the meeting is not live. In some cases, only the host can enter the meeting room when the meeting is not live. In other cases, you can enter the meeting room when the meeting is not live if enough meeting room spaces are available across the system at the moment you enter.

You create the meeting room with Enterprise Manager. In Enterprise Manager, all meeting rooms are contained in the Meeting library.

A Connect Enterprise *seminar* is a unique kind of meeting, with its own licensing requirements and attributes. A seminar room is comparable to a meeting room, that is, it's a Flash application that runs in a browser window. The difference is that at least one seminar presenter or host must be in the room in order for others to enter, even if the seminar is public. A seminar ends if all the presenters and hosts exit the room. Because of their unique requirements and format, seminars have a dedicated Enterprise Manager tab named Seminar Rooms, as well as their own Seminar library.

**Connect Enterprise content**
Any file or folder that is stored in the Content library is referred to in Connect Enterprise as *content*. Content is synonymous with information and accessed from the Content tab of Enterprise Manager.

The Content library is associated with Connect Enterprise authors, the only users who can upload files to this library.

**Connect Enterprise events**
In Connect Enterprise, the term *event* means a large-scale web meeting, presentation, seminar, or training that requires registration and has unique reporting requirements. As such, the Connect Enterprise Event Management functionality contains special features that are exclusive to events.

**Connect Enterprise reports**
You can create diverse types of reports in Enterprise Manager for information about individual meetings, courses, curriculums, seminars, and users, among others. You can add report filters to streamline report information, and if you are a manager, you can view reports for your team members.

**Enterprise Manager How To Topics**

**Content**
- “Managing content in the Content library” on page 21
- “Searching the Content library” on page 13
- “Move a library folder or file” on page 17
Training
• “Creating a course” on page 91
• “Creating a curriculum” on page 100
• “Accessing the Training library” on page 88

Seminar Rooms
• “Creating a seminar” on page 118
• “Pre-seminar tasks” on page 117

Event Management
• “Creating an event” on page 129
• “Change an existing event” on page 133

Administration
• “Managing content in the Content library” on page 21
• “Searching the Content library” on page 13
• “Move a library folder or file” on page 17

Adobe Connect Enterprise Manager

About Enterprise Manager
Enterprise Manager is a web application that acts as an access and control point for all Connect Enterprise applications. Enterprise Manager allows you to set up and manage meetings, seminars, and training courses and curriculums, as well as manage content that can be shared through meetings, presentations, training courses, and events.

In addition, the user management component of Enterprise Manager enables you to set access permissions for both the users of this content and the content itself.

Note: Not everyone can use all the Enterprise Manager features. The features you can access depend on your Connect Enterprise configuration and your permissions.

Enterprise Manager users
You use different features of Enterprise Manager depending on your user needs. Users are divided into the following groups:

Meeting Hosts This group includes administrative assistants, managers, and everyone in an organization who can create meetings in Connect Enterprise Manager. You do not need Enterprise Manager to attend such a meeting; all you need is the meeting URL. However, in many cases, you can enter a meeting from Enterprise Manager as well.

Authors An author is anyone who uploads content to the Connect Enterprise Server. Content can include files created in Presenter, Adobe® Captivate®, or any other content uploaded to the Content library.

Training Managers This group includes anyone developing courses and curriculums.
Seminar Hosts  This group includes individuals who present seminars. A seminar is a special kind of meeting with its own attributes and licensing structure.

Event Managers  This group includes anyone who organizes events. An event can be any meeting, presentation, course, curriculum, or seminar that requires registration and generates reports with participant tracking information.

Administrators  This group consists of the users who manage Connect Enterprise applications for the entire organization. As such, administrators are responsible for customizing the appearance of these applications for their organization and managing all aspects of accounts. This includes performing any task pertaining to account and user management, such as creating custom user groups, and assigning users to custom user groups and to built-in groups.

Start Enterprise Manager
Every Connect Enterprise user receives an organization-specific Enterprise Manager URL, along with a user name and a modifiable password, in an e-mail sent out by their organization's Connect Enterprise administrator. You access Enterprise Manager by typing this URL in a browser window, and then logging in, as described below.

1 In a browser window, enter the URL provided by your administrator or included in the Welcome e-mail.
2 On the Login page, enter your user name and password.
3 Click Submit.

See also
“Logging out” on page 13

About starting Enterprise Manager in Internet Explorer
Microsoft has released an update that changes how Internet Explorer manages active content, including content viewed in certain Adobe products. Active content embedded in HTML may not work properly until the user clicks to either activate or continue loading the active control.

If you have installed the Microsoft update and do not have the JavaScript option in Internet Explorer selected, you may need to activate (by clicking) an object so that Enterprise Manager can start. This activation step may be necessary because Enterprise Manager is launched from an Internet Explorer window.

Determine the version number
Knowing your version number can be useful, especially when contacting the Connect Enterprise support team for help or when reporting any issues with an application. There are two ways to find your version number.

Determine version number on login page
1 Start Enterprise Manager.
2 On the login page (the page where you enter your login and password) move your cursor over the Help link. The version number appears.

Determine version number by viewing version.txt file
1 Start Enterprise Manager.
2 In the web browser address field, edit the address so it reads http://<adobe connect url>/version.txt. For example, if your server is named “server1,” the address would read http://server1.mcompany.com/version.txt.
3 Click Enter on your keyboard.
The version.txt file appears listing your Connect Enterprise version number.

**Overview of the workspace**
Enterprise Manager is the web application that enables users to manage content and create meetings, events, courses, and much more.

The full Enterprise Manager application user interface consists of seven tabs (also called *pages*), each associated with a particular function and application, as the following illustration shows.

**Navigating the workspace**
A. Tabs (pages)  B. Links  C. Navigation trail  D. Navigation bar  E. Navigation buttons  F. Folder  G. Click an item (file) to go to the information page for that item  H. Information about the item

**Connect Enterprise Manager icons**
Enterprise Manager uses icons to represent meetings, seminars, presentations, courses, and curriculums.

**Content** — Content includes files such as Adobe PDF files or Microsoft Word documents that are used with Connect Enterprise meetings, seminars, presentations, or training.

**Course** — A presentation that is associated with a group of enrolled learners with tracking for each individual. The course can be used independently or as part of a curriculum.

**Curriculum** — A group of courses and other learning content that guides students along a learning path. Curriculum can include Connect Enterprise content, presentations, meetings, seminars, and external content such as classroom sessions and reading lists.

**Event** — A Connect Enterprise event includes registration, invitations, reminders, and reporting. Events usually involve a large number of participants and are built upon a Connect Enterprise meeting, seminar, presentation, or training.
Meeting  
An online real-time meeting in which a host or presenter can show slides or multimedia presentations, share screens, chat, and broadcast live audio and video.

Seminar  
A seminar is similar to a Connect Enterprise Professional meeting, but seminars are usually conducted for one-time or infrequent meetings that have at least 50 participants and involve little audience participation or interaction.

Archive  
A recorded Connect Enterprise Professional meeting or seminar, which users can view at their convenience.

Authorware content  
Files created in Macromedia Authorware from Adobe, a visual authoring tool for creating e-learning applications that can be delivered on corporate networks, CDs, DVDs, and websites.

Adobe Captivate content  
Files created in Adobe Captivate, an application that automatically records all onscreen actions and instantly creates an interactive Flash simulation.

External training  
In a curriculum, training that occurs outside of Connect Enterprise, such as classroom training.

Flash Video file (FLV)  
A video file that users can access just as they access other Connect Enterprise content.

HTML file  
File defining the structure and layout of a web document using a variety of tags.

Image file (JPEG, GIF, PNG, BMP)  
Image files can be drawings, photographs, charts, graphs, icons, or any other type of graphics.

MP3 file  
An audio, sound, or music sequence that is compressed to a small file size.

Presentation  
A presentation created using the Adobe Presenter Plug-in for Microsoft PowerPoint. These presentations have not been converted into Adobe Presenter presentations.

Presentation  
A presentation created with Adobe Presenter, a plug-in for Microsoft PowerPoint that lets users add audio, quizzes, and visual features to a PowerPoint presentation.

Shockwave file (SWF)  
A multimedia animation file that can be viewed in a web browser.

Enterprise Manager tabs
The tabs at the top of Enterprise Manager represent the Connect Enterprise applications. Your organization may have purchased some or all of the applications. If you cannot access an application through a tab, your organization may not have purchased the application or your administrator may not have granted you access to that application.

Home tab  
Used to perform various tasks related to individual user accounts. This is the only tab accessible to all Enterprise Manager users.

Content tab  
Used to manage content for presentations, training, meetings, and seminars. From the Content tab you access the Content library, a set of content folders and files. Users who create content are called authors. However, the Content tab is available to all users with appropriate access permissions.

Training tab  
Used to work with courses and curriculums. If you use this tab to create courses and curriculums, you are a training manager.

Meetings tab  
Used to create and manage meetings. If you can create meetings that appear on this tab, you are a meeting host.

Seminar Rooms tab  
Used to create and manage seminars, a special type of meeting with its own requirements.
**Event Management tab**  Associated with events, which can be any meeting, training, presentation, or seminar that has registration and special reporting requirements. *Event managers* use the Event Management tab to create and manage events.

**Administration tab**  Used by administrators to add new users, assign permissions, customize the interface, and perform other management functions. Although visible to all users, the Administration tab is accessible only to administrators.

**See also**
- “Adobe Connect Training” on page 88
- “About Acrobat Connect Professional meetings” on page 29
- “About Adobe Acrobat Connect Professional Seminars” on page 116
- “About events” on page 126
- “Managing the Adobe Connect Enterprise Account” on page 217

**About the Home tab**

No matter what functions you use, if you have a Connect Enterprise account, the Home tab (also called the Home page) is always available to you. Displayed when you log in, this Home page is your base of operations. From here, you join any meetings or events for which you are scheduled, create any meetings or events for which you have permission, locate information and resources, and manage your account.

Below the Enterprise Manager tabs is a row of links that take you to lists with information relevant only to you. When you display one of these lists, you can often perform additional actions.

---

**My Home Page**

- **Tabs (pages)**
- **My links**
- **Shortcut links to creating new items**
- **Information for My Home Page**

**My Training**

My Training leads to a complete list of training courses or curriculums in which you are enrolled. To get details about any item, click its name. To see a list of completed classes, click Training I’ve Completed.

**My Scheduled Meetings**

My Scheduled Meetings leads to a complete list of your current, future, and expired meetings and your role in those meetings. Click the Enter link to enter the meeting room, where you can join a live meeting or view a presentation from a past meeting. Click the meeting name to display the meeting details, and then click Enter Meeting Room to join the meeting.
Note: The same information is displayed in list form on the Home page, but without expired meetings. Clicking the More link below the list has the same effect as clicking My Scheduled Meetings.

**My Scheduled Events**
My Scheduled Events leads to a list of all the events for which you are registered, as well as all your expired events. Click Enter to view an event.

**Manager Reports**
The Manager Reports link applies only to users who are managers. (Managers are defined here as people or staff managers, not training or system managers.) If you are a manager, use this link to display a list of all your direct reports. You can also select links to the training, meeting, and event reports for each of your reports. From Manager Reports, you can click the link for a report type to see a list of all reports for this team member for this report type. You can then click the link for a given report to see the report information, and depending on the report you selected, you can click another link to see more specific information.

In addition, if any of the users you manage also has subordinates, you can click the direct report's name to display a list of that person's direct reports and the corresponding training, meeting, and event reports for each of them. In this way, you can view reports for all of the people who report to you either directly or indirectly.

**Create menu**
On the left side of the Home page is a Create menu for creating new meetings, new content, new events, and so on.

**Learn menu**
On the left side of the Home page is a Learn menu with links leading to useful information.

**Viewing and changing your profile**
Clicking the My Profile link displays information about your account, as well as links for changing your password, editing your preferences, and so on. Displayed information includes:

**User Information** The information displayed may vary, depending on the information your administrator has defined for user profiles, but usually your first and last names and your e-mail address are listed. In addition, the following information also appears:

**Audio Conference Settings** Audio conference settings include telephone access information (your moderator code and client ID) for dialing into meetings. Your manager's name (if applicable) and your team members' names (if applicable) may also appear.

**Note:** The client ID is the customer identification number assigned by Premiere Conferencing. If your company uses another provider, this field has another name.

The following links appear at the top of your profile page:

**Change My Password** Click here to change your password. When you do, you are prompted once for your current password, and then twice for your new password.

**Edit My Preferences** Click here to change your time zone and audio conference settings.

**Group Memberships** Click here to display a list of all the groups to which you belong, including built-in groups.

**Organization** Click here to display your manager's name and the names of all of your team members, if applicable.
Logging out
You can log out of Enterprise Manager at any time.

1. Click Logout [your login name] in the upper-right corner of Enterprise Manager.

   The Enterprise Manager login page appears.

2. Close the login page to quit Enterprise Manager.

See also
“Start Enterprise Manager” on page 8

Searching the Content library
You can enter keywords at the Search Content link to search the Content library for presentations, as well as meeting and seminar archives.

Note: The presentations themselves must be searchable for the Search feature to be operable. In addition, you must have permissions to view the content you are searching for.

To use Search Content, enter a keyword and click Search Content. You can also click Search Content without entering a keyword to set the search parameters to refine your search.

Managing permission access for library folders and files

About libraries
The Content, Training, Meetings, Seminar Rooms, and Event Management tabs in Enterprise Manager each contain a library with files organized into a directory of folders. Files that you store in the Training, Meetings, Seminar Rooms, and Event Management libraries are available for activities in those respective tabs only. Files in the Content library can be accessed from all tabs in Enterprise Manager.

Administrators can set permissions to determine what tasks each user can perform in the libraries. Tasks include creating, editing, moving, adding, removing, and managing files and folders.

With the exception of the Seminar library, each Connect Enterprise library has two high-level folder directories: Shared folders and User folders.

• Shared folders: When Connect Enterprise is installed, only the administrator has access privileges to the Shared folders. Administrators can assign permissions for the Shared folders in any way appropriate. However, although Manage permissions for a Shared folder can be assigned to any Connect Enterprise user, only members of the Built-in group associated with that library can create new functions (meetings, events, and so on) in the folder. For example, in the Meetings library, any user with Manage permissions for a specific Shared Meetings folder can manage this folder, but only meeting hosts can create new meetings in it.

• User folders: When a user is assigned to a specific Built-in group, Connect Enterprise creates a user folder for that individual in the associated library. For example, any user assigned to the meeting host group automatically receives his or her own folder in the User Meetings folder in the Meetings library. It is this folder the user sees when accessing the Meetings tab. Users can manage their own user folders, including setting permissions that give other users access privileges to the folders, but users can do this only for their own folders.
Seminar library folders have a different structure. In the Seminar library, there are no user folders; instead, each folder represents a different seminar license that your organization purchased. When a user is assigned to the Seminar Host group, this user automatically has Manage permissions for all Seminar Rooms folders; such a user can add and delete seminars, and assign Manage permissions to other users. Only a seminar host can create new seminars in this folder.

About library permissions

You can set permissions on library files and folders to determine the level of access that users or groups have to the items.

These permissions are available for users and groups in the Content, Training, Meetings, Seminar Rooms, and Event Management libraries:

Manage  Users or groups with a Manage permission setting for a folder or file can view, delete, move, and edit the file or folder, view reports for files in that folder, set permissions for the file or folder, and create new folders. However, they cannot publish to that folder.
Denied  Users or groups with a Denied permission setting for a folder or file cannot view, publish, or manage this folder or file.

These additional permissions are available for users and groups in the Content library only:

Publish  Users or groups with a Publish permission setting for a folder or presentation can publish, update, and view presentations, as well as view reports for files in that folder. However, these users must also be members of the built-in Author group, as well as have Publish permission, to publish content to this folder.

View  Users or groups with a View permission setting for a folder or file can view any content in the folder, or can view the individual file.

About permissions for Built-in groups
Connect Enterprise recognizes seven default permission groups, each associated with a different Connect Enterprise library. Each member of a Built-in group has an individual user folder in the corresponding library. You cannot change the permissions for these groups, but you can extend them by assigning individuals or groups to more than one Built-in group. In addition, the administrator can create custom groups and assign these groups permissions for specific library folders. There are seven Built-in groups:

• Administrators
• Meeting Hosts
• Training Managers
• Seminar Hosts
• Event Managers
• Authors
• Learners

Note: For the Events library, users who belong to the Administrators group can view all events and folders. Users who belong to the Event Hosts group can view all events and folders in the Shared Events folder and in their My Events folder. Event permissions apply to all events in a folder. You cannot set permissions for individual events.

See also
"About Built-in groups” on page 233

Viewing options for content files and folders
You can make content files public or private, as follows:

Public  Anyone can view a public content file if they have its URL.

Private  Only Connect Enterprise users with View, Manage, or Publish permissions can view private content. To do so, they must first log in with a Connect Enterprise user name and password.

If you publish or upload a file to a folder that has its permissions set to allow public viewing, the content file is also available for public viewing by default. Similarly, if the parent folder has a custom permissions profile that allows only certain groups to view or manage it, the content file by default has the same profile.

You can customize the permission settings of a content file or folder by using the following options:

Allow public viewing  Make the content file or folder available publicly, even if the parent folder permissions are not set to allow public viewing.
**Set a custom permission profile for users and groups**  Add users or groups to the profile and set the access for each to Denied, View, Publish, or Manage. User and group permissions that you set for the file or folder take precedence over the permissions that are set for the parent folder.

**Reset to parent**  Set the content file permissions back to the permissions of the parent folder.

**To set permissions for content files or folders**

To customize the permissions list for a file or folder, you must be an administrator or a user with Manage permission for that library folder.

1. Click the Content, Training, Meetings, Seminar Rooms, or Event Management tab.
2. Navigate to the folder or file and click its name to open it.
3. Click Set Permissions on the navigation bar.
4. Click Customization. (If the permissions for this item have been modified before, the Customization button does not appear. Proceed to the next step.)

The Available Users and Groups pane displays users and groups for whom you can define permissions for the library item. The Current Permissions pane displays users and groups who already have permissions for the library item. You can change the existing permissions if desired.

5. To add a user or group to the Current Permissions pane, select the name in the Available Users And Groups list and click Add.

6. To set the permissions for a user or group, select the name in the Current Permissions list and click Permissions.

---

Setting permissions and navigating Available Users and Groups

A. Click to set folder or file permissions to be the same as the parent folder permissions  
B. Choose a viewing permission  
C. Double-click a group name to view the users in that group  
D. Double-click the Up One Level icon to go up one folder level  
E. Users  
F. Click the Search button to open a text box for searching  
G. Click Add to move a selected user or group to the Current Permissions list
7 Select the appropriate permission setting from the pop-up menu: Manage, Denied, View (for Content library only), or Publish (for Content library only).

8 To remove a user or group from the Current Permissions list, select the name and click Remove.

9 To reset permissions for the entire library folder or file to be the same as those of the parent folder, click Reset to Parent.

10 For Content library only: Select Yes for Allow Public Viewing to make this folder publicly viewable, even if the parent folder is not publicly viewable. Select No to make the folder inaccessible to the public.

Managing library folders and files

Create a folder
Administrators and users with Manage permission for a specific folder can create folders and subfolders within it. You cannot create a new folder in the Seminars library.

1 Click the Content, Training, Meetings, or Event Management tab at the top of the Enterprise Manager window.
2 Navigate to the location where you want to add the new folder.
3 Click New Folder on the menu bar above the folder list.
4 Enter the name of the new folder on the new page that appears.
5 Click Save to create the new folder.

Move a library folder or file
You can move a folder or a file in a library. When you move a folder, all of the items within the folder also move to the new location. You can move folders and files in the Content, Training, Meetings, or Event Management libraries using the Move button. You can move folders and files in these libraries and in the Seminar Rooms libraries using the Up One Level button. In Seminar Rooms libraries, you can choose to move uploaded content or recordings that are saved with a seminar.

1 Click the Content, Training, Meetings, Seminar Room, or Event Management tab at the top of the Enterprise Manager window.
2 Navigate to the folder or file that you want to move.
3 Select the check box to the left of the item that you want to move. For a seminar, choose Uploaded Content or Recordings if you want to move either of those types of items saved with the seminar.

4 Do either of the following:

- Click Up One Level to move the item up one level in the library folder directory.
- Click Move (this option is not available for the Seminar Rooms tab). Select a folder in the folder directory tree, or click Up One Level. Click Move and then click OK to apply the change.

Delete a library folder or file

When you delete a library folder or file, it is permanently removed from the library and cannot be retrieved. Be careful to delete only those items you are sure you will not need again. If you delete items from the Content library that are linked to meetings, events, seminars, or courses, the deleted content is unavailable from them. When you delete an item, Enterprise Manager indicates whether the item is linked and allows you to cancel the deletion. In Seminar Rooms libraries, you can choose to delete uploaded content or recordings that are saved with a seminar.

Note: For the Training library, if you delete a training folder containing a course that was part of a curriculum, the deleted course is still listed on the Curriculum information page as a course item. However, the course is no longer available.

1 Click the Content, Training, Meetings, Seminar Room, or Event Management tab at the top of the Enterprise Manager window.

2 Navigate to the folder or file.

3 Select the check box to the left of the item that you want to delete. For a seminar, choose Uploaded Content or Recordings if you want to delete either of those types of items saved with the seminar.

4 Click Delete on the menu bar above the content list.

5 Click Delete again to permanently delete the selected items, or click Cancel to cancel the deletion.

Edit library folder or file information

You can edit the title or name of a library item and other information, using the Edit Information button.

Note: If you are editing a Seminar library folder, you can view information about the Seminar license for that folder. This is a quick way to see how many users and meetings are available for a specific Seminar folder. In the navigation bar next to the Editor Information link, click License Info. Information that appears includes title, summary, start date, end date, number of concurrent users, and number of concurrent meetings.

1 Click the Content, Training, Meetings, Seminar Room, or Event Management tab at the top of the Enterprise Manager window.

2 Navigate to the folder or file.

3 Click the Edit Information link in the navigation bar below the navigation trail.

4 Edit the title, name, or other properties that you want to change.

5 Click Save.
Download Content library files (except presentations)

Users who have access (the correct permission level) to an item can download Content library files to their computers. You can download any type of content. If the content is composed of more than one file, it is packaged into a ZIP file.

1. Click the Content tab.
2. Navigate to the content file that you want to download.
3. Click the name of the content file.
4. Click the Download Content link on the navigation bar.

The Download Content link is on the information page for the item to be downloaded

5. Under Download output file(s), click the content file name.
6. Click Save.
7. Navigate to where you want to save the file. If necessary, replace the default filename.
8. Click Save.
9. When the download is complete, click Close.

Download presentations from the Content library

Users who have Manage permissions can download a presentation to deploy it intact on an intranet or distribute it on a CD. It is downloaded as a ZIP file, which the user then extracts.

1. Click the Content tab.
2. Navigate to the presentation and click its name.
3. Click the Download Content link on the navigation bar.
4. Click the Download Output File link.
5. In the Save As dialog box, navigate to where you want to save the file.
6. Click Save in the File Download dialog box.
Download presentation source files from the Content library

You can download the source files associated with any type of content. If the content is composed of more than one file, it is packaged into a ZIP file.

Downloading source files can be helpful if you no longer have your source PPT and PPC files for an Adobe Presentation. You must save the PPC file in the same folder in which you saved the PPT file, and you must give it the same name as the PPT file, but with the .ppc extension, to maintain any audio or timings in the presentation. Thus, you should have both the PPC and PPT files in your folder, with the same name but with different file extensions. It’s critical that you do not overwrite the PPT file extension with a PPC extension; if you do, the file may become unusable.

Note: The only source files available for download are files that have been uploaded. For example, Adobe Presenter and Adobe Captivate give users the option to upload or not upload source files. If the option to upload source files is not selected, those files will not be available for download later.

1. Click the Content tab.
2. Navigate to the presentation and click its name.
3. Click the Download Content link on the navigation bar.
4. In Download source files, click the PPT or PPC file.
5. Click Save in the File Download dialog box.
6. Navigate to where you want to save the file in the Save As dialog box.
7. Click Save.
8. In Download output files, click the zip file.
9. Click Save in the File Download dialog box.
10. Navigate to where you want to save the file in the Save As dialog box.
11. Click Save.

Navigate in a library

If you are an administrator, a host, or a user with permissions to manage a specific library folder, you can navigate in a library.

To open a folder

1. Click the Content, Training, Meetings, Seminar Room, or Event Management tab located at the top of the Enterprise Manager window.
2. Click the name of the folder.

The folders and files within that folder appear, and the name of the selected directory appears in the navigation links at the top of the browser window.

To move up one folder

☐ Click the Up One Level button on the navigation bar above the folder list.

The folders and files within the parent folder appear. The name and location of the parent folder appear in the navigation links list at the top of the browser window.
To return to any folder
Above the functional links is a list of navigation links called the navigation trail, which indicates your current location in the directory structure. You can move to any parent (higher) folder shown in the navigation trail.

❖ Click the name of a parent folder in the navigation trail.

The folders and files in the higher parent directory appear. The name and location of the parent folder appear in the navigation links at the top of the browser window.

To edit a seminar folder name or description
To edit a seminar folder name and description you must have Hosted Manager access.

1. Click the Seminar Rooms tab at the top of the Enterprise Manager window.
2. Navigate to the folder and click its name.
3. Click the Edit Information link above the seminar list.
4. Enter the new name for this folder in the Title text input box and, if desired, a description in the Summary text input box.
5. Click Save.

Managing content in the Content library

Content library supported file types
All content in the Content library must be one of the following types

• A single PDF file
• A single PPT file
• A single SWF file
• A single HTML file
• A single Adobe Captivate SWF file
• Captivate content published through the Adobe Captivate application
• Adobe Presenter content published through the Presenter plug-in
• Presenter content packaged as a ZIP file
• An old Macromedia Breeze 4.1 presentation packaged as a ZIP file (downloaded for a 4.1 server) (Breeze is now Adobe Connect.)
• A ZIP file that contains multiple SWF files and extra files (images, XML files, and so on) and one file called index.swf that will be loaded first
• A ZIP file that contains simple Authorware content (one HTM file, one AAM file, and extra Authorware files
• A ZIP file that contains multiple HTM or HTML files and extra files (images, SWF, and so on) and one file called index.htm or index.html
• An Adobe Flash video file (FLV file)
• A single image (JPEG, GIF, or PNG)
• A single audio file (MP3)
Each file type is represented by a separate icon in the Content library.

**Upload files from Connect Enterprise Manager**
Only members of the built-in Authors group with Publish permissions for a specific Content library folder can upload files to that folder.

1. In Enterprise Manager, do either of the following:
   - On the Home tab, select New Content from the Create menu.
   - On the Content tab, click the New Content button.
2. Under Select Content File, click Browse to locate the file, click its name, and then click Open.
3. Enter a title for the new content file (required) and a summary (optional) in the Enter Content Information text boxes.
4. (Optional) Enter a custom URL (if you do not assign a custom URL, the system automatically assigns one).
5. Click Save.

The file is uploaded to the server and appears in the content folder.

**Note:** If you attempt to upload a file of an unsupported file type, the Enter Content page reappears with the message “Invalid file format selected.”

**Note:** If you have Adobe Presenter or Adobe Captivate installed, you can also use the Publish option within those applications to upload content to the Content library.

**Upload new version of existing file from Connect Enterprise Manager**
You can upload new versions of content that already exist in the Connect Library.

1. On the Home tab, click Content.
2. In the Content List, click the content file you want to update.
3. Click Upload Content.

   A message appears stating “Please select the location of the content to upload. The content should be in the following format: *.xxx.”

4. Click Browse to locate a file in the format specified in the message, click the file's name, and then click Open.
5. Click Save.

The new version of the content is uploaded to the Content library. To check that the process was successful, find the file in the Content List and check the Date Modified. You can also go to the Content Information page, click the URL, and view the new version of the content.

**About AICC content**
To upload Aviation Industry CBT Committee (AICC) content into the Content library, you must zip up the files into a content package and upload it through the New Content interface in Enterprise Manager.

**Note:** Content should be AICC compliant if the content contains quizzes or data that can be scored and you want Connect Enterprise to keep track of the scores.
Keep the following in mind when you create AICC content:

- The content must be able to report either "complete" or "passed" to indicate that the user has finished interacting with the content.
- The content package must have a file named index.htm or index.html that the server relies on to launch the content.
- Content must report "Incomplete" on all communications until the user has finished interacting with the content.

**Creating custom URLs**

When you add a new piece of content, a new meeting, a new course or curriculum, a new seminar, or a new event, you can include a custom URL. This URL is unique across the entire Connect Enterprise account and should have a meaningful name. For example, the custom URL could be your name or the name of your organization.

<table>
<thead>
<tr>
<th>Name: *</th>
<th>Team Demo</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom URL:</td>
<td>[Leave this field blank for a system-generated URL or include a unique URL path. For example, &quot;productdemo&quot; will result in <a href="http://www.yourcompany.acrobat.com/productdemo/">http://www.yourcompany.acrobat.com/productdemo/</a>]</td>
</tr>
<tr>
<td>Summary: (max length=250 characters)</td>
<td>Demonstration of new training tools</td>
</tr>
</tbody>
</table>

**Adding a custom URL**

A. Uneditable portion of URL set by your administrator  
B. Customizable portion of URL

**Custom URL use**

A custom URL can be associated with only the specific item in which it is included, and you cannot use it for any other Connect Enterprise function. For example, if you assign the custom URL /yourname to a piece of content, you cannot assign that URL to another piece of content or to a meeting, nor can any other user who shares your account assign that URL to anything. If you delete the content that includes the custom URL, however, the custom URL becomes available for re-use.

If another user is currently using the custom URL, you receive an error message when you enter the URL. In this case, depending on the circumstances (for example, if another user is using your full name as a custom URL), you can check with your administrator to see who is using the URL.

**Custom URL rules**

- You cannot edit a custom URL after you create it.
- You cannot use digits (0 to 9) at the beginning of a custom URL.
- Custom URLs cannot contain any punctuation, spaces, or control codes.
- If you enter any uppercase letters, they are automatically converted to lowercase letters to conform to URL case-sensitivity conventions.
- Do not use any of the following reserved keywords in your custom URL.

<table>
<thead>
<tr>
<th>account</th>
<th>content</th>
<th>idle</th>
<th>report</th>
</tr>
</thead>
<tbody>
<tr>
<td>adobe</td>
<td>cs</td>
<td>input</td>
<td>search</td>
</tr>
</tbody>
</table>
View Connect Enterprise content from the Content library
You can open content for viewing from within Enterprise Manager after you browse to it in the Content library.

1. Click the Content tab at the top of the Enterprise Manager window.
2. Browse the Content library, and click a filename to view the associated Content Information page.
3. Click the file's URL For Viewing link. A new browser window displays the selected file or presentation.

View Connect Enterprise content in a browser window
You do not have to open Connect Enterprise content from within Enterprise Manager. When you have the URL for viewing the file, you can also browse to it directly from any browser window.

1. Open a browser window.
2. Enter the URL for viewing the content in the browser URL address text box or click a link received in an e-mail.

Send a content URL by e-mail
Every content file in the Content library has a unique URL that lets users view the contents of the file. You can send this URL to other people by e-mail from within Enterprise Manager.

Enterprise Manager creates a unique version of the URL for each e-mail recipient. Compared to pasting the URL in an e-mail, using Enterprise Manager has these advantages:

• You can request that a return receipt be sent to you when an e-mail recipient clicks the web link. You can track who viewed the contents because a unique URL was created for each recipient.
• Recipients can view the content without having to log in with a Connect Enterprise user name and password, even if the permissions for the content file in the Content library are not set for public viewing.

1. Click the Content tab at the top of the Enterprise Manager window.
2. Navigate to the content file and click its name.
3 Click E-mail Link on the navigation bar.
4 Enter the e-mail addresses for all recipients in the To text box on the E-mail Link page.
   If necessary, separate multiple e-mail addresses with commas to create a unique URL for each e-mail recipient.
5 Edit the Subject and Message Body text boxes as needed.
   **Note:** Do not delete the information in the braces ("{tracking-url}") in the message body. This is a placeholder that is
   replaced with the content URL in the generated e-mail message.
6 Select Generate a Return Receipt When Presentation Is Viewed to receive an e-mail notification when a recipient
   views the content file; otherwise, clear the check box.
7 Click Send.

**About the Content Dashboard**

The Content Dashboard provides a graphical representation of statistical data about your content. The data reflects all of the content in your My Content folder and appears in four bar graphs.

- **Most Viewed Content Over Last 30 Days**  The number of views.
- **Most Effective Presentations Over Last 30 Days**  Determined by percentage of slides viewed across all viewers.
- **Most Recently Viewed Content Over Last 30 Days**  In list format, shows the name, content type, number of views, and last time this content was viewed. The most recently viewed is listed first.
- **Aging Content**  In list format, shows the name, content type, and last time this content was viewed. The most recently viewed is listed last.

Click any item in these displays to view the corresponding Content Information page.

The bar graphs appear in the Enterprise Manager Content tab window. However, you can also export the Dashboard to a printable browser window. To do so, click Printable Version on the left, above the display.

**Viewing content reports**

The Reports feature of Enterprise Manger lets you create reports that show you a given piece of content from different perspectives.

1 Access the information page (for example, the Content, Meeting, Course Information page, and so on) for the file whose reports you want to set.
2 Click the Reports link above the Content Information title bar. This displays other links that let you define the kinds of report information you can see for this content. The links are as follows:
   - **Summary**  The first report type that appears when you access the Reports feature. The Summary provides the content name, the date that the content was last modified, and the number of times this content was viewed.
   - **By Slides**  Applies to presentations only. A bar graph lists each slide in the presentation by slide number and the number times it was viewed; below the graph is a table with the same information, which also includes the last time each slide was viewed.
   - **By Questions**  A bar chart shows each question, color-coded as correct or incorrect, and the number of respondents to the question. Click a question in the bar to display a pie chart with a table that provides the answer key and answer distribution. The answer key lists all possible answers for the selected question and their corresponding answer number or letter. The answer distribution lists all of the answer choices selected for this question, flags the correct answer, and shows the number of users who selected each answer, as well as what percent of the total each number
of users represents. Finally, the chart totals the users by number of users and percent of users. Below the graph is a table that provides an overview of all questions, listing each question by number, name, number of correct answers, number of incorrect answers, percentage of correct, percentage of incorrect, as well as the score.

**By Answers** A table provides the maximum possible score, the passing score, the average score, and the high score for the quiz. For each question, the table also shows the question number, the question itself, and the answer distribution; that is, how each question was answered, if at all. Click the View Answers link to display a pie chart with a table that provides the answer key and answer distribution. The answer key lists all of the possible answers for the selected question and their corresponding answer number or letter. The answer distribution lists all of the answer choices selected for this question, flags the correct answer, and shows the number of users who selected each answer, as well as what percent of the total each number of users represents. Finally, the chart totals the users by number of users and percent of users.

**Note:** Connect Enterprise resets content scores for quizzes and surveys each time the user accesses the content. This means that if a user closes the quiz or survey without completing it, then returns to it later, all of the previous answers are lost. If you do not want the score to reset, and you have access to the Training tab, you can create a new course and select the content in question as the course content. This way, you have turned the content into a course.

The Hide Answer Distribution/Show Answer Distribution button is a toggle for showing and hiding the distribution of answers for each question.

### About content report filters
Where appropriate, you can restrict the information you see on a report by specifying report filters. When the filters are in effect for a given report, the Report Filters link appears above the report display. You can set any or all of the following criteria to refine your reports:

**Time period** A date range for the information in that report. For example, if you select a date range for the By Slides report, it shows only the slides that were viewed within that time frame.

**Team members (for managers only)** The data on the report applies only to the people who are the manager's subordinates, either as direct reports or all reports (including both direct and indirect subordinates). This distinction depends on which option was selected: Show Data From People I Manage Directly or Show Data From People I Manage Directly And Indirectly.

**Groups** The data on the report applies only to the members of a specific group that participated. You can select more than one group, and then deselect any group.

Any filters you set apply to all reports that you create, both for the specific report and for any other Connect Enterprise functionality. For example, if you create a training report after you set filters for a content report, the filters you set apply not only to the content report but also to the training report. This rule applies to any date range you specify. If you do not clear a date range filter that you set for one report, all reports are filtered by that date range as well.

**Note:** Report filters are only saved for the current session. If you set report filters, click Save, then logout of Connect Enterprise, when you log in again the report filters you previously set are not retained.

To clear filters you have set, click Reset on the Set Report Filters page.
**Set content report filters and generate reports**

You can set report filters and download reports whenever necessary.

**Set report filters**

1. Access the information page (for example, the Content, Meeting, Course Information page, and so on) for the file whose report filters you want to set.

2. On the information page, click the Reports link above the Content Information title bar.

A set of report links appears above the title bar, with Summary highlighted, and the Summary report for this meeting appears below the information heading.

3. Click the report type for which you want to set filters.

The data for the report type you selected appears in the Enterprise Manager window.

4. Click the Report link, to the right of the *No Filters Have Been Set* label.

5. Set one or more of the following filters:

   - To set the date range filters, select the *From* and/or *To* check boxes and the start and/or end dates and times.
   - To set filters for groups, click the Add/Remove Groups link and select the check box for the groups you want to track in your report.
   - To select team members, click either Show Data From People I Manage Directly or Show Data From People I Manage Directly And Indirectly.

6. Click Save at the bottom of the Set Report Filters page.

The report page reappears with the filters you set, above the display bar.
Download reports
1 Access the information page (for example, the Content, Meeting, Course Information page, and so on) for the file whose report you want to download.

2 On the information page, click the Reports link above the Content Information title bar.

3 Click a report type, for example, By Slides or By Questions.

4 Click the Download Report Data button.

This exports all the report data to a comma separated values (CSV) file. You can either save or open the report. If you are running Enterprise Manager in an Internet Explorer browser and choose to open the report, Windows automatically opens it in Microsoft Excel. In this case, you must double-click each cell to see its information.

Another option is to save the CSV file to your desktop, select Notepad from the Accessories menu (select Start > Accessories > Notepad), and open the file from Notepad, which makes it easier to read.

In addition, if the Printable Version button appears for a report, you can click the button to export the report to a browser window and print the report.

Remove report filters
1 Access the information page (for example, the Content, Meeting, Course Information page, and so on) for the file whose report filter you want to remove.

2 On the information page, click the Reports link above the Content Information title bar.

3 Click a report type, either By Slides, By Questions, or By Answers.

4 Click the Report Filters link.

5 In the Set Filters page, do either of the following:
   • To clear all filters, click Reset.
   • To clear a specific filter, deselect the check box and click Save; if it’s a group, click Add/Remove Groups, deselect the group check box, and click Save.
Chapter 3: Adobe Acrobat Connect Professional meetings

Acrobat Connect Professional How To topics

How To topics for Hosts and Presenters
- “Creating meetings” on page 42
- “Meeting room layouts and the layout navigation bar” on page 35
- “Start or stop an audio conference call” on page 66
- “Sharing a computer screen, document, or whiteboard” on page 53
- “View or change an attendee’s role” on page 65
- “Add a note to a Note pod” on page 74
- “About the Chat and Q & A pods” on page 75
- “Record a meeting” on page 70

How to topics for Participants
- “Join a meeting” on page 45
- “Join a conference call or mute your phone” on page 69
- “Set up audio broadcasting” on page 81
- “Set up video broadcasting” on page 83
- “Sharing a computer screen, document, or whiteboard” on page 53
- “Send a chat message” on page 76
- “Play back a recorded meeting” on page 71

Adobe Acrobat Connect Professional basics

About Acrobat Connect Professional meetings
An Adobe Acrobat Connect Professional meeting is a live online conference for multiple users. The Acrobat Connect Professional meeting room is an online application that you use to conduct a meeting. The meeting room consists of various display panels (pods) and components. You can choose from several prebuilt meeting room layouts, or customize a layout to suit your needs. The meeting room enables multiple users, or meeting attendees, to share computer screens or files, chat, broadcast live audio and video, and take part in other interactive online activities.
Once you create a meeting room, it exists until you delete it. Its location is a URL, assigned by the system when the meeting is created. When you click the URL, you start the Adobe Flash application in your browser and enter the virtual meeting room that Flash constructs for you. A meeting room can be used over and over for the same weekly meeting. The host can leave the meeting room open or closed between scheduled meetings. If a meeting room is open between meetings, attendees can enter the room at any time to view content.

To take part in a meeting you must have a browser, a copy of the Adobe Flash Player 7 or higher, and an Internet connection. Your capabilities in a meeting depend on your assigned role and permissions.

**Meeting roles and permissions**

Your capabilities for sharing, broadcasting, and other activities in an Acrobat Connect Professional meeting are determined by your role. There are three roles for meeting room attendees: host, presenter, and participant.

The creator of a meeting is designated as the host by default. The host can specify each attendee's role, including selecting other attendees to be hosts for the meeting. Permissions for each role are as follows:

**Host** Hosts can set up a meeting, invite guests, add content to the library, share content, and add or edit layouts in a meeting room. They can promote other participants to the role of meeting room host or presenter, or give enhanced permissions to a participant without promoting the participant. They can also perform all the tasks that a presenter or participant can.

**Presenter** Presenters can share content already loaded into the meeting room from the library and share content from their computer, including Acrobat Connect Professional presentations, slides (PPT files), Flash application files (SWF files), Flash Video files (FLV files), and images (JPEG files). They can share the screen, showing it on the Stage of all attendees, and they can chat, and broadcast live audio and video.

**Participant** Participants can view the content that the presenter is sharing, hear and see the presenter's audio and video broadcast, and use text chat.

**See also**

“About attendee names” on page 64

“Managing the Adobe Connect Enterprise Account” on page 217

“Assigning enhanced participant rights” on page 66
About audio in meetings

There are two ways to use audio in a meeting: integrate with an audio conference call or broadcast audio using VoIP (Voice over Internet Protocol.)

- Audio conferencing. A host can integrate a meeting with an audio conference call. This lets you control the audio conference from the Attendee List pod in the meeting room.

To integrate an audio conference call with a meeting, you must have an Acrobat Connect Professional account with an audio conference bridge installed. Acrobat Connect Professional has partnerships with third-party companies, including Premiere and Avaya, to provide conferencing solutions that integrate with Acrobat Connect Professional. To find out if your account has an audio conference bridge installed, contact your Acrobat Connect Professional administrator.

To integrate an audio conference call with a meeting, you must specify audio conference information (such as the telephone number) in the Meeting Information page in Acrobat Connect Enterprise Manager, when you create the meeting or when you edit the meeting information.

If you have an audio conference bridge installed, you can record an audio conference call when you record a meeting.

If you don't have an audio conference bridge installed, you can use the microphone on your computer system to record the audio from your speakerphone.

- VoIP. You can use the Camera And Voice pod to broadcast audio in a meeting using Voice over Internet Protocol (VoIP) and the microphones on attendees' computer systems.

To use VoIP with a meeting, attendees must have microphones connected to their computer systems. Attendees set up their microphone using the Audio Setup Wizard. With VoIP, audio is recorded automatically when you record a meeting.

Enter or leave a meeting room

You enter a meeting from its Acrobat Connect Professional login page. When you log in, you can enter as a registered Acrobat Connect Professional user or as a guest.

- If you are a registered user, you can provide the user name and password for your Acrobat Connect Professional account (created by an administrator) to enter the meeting room. If you are a host or presenter, you must enter as a registered user.

- Any attendee can log in as a guest. If the meeting's creator designated the meeting as public, your guest login name is automatically accepted. If the meeting creator designated the meeting as private, the meeting host receives your request to enter and can accept or decline it.

Log in to an Acrobat Connect Professional meeting

1 To access the login page, do one of the following:
   - From the Home page in Acrobat Connect Enterprise Manager, under My Scheduled Meetings click the Enter button for the desired meeting.
   - From the Meeting Information page in Acrobat Connect Enterprise Manager, click Enter Meeting Room.
   - Click the meeting URL in the e-mail invitation that you have received.
   - Enter the meeting URL in your browser.

2 Log in to the meeting room as either a guest or an Acrobat Connect Professional user:
   - Select Enter As Guest. Type the name to be used as your identifier in the meeting, and click Enter Room.
   - Select Enter with Your Acrobat Connect Professional Password. Enter your login name and password, click Enter Room.
If the meeting has started, your browser immediately displays the meeting room. If the meeting has not started, you receive this message: “The meeting has not yet started. You will be able to access the meeting once the host arrives. Please wait.”

Leave a meeting room
❖ Click the Close (X) button in the upper-right corner (Windows) or upper-left corner (Mac OS) of the meeting room window, or choose File > Meeting > Exit Acrobat Connect.

Note: If your meeting room view is set to full screen, the Close button is not visible. To view the Close button, resize your meeting room. In Windows, press Esc to enable resizing.

About meeting registration
Depending on the type and purpose of a given meeting, the meeting host may want to have the guests register. If so, the host must have access to the Event Management capabilities in the Acrobat Connect Enterprise Manager application, since registration for any meeting, training, presentation, or seminar can be done only through the Event Management tab.

The Event wizard lets the host select and invite users, select and customize registration questions, and send invitations, even to large e-mail lists.

See also
“Creating meetings” on page 42

About bandwidth and performance
Many network factors affect the performance of the Acrobat Connect Professional application for attendees, including the bandwidth setting for the meeting room, the connection speed setting for each individual attendee, and the type of content being shared and activities being performed in the meeting.

For example, higher bandwidth is required to share a recorded video than to share a text document, and higher bandwidth is required to broadcast live video than to send chat messages.

Optimize Room Bandwidth The meeting host can specify the bandwidth setting at which the meeting is broadcast. Options are Modem, DSL/Cable, and LAN. You should match the room bandwidth to the connection speed available to attendees. For example, only use LAN if all your attendees have access to LAN. If attendees are on a variety of connection speeds, it is best to choose the slowest speed that attendees are using. If a number of attendees are using Modem connection, set the room bandwidth to Modem.

Attendee Connection Speed Each attendee can choose My Connection Speed from the Meeting menu and select Modem, DSL/Cable, or LAN. Attendees should choose the connection speed that matches their Internet connection type. If attendees experience latency in receiving an audio or video broadcast, they should reduce their connection speed setting.

The following general guidelines are recommended for room bandwidth settings. Actual speeds may vary according with each network environment:

• Modem: One presenter can generate around 26 kbits/second of data. Attendees need around 29 kbits/second for a good connection. Having more than one presenter with the Modem setting is not recommended. Screen sharing with the Modem setting is not recommended.

• DSL/Cable: One presenter can generate around 125 kbits/second of data. Attendees need around 128 kbits/second for a good connection. If screen sharing is used, attendees should have 200 kbits/second.
LAN: One presenter can generate around 250 kbits/second of data. Attendees need around 255 kbits/second. If screen sharing is used, attendees should have 400 kbits/second.

See also
“Creating meetings” on page 42

About the Meetings library
The Meetings tab in Acrobat Connect Enterprise Manager contains three panes for accessing meetings: Shared Meetings, User Meetings, and My Meetings, which each contain folders and files with meeting content and recordings. Users can create and manage content in the My Meetings pane that appears when they are logged into Acrobat Connect Enterprise Manager. Access to content in the other panes is determined by the meeting library permissions set for each user by the Acrobat Connect Enterprise Manager administrator.

Content that you place in the Meetings library is available only for use in meetings. If you would like the content to be available for other activities initiated in Acrobat Connect Enterprise Manager (such as events, seminars, or training), you can upload the content to the Content library, or move content from the Meetings library to the Content library.

See also
“Managing permission access for library folders and files” on page 13

“Managing library folders and files” on page 17

Acrobat Connect Professional work area

Inside an Acrobat Connect Professional meeting room
Content in a meeting room is displayed in pods, panels that contain various types of media, including slides, video, whiteboards, shared applications, polls, and messages to meeting attendees. The menu bar at the top of the meeting room window displays meeting information and contains controls for managing the room.

The meeting room Stage is the area of the presenter’s screen that participants see in a meeting. The Stage contains the pods that display various types of content, such as slides, video, or shared windows or applications.
A participant’s view of the Stage
A. Meeting name  B. Participant menu bar  C. Pods

The meeting Host’s view
A. Host menu bar  B. Layout navigation bar  C. Sharing options  D. Show/Hide Presenter Only Area

The Acrobat Connect Professional meeting room window has a second display area, the *Presenter Only area*, which borders the Stage and is visible only to hosts and presenters. Hosts and presenters can use the Presenter Only area to prepare content to be shared with attendees or to view confidential content that is not shared with attendees.

The meeting name appears at the top of the meeting room window.

**Meeting room pods**
A meeting room usually contains a number of display panels, called *pods*, each with its own function. When hosts set up a meeting room, they determine the number, types, size, and position of pods that participants see. The following pods are available:

- **Share pod**  Displays shared content from the presenter’s computer (including windows, applications, or the entire desktop), documents, or whiteboards.

- **Attendee List pod**  Displays the name, role, and status of each attendee, and allows the host to change an attendee’s role or permissions.

- **Chat pod**  Allows attendees to send chat messages to other attendees.

- **Q & A pod**  Linked to Chat pod. Redirects questions from the Chat pod to appropriate presenters.
Note pod  Displays text messages from hosts or presenters to all attendees.

Camera And Voice pod  Allows hosts, presenters, and participants with appropriate permissions to broadcast live audio and video to all attendees.

File Share pod  Allows hosts and presenters to post files which can be downloaded by attendees.

Poll pod  Allows hosts and presenters to conduct polls or ask questions of attendees.

Web Links pod  Lets host post a web link and force all attendees to browse to that link.

Meeting room layouts and the layout navigation bar
The layout navigation bar at the bottom of the meeting room window is visible only to hosts. A host can use the navigation bar to switch to a new layout. It contains the names of meeting room layouts.

By default, a new meeting room contains three prebuilt layouts: Sharing, Discussion, and Collaboration. The pods in these layouts are selected and arranged to facilitate sharing of content, discussion of topics, or collaboration with colleagues.

You can switch from one meeting room layout to another by clicking its name in the layout navigation bar. You can also create your own meeting room layouts.

When a host clicks a different layout on the layout navigation bar, the new layout is displayed on every attendee's screen. In contrast, a host in Preparing mode can navigate between meeting room layouts without affecting the participants' view. This makes it possible for a host to edit or prepare meeting room layouts while another attendee is presenting.

Presenter Only area
A host can place pods offstage—that is, anywhere that is not taken up by the Stage, menu bar, or layout navigation bar. Participants don't see pods placed offstage, in the Presenter Only area. Only other host or presenters can see those pods. Presenters can use these private pods to exchange notes, text messages, and so on, that they don't want participants to see. Any pod in a meeting can be placed in the Presenter Only area.
The Presenter Only area is also useful if a host wants to prepare new content before making it available for viewing. To show new content, the host can drag it onto the Stage from the Presenter Only area. For more information on organizing and creating your own meeting room layouts, see “Working with meeting room templates” on page 39.

**Meeting room menu bar**

The menu bar contains several menus: a host sees the Meeting, Present, Layouts, Pods, and Help menus; a presenter or participant sees only the Meeting and Help menus. All attendees see the meeting room connectivity indicator.

In the right corner of the menu bar, the colored bar indicates the connection status of the meeting room. Messages and warnings also appear in this corner. A red circle in the menu bar indicates that the host is recording the meeting.

Using the menu bar, you can access the following features:

**Meeting menu** Lets you switch between the original size and a full-screen view of the meeting room and (if you’re running the Acrobat Connect Add-in) exit a meeting. By selecting the Audio Setup wizard, you can test your speakers and set the volume levels for your microphone. A host can use this menu to invite participants to a meeting, record a meeting, or stop the current meeting, as well as change room background, set room bandwidth and screen resolution, manage the meeting room using Acrobat Connect Enterprise Manager, and allow all participants to enter the room as presenters.
Present menu  Lets hosts show and hide the Presenter Only area; change the attendee type to host, presenter, or participant; enter Preparing mode; and change the display of the host cursor.

Layout menu  Lets hosts customize the meeting room's layout (for example, to view, add, delete, move, or resize pods).

Pods menu  Lets hosts add pods and content to a layout, and organize and lock existing pods.

Help menu  Lets you test the type of Internet connection you have, and access help and troubleshooting information. Hosts, presenters, and participants have access to all Help menu commands.

Meeting room status  Indicates the connection status of the meeting room. A green bar means that the room connection is optimal. A gray bar with a twirling icon indicates that you have been disconnected, and Acrobat Connect Professional is trying to reestablish your meeting connection. Roll over the twirling icon to view a tooltip with a link to a Troubleshooting page, if reconnection is not successful.

Secure Sockets Lock  Indicates that the meeting is connected over a secure socket (verifying the host server's identity).

Setting up a meeting room
You create a meeting room using the Acrobat Connect Enterprise Manager web application. You select a meeting room template and then specify a meeting room name and description, meeting time, access type (open to anyone, or to registered users only), and attendees to invite. You can also select the language for the interface, and add information on audio conferencing (such as the telephone number.) The application generates a meeting room for you. You can choose a custom URL for accessing the meeting, or use the automatically generated URL. You can use the URL to enter the meeting room at any time. The creator of a meeting is designated the host by default.

Invite attendees and grant or deny access
While in the meeting room, hosts can invite people to attend a meeting. A host can choose to block access to a meeting, and can allow or disallow requests to enter a blocked meeting.

Invite attendees while a meeting is in progress
Hosts can invite people to a meeting from the Acrobat Connect Professional meeting room.

1  Do one of the following:
   • In the menu bar, select Meeting > Invite Participants.
   • In the Attendee List pod, click the Pod Options button in the lower-right corner and select Invite Participants.

2  In the Invite Participants dialog box, do one of the following:
   • Click the Send E-Mail button to open your default e-mail application and send invitees an automatically generated e-mail message with the meeting URL.
   • Copy the meeting URL from the Invite Participants dialog box into an e-mail or instant message and send the message to invitees. Return to the meeting room and click Done to close the dialog box.

Block incoming attendees
1  In the menu bar, select Meeting > Block Incoming Attendees.

2  To allow incoming attendees to request entry to the meeting, select Incoming Attendees Can Request Entry. Deselect this option to disallow requests to enter the meeting.

3  In the text box, enter a message that will be displayed to incoming attendees.
4 Select Save Message to save the message for future use.

5 Click OK.

**Put a meeting on hold or end a meeting**

A host can put participants on hold to block access to the meeting room temporarily. Hosts and presenters can still enter a meeting room and perform activities there while participants are on hold. Audio conference calls are placed on hold.

A host may put a meeting on hold to allow presenters to enter a meeting room while the meeting is not in session, so that they can prepare materials for the meeting. A Stop Meeting icon appears at the right of the menu bar when a meeting is on hold.

A host can remove everyone from a meeting and end the meeting to deny everyone access to the meeting room, including hosts, presenters, and participants. Audio conference calls are disconnected. Hosts may end a meeting if the Acrobat Connect Professional account is billed by the minute, to prevent charges while the meeting is not in session. When a host has ended a meeting, a message appears indicating that the meeting has ended.

A button for restarting the meeting appears to hosts. The host can view a notification window to see how many attendees are waiting to enter the meeting room. Attendees who log into a meeting that is on hold will automatically enter the meeting when it resumes.

Hosts can send On Hold or Meeting Ended messages to inform attendees of the meeting status.

**Place participants on hold**

1 In the menu bar, select Meeting > Place Participants On Hold.

The Message For Viewers text box displays the message “This meeting has been placed on hold. The host will resume the meeting shortly. Thank you.”

2 Revise the message if you wish, and click OK to put the meeting on hold and display the message to participants.

   To find out how many participants are waiting to enter a meeting you have placed on hold, place the pointer over the Stop Meeting icon at the right of the meeting room menu bar.

**End a meeting**

1 In the menu bar, select Meeting > End Meeting.

The Message For Viewers text box displays the message “The host has ended this meeting. Thank you for attending.”

2 Revise the message if you wish, and click OK to end the meeting and display the message to participants.

**Compose an On Hold or End Meeting message without interrupting the meeting**

1 In the menu bar, select Meeting > Place Participants On Hold or Meeting > End Meeting.

2 Revise the message in the Message For Viewers text box. Then click Save Message to save the message for future use and return to the meeting.

**Resume a meeting that is on hold or ended**

❖ Click the Start Meeting button in the message of the Stop Meeting icon.
Working with pods

Hosts can show and hide, add, delete, rearrange, and organize pods. For all pods except the Attendee List pod and the Camera And Voice pod, you can have more than one instance of a pod displayed in a meeting at one time.

Show or hide a pod

1. In the menu bar, select Pods and select the name of the pod to show. A check mark appears next to the name of pods that are currently visible in the meeting. To hide a pod, select the pod name again, or click the Hide button (the minus sign) on the right side of the pod title bar.
2. For pods that can have multiple instances (all pods except the Attendee List and the Camera And Voice pods), to show or hide a specific instance of the pod, select the instance name from the pod submenu.

Add a pod

1. In the menu bar, select Pods and select the name of a pod.
2. From the pod submenu, select New [pod name].

Move and resize pods

1. In the menu bar, select Pods > Move And Resize. A check mark appears next to the option when it is selected.
2. To move a pod, drag it by its title bar. To resize a pod, drag the lower-right corner.

Display a pod at full screen size

1. At the right side of the pod title bar, click the Full Screen button (the screen icon).
2. To restore the pod to its original size, click the button again.

Organize pods

1. In the menu bar, select Pods > Organize Pods.
2. Do one of the following:
   • To delete pods, select the pods in the pane on the left and click Delete.
   • To rename a pod, select the pod in the pane on the left and click Rename. Enter a new name in the Rename Pod dialog box and click OK.
   • To locate all unused pods, click Select Unused.
3. Click Done when you finish.

Working with meeting room templates

About templates

A template is simply a prepopulated meeting room. It can contain one or several layouts with different display panels, or pods, configurations, and content. You can optimize each layout for a specific task, such as presenting slides or collaborating with peers. You can leverage existing layouts and content, reducing repetitive customization each time you create a new meeting. You can create your own templates or use the default templates included with Acrobat Connect Professional.
To help you quickly create a meeting room, Acrobat Connect Professional offers three built-in templates: Default Meeting, Default Training, and Default Events. When you create a meeting by using the New Meeting wizard in Acrobat Connect Enterprise Manager, you simply select one of these three templates for your meeting room, add your content, and start your meeting.

When you create a meeting room from a template, the latest version of the content is added to your room. If you edit the source file for the embedded content, the changes do not affect the content in your room. To update the content in your meeting room, you must upload the revised file to the server and then replace the existing content in the meeting room with the revised content on the server.

**Default Meeting template** General template for meetings. It contains three layouts: Sharing, Discussion, and Collaboration. The Sharing layout is optimized for sharing content (Microsoft PowerPoint presentations, video, Adobe FlashPaper, and so on). The Discussion layout is optimized for discussing issues interactively and taking notes. The Collaboration layout is optimized for annotating content and drawing freehand on content.

**Default Training template** Used for online collaborative instruction. It contains three layouts: Lobby, Classroom, and Analysis. The Lobby layout is a place to exhibit a self-running presentation or display other preliminary content. You can leave the Lobby layout open so that attendees can browse its content while waiting for the meeting to begin. From the Classroom layout, you can present PowerPoint slides, share your screen, or show a whiteboard. With the Analysis layout you can collaborate with students, provide files to download and links to browse, and use a whiteboard for instruction.

**Default Events template** Used for meetings or seminars with a large audience. It contains three layouts: Lobby, Presentation, and Questions And Answers. The Lobby layout is a place to play music, exhibit a self-running presentation, or display other preliminary content. You can leave the Lobby layout open so that attendees can browse content while waiting for the meeting to begin. From the Presentation layout you present PowerPoint slides, share your screen, or show a whiteboard. The Questions And Answers layout facilitates an open Q & A session with participants.

**Information preserved in a template**
A meeting room converted to a template is a duplicate of the original room. Layouts, pods, and most contents and room information are preserved in the template, including the following:

- Layouts with name, order, and starting (selected) status
- Pods with name, size, position, and settings for full-screen toggle
- Pod content
- Page number in FlashPaper and position of the seek bar in Flash Video (FLV file)
- Whiteboard overlay contents
- Poll state (Prepare, Open, Close), questions, answers, and broadcast results
• Questions and answers, Chat pod link, and status (Open, Answered, All)
• Text in Notes pod
• Camera and voice settings
• Room on hold (Yes, No)
• Value for guest entry
• Messages to be displayed to users when a meeting is on hold or ended
• Room background, screen resolution, and bandwidth
• Presenter Only area status

Certain information is not saved to the template. Audio conference settings, Audio Setup wizard settings, and the content of a Chat pod are not saved to a template.

Apply a template to a new meeting
❖ In the Meeting Information Page in Acrobat Connect Enterprise Manager, select a template from the Select Template menu. By default, the Default Meeting template is selected.

See also
“Creating and attending meetings” on page 42

Convert a meeting room to a template
If you are a host, you can create a template in Acrobat Connect Enterprise Manager. From the Meetings tab in Acrobat Connect Enterprise Manager, move the meeting room to one of two template folders: Shared Templates (in the Shared Meetings folder) if you want others to be able to access the template, or My Templates (in your user meeting folder) if you are the only one who will use the template.

1 From the Meetings tab in Acrobat Connect Enterprise Manager, navigate to the meeting room that you want to convert.
2 Select a meeting room from the list below the navigation bar.
3 Click Move on the navigation bar.
Two columns are displayed in Acrobat Connect Enterprise Manager. The name of the meeting room is displayed in the left column. In the right column, under the heading Move To This Folder, Shared Meetings > Shared Templates is selected by default. If this is the folder you want to use, go to step 5.

4 Navigate to and select a template folder.
5 Click Move at the bottom of the column.
Your meeting room now resides in the template folder that you selected. The template is added to the list in the appropriate folder, either Shared Templates or My Templates.

When you are creating a new meeting with the New Meeting wizard, you can select the new template from the Select Template pop-up menu. You can customize this room just like any other to meet your needs. Once the meeting is created, you cannot apply a new template to it. Instead, you must create a new meeting by using the new template.

To add a meeting room to the Shared Templates folder, you must have Manager permissions for the folder. By default, you have full control over meetings and templates in your user meeting folder.
Creating and attending meetings

Creating meetings
You create a meeting in Acrobat Connect Enterprise Manager.

If you want to incorporate registration as part of your meeting, you must have the Event Management tab as part of your Acrobat Connect Professional installation; see “About meeting registration” on page 32.

You can create a personal meeting room that you return to repeatedly for your own use, and leave persistent content in the meeting to refer to whenever you need it. When creating a personal meeting room, set the start time of the meeting far enough in the future that the meeting room will be available whenever you need it (for example, you can set the start time as late as 2010 to ensure that the meeting room will be available for the foreseeable future).

Creating a meeting
You create a meeting using the Meeting wizard, which guides you through the tasks of creating a name and summary, selecting participants, and sending invitations to participants.

1. Start the Meeting wizard
You have two options for starting the Meeting wizard. To create the meeting in your individual My Meetings folder, click New Meeting under "Create" on the Home tab. To create your meeting in another folder for which you have Manage permission, navigate to that folder in the Meetings library and click the New Meeting button. In either case, the Enter Meeting Information page appears.
2. Enter meeting information

On the first page of the Meeting wizard you enter details about the meeting, such as a name, summary, date, duration, custom URL, language, access restrictions, and audio settings. Only the name and language are required. The other information is relevant only if you plan to use the application to send e-mail invitations to the meeting.

<table>
<thead>
<tr>
<th>Enter Meeting Information</th>
<th>Select Participants &gt; Send Invitations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name: * Training</td>
<td></td>
</tr>
<tr>
<td>Custom URL:</td>
<td>http:// horrend.com/san/33t1y2z2m/12t1n31i3y2z2m</td>
</tr>
<tr>
<td>Summary: (max length=50 characters)</td>
<td>Overview of safety and health standards</td>
</tr>
<tr>
<td>Start Time:</td>
<td>17:00, October 2018, 10:00 AM</td>
</tr>
<tr>
<td>Duration:</td>
<td>01:00:00 Hours:Minutes:Seconds</td>
</tr>
<tr>
<td>Select Template:</td>
<td>Shared Template/Default Meeting Template</td>
</tr>
<tr>
<td>Language: * English</td>
<td></td>
</tr>
<tr>
<td>Access:</td>
<td></td>
</tr>
</tbody>
</table>

3. Select meeting participants

Use the Add button in the Available Users And Groups list to add participants. You add participants in order to assign permissions and to send e-mail invitations. You can search for them by name and expand groups to select individuals in the group. If you wish, you can assign roles by selecting participant names and clicking Permissions from the bottom of the participants list. You can then proceed to the final step of sending invitations or exit the wizard to send invitations later.

4. Send invitations

The wizard guides you through two separate processes, depending on whether the meeting is open to registered users only or to anyone. If the former, you select Send Invitations, select a group to invite (for instance, hosts only), and edit the text that will appear in the e-mail. You have the option of including a Microsoft Outlook Calendar appointment. If the latter, you click Send E-Mail Invitations, which opens your e-mail application, and add invitees to the distribution list of your e-mail message.

Get information about a meeting

If you want to see a list of all the meetings you are invited to or (as a host) all the meetings you have scheduled, go to My Scheduled Meetings on the Home tab in your Acrobat Connect Enterprise Manager window. If you have more scheduled meetings than can appear on the Home tab list, click the More button at the bottom of the list to view them. Alternatively, you can display your list of scheduled meetings by clicking the My Scheduled Meeting link at the top of the page.

❖ Click the meeting name under My Scheduled Meetings on the Home tab.

The Meeting Information page appears with the following details:

Meeting name  The meeting's title.
Summary A brief description of the meeting.

Start time The date and time that the meeting begins.

Duration The projected length of time of the meeting.

URL The web address where the meeting is to occur (the meeting room’s virtual location).

Status The current state of the meeting; for example, number of participants in the room.

Language The language in which the meeting will be conducted.

Telephony information The telephone number for participants who call in to this meeting and the code that they must enter (necessary only when the meeting is in progress).

From here, you can click the Enter Meeting Room button to join the meeting.

Set meeting room bandwidth
The host sets meeting room bandwidth to determine the speed (kilobits/second) at which data from the meeting is sent to attendees. The host should choose a room bandwidth that matches the connection speed used by attendees. If attendees are using a variety of connection speeds, choose the lowest speed that attendees may be using. For example, if some attendees are using modems, choose Modem for room bandwidth to ensure that all attendees have a good connection.

❖ Choose Meeting > Optimize Room Bandwidth and choose Modem, DSL/Cable, or LAN.

About starting a meeting
When you are host, starting a meeting is as simple as logging in to your meeting room and then inviting others to do the same. You can send your meeting room URL to attendees in an e-mail or instant message, and frequent guests can bookmark the URL for future use. Meetings can be spontaneous, or you may have prearranged groups who log into your meeting room at the same time every week.

When you have entered the meeting room, you can perform tasks to set the meeting up for attendees, such as the following:

• Specify phone conference information if attendees will be phoning in to the meeting.
• Resize or rearrange the meeting room pods.
• Type meeting notes or other information for attendees.
• Invite attendees and accept or decline requests to join your meeting.

Start a meeting from any web browser
As the host, you can access the meeting room login screen from a web browser.

1 Type your meeting URL in the address bar of a web browser.

❖ The first time you visit your meeting room, bookmark it for quick access the next time you want to start a meeting.

2 Type your Acrobat Connect login and password, and then click Enter Room.
Start a meeting using the Start Meeting button

The Start Meeting button is included in software applications such as Adobe Acrobat®, Adobe Reader®, and some Microsoft Office programs. As a meeting host, you can use the Start Meeting button to access your meeting room login screen or to set up a new Acrobat Connect Professional account.

1. Click the Start Meeting button.

2. If the Welcome To Start Meeting dialog box appears, click Create Trial Account to set up a new account or click Log In if you already have an account.

3. In the Start Meeting Log In dialog box, type your meeting URL, login, and password, and click Log In.

   Note: In Acrobat or Reader, your meeting preferences determine how much login information you need to enter, or whether this dialog box appears at all, before your meeting room opens. To change your Acrobat or Reader meeting preferences, select Edit > Preferences (Windows) or Acrobat > Preferences or Reader > Preferences (Mac OS), and then select Meeting on the left.

Join a meeting

You can join a meeting as a guest or as a registered user, depending on the parameters chosen by the meeting host.

You can join a meeting by entering the meeting URL into a browser and then entering information as a registered user or guest. In addition, if you have Microsoft Outlook and have accepted the invitation, the meeting appears on your Outlook calendar. If you have been invited to a meeting by someone in your organization (someone using the same account), the meeting name appears on the list under My Scheduled Meetings on the Home tab in your Acrobat Connect Enterprise Manager window.

When you join a meeting, check the date and time shown to determine whether it is in progress. (If the date is in the past, the meeting appears on your meeting list under expired meetings.)

If your connection to the server fails, Acrobat Connect Enterprise Manager displays an error message and provides a link to the Acrobat Connect Enterprise Manager Connection test wizard, which leads you through a series of steps to test your connection status.

   Note: If the administrator for your meeting has activated client-side certificates, the Select Certificate dialog box appears when you attempt to enter a meeting, prompting you to select a certificate to verify your identity.

1. On the Home tab under My Scheduled Meetings, scroll to the name of the meeting that you want to attend.

   Alternatively, you can click My Scheduled Meetings in the navigation bar to display a longer list, and select the name from there.

2. Click Enter.

   The meeting room is downloaded to a browser window.

Set your connection speed

Each attendee can choose their connection speed for connecting to a meeting. Attendees should choose the connection speed based on the type of Internet connection they have. For example, attendees who connect to the Internet via DLS should choose DSL/Cable for their meeting connection speed. This ensures that data from the meeting will be delivered at a speed appropriate for their system.

- Choose Meeting > My Connection Speed and choose Modem, DSL/Cable, or LAN.
Updating existing meetings

View a meeting summary and update meeting information
For hosts, the Meeting Information page in Acrobat Connect Enterprise Manager is your starting point for viewing and changing any information about a meeting. This page appears when you click the meeting name in the Meeting List. The Meeting Information page displays a profile of the meeting and provides links to pages with more detailed information that you can review or manipulate.

1. Click the Meetings tab at the top of the Acrobat Connect Enterprise Manager window.
2. If there is more than one meeting folder, navigate to the folder that contains the meeting.
3. Click the name of the meeting in the meeting list.
4. Click Edit Information.

The Meeting Information page appears. Update the information as needed.

View and modify a participant list
If you have Manage permissions for a meeting, you can view a list of all invited attendees for each meeting room. However, if this meeting is presented as an event, you must view and manage participants in the Event Management tab. For more information, see “Adobe Connect Events” on page 126.

If you are an administrator or have Manage permissions for this meeting's folder, you can add or remove attendees and change an attendee's permission setting (host, presenter, or participant).

Removed attendees don't receive any notification, and they can't enter the meeting unless the meeting's access setting is changed to allow entry to anyone who has the meeting URL.

See also
“Creating users and groups” on page 237

View a meeting participant list
1. Click the Meetings tab at the top of the Acrobat Connect Enterprise Manager window.
2. If there is more than one meeting folder, navigate to the folder that contains the meeting.
3. Click the meeting name in the list.

The Meeting Information page appears.

4. Click the Edit Participants link on the navigation bar.

The names of invited participants and groups appear.

Add meeting participants
1. Click the Meetings tab at the top of the Acrobat Connect Enterprise Manager window.
2. If there is more than one meeting folder, navigate to the folder that contains the meeting.
3. Click the meeting name in the list.
4. In the Meeting Information page, click the Edit Participants link on the navigation bar.
In the Available Users And Groups list, do one of the following to select the users or groups:

- Control-click or Shift-click to select multiple users or groups.
- To expand a group to select any individual members, double-click the group name; when you finish selecting names, double-click Up One Level in the list to restore the original list.
- To search for a name in the list, click Search at the bottom of the window, enter the name to display it in the list, and then select it.

6 Click Add.

The names you selected appear in the Current Participants list.

7 For each new participant user or group that you added, select the appropriate permission type (participant, host, or presenter) from the Set User Role menu at the bottom of the Current Participants list.

The user role you assigned for this user appears next to this user's name in the list.

8 Click a link in the navigation bar to perform the next task or return to the Edit Information page.

Remove meeting participants

1 Click the Meetings tab at the top of the Acrobat Connect Enterprise Manager window.

2 If there is more than one meeting folder, navigate to the folder that contains the meeting.

3 Click the meeting name in the list.

4 In the Meeting Information page, click the Edit Participants link on the navigation bar.

5 In the Current Participant list, do either of the following to select users or groups:

- Control-click or Shift-click to select multiple users or groups.
- To search for a name in the list, click Search at the bottom of the window, enter the name to display it in the list, and then select it.

6 Click Remove.

The name no longer appears in the Current Participants list.

7 Click a link in the navigation bar to perform the next task or return to the Edit Information page.

Change a participant's meeting permission

1 Click the Meetings tab at the top of the Acrobat Connect Enterprise Manager window.

2 If there is more than one meeting folder, navigate to the folder that contains the meeting.

3 Click the meeting name in the list.

4 In the Meeting Information page, click the Edit Participants link on the navigation bar.

5 In the Current Participants list, do either of the following to select the users or groups whose meeting permissions you want to change:

- Control-click (Windows) or Command-shift (Macintosh) or Shift-click to select multiple users or groups.
- To search for a name in the list, click Search at the bottom of the window, enter the name to display it in the list, and then select it.

6 For each name, select the new user role (presenter, participant, or host) from the Set User Role menu at the bottom of the Current Participants list.

7 Click a link in the navigation bar to perform the next task or return to the Edit Information page.
View and manage uploaded content
You can view uploaded content at any time. You can also move uploaded content to the Content library or delete uploaded content.

View a list of uploaded content
If you have Manage permissions for a meeting folder, you can view a list of all content that has been uploaded to the server from a meeting room within that folder.

1. Click the Meetings tab at the top of the Acrobat Connect Enterprise Manager window.
2. If there is more than one meeting folder, navigate to the folder that contains the meeting.
3. Click the meeting name in the list.
4. In the Meeting Information page, click the Uploaded Content link on the navigation bar.

A list of all uploaded content appears. From here, you can do any of the following:

- To see the information about a specific item in the list, click the item’s name.
- Move uploaded content to the Content library.
- Delete uploaded content.
- To determine if the content is still being used in the meeting room, view the Reference column. A Yes indicates that it is still being used. An empty column indicates that it is not.

5. Do either of the following, as needed:

- To change the title or summary for the piece of uploaded content, click Edit, make your changes on the Edit page, and click Save.
- To return to the uploaded content list, click Return To Uploaded Content.

Move uploaded content to the Content library
To move uploaded content to the Content library, you must be an administrator or a user with permissions to manage the specific Meetings library folder that contains this meeting.

1. Click the Meetings tab at the top of the Acrobat Connect Enterprise Manager window.
2. If there is more than one meeting folder, navigate to the folder that contains the meeting.
3. Click the meeting name in the list.
4. In the Meeting Information page, click the Uploaded Content link on the navigation bar.
5. Click the check box to the left of each file you want to move.
6. Click the Move To Folder button on the navigation bar.
7. Navigate to the folder location in the Content library where you want to move the content file by clicking the folder titles or the Up One Level button.
8. Click Move.
9. Click OK.

Delete uploaded content
1. Click the Meetings tab at the top of the Acrobat Connect Enterprise Manager window.
2. If there is more than one meeting folder, navigate to the folder that contains the meeting.
3 Click the meeting name in the list.
4 In the Meeting Information page, click the Uploaded Content link on the navigation bar.
5 Click the check box to the left of each file that you want to delete.
6 Click the Delete button above the list.
7 Click the Delete button on the confirmation page to permanently delete the selected content.

View a list of recorded meetings
If you are an administrator or have Manage permissions for a meeting folder, you can view a list of all recordings that have been created from a meeting room.

1 Click the Meetings tab at the top of the Acrobat Connect Enterprise Manager window.
2 If there is more than one meeting folder, navigate to the folder that contains the meeting.
3 Click the meeting name in the list.
4 In the Meeting Information page, click the Recordings link on the navigation bar.

A list of all recordings for the meeting room appears. From here, you can do any of the following:

- To see the information about a specific item in the list, click the item's name.
- To move this content to the Content library, see “Move meeting recordings to the Content library” on page 72.
- To delete this content, see “Delete a meeting recording” on page 72.

5 To change the title or summary of a recording, select the item and click Edit, make your changes on the Edit page, and click Save.

Edit meeting information
If you are an administrator or a user with Manage permissions for this meeting folder, you can modify the meeting properties on the Meeting Information page.

1 Click the Meetings tab at the top of the Acrobat Connect Enterprise Manager window.
2 If there is more than one meeting folder, navigate to the folder that contains the meeting.
3 Click the meeting name in the list.
4 In the Meeting Information page, click the Edit Information link on the navigation bar.
5 Edit the meeting information.
6 Click Save.

The Meeting Information page reappears with the new information.
Options in the Edit Information page

**Name**  
A required field that appears in the meeting list, the meeting login page, and in reports.

**Summary**  
A meeting description that appears on the Meeting Information page, and is included in meeting invitations by default. A meeting summary can be 750 characters long.

**Start time**  
The month, day, year, and time that the meeting starts.

*Note:* Some Acrobat Connect Professional pricing models ignore meeting start dates and allow attendees to enter meetings before the designated start date. Depending on the meeting pricing model your organization uses, if you change the meeting start date to a future date, participants and presenters might still be able to enter the meeting room any time after you create the meeting. When you are logged in to a meeting room, you can stop participants from entering the room between meetings.

**Duration**  
The meeting's length, in hours and minutes.

**Meeting Access**  
There are two options:

- **Registered users only and accepted guests**  
  With this option, the meeting room is accessible only to those who have been invited as registered users, and to guests who are accepted into the meeting room by the host.

  Registered users must enter their user name and password to enter the meeting room. Accepted guests are accepted into the room by the host. Acrobat Connect Professional can generate an individual attendance report for each registered user in the meeting. Accepted guests are added to the total number of meeting attendees on meeting reports, but no individual attendance report is available.

  *Note:* For some Acrobat Connect Professional accounts, a host must be present in a meeting in order for attendees to enter.

- **Anyone**  
  Anyone who receives the meeting URL. Click Send E-mail Invitations to create an e-mail invitation in your own e-mail application. The new message contains a prepopulated subject (Acrobat Connect Professional Invitation) and a prepopulated message (containing the meeting date, time, duration, location, and summary) that you can edit.

**Audio Conference Settings**  
Whether audio conference settings are necessary for this meeting, and if so, the telephone number, moderator code, and participant code for the guests who are calling in.

*Note:* If you did not add audio conference settings when you initially created the meeting, and you want to add them while you are in the meeting itself, you can use the preceding procedure to create them in Acrobat Connect Enterprise Manager. In this case, however, you must first ask all users to log out of the meeting, add the telephony information, and wait five minutes.

**Update information for any items linked to this item**  
Select this check box to update any items linked to the meeting with the revised meeting information.

Send meeting invitations for an existing meeting

You can send invitations for a meeting that has already been created if you are the meeting host, an administrator, or have Manage permissions for this meeting's folder.

A meeting invitation is an e-mail invitation informing participants of the date, time, duration, summary, URL, and audio conference information. You can also choose to attach a Microsoft Outlook calendar event to the e-mail message. This enables attendees to add the meeting to their Outlook calendar.
The way that invitations are sent depends on the type of meeting:

**Registered guests** If your meeting is for users only, you create a custom e-mail message from within Acrobat Connect Enterprise Manager. You can send the e-mail invitation to all hosts, participants, and presenters; presenters only; or participants only. You can customize the subject and message body.

**Anyone** If your meeting is open to anyone who receives the meeting URL, click Send E-mail Invitations to create an e-mail invitation in your own e-mail application. The new message contains a prepopulated subject (the meeting name) and a prepopulated message (containing the meeting date, time, duration, URL, and summary) that you can edit.

**Send invitations to registered guests only**
1. Click the Meetings tab at the top of the Acrobat Connect Enterprise Manager window.
2. If there is more than one meeting folder, navigate to the folder that contains the meeting for which you want to get information; for more information, see “Navigate in a library” on page 20.
3. Click the meeting name in the list.
4. In the Meeting Information page, click the Invitations link on the navigation bar.
5. From the To menu, select the group to invite: hosts, participants, and presenters; presenters only; or participants only.
6. Edit the subject and the message body as appropriate.
7. To attach an Outlook calendar event to the e-mail, select the check box next to Attach Microsoft Outlook Calendar Event (iCal) To E-mail Message; otherwise, clear the check box.
8. Click Finish.

**Send invitations to a meeting open to anyone**
1. Click the Meetings tab at the top of the Acrobat Connect Enterprise Manager window.
2. If there is more than one meeting folder, navigate to the folder that contains the meeting; for more information, see “Navigate in a library” on page 20.
3. Click the meeting name in the list.
4. In the Meeting Information page, click the Invitations link on the navigation bar. You see the Invitations page with the meeting details.
5. Do either of the following as appropriate:
   • Click Send E-Mail Invitations to automatically display a new blank message in your e-mail application.
   • Manually create a new e-mail message, then copy and paste the meeting URL (shown in the meeting details) into the message.
6. Type the e-mail addresses of the invitees or add them from your address book.
7. Edit or type, as appropriate, the e-mail subject and message.
8. Send the e-mail invitation.
Viewing data about meetings

About the Meeting Dashboard
The Meeting Dashboard provides a graphical representation of statistical data about your meetings. To see the Dashboard, click the Meeting Dashboard link under the tab bar, at the top of the Meetings window. The data, which reflects all the meetings you have created, appears in three bar graphs; clicking in any of these brings up the Summary Report for the meeting.

Most Active Meetings Over Last 30 days  Determined by the number of sessions.

Most Participant Meetings Over Last 30 Days  Determined by the number of participants. This feature counts only registered attendees; guest attendees are not included in the count. However, guest attendees are included in the data reported in the Summary Report for each meeting.

Most Viewed Archives Over Last 30 days  Determined by the number of views (that is, the number of times each archived meeting has been viewed).

The bar graphs appear within the Acrobat Connect Enterprise Manager Meetings tab. However, you can also export the Dashboard to a browser window to print. To do this, click the Printable Version button on the left, above the display.

Meeting reports
The Reports feature of Connect Enterprise Manager lets you create reports that show you a given meeting from different perspectives. To use this feature, open the Meeting Information page and then click the Reports link above the Meeting Information title bar. This displays links that let you define the following information that you can see for this meeting:

Summary  The first report type that appears when you access the Reports feature. The Summary shows you aggregate meeting information, which includes: name; viewing URL; Unique Sessions (a single instance in which a given user has joined and exited the meeting); the last time that any invitee entered the meeting room (Most Recent Session); number of people invited; number of those who attended; and the greatest number of people who entered the room at any one time (Peak Users).

By Attendees  Lists the name and e-mail address of each meeting participant, as well as the time they entered the meeting and the time they left it.

By Sessions  Lists the start and end time of each session, the session number, and the number of attendees. Clicking on the session number displays the participant list for this session, including participant name and entry and exist times for each participant.

By Questions  Lists each poll by session number, number, and question. You can drill down to two separate views by clicking the appropriate link under the Report column:

• “View answer distribution” displays a pie chart in which each answer is color-coded with a unique color.

• “View user responses” provides an answer key that lists each answer for this poll and its corresponding answer number; these numbers map to the pie chart. This option also shows a list of all the participants who responded in this poll and the number of the answer they selected (if the poll question allowed multiple responses, these are all shown for the user).
Sharing content during a meeting

Sharing a computer screen, document, or whiteboard
Hosts and presenters can share a variety of content with participants in a meeting.

Hosts and presenters use the Share pod to display content to attendees, such as the following:

- Selected items on your computer screen, including one or more open windows, one or more open applications, or the entire desktop. See “Share your screen or control of your screen” on page 53.
- A document, such as a presentation, an FLV file, a JPEG, or other file format. See “Share a document” on page 57.
- A whiteboard with a variety of writing and drawing tools. You can share a stand-alone whiteboard, or a whiteboard overlay that appears on top of other shared content. See “Share a whiteboard” on page 58.

Documents shared in the Share pod can be viewed but not downloaded by attendees. In order to enable attendees to download documents, a host or presenter must upload the documents to the File Share pod.

When you share content in the Share pod, attendees see your pointer move in the Share pod window. All activities you perform in shared window, application, or document are visible to attendees.

Presenters and hosts must install the Add-in the first time they attempt to upload content or share a screen. The Add-in is a special version of Flash Player with additional features for hosts and presenters. The Add-in provides support for uploading files to the server and sharing screens during a meeting. It also provides additional audio support.

Note: If you have a pop-up blocker enabled in your browser, the dialog box for downloading the Add-in will not appear. To correct this problem, temporarily disable the pop-up blocker.

For more information on screen sharing, see Screen Sharing Best Practices.

Note: In a meeting, choose Help > Quick Start to view short demos about sharing content.

Uploading a document
To enable attendees to download a document, a host or presenter uploads the document to the File Share pod. Hosts and presenters can upload files from their computer or from the Content library. Meeting participants cannot upload files; however, the host can change a participant’s role or rights to allow uploading of files. See “Upload and manage files using the File Share pod” on page 61.

Share your screen or control of your screen
As a host or presenter in a meeting, you can share windows, applications, or your entire desktop with participants in a meeting.

When you share anything on your computer screen, actions you take in the shared region are visible to all participants in the meeting. Your viewers follow the progress of your pointer as you move it across your screen.

The region or regions that you share must be visible on your desktop in order to be visible in the Share pod to other participants. Overlapping windows on the desktop appear as a blue cross-hatched pattern in the Share pod.

You can also display a whiteboard over a shared screen to enable attendees to add annotations.

Note: When you share a screen with participants who use the Macintosh OSX operating system, a system error sometimes enables those participants to view the Presenter only area, even though they do not have Presenter status.
See also
“Share a whiteboard” on page 58

Share your computer screen
1 With a blank Share pod open in a meeting, do one of the following:
   • Click the My Computer Screen button in the middle of a blank Share pod.
   • Click the Share button on the Share pod control strip, and select My Computer Screen from the pop-up menu.
The Start Screen Sharing window appears.
2 Do one of the following:
   • Select Desktop to share your entire desktop. If you have more than one monitor connected to your computer, a
desktop appears for each monitor. Choose the desktop that you want to share.
   • Select Windows to share one or more windows that are open on your computer. Choose the window or windows
   that you want to share.
   • Select Applications to share an application and all its related windows that are open on your computer. Choose the
   application or applications that you want to share.
3 Click the Share button at the bottom of the Start Sharing window to begin sharing.

Share control of your screen with another presenter
While screen sharing, you can pass control of the shared desktop, window, or application to another presenter. The
presenter must request control before you can hand over your shared screen to them.
1 Start sharing your computer screen in a meeting.
When another presenter requests control of your screen, you see a request message in the upper-right corner of the
meeting room window.
2 Do one of the following:
   • Click Accept to grant control of your screen to the requesting participant.
   • Click Decline to deny control of your screen to the participant.

Request control of a shared screen from another presenter
❖ Click the Request Control button on the Share pod control strip.
If the request is accepted, a message informs you that you have been granted control of the screen. The Request
Control button becomes a Release Control button. You can now take control of the shared screen.

Release control of a shared screen
❖ Click the Release Control button on the Share pod control strip to return control of the shared screen to the
original presenter.

Preview your shared screen in the meeting room
When sharing an application, window, or desktop on your computer, you can select the Preview option to show the
same view that participants see in their Share pod.
❖ Click the Pod Options button of the Share pod and select Preview In Pod While Screen Sharing, or click the Preview button (the eyeglasses icon).
Share content in the Share pod
The Share pod controls let hosts and presenters share content in various ways. You can display the pod at Full Screen size to make contents larger. You can enable attendees to toggle between Full Screen and Normal display size. You can choose to display changes in the presenter’s pod to all attendees, so that the presenter can control the pod size for viewers. You can share content that is already loaded into the meeting room but is not currently displayed. When content is displayed in the Share pod, you can use a pointer to call attention to particular areas.

Change the content displayed in a Share pod
1. Click the Share button on the Share pod control strip.
2. Select My Computer Screen, Documents, or Whiteboard and select the item you want to share from the submenu.

Display and enable the Full Screen mode
1. To display the Share pod at full screen size, click the Full Screen button in the Share pod control strip. Click the button again to return to normal display size.
2. To change the attendees’ Share pod display size when you change your own, click the triangle next to the Full Screen button and select Enable Full Screen Toggle For Participants. (When this option is turned off, attendees control the size of their own Share pods.)

Note: When you enable full screen mode, use Alt + Tab to go to the window that you want to share.

Display changes in the presenter’s pod to all participants
❖ Click the triangle next to the Full Screen button and select Presenter’s Changes Affect Everybody from the submenu.

Turn off sharing but keep the Share pod open
❖ Click Stop Sharing on the Share pod control strip.

Redisplay Share pod content that has been closed
❖ Do one of the following:
   • Select Share > Documents or Share > Whiteboard from the control strip at the bottom of the Share pod, and select the shared document or whiteboard by name from the submenu.
   • Select Pods > Share and select the Share pod by name from the submenu.

Use a pointer in a Share pod
❖ Do one of the following:
   • Click the Pointer button on the Share pod control strip.
   • Choose Show Pointer from the Share pod options menu.

Share presentations in the Share pod
For hosts or presenters who share a presentation in the Share pod, special controls are available for navigating and displaying the presentation. A presentation layout has the following areas:

Presentation  The main part of the window, which displays the presentation slides.
**Presentation sidebar**  An area on the right side (default location) of the browser window that shows the name of the presentation, the presenter information, and the Outline, Thumb, Notes, and Search tabs (if the tabs were including when the Presentation was created).

**Presentation toolbar**  A control bar at the bottom of the presentation that gives you control over the presentation playback, audio, attachments, and screen size. This is visible to hosts only, unless a host chooses to display it to participants.

**Use the presentation Outline tab**
Most presentations have an Outline tab on the sidebar. The Outline tab lists the title and duration of each slide. You can use the Outline tab to display information and to move to a specific slide in the presentation. The current slide is highlighted with a glow color, which you can change in the theme. You can choose to display the highlight outline to all attendees or to hosts and presenters only.

1. Click the Outline tab in the sidebar at the right.
2. To move to a slide in the presentation, click its title in the Outline tab.
3. To show the slide title, move the pointer over the title.

**Use the Presentation Thumb tab**
Presentations can have a Thumb tab on the sidebar. The Thumb tab shows a small picture of each slide, the slide title, and the slide duration. The current slide is highlighted with a glow color, which you can change in the theme. You can use the Thumb tab to see the contents each slide quickly and to move to a specific slide in the presentation.

*Note:* If you upload your presentations directly from your computer and into a meeting, the Thumb tab is not displayed. Adobe recommends adding presentations to a meeting from the Content library.

1. Click the Thumb tab in the sidebar at the right.
2. To move to a slide, click its title in the Thumb tab.
3. To show the slide title, move the pointer over the title.

**View Presentation slide notes**
When creating a presentation in PowerPoint, you can enter notes for individual slides. If any slide notes exist, they can be displayed in the presentation. Slide notes appear on the right side of the presentation window. You cannot change the size of the slide Notes tab.

❖ Click the Notes tab in the sidebar on the right side.

The complete notes text is displayed. The text is unformatted and cannot be edited directly on the tab.

**Search for text in a presentation**
1. Click the Search tab in the sidebar on the right side.
2. Type the text to search for directly into the text box.
3. Click the Search button.

Search results are displayed below the text box. Click any slide title in the results list to display that slide.
Presentation toolbar options
You can control the presentation appearance and playback by using the toolbar located at the bottom of the presentation.

Play/Pause button  Pauses and resumes play of the current slide.

Back button  Moves to the previous slide in the presentation.

Forward button  Moves to the next slide in the presentation.

Slide progress bar  Shows and controls the playback location within the current slide. The position marker moves as the slide plays. You can drag the marker arrow forward or back in the current slide to change your playback location. You can also click a specific location on the progress bar to move the slide marker position and slide playback there.

Current slide number  Shows the number of the currently displayed slide and the total number of slides (for example, slide 2 of 10).

Status  Shows the status of the current slide, such as Playing, Stopped, No audio, or Presentation complete.

Time  Shows the current slide time and the total slide time as the slide plays (for example, 00.02/00.05).

Audio volume  Shows the volume level that is set for the slide.

Attachments  Displays a small window showing any attachments (for example, documents, spreadsheets, images, URLs) that have been added.

Show/Hide sidebar  Shows or hides the sidebar.

Share a document
A host or presenter can share documents that have been uploaded to the Content library, or share documents directly from your computer.

If you turn off sharing, change the content in a Share pod, or close the Share pod, the document is still part of the meeting room and can be displayed again. If you delete a Share pod, the document is deleted from the meeting room. (If you uploaded it to the Content library previously, it is still available there.) To edit a shared document, you must edit the source document and reload it into the meeting.

Share documents from the Content library
A host or presenter can load presentations, SWF files, JPEG files, MP3 files, or FLV files from the Content library on the server into a Share pod in a meeting. In the Content library, you can select documents from a shared content folder or from a user folder, either your own or another user’s. The Content library is available in the Acrobat Connect Enterprise Manager application. (To access a user folder other than your own, the user must grant you View permission).

If you share a presentation, the Share pod displays controls for navigating the presentation.

Note: You create presentations from PowerPoint presentations, using Adobe Presenter. Acrobat Connect Professional does not support progressive-scan JPEG files.

1  Do one of the following:
   • In the Share pod, click the Documents button.
   • Select Pods > Share from the menu bar.
   • Select Share > Documents from the control strip at the bottom of the Share pod.

2  Click Select From Content Library on the pop-up menu.
The Browse Content window appears.

3 Select one of the following:
   • Shared Content displays uploaded content that is available to all account holders with the appropriate permissions.
   • User Content displays uploaded content in individual user folders. To view the content in another user's folder, you must have View permission from that user.
   • My Content displays the uploaded content in your user folder.
   • Uploaded Content displays the content that has been uploaded for the current meeting.

4 Select the document that you want to share, and click Open.

The selected document appears in the Share pod. The document name appears in the title bar of the pod.

**Share documents from your computer**

You can load PPT, SWF, JPEG, MP3, or FLV files from your computer into a Share pod. The files are uploaded to the server. PPT files are converted to presentations.

1 Do one of the following:
   • In the Share pod, click the Documents button.
   • Select Pods > Share from the menu bar.
   • Click Share on the control strip at the bottom of the pod.

2 Click Select From My Computer on the pop-up menu.

A Browse Content dialog box appears.

3 Select the document that you want to share and click Open.

The selected document appears in the Share pod. The document name appears in the title bar of the pod.

The document is added to the Uploaded Content folder associated with the meeting room in Acrobat Connect Enterprise Manager. An Acrobat Connect Enterprise Manager administrator can move the document to the Shared Content folder in the Content library to make the document available for other meetings. For more information on using the Content library, see "About library permissions" on page 14.

**Turn off display synchronization for multiframe documents**

By default, Acrobat Connect Professional synchronizes display of multiframe documents so that attendees see the frame that the presenter sees. A host or presenter can use the Sync button to turn off synchronization so that viewers can move through presentations or Flash Paper documents at their own pace.

*Note:* The Sync button appears only when you have multiframe content loaded in the Share pod.

❖ In the Share pod window, with content loaded, click the Sync button (Sync is on by default). Controls for presentation playback appear at the right of the Share pod.

Click the Sync button again to turn off synchronization and allow participants to advance through presentations at their own pace.

**Share a whiteboard**

A host or presenter can use a whiteboard to create collaborative text, drawings, and other annotations in a meeting.
Create and display a whiteboard
A whiteboard allows hosts or presenters to create text, lines, circles, squares, and other free-hand drawings in real time during a meeting.

You can use a whiteboard in two different ways in a Share pod:

- A stand-alone whiteboard allows presenters to create content on a white background.
- An overlay whiteboard allows presenters to create content over an existing document in a Share pod, adding annotations to and drawing on the document. You can lay a whiteboard over presentations, JPG, SWF, FLV, and FlashPaper documents.

If you turn off sharing, change the content in a Share pod, or close the Share pod, the whiteboard is still part of the meeting room and can be displayed again. If you delete a Share pod, the whiteboard is deleted.

Create a stand-alone whiteboard in a blank Share pod
1. Do one of the following:
   - In the Share pod, click the Whiteboard button.
   - Select Pods > Share.
   - Click Share on the control strip at the bottom of the Share pod.
2. Select New Whiteboard in the pop-up menu.
   A blank whiteboard appears in the pod.

Add an overlay whiteboard over a document or a shared screen in a Share pod
❖ With the document displayed in a Share pod, do one of the following:
   - Click the Whiteboard button in the Share pod control strip.
   - Click the Pod Options button the lower-right corner of the Share pod, and select Whiteboard Overlay.
• In the upper-right corner of the window of the application you are sharing, click the arrow next to the red Stop Sharing button and select Pause and Annotate.

• If you are sharing your entire desktop, click the Acrobat Connect Add-in icon in the system tray (Windows) or icon bar (Macintosh) and select Pause and Annotate.

Display an existing whiteboard
1 Do one of the following:
   • Select Pods > Share from the menu bar at the top of the Stage.
   • Select Share > Whiteboards from the control strip.
2 Select the name of the whiteboard that you would like to display on the Stage.

Clear a whiteboard
❖ Press Control+D or press the Clear button 🗑.

Navigate between multiple whiteboard pages
A standalone whiteboard is composed of multiple pages. If you need to present multiple whiteboard pages during a meeting, you can use the forward and back arrow buttons to move between pages.

1 Click the Whiteboard Toolbar button.
The page number and next and previous buttons appear in the toolbar.

2 Do one of the following:
   • Click the right-pointing arrow to display the next page.
   • Click the left-pointing arrow to display the previous page.

Whiteboard drawing tools
The following tools are available to create text and drawings on the whiteboard:

**Selection tool** ✂ Selects a shape or area of the whiteboard. Click a shape to select it. Drag on the whiteboard or content to create a selection rectangle that selects all the shapes within the rectangle. The selection rectangle has eight control points for resizing the selected shape or shapes. Shift-drag a corner control point to maintain the aspect ratio when you resize. Select and drag a shape to move it. To add a shape to the selection, Shift-click the shape.

**Pencil tool** ✏ Creates a free-form line. You can customize stroke color and stroke weight by using the color picker and stroke weight pop-up menu at the lower part of the Whiteboard pod.

**Marker tool** ✏ Creates a free-form thick marker line. You can customize stroke color and stroke weight by using the color picker.

**Line tool** ← Draws a straight line between two points. You can customize stroke color and stroke weight by using the color picker and line width pop-up menu at the lower part of the Whiteboard pod. You can create arrows by using the arrow buttons at the lower part of the Whiteboard pod. Holding down the Shift key while drawing makes the line snap every 45 degrees.

**Rectangle tool** 🎨 Creates square and rectangle shapes. You can customize stroke color, fill color, and stroke weight by using the color picker and the stroke weight pop-up menu. You can use No Fill as a setting for stroke color and fill color; however, you cannot use No Fill for both stroke color and fill color. Drag to expand the shape. Hold down the Shift key while drawing to make the rectangle a square.
**Ellipse tool** Creates circle and ellipse shapes. You can customize stroke color, fill color, and stroke weight by using the color picker and stroke weight pop-up menu. Drag to expand the shape. Hold down the Shift key while drawing to make the ellipse a circle.

**Text tool** Creates a floating multiline text field. You can customize fill color, font face, and font size by using the color picker, font pop-up menu, and font size pop-up menu. Drag to create a text area where you can type.

**Stamper tool** Leaves a Check mark, Arrow, Star, or Cross on the screen. A check mark is the default stamp. You can change the stamp image by clicking the arrow, star, and carat buttons. You can customize image color and shape size by using the color picker and size pop-up menu. If your company has a licensed Connect Enterprise account, you can use a custom image for the stamp. See Custom whiteboard stamps in the Adobe Connect Enterprise Server 6 Installation and Configuration Guide.

**Undo** Undoes the previous action. You can undo the following actions: drawing a shape, moving a shape, resizing a shape, clearing the whiteboard, and changing a shape's property. There is no limit to the number of times that you can perform this operation in the pod.

**Redo** Repeats the previous action.

**Clear** Deletes everything on the whiteboard.

**Print** Prints the contents of a whiteboard.

---

**Change the Share pod size when viewing content**

Content displayed in the Share pod by a host or presenter appears to all meeting attendees. Participants can switch the Share pod size between full-screen and original size when a host enables this feature.

---

**Upload and manage files using the File Share pod**

Hosts and presenters can upload files to share with meeting attendees either from their computers or from the Content library. Meeting participants cannot upload files; however, the host can change the participants' status to allow them to upload files. Participants who want to upload files should request the host to change their attendee role or to grant enhanced rights for the File Share pod.

**Upload a file from the Content library**

1. Click Upload File.
2. Click Add From Content Library.
3. Navigate to the folder that contains the file.
4. Select the file and click Open.

The filename appears in the File Share pod.

**Upload a file from your computer**

1. Click Upload File.
2. Click Add From My Computer.

A Browse Content window appears.

3. Navigate to the folder that contains the file.
4 Select the file and click Open. The filename appears in the File Share pod.

**Download a file**
Meeting attendees can download files from the File Share pod to their computers.
1 In the File Share pod, select the file to download.
2 Select Save to My Computer.
A browser window opens, with the Save to My Computer dialog box.
3 Click the Click to Download button.
4 Navigate to the desired location.
5 Click Save.

**Rename a file**
This operation changes only the label that appears in the File Share pod; it doesn't change the actual filename.
1 In the File Share pod, select the file that you want to rename.
2 In the lower-right corner, click the Pod Options button.
3 From the pop-up menu, select Rename Selected.
4 Type the new name in the Name text box and click OK.

**Remove a file**
1 In the File Share pod, select the file that you want to remove.
2 In the lower-right corner, click the Pod Options button.
3 From the pop-up menu, select Remove Selected.
The filename disappears from the list of files.

**Display web pages to attendees**
During meetings, hosts or presenters may want participants to view websites. You can use the Web Links pod to force attendees' browsers to open a designated URL.

**Add a new web link**
1 Click the Pod Options button in the lower-right corner.
2 Select Add Link.
3 Type the URL name and URL path in the text boxes.
4 Click OK.
The URL name appears in the Web Links pod.

**Display a web link to all attendees**
1 Select a link in the Web Links pod, or enter a URL in the Browse To text box.
2 Click Browse To.
Meeting participants browse to the link.
**Rename a web link**
1. Select a URL name in the Web Links pod.
2. Click the Pod Options button in the lower-right corner.
3. Select Rename Selected Link from the pop-up menu.
4. Type the new name in the URL Name text box.
5. Click OK.

The new URL name appears in the Web Links pod.

**Remove a web link**
1. Select a link in the Web Links pod.
2. Click the Pod Options button in the lower-right corner.
3. Select Remove Selected from the pop-up menu.

The link disappears from the Web Links pod.

## Managing attendees

### About the Attendee List pod
From the Attendee List pod, attendees can quickly see who is logged in to a meeting and monitor everyone's name, role, and status. You can also communicate with the presenter by displaying your participant status next to your name.

If audio conference calling is enabled, you can view your conference call status, dial out to yourself to enter the phone conference, and mute your phone connection. A host can manage meeting attendance and participants' rights.

![Attendee List pod](image)

*Using the Attendee List pod to monitor names, roles, and conference call status*

### See also
- “About audio in meetings” on page 31
- “Using audio conferencing in a meeting” on page 66
About attendee names
Adobe Acrobat Connect Professional users who logged in with a password are listed by their full name in the Attendee List pod, as it is registered in Acrobat Connect Enterprise Manager. If an attendee is logged in to a meeting as a guest, the name in the Attendee List pod is the name that the guest entered at login.

Within a role group, attendee names are organized alphabetically.

Change attendee status
By default, participant status is blank. However, participants can change their own status. When a participant selects a status, an icon appears to the right of the participant’s name. Participants can clear their status at any time during a meeting. When you have responded to a message and want to clear the participant status, select Clear User Status from the Attendee List Pod Options menu.

The following table lists the status settings and icons.

<table>
<thead>
<tr>
<th>Attendee status</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>I have a question</td>
<td>![i have a question icon]</td>
</tr>
<tr>
<td>Go faster</td>
<td>![go faster icon]</td>
</tr>
<tr>
<td>Go slower</td>
<td>![go slower icon]</td>
</tr>
<tr>
<td>Speak louder</td>
<td>![speak louder icon]</td>
</tr>
<tr>
<td>Speak softer</td>
<td>![speak softer icon]</td>
</tr>
<tr>
<td>Thumbs up</td>
<td>![thumbs up icon]</td>
</tr>
<tr>
<td>Thumbs down</td>
<td>![thumbs down icon]</td>
</tr>
<tr>
<td>Stepped away</td>
<td>![stepped away icon]</td>
</tr>
</tbody>
</table>

Change your status
1. Click the My Status bar in the Attendee List pod.
   A pop-up menu appears with a list of the available status settings.
2. Select the status that you want to show to the presenters.

Clear a participant’s status (host and presenter)
1. Select a participant’s name.
2. Click the Pod Options button in the lower-right corner of the Attendee List pod.
3. Select the Clear User Status option.

View connection status
A group of bars, similar to the bars indicating signal strength on a cell phone, appear next to an attendee’s name in the Attendee List pod to indicate an attendee’s connection status.
When the attendee’s connection falls below the current meeting room bandwidth, the number of bars in the icon decreases. A host can configure the network connection status indicators to be on or off at any time during a meeting.

1. Click the Pod Options button in the lower-right corner of the Attendee List pod.
2. Select Show Connection Status from the pop-up menu.

If you are a host, you can select Show Connection Status in the pod menu. The network connection status is enabled, and network connection status is shown for all attendees in your meeting. If the option is not selected, the connection status indicators are hidden for users in your meeting.

**View or change an attendee’s role**
A host can change the role of any attendee in the Attendee List pod, promoting and demoting attendees as necessary.
As a host, you can also change your own role. You can demote yourself to a presenter or participant role, so that you can see what attendees with other roles are seeing in the meeting room. Although you can demote yourself in the Attendee List pod, you cannot promote yourself there; instead, you must use the Present menu.

**View information about an attendee**
✧ Move the pointer over each name to view the attendee’s full name, meeting role, audio conference status, connection status, and enhanced rights.

**Change an attendee’s role**
1. In the Attendee List pod, select the name of the attendee whose role you want to change.
2. Click Set User Role in the lower-left corner of the Attendee List pod.
3. From the pop-up menu, select the role to give to the selected attendee: Participant, Presenter, or Host.
The icon of the attendee changes on all attendees’ screens and attendee names are re-sorted in the list according to role.

**Change your own role**
1. If you are a host, in the menu bar at the top of the meeting room window, click Present.
2. Select one of the following:
   • Make Me a Participant.
   • Make Me a Presenter.
   • Make Me a Host.
Your role icon changes on all attendees’ screens.

**Remove a participant from a meeting**
A host can remove a participant from a meeting.
1. In the Attendee List pod, select the name of the participant to remove.
2. Click the Pod Options button in the lower-right corner of the Attendee List pod.
   A pop-up menu appears with a list of the available pod options.
3. Select Remove Selected User from the pop-up menu.
See also
“Managing the Adobe Connect Enterprise Account” on page 217

Assigning enhanced participant rights
A host can change the rights of a participant to give the participant control over selected pods. This is a way of enhancing a participant’s rights without promoting the participant to be a presenter. To change rights for multiple participants

1 Select the name of a participant from the Attendee List pod. To change the rights for multiple participants, select multiple names.
2 Click the Pod Options button in the Attendee List pod.
3 Select Change Enhanced Participant Rights.
4 In the dialog box, select the pods that you want the participant to control.
5 Click OK.
The user has full functionality for all instances of the selected pod types.

Using audio conferencing in a meeting

Start or stop an audio conference call
In order to use the Acrobat Connect Professional audio conference calling features, the meeting creator must have an account with an audio conference bridge installed. For more information about audio conference bridge availability with your account, contact your account administrator.

If you have an audio conference bridge installed, you must enter information for the audio conference, such as call-in number and participant code, either when you create the meeting, or when you edit the meeting information. If you have an audio conference bridge and you want the conference call to be integrated with the meeting, you can select the option on the Meeting Information page labeled Select My (service name) Audio Conference with this Meeting.

You can save your audio conference call information, such as moderator code, client id, and password, in Acrobat Connect Enterprise Manager under My Profile > Edit My Preferences.

In a meeting, you initialize the conference call connection to the audio bridge by selecting Start Audio Conference in the Attendee List pod. Once the phone conference is initialized, you can dial out to yourself from the Attendee List pod or dial in. Stop Audio Conference disconnects everyone in the meeting and ends the call.

Once an audio conference is started, a dialog box appears to all attendees, inviting them to join the teleconference.

Start an audio conference
1 Click the Phone Conference Options button at the bottom of the Attendee List pod.
2 Select Start Audio Conference from the pop-up menu. When the audio conference begins, the dial-in number or numbers appear at the right side of the meeting window.

Stop an audio conference
1 Click the Phone Conference Options button at the bottom of the Attendee List pod.
2 Select Stop Audio Conference from the pop-up menu.
Include attendees in an audio conference call

Acrobat Connect Professional gives hosts several options for dialing out to include participants in an audio conference call. You can dial out to a registered participant by using the telephone number stored in his or her profile or by entering a new telephone number. To include an unregistered participant in the audio conference call only, you can enter a new name and number to dial. You can create an offline entry to dial later and a list of offline entries to dial all at once. And you can hang up on selected attendees.

Acrobat Connect Professional provides audio announcements when an attendee enters or departs from a meeting, when a meeting is ended, and when a meeting is extended.

Call out to a new telephone user
1. Click the Phone Conference Options button at the bottom of the Attendee List pod.
2. Select Call New Telephone User from the pop-up menu.
   The Call New Telephone User dialog box appears.
3. Enter the participant’s name and telephone number.
4. Select Call Now to call the participant immediately.
   The attendee is called on the phone and the Call in Progress icon 📞 is displayed to the right of the attendee’s name.

Create a list of participants to call later
1. Click the Phone Conference Options button at the bottom of the Attendee List pod.
2. Select Call New Telephone User from the pop-up menu.
   The Call New Telephone User dialog box appears.
3. Enter the participant’s name and telephone number.
4. Select Call Later.
   The participant is added to the Attendee List pod as an offline attendee (gray participant icon with no phone icon).

Call out to a participant who is logged in to Acrobat Connect Professional
1. In the Attendee List pod, select the name of the participant to add to the audio conference.
2. Select Call Selected User from the pop-up menu.
   The Call Out dialog box appears. You can either enter a new phone number or select a number from the list of numbers associated with the participant.
3. Click Call.
   The participant is called on the telephone.

Call out to several listings at the same time
1. In the Attendee List pod, select the names of the attendees to add to the audio conference.
2. Select Call Selected User from the pop-up menu.
   All the selected participants are called.

About audio conference status
If a host enables audio conferencing in a meeting and an attendee calls in or is called, an audio conference status icon appears next to the attendee’s name.
When an attendee dials in or a host dials out, a conference call status icon appears to the right of the attendee's name, so that you can quickly see the status of the attendee's conference call.

<table>
<thead>
<tr>
<th>Attendee status</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>On the phone</td>
<td>📞</td>
</tr>
<tr>
<td>Talking</td>
<td>🎤</td>
</tr>
<tr>
<td>Dialing in progress</td>
<td>📆</td>
</tr>
<tr>
<td>On hold</td>
<td>⏭</td>
</tr>
<tr>
<td>Muted</td>
<td>🔈</td>
</tr>
</tbody>
</table>

**Use Mute, Volume, and On Hold controls**

From the Attendee List pod, a host can control an attendee's volume, mute the connection, and place the user on hold.

**Control the volume**
1. In the Attendee List pod, select the participant's name.
2. Click the Volume button (Speaker icon).
3. Slide the indicator up or down to increase or decrease the volume.

**Mute a participant**
1. In the Attendee List pod, select the participant's name.
2. Click the Volume button (Speaker icon).
3. Click the Mute button (No Speaker icon).
The other attendees cannot hear the participant.

**Place a participant on hold**
1. In the Attendee List pod, select the participant's name.
2. Click the Hold button (Hand icon).
The participant cannot be heard and cannot hear the audio segment of the meeting.

**Merge two listings for the same caller in a conference call**

If an attendee logs into a meeting and is then called into an audio conference, the two entries are automatically merged and only one name appears for the user. But if the attendee's phone number is not recognized, the attendee may appear twice on the list, once under Acrobat Connect Professional with a name and once under Unknown Dial In without a name. If a host knows that an attendee is listed twice, the host can use the Merge Caller ID feature to combine the listings into one.

1. In the Attendee List pod, select the name of an Acrobat Connect Professional attendee.
2. Control-click the name of an Unknown Dial In attendee.
3. Click the Merge User button 📅 in the lower part of the pod.
The two listings merge into one under the Acrobat Connect Professional users group.

*Note: For audio conference features to function in your meeting, the conference adapter must be enabled.*

**Join a conference call or mute your phone**

Once an audio conference is started in a meeting that you are attending, a dialog box appears inviting you to join. The dialog box enables you to enter your telephone number so that Acrobat Connect Professional can dial the number and add you to the conference.

If the meeting you are joining has multiple dial-in numbers (such as a meeting with international attendees which offers a local dial-in number for each country) you can view a list of the dial-in numbers. This list appears automatically during the first five seconds after you log into the meeting. You can also choose to view the list at any time while you are logged in.

You can also mute your connection so that you can listen to the conference call but cannot be heard.

**Join the audio conference call**

1. In the Join Audio Conference dialog box, enter your telephone number. If the Join Audio Conference dialog box is not visible, choose Show Teleconference Info.
2. Click Call My Phone.

You can also select Call My Phone from the My Status menu.

**View the list of multiple dial-in numbers during a meeting**

❖ Hover over the telephone icon in the upper right corner of the meeting room.

**Use the Mute Me button**

1. Click the My Status button in the upper-right corner of the pod.
2. Select Mute Me from the pop-up menu.

You cannot be heard, but you can hear the speaker.

**Recording and playing back meetings**

**About meeting recordings**

A host can record a meeting room session in case some participants missed it or want to replay it. When played back, the recording shows exactly what the attendees saw and heard during the meeting. A host or presenter can create a reference archive of meetings and make the recordings available to attendees.

The meeting recording is assigned a URL and added to the Recordings page associated with the meeting room in Acrobat Connect Enterprise Manager. To play a recording, you need an Internet connection, the recording URL, and permission to view it.
Record a meeting
If you are a host, you can select a recording option. Everything that happens in the meeting room is recorded, with the exception of the Presenter Only area. At the beginning of the recording, you enter a recording name and description. You also select the microphone input for the audio recording. You can start and stop recording at any time during the meeting, so you can decide what meeting content to record.

If you use the Camera And Voice pod to broadcast audio to meeting attendees, all audio is recorded automatically. The audio broadcast from the Camera And Voice pod is voice over IP (VoIP).

To record an audio conference call, you can use your speaker phone and your computer microphone as the recording devices. If you select the Record Audio From Speaker Phone option when your first start recording, audio broadcasts from the Camera And Voice pod are disabled. All audio input to your computer is captured and recorded but is not broadcast to participants.

If you have integrated your audio conference using an audio conference bridge, the recording includes audio from both the Camera And Voice pod and the audio conference. The Record Audio From Speaker Phone option is not available.

If you are using the Premiere audio conferencing bridge, be sure to begin your recording from within Acrobat Connect Professional (do not begin your recording by using a Premiere telephone key command).

Note: If you are using Premiere audio conferencing service, and Premiere is unable to create the audio recording when you begin recording a meeting, you will receive an error message.

Start recording a meeting
1. From the menu bar, select Meeting > Record Meeting.
2. In the Record Meeting dialog box, enter a name and summary for the meeting recording.
3. (Optional) Select Record Audio From Speaker Phone.

4. Click OK.

A recording icon (red circle) appears in the menu bar to indicate that the meeting is being recorded.

Stop recording a meeting
To stop recording a meeting, do one of the following:

• Place the pointer over the red circle in the menu bar, and select Stop Recording from the pop-up menu.

• Select Meeting > Record Meeting to remove the check mark from the menu bar.

The meeting recording is saved and is available for playback at any time.
Play back a recorded meeting
A host or presenter can make a URL available so that attendees can play the recording of a meeting.

Every recording is automatically assigned a unique URL and is stored on the Recordings tab for the meeting room in Acrobat Connect Enterprise Manager. Any attendee who has access can view information about the recording, such as disk use, permissions, recording date, and duration. From this page, the meeting host can edit the recording title and summary.

When you play a recording, a recording navigation bar appears in a space below the meeting room. For optimal performance, a high-speed Internet connection is recommended for recording playback.

![Recording navigation bar](image)
A. Hide toolbar  B. Show/Hide archive transcript  C. Pause/Play toggle button  D. Status bar  E. Elapsed time

Play a recording from a URL
❖ Click the recording URL that the presenter sent to you.
The recording opens in your browser and is ready for playback.

Play a recording from Acrobat Connect Enterprise Manager
1 Click the Meetings tab to go to the Meetings library in Acrobat Connect Enterprise Manager.
2 In the Meetings library, click the meeting link that includes the recording.
3 Click the Recordings option.
The Recordings page appears, listing all recordings for the meeting.
4 Select the recording that you want to play.
The Recording Information page appears.
5 Click the meeting URL.
The recording is played in your meeting window.

Navigate recorded meetings
Certain events are indexed for each meeting recording, including layout changes, chat messages, slide changes, and users joining or leaving the Attendee List or Camera And Voice pod.

Each event is represented by an item in the Recording Index and is followed by a timestamp. By navigating the Recording Index for a meeting, you can filter and search recorded meetings.

1 Click the View Archive Transcript button on the recording navigation bar.
2 Expand or collapse layout folders to see the recorded events.

About managing recorded meetings
You can view all recordings made for a particular meeting, change permissions, rename, or move a recording, or view a content report for a recording. You can use a recorded meeting as content for another meeting. To view and update information about recorded meetings, click the meeting title in Acrobat Connect Enterprise Manager and click the Recordings tab.
Move meeting recordings to the Content library
To move meeting recordings (recordings associated with a meeting in a Meetings library folder) to the Content library, you must be an administrator or a user with permissions to manage that specific Meetings library folder.

1. Click the Meetings tab at the top of the Acrobat Connect Enterprise Manager window.
2. Navigate to the meeting that has recordings you want to move.
3. Click the meeting name in the list.
4. In the Meeting Information page, click the Recordings link on the navigation bar.
5. Select the check box to the left of any recording that you want to move.
6. Click Move on the navigation bar.
7. Navigate to the folder location in the Content library where you want to move the recording by clicking the folder titles or the Up One Level button. (As you navigate, the new destination appears in the upper right of the Connect Enterprise Manager window.)
8. Click Move.

The Recordings page appears with an updated recording list.

Delete a meeting recording
To delete a meeting recording associated with a meeting, you must be an administrator or a user with permissions to manage that specific Meetings library folder. When you do delete a recording, you are deleting it from the Meetings library. (This process does not delete the recording from the Content library if you moved it there previously. To delete a meeting recording you moved to the Content library, see “Delete a library folder or file” on page 18.)

1. Click the Meetings tab at the top of the Acrobat Connect Enterprise Manager window.
2. Navigate to the meeting that has recordings you want to delete.
3. Click the meeting name in the list.
4. In the Meeting Information page, click the Recordings link on the navigation bar.
5. On the Recordings page, select the check box to the left of any recording you want to delete.
6. Click Delete above the list.
7. Click Delete on the confirmation page.

The Recordings page appears with an updated recording list.

Filter meeting events
To find and view an event, you can use the filtering feature in the Recording Index. You can show all events, a single event, event types, or any combination of events that can be indexed. Events that can be filtered include layout changes, chat messages, slide changes, and users joining or leaving the Attendee List or Camera And Voice pod.

1. Click the Select Events button at the top of the Recording Index.
2. Select an option from the pop-up menus.

A filtered list of meeting events appears in the Recording Index.
**Search for a meeting event**

To find a specific meeting event, you can use the search feature in the Recording Index. You enter a search term in the Find text box in the Recording Index, and all events that contain a match appear highlighted in pink. You can search the following terms in a an archive:

- Names of meeting participants
- Text in all Note pods
- Text in all Chat pods
- Text on slides shown in the meeting

1. Type a search term in the text box at the top of the Recording Index.
2. Click Find.

A list of items appears in the Recording Index.

---

**Taking notes in a meeting**

**Using the Note pod**

As a host or presenter, you can use a Note pod to take meeting notes that all attendees can see. Unlike a chat message in a Chat pod, the text note in a Note pod is created and displayed only by presenters. It remains visible in a Note pod throughout the meeting or until a presenter edits the note or displays a different note. A host can remove the Note pod from view, or switch to a different room layout that does not contain that Note pod.

A new meeting created from the Default Meeting Template contains three layouts. Each layout contains an instance of the same Note pod. When you type a message in one layout’s Note pod, the same text appears in all three layouts. With the New Note Pod option, you can create a single instance of a Note pod that appears in only one layout.

You can use the Note pod in several ways:

- Create a single, persistent note that is visible to attendees during the entire meeting.
- Create multiple notes in a single pod.
- Create multiple Note pods to display different notes.

You can also e-mail the contents of a note pod.

**Create a Note pod**

A host can create and display multiple Note pods, each with its own text. You can use different Note pods for different layouts and meetings. When you create a Note pod, it is assigned a default name, such as Note 1, Note 2, and so on. You can rename the Note pod after it is created.

- From the menu bar at the top of the Stage, select Pods > Note > New Note pod, or choose New Note from the Note pod options menu.

A new Note pod appears on the Stage. You can move, resize, and rename the pod.
Add a note to a Note pod
A host or presenter can add or change text in any Note pod.

1. Click anywhere inside the Note pod.
2. Type the text that you want to appear in the Note pod.

Meeting attendees immediately see the new text.

Create multiple notes in a Note pod
A host or presenter can create more than one note in a Note pod, and choose which note to display.

Create multiple notes
1. Click the Pod Options button in the lower-right corner.
2. Select New Note from the pop-up menu.

Select which note to display
1. Click the Pod Options button in the lower-right corner of the Note pod.
2. Select the Select Note option.
3. Select the name of the note that you want to display from the pop-up menu.

Edit a note
A host or presenter can edit the text in a Note pod. All the text in a pod uses the same formatting. All editing changes are immediately visible to attendees.

1. Click anywhere inside the Note pod containing the text that you want to edit.
2. Modify the text.
3. To change the size of the text, click the Pod Options button in the lower-right corner of the Note pod, and then select Text Size. Next, select a text size.
4. To change the alignment of the text, click the Pod Options button in the lower-right corner of the Note pod, select Text Alignment, and choose an alignment option: left, center, or right.

Rename a note
When a host or presenter creates a note, it is assigned a default name, such as Note 1 or Note 2. If you are a host, you can rename a note. Simply double-click the name and enter a new one, or follow the procedure below.

1. Click Pods in the menu bar.
2. Select Organize Pods.

The Organize Pods dialog box appears.

3. Select the name of the Note pod that you want to change.
4. Click Rename.

The Rename Pod dialog box appears.

5. Type the new name.
6. Click OK.
The new name appears in the Organize Pods dialog box.
7 Click Done.

Delete a note
1 Click Pods in the menu bar.
2 Select Organize Pods.
The Organize Pods dialog box appears.
3 Select the name of the note that you want to delete.
4 Click Delete.
5 Click Done.

E-mail the contents of a note pod
• If you are a host, in the Note pod select Email Note from the pod options menu (the Acrobat Connect Add-in must be installed to use this option).
A new message appears in your default email client, with the subject Note and the contents of the Note pod in the message body. Edit the note if necessary, address the message to recipients, and send.

Chat options in a meeting

About the Chat and Q & A pods
You can communicate with other attendees while a meeting is in progress, using a Chat pod to send or receive a chat message. If you have a question and do not want to disturb the meeting flow, or if you cannot speak in a meeting because sound is not enabled on your computer, you can send a chat message to the presenters or to another meeting participant. For example, when you first enter a meeting room, you can introduce yourself by sending a chat message to everyone in the room. Or you can send a chat message to the meeting organizer to ask a question about the schedule of events.

As a presenter, you can use more than one Chat pod simultaneously. You can specify the Chat pod to display content to everyone, or to presenters (and hosts) only.

In the Chat pod, messages appear as they are submitted, and they are listed sequentially in the pod. Questions and answers are not linked, and they can appear in different locations on the list in the Chat pod. Presenters can allow participants to conduct private chats, to clear a chat, and to turn off chat notifications.

Chat pod content is persistent, and will remain in a meeting room until you delete it. If you want to preserve Chat pod content for future use, you can email it.

You can use a Q & A pod to answer questions posed by attendees. The Q & A pod is linked to the Chat pod. When an attendee asks a question in the Chat pod, a presenter can answer in the linked Q & A pod. When a presenter answers a question, the question and answer appear as pairs in the Chat pod.
A host or presenter links the Q & A pod to the Chat pod

A participant submits a question in the Chat (Q & A) pod

The presenter selects a question and answers from the linked Q & A pod

The question and answer appear as a pair in the Chat pod

Send a chat message

You can use the Chat pod to compose a chat message and address it to a specific participant, to all presenters at the meeting, or to all attendees (participants, presenters, and hosts).
When you receive a chat message from a meeting participant, your Chat pod shows the sender's name and the message. If the message was sent to everyone, the sender's name is followed by the message. If the message was sent only to you, the sender's name is followed by "(privately)". If the message was sent only to the presenters, the sender's name is followed by "(presenters)."

1. Select one of the following options from the pop-up menu at the bottom of the Chat pod:
   - The name of a participant to whom you want to send a message
   - Presenters
   - Everyone
2. Click the text box in the Chat pod.
3. Enter your message.
4. Do one of the following:
   - Click the Send Message button next to the text box.
   - Press Enter or Return.

Your name appears in the Chat pod, followed by the addressee you selected and your message.

**Disable private chat between participants**

By default, two participants can chat privately. When Enable Private Chat For Participants is selected, participants can send messages to individual participants as well as to presenters and to all attendees. As a host, you can disable this option and prevent private chat.

1. Click the Pod Options button in the lower-right corner of the Chat pod.
2. Click Enable Private Chat For Participants to disable the option. A check mark indicates when the option is enabled.

*Note: This option is not available if the Chat pod is linked to a Q&A pod.*

**Clear messages from a Chat pod**

When an empty Chat pod is required in a meeting, a host or presenter can clear all messages for all attendees.

1. Click the Pod Options button in the lower-right corner of the Chat pod.
2. Select Clear Chat.

All text is removed from the attendees' Chat pods.

**Use chat notifications**

If you are a host or presenter and you are using the Acrobat Connect Add-in, chat notifications let you communicate with your audience while you are presenting and the meeting window is minimized or maximized to full-screen, concealing the Chat pod. If an attendee sends you a message while you are presenting in full screen or screen sharing mode, a notification appears in the lower-right corner of the screen. You can see the sender’s name and the first few words of the message in the notification window. By default, Chat Notifications is enabled. If you don't want notifications to be shown while you are presenting, you can disable them.

1. Click the Pod Options button in the lower-right corner of the Chat pod.
2. Select Disable Chat Notifications.
Moderating questions with the Q & A pod

If you are a host or presenter, the Q & A pod gives you additional control for managing questions and answers during a meeting. Using this pod, you can redirect a question to the appropriate presenter and place questions in a queue until you are ready to answer them.

To manage your queue of questions, you can apply a filter, so that you see certain questions while hiding others. You can select and edit a question, enter your reply, and send the answer either to all participants or just the sender. Questions and answers appear as pairs in the Chat (Q & A) pod.

You might use the Q & A pod in situations like these:

- During a product launch with more than a hundred participants, questions are added to a queue on the Q & A pod while the speaker presents. After completing the presentation, the speaker reviews the messages, applies a filter, and begins answering the questions.
- A meeting moderator answers logistical questions but forwards technical inquiries to an engineer, who is presenting.
- A meeting moderator returns certain replies to the sender only. Replies that are relevant to all attendees are sent to everyone in the meeting.

Add a Q & A pod and link it to a Chat pod

If you are a host or presenter, you can add a Q & A pod to a meeting room with an existing Chat pod. You must create a link between the two pods. After the two pods are linked, “(Q & A)” is added to the name of the Chat pod. In Q & A mode, participants can send messages only to the presenters. There can be only one Q & A pod in a meeting room.

Add a new Q & A pod to a room

* From the menu bar at the top of the Stage, select Pods > Q & A.

Link a Chat and a Q & A pod

1 In the Q & A pod, select the name of the Chat pod that you want to link to from the pop-up menu.
2 Click Link.

The Chat pod is linked to the Q & A pod and (Q & A) is displayed in the Chat pod name.
Submit a question in the Chat pod
Hosts can submit questions in the Chat pod.

1. From the pop-up menu at the bottom of the Chat pod, select Submit Question (this option is available only if a Q & A pod is linked to the Chat pod).
2. Enter your message in the text box, and click the Send Message (arrow) button, or press Return.

Answer questions using the Q & A pod
If you are a host or presenter, you can apply a filter to the queue of messages to quickly find the questions that you want to answer.

1. Select a question from the Incoming Messages list.
   The question is highlighted and a duplicate of the question appears in the Preview pane so that you can edit it if necessary.
2. (Optional) Edit the question in the Preview pane.
3. Type your answer in the text box at the bottom of the pod.
4. Click one of the following buttons in the lower-right corner of the Q & A pod:
   - **Answer question to everyone** Sends the answer to all meeting attendees.
   - **Answer question to submitter only** Sends the answer only to the attendee who sent the question.

When a question is sent, it is deleted from the Incoming Messages list and appears in the Chat pod as a question and answer pair in the “Answered Questions” list.

Filter and forward questions using the Q & A pod
If you are a host or presenter, you can add a filter to the queue of questions in a Q & A pod so that you can see certain questions while hiding others. You can also forward a question to another presenter who might be better able to answer it.

Manage your questions with filters
1. Click the pop-up menu in the upper left corner of the Q & A pod.
2. Select a filter from the following list:
   - **Show All Questions** Displays all questions that you have received, starting either with a new pod or from the last time the pod was cleared.
   - **Show My Questions** Displays only the questions that have been assigned to you.
   - **Show Open Questions** Displays all unanswered questions not assigned to anyone.
   - **Show Answered Questions** Displays all questions that have been answered.

Forward a question to another presenter
1. Select the question from the Incoming Messages list.
   The question is highlighted, and a duplicate of the question appears in the Preview pane.
2. Click Presenter and select a presenter’s name from the pop-up menu.
   The presenter’s name appears on the Presenter button.
3 Click Forward.

**Manage questions**
If you are a host or presenter, you can mark a question as open, delete a selected question, delete all questions, and select a Chat pod to link to your Q & A pod. Marking a question as open is useful if you want to make it easier for a presenter to tell which questions still require attention. You can also choose to display the submitter’s name in front of questions or the presenter’s name in front of answers.

**Mark a question as open**
1 From the Incoming Messages list, select an unanswered question.
2 Click the Pod Options button in the lower-right corner.
3 Select Mark as Open.

**Delete a message**
1 From the Incoming Messages list, select a question.
2 Click the Pod Options button in the lower-right corner.
3 Select Delete Question.
The selected question is removed from the list.

**Delete all questions**
1 From the Incoming Messages list, select a question.
2 Click the Pod Options button in the lower-right corner.
3 Select Delete All Questions.
All questions are removed from the list.

**Show the submitter’s name or presenter’s name in front of the question or answer**
1 Click the Pod Options button in the lower-right corner.
2 Select one of the following options:
   • Show submitter name with answered question.
   • Show presenter name with answered question.

**Email the contents of a Chat pod**
• In the Chat pod, select Email Chat History from the pod menu (the Acrobat Connect Add-in must be installed to use this option).
A new message appears in your default email client, with the subject Chat History and the contents of the Chat pod in the message body. Edit the message if necessary, address the message to recipients, and send.
Broadcasting audio and video

About audio and video broadcasting
Using the Camera And Voice pod in Acrobat Connect Professional, hosts and presenters can broadcast and view live audio, video, or both. To broadcast audio, the broadcaster’s computer must have a microphone connected to it. To broadcast video, the broadcaster’s computer must have a video or web camera connected to it. For participants to broadcast audio and video, a host must grant them enhanced rights for the Camera and Voice pod, or promote them to host or presenter.

Note: If you have an audio conference bridge installed with your Acrobat Connect Professional account, you can use audio conferencing via telephony.

Attendee roles and audio and video broadcast capabilities
In a meeting, your broadcast capabilities are determined by your attendee role—host, presenter, or participant. Hosts control participant access to broadcasting capabilities. The following audio and video capabilities are available for each attendee role:

The host can do the following:
• Choose settings for broadcasting audio and video
• Broadcast audio and video
• Select the broadcasts that you want to receive
• Control participant access to broadcasting capabilities
• Stop an attendee from broadcasting

The presenter can do the following:
• Choose settings for broadcasting audio and video
• Broadcast audio and video
• Select which broadcasts to receive

The participant can do the following:
• If granted enhanced rights to the Camera and Voice pod by a host, can broadcast audio and video
• If promoted by host to be a presenter, can broadcast audio and video
• Select which broadcasts to receive

Set up audio broadcasting
Use the Audio Setup wizard to quickly set up and use your audio devices. You can test sound output, select a microphone, tune the microphone volume, and tune the silence level.

You can also use Advanced Settings to make further adjustments to the ways that Acrobat Connect Professional handles audio data. Using Advanced Settings is recommended only if you have advanced understanding of audio technology.

Test audio devices and configure settings
1 Select Meeting > Audio Setup wizard from the menu bar.
The Welcome page of the Audio Setup wizard appears.

2 Click Next to begin testing your sound output.

3 On the Sound Output page, click Test.

A sound sample plays from your speakers or headphone. If you did not hear the sound sample, click Help for more information.

4 Click Next.

5 On the Select Microphone page, select your microphone type from the pop-up menu.

6 Click Next.

7 On the Test Microphone page, click Record to test your microphone.

8 If a dialog box appears requesting access to your camera and microphone, click Allow to allow Acrobat Connect Professional to access your camera and microphone.

9 Click Next.

10 On the Tune Silence Level page, click Silence. Remain silent until progress is complete.

Acrobat Connect Professional sets a microphone sound level that compensates for background noise in your environment.

Set Advanced Settings in the Audio Setup wizard (Windows only)

1 From the menu bar, select Meeting > Audio Setup Wizard.

The Welcome page of the Audio Setup wizard appears.

2 Click the Next button to advance to Step 5 of 5 in the Audio Setup Wizard.

3 Click the Advanced Settings button.

The Advanced Audio Settings panel appears.

4 Make sure Use Enhanced Audio (selected by default) is selected.

This option turns on automatic audio control, including echo cancellation, microphone volume control, silence detection, and noise suppression. You must select this option to use the other Advanced Settings.

5 For Silence Level, drag the slider to adjust the level. A higher setting results in more sensitivity to silence in an audio broadcast.

6 For Acoustic Echo Cancellation Mode, select an option to adjust echo cancellation (the Acrobat Connect Add-in must be installed to use this option):

**Full Duplex** Enables multiple users to speak at one time. If echo feedback results, select another option (this option is preferred for most systems).

**Half Duplex** Enables only one user to speak at a time. Use this option if microphones on your system are unusually sensitive (transmitting unwanted background sound) or if you have poor echo cancellation.

**Headphones** Optimizes audio settings for use with headphones. This option uses Full Duplex mode, in which multiple users can speak at one time.

**Off** Disables echo cancellation.

7 To enable the Acrobat Connect Add-In to automatically select the optimal Acoustic Echo Cancellation Mode, make sure Auto Sense Acoustic Echo Cancellation Mode (selected by default) is selected.
If this option is selected, the Add-In begins with the Mode you selected in step 6 and adjusts the mode based on information from users’ systems. To disable automatic adjustment of AEC mode and use only the mode you selected in step 6, you can deselect this option.

8 To enable your microphone volume to adjust automatically in response to changes in voice level, make sure Automatic Gain Control (selected by default) is selected. Deselect this option if you experience problems with the audio volume fluctuating unpredictably. Deselecting this option will prevent microphone volume from adjusting automatically.

9 For Audio Quality, select an option to adjust a combination of all audio settings, including silence level, echo cancellation, and gain control, to provide optimized performance. A higher quality setting uses more CPU resources, and therefore slows performance, but provides better audio quality. It is recommended that you use the highest quality setting that does not cause detectable audio degradation on your system. Select one of four settings:

**Fast** Provides the fastest performance but the lowest audio quality. (This setting uses the fewest CPU resources. Use this option for systems with slower CPUs.)

**Good** Provides somewhat slower performance but better audio quality. (This is the default setting, recommended for most systems.)

**Best** Provides the slowest performance but the best audio quality. (Use this option for systems with very fast CPUs.)

**Custom** Enables you to select options for audio quality settings. Use this option if the standard settings do not provide adequate results. Proceed to step 10 to select Custom options.

10 If you selected Fast, Good, or Best in step 9, proceed to step 11. If you selected Custom in step 9, choose from the following options:

- For Echo Path, select 128 (the default setting) or 256. The higher setting provides greater suppression of audio feedback. This setting uses more CPU resources and is recommended for systems that don’t use headphones.

- Select Noise Suppression (selected by default) to reduce the amount of noise that the microphone picks up. Deselect the option to make the microphone more sensitive.

- For AEC (Acoustic Echo Cancellation), select Fast for the fastest performance and poorest quality, Good for slower performance and better quality, or Best for slowest performance and best quality.

- Select Non Linear Processing (selected by default) to use non-linear processing for audio data. Deselect the option to use standard processing (and fewer CPU resources).

11 To override your selections and restore the default Advanced Settings, click Reset to Defaults.

12 To apply the Advanced Settings and return to the Audio Setup Wizard, click OK. Step 5 of the Audio Setup Wizard appears.

13 Click Finish to exit the Audio Setup Wizard.

**Set up video broadcasting**

You can select a camera for video broadcasting.

*Note: To use the Select Camera option, a participant must be promoted by a host.*

1 Select Meeting > Select Camera from the Menu bar.

An Adobe Flash Player Settings window opens, with the Camera tab selected.

2 Select the camera that you want to use from the Camera pop-up menu.

*Note: If no camera is connected, a No Camera Found message appears instead of the Camera pop-up menu.*
3 Click Close.

**Specify audio broadcast settings for all participants**
If you are a host, you can turn audio broadcasting on and off for all attendees, and enable one or multiple attendees to speak at one time.

1 Click the Pod Options button  in the lower-right corner of the Camera And Voice pod.

2 Choose one of the following:
   • Voice Off turns off all audio broadcasting.
   • Voice On - Multiple Speakers turns on audio broadcasting. Meeting attendees who have the appropriate permissions can broadcast audio. Any attendee can talk when holding down the Talk button.
   • Voice On - One Speaker turns on audio broadcasting. Meeting attendees who have the appropriate permissions can broadcast audio. When a speaker holds down the Talk button, the Talk button is disabled for other users, who cannot broadcast their voice.

**Specify video broadcast settings for all attendees**
If you are a host, you can turn video broadcasting on or off for all participants, and specify image quality.

*Note:* If you change a setting while video is being broadcast, buttons may be added to or removed from the Camera And Voice pod.

1 Click the Pod Options button in the lower-right corner of the Camera And Voice pod.

2 Choose one of the following:
   • Camera Off turns off video broadcasting.
   • Slow Images samples and transmits the camera image less frequently than other image settings. Images tend to be low-quality and can shift abruptly. Use this setting if most attendees have low-speed connections or if you are not concerned about image quality.
   • Fast Images (the default setting) provides a clear but not high-quality image. Use this setting if attendees are connected at a variety of speeds.
   • High Quality Images provides high-quality images. Use this setting if all attendees are connected at high speeds.
   • High Bandwidth provides the highest-quality images, suitable for use with the highest connection speeds, such as DSL/Cable or LAN.

**Change the aspect ratio of videos**
If you are a host, you can choose between Portrait (the default setting), Standard, or Landscape aspect ratio for video display.

1 Click the arrow in the lower-right corner of the Camera And Voice pod.

2 Select the aspect ratio settings you want from the pop-up menu:
   • Portrait displays video with a square aspect ratio.
   • Standard displays video with a width-to-height aspect ratio of approximately 4/3.
   • Landscape displays video with an aspect ratio of approximately 9/5.
Enable participants to broadcast audio and video
A meeting host can enable a participant to broadcast audio and video by changing the participant’s role to presenter, or by changing the participant’s permissions for the Camera And Voice pod.
❖ In the Attendee pod, select the participant’s name and do one of the following:
• Click the Set User Role button in the lower left corner, and select Set as Presenter.
• Click the Pod Options button and select Change Enhanced Participant Rights. In the dialog box, select Camera And Voice pod and click OK.

Stop an attendee from broadcasting
When necessary, a host can stop a meeting attendee from broadcasting video or voice.
1 Roll over the attendee’s name in the Camera And Voice pod.
2 Click the close icon (X) to the right of the attendee’s name to stop the attendee’s broadcast.
The attendee’s name, image, and media control buttons disappear from all attendees’ Camera And Voice pods.

Control your video and audio broadcast
You click a button in the Camera And Voice pod to turn on your video camera and microphone and start audio and video broadcasting. Your broadcast appears in the Camera And Voice pod along with other broadcasts in the meeting (if any are in progress).

You press the Talk button to activate your microphone, or the Hands-Free button to keep your microphone on all the time. When you speak, a green line indicates your audio broadcast level. You can pause broadcast of your microphone or camera, or turn off broadcasting.

Note: In Acrobat Connect Professional, a host must grant permission to a participant to broadcast video and voice.

Using the Camera And Voice pod
A. Stop My Camera and Voice  B. Camera  C. Hold to talk  D. Hands-Free

Start audio and video broadcasting
❖ In the Camera And Voice pod, click the Start My Camera And Voice button.

Broadcast your voice
Do one of the following:
• Hold down the Talk button to speak during a meeting.
• Click the Hands-Free button (lock icon) in the control strip of the Camera And Voice pod. When the Hands-Free button is selected, you can speak at any time during the meeting. Click the button again to turn off hands-free audio broadcasting.

Pause video broadcasting
❖ Click the Camera button in the Camera And Voice pod. Click the button again to resume video broadcasting. When video broadcasting is paused, the last image broadcast from your camera remains in the Camera And Voice pod.

Stop broadcasting your video and voice
❖ Click the Stop My Camera And Voice button.

Select which broadcasts you receive
If you are a host, you can select to receive or block a video or audio broadcast from a participant. A red line over a participant’s Microphone or Camera icon indicates that broadcasts from that participant are blocked. If no red line is visible, broadcasts from that participant are allowed.

Block or unblock audio broadcasts from a participant
❖ Roll over the participant’s name in the Camera And Voice pod and click the Microphone icon next to the name.

Block or unblock video broadcasts from a participant
❖ Roll over the participant’s name in the Camera And Voice pod and click the Camera icon next to the name.

Polling attendees

About the Poll pod
Hosts can use the Poll pod to create questions, or polls, for participants and to view the results. Only hosts can control poll management and how polls appear to meeting participants. Hosts can also cast votes.

Poll attendees
To poll attendees, a host must create a new Poll pod. Poll results are sent to the server only when the poll is closed.

Ask participants to respond to a poll
❖ Enter a question into the Poll pod and click Open at the bottom of the Poll pod.

Close the answer period for a poll
❖ Click Close at the bottom of the Poll pod. The results are sent to the application server.

Edit a poll
After you create a poll, you can make changes to the question and responses.
**Edit a poll**
1. Click Prepare in the lower-left corner of the Poll pod.
2. Click the location for the text and edit the text.
3. Click Open at the bottom of the Poll pod.
   
The updated poll appears in the Poll pod.

**View and show poll results**
As a host or presenter, you can view poll results in both open and close modes. These results are updated in real time as participants continue to cast or change their votes.

**View poll results**
❖ In open or close mode, click Show Individual Votes at the bottom of the Poll pod.
   
The participant names and responses appear in the Poll pod.

**Show poll results to participants**
1. Click the pod options menu button in the lower-right corner of the Poll pod.
2. Do one of the following:
   • Select Broadcast Results from the pop-up menu.
   • Scroll to the bottom of the main area and click Broadcast Results.
   
The poll responses appear to all meeting participants.

*Note: This option appears only when the pod is not being edited.*

**Navigate among polls**
You can create multiple polls and navigate among them quickly and easily.
1. Click the pod options menu button in the lower-right corner of the Poll pod.
2. Choose Select Poll.

**Clear poll answers**
1. Click the pod options menu button in the lower-right corner of the Poll pod.
2. Select Clear all Answers from the pop-up menu.
   
The results are cleared from the main window.
Chapter 4: Adobe Connect Training

About Adobe Connect Training 6

About content, courses, and curriculums
The Adobe Connect Training 6 application consists of two components: courses and curriculums. Courses are created using content within the Content library. You can only use the Connect Training application if this feature has been enabled for your Adobe Connect Enterprise Server 6 account.

Content is files stored in the Connect Enterprise Server Content library. Content can be any of the following file types: PPT, FLV, SWF, PDF, GIF, JPG, PNG, MP3, HTML, or ZIP. With content, no individual user information is stored. Reports are created for content, but they are aggregate, content-specific reports, and are based on access. If content is created with Adobe Presenter and the presentation contains quizzes, you cannot set the number of attempts users have to pass the quizzes. Also, with content there is no resume functionality so, for example, if a user quits halfway through a content item, the next time they launch the item they are taken back to the beginning of the content.

A course contains any item from the Content library. A course is associated with a given set of enrolled learners and there is usage tracking for each individual learner. The course can be delivered and administered independently or as part of a curriculum. When you use courses, scores can be captured for AICC-conformant objects and you may enforce the number of attempts users have to complete the course. Courses also contain resume functionality so that users can view half a course, close the course, and then open it again later at the spot where they left off.

A curriculum is a group of courses and meetings that moves students along a particular learning path. A curriculum consists primarily of Connect Training courses, but may include other items such as live training sessions. With curriculums, you can assign prerequisites, test-outs, and completion requirements to enforce a specific learning path. As is the case with courses, you can generate reports to track the progress of the enrollees as they move through the curriculum to ensure that they meet the learning objectives.

Accessing the Training library
All Connect Training courses and curriculums are contained and organized in a directory of folders called the Training library. You access the Training library by clicking the Training tab at the top of the Adobe Connect Enterprise Manager window. As you navigate the library, the names of the folders appear as a navigation trail at the top of the browser window.

To create courses and curriculums, you must be a training manager. To manage a Training library folder, you need not be a training manager, but you must have Manage permissions for this folder in the Training library.

See also
"About libraries" on page 13
About Training library permissions

Consider the following aspects of permissions when you work with the Training library:

**Enrollee permissions** define the access that learners have for a given course or curriculum. The two enrollee permissions are Enrolled and Denied. Individuals with an Enrolled permission can view a course or curriculum; individuals with a Denied permission cannot access the course or curriculum.

Enrollee permissions are assigned when a course or curriculum is created. Permissions can also be changed after the course or curriculum is created. To change permissions, the training manager must open the course or curriculum and edit the participant list to add or remove enrollees. The training manager must also have Manage permissions for the folder where this course or curriculum is located.

**Training library management permissions** define who can perform the different tasks associated with the Training library files and folders, such as adding and deleting files, searching the library archives, and so on. The ability to create, delete, and edit courses and curriculums in various folders in the Training library is determined by the groups that a user belongs to and the individual permissions that are assigned to a user for specific files and folders. The Training library has only two permissions: Manage and Denied.

Members of the Administrator group can manage all files and folders in the Training library. By default, training managers have Manage permissions only for their individual folder in the User Training folder. This means that training managers can add, delete, change, or assign permissions only for their own folders. All other Manage permissions are assigned on an individual or group basis by the administrator.

**Training library permissions for Built-in groups**

Connect Enterprise Server recognizes six default permission groups called Built-in groups. You cannot change the permissions for these groups, but you can extend them by assigning individuals or groups to more than one Built-in group.

The Training module applies to the Training Managers group. This group is associated with the Training library. Each training manager has an individual folder in the User Training folder within the Training library, in which they can create and administer their courses and curriculums. Each training manager also has a content folder. The Connect Enterprise Server administrator can also assign Manage permissions for specific Training library folders to users who are not training managers. Only training managers can create new courses or curriculums, however.

See also

“Multiple permissions precedence” on page 230

Course and curriculum registration

Depending on the type and purpose of a given course or curriculum, the training manager might want to have the guests register. If so, the manager must have the Event Management tab as part of the Enterprise Manager application, since registration for any training can only be done through the Event Management tab. A training manager who has this tab must first use the Course or Curriculum wizard to create the course or curriculum from the Training tab, but skip the select participant and send invitations steps. Next, the training manager creates an event by using the Present an Adobe Connect Training Course or Curriculum option in the Event wizard, and selects the course or curriculum that was created as the event.

The Event wizard lets the training manager select and invite enrollees, select and customize registration questions, and send invitations, even to large e-mail lists.
If the training is presented as an event, all enrollees, regardless of whether they have a Connect Enterprise Server account or whether the URL is public, must provide registration information before the training. In this case, the training manager can review the registration applications before the training and approve or deny admittance to each registrant.

See also
“Events overview” on page 126

AICC content for courses
When you use Aviation Industry CBT Committee (AICC) content in courses, Connect Enterprise Server applies some specific rules. For more information, see “About AICC content” on page 22.

Viewing the Training Dashboard
The Training Dashboard contains two bar graphs, one for courses and one for curriculums:

Course Summary Over the Last 30 Days  Shows the courses over the last 30 days with the greatest number of enrollees who have passed this course; click any bar to see more detail.

Curriculum Summary Over the Last 30 Days  Shows the curriculums over the last 30 days with the greatest number of enrollees who have completed this curriculum; click any bar to see more detail.

The bar graphs appear within Connect Enterprise Manager. However, you can also export the Dashboard to a browser window that you can print. To do this, click Printable Version on the left, above the display.

Tips for creating training courses and curriculums
Following are some tips for creating training courses and curriculum in Connect Training:

• Use Adobe Presenter and Adobe Captivate to create content for courses. Presenter is suitable for the creation of linear, simple training materials and Adobe Captivate can be used for creating training materials that need to contain complex branching and simulations.

• At the course level, set client-side maximum retries to one and server-side maximum retries to any number. (Set server-side maximum retries to unlimited if you want learners to have as many attempts as they need to pass.)

• Add curriculum items directly into curriculums, not into folders.

• When adding content from the Content library directly into a curriculum, the content is automatically converted to a course and tracking is enabled. In addition, a curriculum resource folder is automatically created and any curriculum-specific courses (that is, content automatically converted to a course for this curriculum) are placed in the folder.

• Communicate with your learners about how to take courses and curriculums, especially any specific settings you have used. For example, tell them how many times they can attempt to pass a quiz. Also, if you do make any changes to a curriculum after making the curriculum available, such as adding or removing items, tell your learners.

• Ask learners to open an item or course in only one browser window and to close that browser window when they are done.

• When planning to make a large curriculum available, do a test first. For example, ensure that your Connect Enterprise Server system (network, servers, database, etc.) is set up properly and has sufficient resources to manage the volume of learners scheduled to enroll in the curriculum.
• Minimize changes to your courses and curriculums after you have made them available to learners.

**Working with Courses**

**About courses**

*Note: The material on courses applies only to accounts that include the Adobe Connect Training application.*

A course is content for a set of enrolled learners that also includes usage tracking for each learner. A course might consist of a stand-alone presentation and may be offered as part of a curriculum.

**See also**

“About curriculums” on page 99

**Creating a course**

In creating a course, your workflow involves the following tasks:

1. **Start the Course wizard**

   You can create or browse to a folder in the Training library that will contain the course (you must have permission to access the folder). When you determine a location, open the New Course wizard by clicking the New Course button.

2. **Course information**

   On the first page of the Course wizard you enter background details about the course, such as a name and summary. (Only the course name is required; all other fields are optional.) You can edit this information after the course is created.

   *Note: By default, the “Update information for any items linked to this item” option is selected. Since you are creating a new course, you probably do not have any items linked to the course yet, but keep this item selected if you think you will link any items later.*

3. **Select course content**

   In this part of the Course wizard, Connect Enterprise Server directs you to the Content library, where you navigate to the content file you want to use. You can select only one file from the library, and you must have either View or Manage permissions for this file. After adding content, you can continue in the wizard and enroll learners or save the curriculum and exit the wizard. (To enroll learners, set up course notifications, or enable e-mail reminders later, you can edit the course.)

4. **Enroll learners**

   In this part of the Course wizard, you can enroll users or groups of users. Only enrolled users can browse to the course URL and log in to view the course. To enroll large numbers of users, if you have the Event Management application, present the course as an event.

   You can add and delete learners, as required, after the course is created.
5. **Set up notifications**

In this part of the Course wizard, you set up course notifications. A course notification is an e-mail message telling enrollees how to access the course.

When you format your notification, you can use run time fields in the subject line and in the body of the message. These fields are course information variables that are automatically filled in for you when the e-mail notification is sent.

You can change the course notifications after the course is created.

6. **Set up reminders**

The final part of the Course wizard involves setting up course reminders. Reminders are optional. A course reminder is an e-mail message sent to either all or selected course enrollees after you set up the course. You can use reminders, for example, to remind enrollees that they are scheduled to take the course or to notify specific individuals that they are required to complete the course.

**See also**

“Edit courses” on page 95

“Creating a curriculum” on page 100

**View course information and the enrollee list**

After you create a course you can view information about the course and a course enrollee list.

**View course information**

You can view or change information about a course from the Course Information page of Connect Enterprise Manager, the page that appears when you click the course name in the Training folder list. From this page, you can view or edit the information for a specific course, including the course summary, content, enrollees, and settings for notifications and reminders. Each of these features is accessible as a navigation link.

Every course has a Course Information page, which is a summary that contains the information displayed in the following illustration.
The Course Information page shows key information about individual courses.

**Course Information**  The course name, ID, summary, open date, close date, course URL, number of slides, duration, maximum attempts (the maximum number of attempts the enrollee has to pass this course), and language.

**Reminder Policy**  A field that indicates whether a reminder policy is enabled, to whom reminders are being sent, the date that the next reminder will be sent, and how often reminders are sent. Click the Training tab at the top of the Connect Enterprise Manager window. Navigate to the folder that contains the course for which you want to get information. In the course list, click the name of the course to select it.

**View a course enrollee list**

1. Click the Training tab at the top of the Connect Enterprise Manager window.
2. Navigate to the folder that contains the course.
3. In the course list, click the name of the course.
4. Click the Manage Enrollees link in the navigation bar.

A list of enrolled users and groups are shown in the Current Enrollees window on the right.

**About notifications and reminders**

Notifications are placed in a queue and are sent as follows:

- Notifications set to Send now are sent when you click Send.
- Notifications set up for future dates are processed every night at midnight. On the set date, depending on the number of notifications in the queue, they are sent within a few minutes or a few hours after midnight PST.

Notifications appear to be sent from whoever creates the course, using the e-mail address specified in their Connect Enterprise Server account. Any e-mail delivery failure notifications are also sent to that address.

All e-mail notifications are sent individually. Recipients do not see the list of other recipients in the message header.

Reminders are placed in a queue and are sent as follows:

- Reminders to be sent starting on the current date are sent shortly after the course is created.
• Connect Enterprise Server sends reminders from the person who creates the course, using the e-mail address specified in the curriculum creator's Connect Enterprise Sever account. The e-mail reminders are sent individually; recipients do not see the list of other recipients in the message header. (Also, any e-mail delivery failure notifications are sent to course creator's e-mail address.)

• Reminders set up for future dates are processed every night at midnight. On the set date, depending on the number of e-mail reminders in the queue, they are sent within a few minutes or a few hours after midnight PST.

**About changes to course content**

There are some important points to remember when making changes to course content.

• When you create a course from content, a copy of the content is made into the course. If you make a change to course content, the change is not carried over to the course.

• When you add a course to a curriculum, it is a link to the course and not a copy. If you make a change to a course, the change is carried over to the course inside a curriculum.

• Try to minimize changes to course content if the current course content has a quiz that users have already taken. Minimizing changes helps lower the number of versions that exist. It also lowers the number of reports for users who took earlier versions.

**See also**

“Adding and deleting items from a curriculum” on page 103

**About review modes**

Connect Training contains two review modes: server-side and client-side. It's important to understand these review modes, especially if your courses contain quizzes.

**Server-side review mode** is used only with Connect Training courses. For Connect Training courses, a training manager can specify the maximum attempts a learner has to complete or pass the course successfully. A learner is locked into review mode in the following cases:

• The learner has passed or completed the course within the set number of maximum attempts.

• The learner has exceeded the maximum number of attempts allowed to pass or complete the course.

Learners can see whether they are locked into review mode two ways:

• The text “[Review Mode]” appears in the browser title bar when a course is opened.

• This message appears at the top of the screen: “You have exhausted all your attempts and are now in Review Mode. Any choices selected will not be tracked.”

If learners are in review mode and they take any quizzes included in the course, their scores and statuses are not posted to Connect Enterprise Server. This prevents learners from trying to improve their score after passing a course.

**Important:** Learners should always open a course or item in only one browser window at a time and close the window when they finish. Learners may be locked into review mode incorrectly if they open the same item or course in multiple windows simultaneously.

The server-side maximum retry setting for a course carries over to all Curriculum items that link to the course. Because the server-side retry setting for the course is the only one that is enforced, Adobe recommends disregarding curriculum-level maximum retry settings.
Client-side review mode is enforced through the maximum retry setting in presentations created with Adobe Presenter and Adobe Captivate. Client-side review mode applies only to retries attempted within a single browser session. However, client-side review mode can persist across multiple browser sessions if the user exits the presentation before finishing, causing resume data to be sent to the server.

In Adobe Presenter the retry setting is defined in the Quiz Manager pass or fail options. For example, if you set the “If failing grade allow x attempts” option to 1, users have only one chance to take the quiz. Suppose a user begins taking the quiz, then leaves it to view a slide that is not part of the quiz or begins a second quiz in the presentation. By exiting the first quiz while the presentation is still open (a single browser session), the user exhausts the single allowed attempt and can’t re-enter the quiz. Now suppose that a user enters a quiz, answers one or two questions (but not enough to pass the quiz), and closes the browser. In this second case, the user exited the presentation but not the quiz. When this happens, resume data is sent to Connect Enterprise Server and, if the user is permitted another server-side (course-defined) attempt, the user can open the presentation again and continue working on the first client-side attempt (although it will be the second server-side attempt).

To prevent possible status and score discrepancies, Adobe recommends setting the client-side maximum retry attempts to 1. (In both Presenter and Adobe Captivate, the default setting is 1.) A client-side setting of 1 does not mean that the user has only one chance to complete or pass the course; the course-level setting governs the maximum number of retries.

Edit courses
If you are an administrator or a user with permission to manage a specific Training library folder, you can manage courses.

See also
“About changes to course content” on page 94
“About notifications and reminders” on page 93

Edit course information
You can edit course information, which includes the course name, ID, summary, start date, and close date.

1 Click the Training tab at the top of the Connect Enterprise Manager window.
2 Navigate to the course.
3 In the course list, click the name of the course.
4 Click the Edit Information link in the navigation list.
5 Edit the course information. You can change the following information:

   - Course Name  (Required) The name of the course; it appears in the course list and in reports.
   - Course ID  The course number or ID: for example, 100, CS100, and so on.
   - Summary  A course description that appears on the Course Information page.
   - Course Starts On  (Required) The date before which users cannot access the course. If you change an existing course's start date to a later date, no users (not even those who already accessed the course) can access the course until the new start date. If some enrollees have already accessed the course, their tracking and quiz information is retained in reports.
   - Course Closes On  The date after which users cannot access the course.
Max Attempts  The maximum number of attempts the enrollee has to pass this course; if you leave this blank, you are allowing an unlimited number of retries.

6  Click Save.

Be aware that changing the course title or course summary does not change the information on a presentation summary slide. This slide uses the information specified at the time the presentation was originally published. To change this information, you must republish the content and then reselect the content that the course uses.

Change course content
When you create a new course, you select the content to be used in the course from the Content library.

1  Click the Training tab at the top of the Connect Enterprise Manager window.
2  Navigate to the course whose content you want to change. In the course list, click the name of the course to select it.
3  Click the Select Content link in the navigation bar.
4  Navigate to the folder that contains the content that you want to use for the course.
5  Select the button next to the content that you want to use for the course.
6  Click Save.
7  A warning message is displayed. To update the content, click Yes, Update My Content. To keep the existing content, click No, Cancel This Request.

Add course enrollees
If you add enrollees to a course, you must notify the new enrollees. You might also want to set up reminders for them.

1  Click the Training tab at the top of the Connect Enterprise Manager window.
2  Navigate to the course.
3  In the list, click the name of the course.
4  Click the Manage Enrollees link in the navigation bar.
5  Do one of the following to select enrollees in the Available Users and Groups list:
   •  Press Control-click or Shift-click to select multiple users or groups.
   •  To expand a group to select individual members, double-click the group name. Then select individual users.
   •  To search for a name in the list, click Search at the bottom of the window; enter the name to display it in the list, and then select it.
6  Click Add.

The users and groups you added appear in the Current Enrollees list; to remove a name from this list, select it and click Remove.

Remove course enrollees
If you remove enrollees, they do not receive notification and are no longer able to access the course.

1  Click the Training tab at the top of the Connect Enterprise Manager window.
2  Navigate to the course.
3  In the course list, click the name of the course.
4  Click the Manage Enrollees link in the navigation bar.
To select users or groups to be removed, do one of the following in the Current Enrollees list:

- Press Control-click or Shift-click to select multiple users or groups.
- To search for a name in the list, click Search at the bottom of the window; enter the name to display it in the list, and then select it.

Click Remove.

**Change settings for course notifications**

Notifications help you communicate with course enrollees. You can change notification settings at any time.

1. Click the Training tab at the top of the Connect Enterprise Manager window.
2. Navigate to the course.
3. In the course list, click the name of the course.
4. Click the Notifications link in the navigation bar.
5. On the Notifications page, select the notification timing you want and reset the Send On date, if necessary.
6. Select the group of recipients to which you want to send the notification. (If you enter e-mail addresses, use commas to separate the addresses.)
7. Edit the e-mail subject and message; to use a run time field, copy the field name from the Run Time Fields list and paste it into the message subject or body. Do not change the run time field text in braces.
8. Click Send to apply the notification changes.

**Change settings for course reminders**

You can change reminder settings at any time to, for example, change how frequently reminders are sent or edit reminder text.

1. Click the Training tab at the top of the Connect Enterprise Manager window.
2. Navigate to the course.
3. In the course list, click the name of the course.
4. Click the Reminders link in the navigation bar.
5. On the Reminders page, specify the reminder notification timing; change the starting date or recurrence frequency if necessary.
6. Specify which recipients should receive the reminder. (If you enter e-mail addresses, use commas to separate the addresses.)
7. (Optional) Edit the e-mail subject and message; to use a run time field, copy the field name from the Run Time Fields list and paste it into the message subject or body. Do not change the run time field text in braces.
8. Click Save.

**Delete a course**

Before you delete a course, be aware of the effect of this action:

- The course is removed from the Training library.
- Enrollees can no longer access the course.
- Reports for the course are no longer available. (To prevent access to the course while retaining reporting information, set the course close date and do not delete the course.)
• No more course reminders are sent, and delayed course notifications are not sent.

• The content used by the course remains in the Content library.

• The course will be removed from the item list of any curriculum in which it is included. This affects the
curriculum reports. Be careful when deleting courses that are included in curriculums.

1 Click the Training tab at the top of the Connect Enterprise Manager window.

2 Navigate to the course.

3 Select the check box to the left of the course that you want to delete.

4 Click the Delete button.

5 On the confirmation page, click Delete to remove the selected items.

**View course reports**

The Reports feature of Connect Enterprise Manager lets you create reports that show you a course from different
perspectives. Course reports also enable you to track the performance of specific learners. (When learners access a
course, either from a direct course URL or from the course URL within a curriculum, course reports are created.)

To use this feature, access the Course Information page, and then click the Reports link. This displays other links that
let you define the kinds of report information you can see for this course.

Content and course reports are distinct, because a course is associated with a specific version of content. (In contrast,
course and curriculum reports are shared, because a curriculum is only a link to a course.)

1 Click the Training tab at the top of the Connect Enterprise Manager window.

2 Navigate to the course.

3 In the course list, click the name of the course.

4 Click the Reports link.

5 To generate a report, click any of the following links:

• Summary shows you course information (name, ID, open date, close date, and URL) and course status (enrolled
users, total course completions, users passed, and users failed).

• By Slides shows a bar graph that lists each slide in the course and the number of times it has been viewed. A table
that shows the last time each slide was viewed.

• By Users shows the users who have accessed the course, their status (Passed, Failed, or Incomplete), score, date
taken (user’s most recent attempt), time taken (time of most recent attempt), how many times the user took the
course, the course version, and the certificate number, if applicable. Click the name of a user to view a bar graph
and a table that shows each question and whether the user answered it correctly or incorrectly, as well as the score
for the question. You can also click the View Answers link for each question, which displays the answer distri-
bution.

• By Questions shows a table that lists question numbers, questions, the number of times the question has been
answered correctly, the number of times the question has been answered incorrectly, the percentage of times the
question has been answered correctly, and the question score.
• By Answers shows a table that lists the maximum possible score, the average score, the high score, and the low score for the quiz. For each question, the table also shows the question number, the question itself, and the answer distribution; that is, how each question was answered, if at all. Click the View Answers link to view a pie chart with a table that provides the answer key and answer distribution. The answer key lists all of the possible answers for the question and their corresponding answer number or letter; the answer distribution lists all of the answers selected for this question, flags the correct answer, and shows the number of users who selected each answer, as well as what percent of the total each number of users represents. Finally, it totals the users by number of users and percent of users.

*Note:* The Hide Answer Distribution/Show Answer Distribution button is a toggle that lets you hide the distribution of answers for each questions, then show them again.

**See also**
“View and manage curriculum reports” on page 111

### Setting and removing report filters
Where appropriate, you can further define the information you see on a particular report by specifying report filters. For courses, these filters can operate on all five report types.

**See also**
“Set content report filters and generate reports” on page 27

### Downloading reports
With the exception of the Summary report, you can export all course reports to a comma separated values (CSV) file by clicking Download Report Data under the report types links.

You can also export the By Slides or By Questions report to a browser window by clicking Printable Version on the left, above the display.

## Working with Curriculums

### About curriculums
A curriculum can include courses, presentations, and meetings. You can define prerequisites for a curriculum, and you can design your program so that users can test out of certain curriculum items.

As users complete items in the curriculum, you can track their progress and generate reports to ensure that the curriculum meets the learning objectives.

The key features of Connect Training curriculums let you do the following:

• Organize items, such as courses and presentations, in logical groups that support a learning path.

• Define prerequisites and test-outs for items, allowing enrollees to bypass certain curriculum items if they pass the corresponding test-out item.

• Specify completion requirements - items required to successfully complete the curriculum.

• Send e-mail notifications and reminders to users regarding the curriculum.
• Generate reports that include curriculum statistics.
• View a visual representation of report data using the Training Dashboard.

See also

"About courses" on page 91

Creating a curriculum

A wizard guides you through the main steps of creating a curriculum, such as entering curriculum information and selecting courses for the curriculum. After you create a curriculum, you can complete additional tasks, such as adding enrollees and sending reminders.

In creating a curriculum, your workflow involves the following tasks:

1. Browse to a curriculum location

You can create or browse to a folder in the Training library that will contain the curriculum (you must have permission to access the folder). When you determine a location, you open the New Curriculum wizard to create your curriculum in the selected location.

Navigating the Training library

A. Determine a location  B. Create another folder or add a new curriculum

Note: If you want to save your curriculum in your User Training folder, you can bypass this procedure by simply clicking the New Curriculum link on the Connect Enterprise Manager Home page and following the steps to enter curriculum information.

2. Enter curriculum information

The first page of the New Curriculum wizard lets you enter details, such as descriptive summary information and start and end dates, about the curriculum. (You must enter the curriculum name, but all other fields are optional.) The information that you enter in the wizard appears later on the Curriculum Info page, as well as on the page that enrollees access from their My Training link.

The Custom URL text box displays the first part of the URL that users click to access the curriculum. You can leave the text box blank to have Connect Enterprise Server generate a system URL or enter a custom URL in the text box to specify how the remainder of the URL should read. For example, you can enter a word that describes the curriculum.

Note: The start and end dates that you select override the start and end dates for the individual items in your curriculum. For example, if you add a meeting with an end date that already passed, but your end date for the curriculum is in the future, the meeting assumes the end date of the curriculum.
Use the Curriculum Information page to add a name and details about a curriculum.

3. Add items to the curriculum

After you enter curriculum information in the New Curriculum wizard and click Next, a page appears that lets you add items to the curriculum. When you add an item to a curriculum, you are actually adding a link to the item, not copying the item in a new location within Connect Enterprise Server.

You can add content from the Content library, a meeting from the Meeting library, or any existing courses to a curriculum. Content added to a curriculum is now automatically converted to a course so it can be tracked accurately. The new course is added to the automatically created curriculum resource folder. (This folder is in the same location as the curriculum and has the same name as the curriculum with "Resources" appended to the end.)

After creating a new curriculum, add courses to build the curriculum.
Note: If you want to group items in folders, do not add the items using the New Curriculum wizard. Instead, exit from the wizard, open the curriculum information page for the curriculum, click Add Item, click New Folder, type in a folder name, click Save, select the new folder, click Add Item, and then add items to the folder.

4. Change the order or remove items, if necessary
After adding content and courses, you can change the order of items to alter the learning path. You also have the option to remove any items.

Note: Although you can move items within a folder, you cannot move items in or out of folders.

5. Select any additional options
The final step when creating a new curriculum is to select any options you require from the Additional Options page.

See also
“Creating a course” on page 91
“Edit prerequisites, test-outs, and completion requirements” on page 107

View curriculum information and status
After you create a new curriculum, you can view and modify curriculum details on the Curriculum Info page.

See also
“About notifications and reminders” on page 93

Display curriculum information
1 Click the Training tab at the top of the Connect Enterprise Manager window.
2 Navigate to the folder that contains the curriculum.
3 Select the name of the curriculum in the course list.

View curriculum status information
Viewing curriculum status offers another way to view a summary report.

1 If you’re not on the Curriculum Info page for the curriculum that you want to view, click the Training tab and browse to the curriculum. Select the curriculum name to open the Curriculum Info page.
2 In the Curriculum Status area, click the View button.

The Reports tab opens on a Summary page. In addition to the same information that appears in the curriculum information area of the Curriculum Info page, the Summary page includes the following information:

Enrolled Users  The number of users enrolled in the curriculum.

Users Completed  The number of users that have accessed the curriculum and have successfully completed all required items. This includes all users who have ever been enrolled in this curriculum, whether they are enrolled currently or not.

Users Incomplete  The number of users that have accessed the curriculum, but have not yet completed all required items. This includes all users who have ever been enrolled in this curriculum, whether they are enrolled currently or not.
Note: There are two types of users not included in the curriculum status numbers: first are users that are enrolled in the curriculum, but have not yet accessed the curriculum and, second, users who have been enrolled in this curriculum in the past, but have subsequently been deleted from Connect Enterprise Server.

Adding and deleting items from a curriculum
You can add and delete content and courses from a curriculum after a curriculum is created. For example, you can add any course in your Training library to a curriculum.

Here are a few tips:

• Try to minimize the addition and deletion of courses and content after a curriculum is made available to learners.
• Communicate with learners enrolled in the curriculum. Tell them when content and courses are added or deleted and ask them to log in to the curriculum so their status updates.
• There is a distinction between including an existing course in a curriculum and creating a new course for a curriculum. When you add a course to a curriculum and the course already exists, the course is not added to the individual curriculum's Resources folder. Only items that are automatically created for the first time as a course are automatically added to the curriculum Resources folder. You can, however, move or copy items into the Resources folder.
• When a course is added to a curriculum, what is actually added is a link to the course in the Content library. This allows learners to receive credit for a course even if the course is taken outside the curriculum. To receive credit for taking the course, the learner must have logged in to the curriculum at least once. (Adobe recommends that curriculum learners always launch items from within the curriculum.)
• If you delete a required item from a curriculum, the status of learners who have completed all other required items will change to Complete.
• After a curriculum has been modified (for example, required items have been added or deleted), ask learners to log back into the curriculum to have their status and scores updated.
• Sometimes, a learner can take a course and then the course is added to a curriculum in which the learner is enrolled. For the learner to receive credit for having already taken the course, ask the learner to log into the curriculum. Their status within the curriculum will be updated automatically.

See also
“About changes to course content” on page 94

Add folders and items to a curriculum
After creating a curriculum, you can add folders or items to the curriculum at any time.

Note: Adding or removing items from a curriculum may affect learner transcripts. As a best practice, do not make changes to curriculums once you have enrolled learners. If you do add or remove items, tell learners about the changes to the curriculum and ask them to log in to the curriculum to update their status.

Add a folder to a curriculum
After you create a curriculum, you can group items in folders to organize your items. For example, you can group a set of items in a Beginner Topics folder and another set in an Intermediate Topics folder.
**Note:** You add items to a curriculum folder rather than move items already in your curriculum into a folder.

1. If you're not on the Curriculum Info page for the curriculum that you want to modify, click the Training tab and browse to the curriculum. Select the curriculum name to open the Curriculum Info page.
2. Click Add Item.
3. Click New Folder.
4. On the New Folder page, enter a name for the folder in the Folder Name text box, and click Save.
5. In the curriculum list, you can select the folder that you just created and add items to it.

**Add content to a curriculum**
After you create a curriculum, you can add more content as necessary. Content added to a curriculum is now automatically converted to a course so it can be tracked accurately. The new course is added to the automatically created curriculum resource folder. Any further content you add to the curriculum is also automatically converted and placed into the resource folder. This folder is in the same location as the curriculum and has the same name as the curriculum with "Resources" appended to the end. (If you add courses that you have already created to a curriculum, those courses are not placed in the resources folder.)

1. If you're not on the Curriculum Info page for the curriculum that you want to modify, click the Training tab and browse to the curriculum. Select the curriculum name to open the Curriculum Information page.
2. Click Add Item.
3. Click Add Content.
4. If necessary, browse to the folder that contains the content.
5. Select the check box for the content that you want to add to the curriculum, and click Add.
6. Click Add again.

**Add a course to a curriculum**
Any courses available in your Training library are available for you to include in a curriculum.

1. If you're not on the Curriculum Info page for the curriculum you want to modify, click the Training tab and browse to the curriculum. Select the curriculum name to open the Curriculum Info page.
2. Click Add Item.
3. Click Add Course.
4. If necessary, browse to the folder that contains the course.
5. Select the check box for the course that you want to add to the curriculum, and click Save.

**Note:** Invitations, enrollments, and reminders that you created for a course are not carried over when you add a course to a curriculum. The notification options for a curriculum apply to all courses inside the curriculum; you cannot set individual notification settings for courses inside a curriculum. (If a course exists outside of a curriculum, however, the course invitation, enrollment, and reminder settings are all valid for the course.)

**Add a meeting to a curriculum**
You can add a meeting, available in your Meetings library, to an existing curriculum.

1. If you're not on the Curriculum Info page for the curriculum that you want to modify, click the Training tab and browse to the curriculum. Select the curriculum name to open the Curriculum Info page.
2. Click Add Item.
3 Click Add Meeting.
4 If necessary, browse to the folder that contains the meeting.
5 Select the check box for the meeting that you want to add to the curriculum, and click Save.

Note: To send an Outlook Calendar Event, which lets users add the meeting to their Outlook calendars, you select the iCal option when you send meeting reminders (not when you add the meeting to your curriculum).

Add external content to a curriculum
A curriculum is not limited to Connect Enterprise Server items. You can include external training. For example, you may want to add a classroom lecture that enrollees should attend. Since a lecture is a live event, you can create a Connect external event to represent the lecture. By using the status override feature, you can then mark the enrollees that attend as "Passed" and those that do not attend as "Failed."

Note: When the user status changes for external training, you should update the user's completion status manually.
1 If you're not on the Curriculum Info page for the curriculum that you want to modify, click the Training tab and browse to the curriculum. Select the curriculum name to open the Curriculum Info page.
2 Click Add Item.
3 Click New External Training.
4 In the Title text box, enter the name of the external training.
5 In the Max Possible Score text box, enter the maximum points to be awarded for completing the external training.
6 In the Summary text box, enter a description of the external training.
7 Click Save.
On the Curriculum Info page, the external training appears in your list of items.
8 To enter an ID for the external training, click the Edit button in the Curriculum Information area.
9 In the ID text box, enter identification text or numbers.
10 Click Save.

Edit curriculums
You can edit information in a curriculum, such as changing the order of items or removing items. You can also delete any entire curriculum

Note: Adding items to or removing them from a curriculum may affect learner transcripts. As a best practice, do not make changes to curriculums once you have enrolled learners. If you do add or remove items, tell learners about the changes to the curriculum and ask them to log in to the curriculum to update their status.

Edit curriculum information
1 If you're not on the Curriculum Info page for the curriculum that you want to modify, click the Training tab and browse to the curriculum. Select the curriculum name to open the Curriculum Info page.
2 In the Curriculum Information area, click Edit to modify the following information:

Curriculum Name  A title for the curriculum.
Curriculum ID  The identification number for the curriculum. (You can assign any code, such as a catalog number.)
Summary  The curriculum description.
Curriculum Starts On  The date on which the curriculum starts. Users cannot access the curriculum before this date.
Note: The start and end dates that you select override the start and end dates for the individual items in your curriculum. For example, if you add a meeting with an end date that already passed, but your end date for the curriculum is in the future, the meeting assumes the end date of the curriculum.

Curriculum Closes On  The date on which the curriculum ends; select from the pop-up menu or select No Close date.

3 When you finish editing the curriculum information, click Save.

Edit external content information
To edit external content information, you must have already added it to the curriculum.

1 If you're not on the Curriculum Info page for the curriculum that you want to modify, click the Training tab and browse to the curriculum. Select the curriculum name to open the Curriculum Info page.

2 In the list of items, select the name of the external training.

3 In the External Training Information area, click Edit.

4 In the Item Info area, edit the Name, ID, or Summary information, and click Save.

Change the order of items in a curriculum
1 If you're not on the Curriculum Info page for the curriculum that you want to modify, click the Training tab and browse to the curriculum. Select the curriculum name to open the Curriculum Info page.

2 Select the check box next to the item that you want to move, and then click either the up or down arrow to move the item in the list.

Remove items from a curriculum
If you no longer want to include an item in a curriculum, you can remove it without affecting the original item that exists in its respective library.

1 If you're not on the Curriculum Info page for the curriculum that you want to modify, click the Training tab and browse to the curriculum. Select the curriculum name to open the Curriculum Info page.

2 In the list of items, select the check box next to the items that you want to remove, and then click Remove Item.

3 Verify that you do want to remove the selected items, and click Delete.

Delete a curriculum
Before you delete a curriculum, be aware of the following effects of this action:

• The curriculum is removed from the Training library.

• Enrollees can no longer access the curriculum.

• Reports for the curriculum are no longer available. (To prevent access to the curriculum while retaining reporting information, set the curriculum close date and do not delete the curriculum.)

• Curriculum reminders are not sent, and delayed curriculum notifications are not sent.

• Deleting a curriculum is a permanent action. Once it is deleted, there is no way to recover a curriculum.

Deleting a curriculum from the Training library does not affect the library items that constitute the curriculum.

1 Click the Training tab in Connect Enterprise Manager and browse to the curriculum.

2 Select the check box next to the curriculum and then click Delete.

3 After verifying that you want to delete the selection, click Delete.
Edit prerequisites, test-outs, and completion requirements

After creating a curriculum, you can make many changes such as assigning prerequisites, assigning test-outs, and editing completion requirements. Adobe recommends using either test-outs or prerequisites, but not both, to create learning paths. Using both is possible, but it may be time-consuming and complicated to test all of the possible workflows learners may encounter.

Assign prerequisites to an item

Assigning prerequisites enforces learner access to items in a specific sequence. A folder cannot be set as a prerequisite.

**Note:** Avoid creating redundant prerequisites; they are confusing for learners and may cause performance issues on your Connect Enterprise Server.

**Note:** External training items should not be set as Required, because Connect Enterprise Server cannot automatically track external items.

1. If you’re not on the Curriculum Info page for the curriculum that you want to modify, click the Training tab and browse to the curriculum. Select the curriculum name to open the Curriculum Info page.

2. In the list of curriculum items, click the name of the item or folder that requires a prerequisite. This procedure refers to this item as the **selected item**.

3. In the Prerequisites area, click Edit.

4. The Select Prerequisite area lists the items in the curriculum. Use the Options pop-up menu to specify prerequisites, using the following criteria:

   **Required** Indicates that the prerequisite must be completed successfully, not just completed, before taking the selected item. Do not assign Required status to external content. Connect Enterprise Server cannot verify completion of external content, such as a website URL.

   **Optional** Indicates that the prerequisite is optional. Users receive a message requesting that they take the prerequisite before taking the selected item.
**Hidden** Indicates that the selected item appears on the enrollment page only after the user completes the prerequisite.

5 When you finish selecting prerequisites, click Save.

**Assign test-outs for an item**

You can design the curriculum so that enrollees are not required to take an item if they pass a related test-out item. Test-outs cannot be set for a folder; always use a specific course, not a folder, as a test-out for any other learning object.

Here are tips for creating test-outs:

• Carefully choose between the Optional, Blocked, and Hidden options. Your learners could have a very different path and learning experience depending on which option you select for a test-out.

• You cannot assign a test-out for the first item in a curriculum.

• Do not use chained test-outs. An example of a chained test-out is setting item 1 as a test-out for item 2 and then setting item 2 as a test-out for item 3.

1 If you’re not on the Curriculum Info page for the curriculum that you want to modify, click the Training tab and browse to the curriculum. Select the curriculum name to open the Curriculum Info page.

2 In the list of items, click the name of the item that requires a test-out item. This procedure refers to this item as the **selected item**.

3 In the Test-Outs area, click Edit.

4 The Select Test-Outs area lists items in the curriculum. Use the pop-up menu by an item to designate it as a test-out for the selected item, using the following criteria:

**Optional** Indicates that if the enrollee passes the test-out item, the selected item is no longer required to complete the curriculum.

**Blocked** Indicates that if the enrollee passes the test-out item, the selected item is unavailable to the enrollee. If the enrollee fails the test-out item, the selected item becomes available.

**Hidden** Indicates that if the enrollee passes the test-out item, the selected item is hidden from the enrollee. If the enrollee fails the test-out item, the test-out item is visible and available for the enrollee to take.

5 When you finish specifying test-out items, click Save.

**Edit completion requirements**

You can designate an item as **required**, which specifies that an enrollee must successfully complete the item to complete the curriculum. By default, all items are required, but you can set individual items as optional or required without impacting other items.

1 If you’re not on the Curriculum Info page for the curriculum that you want to modify, click the Training tab and browse to the curriculum. Select the curriculum name to open the Curriculum Info page.

2 In the Completion Requirements area, click Edit.

3 For each item that you want to specify as required, select Required from the pop-up menu.

4 When you finish specifying required items, click Save.
Manage enrollees

Connect Enterprise Manager allows you to view and add enrollees to a curriculum, as well as set access permissions for enrollees.

View and add enrollees to a curriculum

1. If you’re not already on the Curriculum Info page for the curriculum, go to the Training tab in Connect Enterprise Manager and browse to the curriculum. Click the curriculum name to open the Curriculum Info page.
2. Click Manage Enrollees.
3. To add enrollees, select the name or group in the Available Users and Groups list.
   - Press Control-click or Shift-click to select multiple users or groups.
   - To expand a group to select individual members, double-click the group name. Then select individual users.
   - To search for a name in the list, click the Search button at the bottom of the window; enter the name to display it in the list, and then select it. (Click Clear to return to the original list.)
4. After selecting the enrollees, click Add.

Note: After adding enrollees, you must send notification to the enrollees that the curriculum is available.

Set permissions for curriculum enrollees

After you’ve added enrollees to a curriculum, you can determine permissions for enrolled users and groups.

1. If you’re not already on the Curriculum Info page for the curriculum, go to the Training tab in Connect Enterprise Manager and browse to the curriculum. Click the curriculum name to open the Curriculum Info page.
2. Click Manage Enrollees.
3. Select the enrollee or enrolled group in the Current Enrollees column and click Permissions.
4. Select one of the following permissions:
   - Enrolled allows the enrollee to access the curriculum.
   - Denied bars the enrollee from accessing the curriculum.

Remove enrollees from a curriculum

You can remove an individual curriculum enrollee or a group of enrollees at any time.

1. If you’re not already on the Curriculum Info page for the curriculum, go to the Training tab in Connect Enterprise Manager and browse to the curriculum. Click the curriculum name to open the Curriculum Info page.
2. Click Manage Enrollees.
3. Select the enrollee or enrolled group in the Current Enrollees column and click Remove.

Communicate with curriculum enrollees

You can use Connect Enterprise Manager to send notifications and reminders to curriculum enrollees. Default message text is provided, but you can edit the text and customize the message to suit your needs.
Send notifications to curriculum enrollees

You can use the notifications feature in Connect Enterprise Manager to send an e-mail message to enrollees. A typical message tells enrollees that the curriculum is available, provides details about the curriculum, and includes a link to the curriculum. The message can go to all enrollees, or to a subset of enrollees, such as those who have not completed the curriculum.

1. If you’re not already on the Curriculum Info page for the curriculum, go to the Training tab in Connect Enterprise Manager and browse to the curriculum. Click the curriculum name to open the Curriculum Info page.

2. Click Notifications. On the Notifications page, select when recipients should receive the notification.

3. Specify which recipients should receive the notification.

4. If you selected Only to Specific E-mail Addresses in the previous step, enter the addresses, separated by commas, in the Specific E-mail Address text box.

5. In the Message area, modify the text, and then click Send.

Send reminders to curriculum enrollees

The reminders feature in Connect Enterprise Manager, similar to the notification feature, lets you send e-mail messages to enrollees. The primary difference between notifications and reminders, however, is that the Reminders page lets you send the messages at specified intervals. The message can go to all enrollees, or to a subset of enrollees.

1. If you’re not already on the Curriculum Info page for the curriculum, go to the Training tab in Connect Enterprise Manager and browse to the curriculum. Click the curriculum name to open the Curriculum Info page.

2. Do one of the following:
   
   • Click Reminders at the top of the Connect Enterprise Manager window.
   
   • Click Edit in the Reminders Policy area.

3. Select Send Curriculum Reminders.

4. In the Starting pop-up menus, select the date when Connect Enterprise Manager should send the first reminder.

5. In the Recurrence pop-up menus, specify the recurrence frequency.
Specify which recipients should receive the reminder. (If you enter e-mail addresses, use commas to separate the addresses.)

In the Message area, modify the text, and then click Save.

**Disable reminders**
1. If you’re not already on the Curriculum Info page for the curriculum, go to the Training tab in Connect Enterprise Manager and browse to the curriculum. Click the curriculum name to open the Curriculum Info page.
2. Click Reminders. On the Reminders page, select Disable Curriculum Reminders, and then click Save.

**View and manage curriculum reports**
You can view reports, which provide summaries, statistical information, and status information about a curriculum. You can view data for the overall curriculum, for individual users, and by item. Course and curriculum reports are shared, because a curriculum is only a link to a course. (In contrast, content and course reports are distinct, because a course is associated with a specific version of content.)

*Note:* Curriculum reports do not display the specific version of a curriculum a learner completed.

Curriculum reports show learner status in several ways:
- In a presentation with no quizzes, Complete is achieved when 100% of the slides in a presentation have been viewed.
- In a presentation with one or more quizzes, Incomplete status is listed if all quiz questions with a point value (non-zero weighted) in all quizzes have not been answered. If all questions with a point value have been answered, Connect Enterprise Server lists a Pass or Fail depending if the learner score equals/exceeds or is less than the passing score.

*Note:* If a course in the curriculum was made available to users before the course was added to the curriculum, any data that existed for that individual course appears in the curriculum report. If you do not want prior data to appear in the curriculum report, you can recreate any courses that existed before you created the curriculum.

**View a curriculum Summary report**
A Summary report offers general information about a curriculum, including the number of enrollees and the number of users who passed the curriculum.

You can filter the report on start or end dates, groups or users, and people managed directly or indirectly.

1. If you’re not already on the Curriculum Info page for the curriculum, go to the Training tab in Connect Enterprise Manager and browse to the curriculum. Click the curriculum name to open the Curriculum Info page.
2. Click the Reports link, toward the top of the Connect Enterprise Manager window.

Connect Enterprise Manager opens, by default, on the Summary report page. In addition to the information that appears in the Curriculum Information area of the Curriculum Info page (such as Curriculum Name, Curriculum ID, Summary information, and open and close dates), the report contains the following information:

**Enrolled Users** The number of users enrolled in the curriculum.

**Users Completed** The number of users that have accessed the curriculum and have successfully completed all required items. This includes all users who have ever been enrolled in this curriculum, whether they are enrolled currently or not.

**Users Incomplete** The number of users that have accessed the curriculum, but have not yet completed all required items. This includes all users who have ever been enrolled in this curriculum, whether they are enrolled currently or not.
**Note:** There are two types of users not included in the numbers represented by this report: first are users that are enrolled in the curriculum, but have not yet accessed the curriculum and, second, users who have been enrolled in this curriculum in the past, but have subsequently been deleted from Connect Enterprise Server.

**View a curriculum report by users**

You can view general report data about curriculum enrollees, such as the date on which the user completed the curriculum.

You can filter the report on start or end dates, groups or users, and people managed directly or indirectly.

When you view a curriculum report by user, the override option enables you to change the status of a user. For example, you could change the status of a user from "Failed" to "Passed." You can change the status for independent courses and for courses within curriculums. You cannot, however, override the status of a user for a curriculum as a whole. Overrides are, in general, designed to be used when a situation occurs that may have been out of the users control. For example, if there was an error in the training content and that caused a user to fail a course. Overrides are also useful when you want to manually set a status for external training sessions such as live workshops or attendance at a field trip.

1. If you're not already on the Curriculum Info page for the curriculum, go to the Training tab in Connect Enterprise Manager and browse to the curriculum. Click the curriculum name to open the Curriculum Info page.
2. Click the Reports link, toward the top of the Connect Enterprise Manager window.
3. Click By Users to view the following information for each enrollee:
   - **Name** The name of the enrollee. Click an individual name to obtain details about the enrollee such as status, cumulative score, and number of attempts made to complete curriculum items.
   - **Status** Where the user stands in terms of completing the item.
   - **Date Taken** The date on which the item was taken by the enrollee.
   - **Certificate #** A system-generated number that proves the user completed the curriculum and provides the user with a unique ID.

4. To change the number of users who appear in the list, select a different number in the Display pop-up menu.

**Change the user status field in a report**

The user Status field in a report contains one of the following values:

- **Not taken** The user did not access the item.
- **Passed** The user completed the item with a passing score.
- **Failed** The user completed the item, but did not achieve a passing score.
- **Complete** The user completed the item (for items that do not specify a passing score).
- **Incomplete** The user accessed the item but has not completed the item.

The Status field updates each time user status changes for items that Connect Enterprise Manager tracks. If the user status changes for an external training, you can manually change the status in Connect Enterprise Server.

You can filter the report on start or end dates, groups or users, and people managed directly or indirectly.

1. If you're not already on the Curriculum Info page for the curriculum, go to the Training tab in Connect Enterprise Manager and browse to the curriculum. Click the curriculum name to open the Curriculum Info page.
2. Click the Reports link, toward the top of the Connect Enterprise Manager window.
3 Click By Users.

4 In the Name column, click the name of the enrollee whose status you want to change. A list of items assigned to the enrollee appears. The status column indicates the status for each item.

5 To change the status of an item, click Override and select a different status in the Status pop-up menu.

6 Enter the user’s score in the Score text box. (For items without an associated pass or fail score, you can enter 0.)

7 Enter the highest possible score in the Max Possible Score text box.

8 Click Save.

The updated status appears on the Users report.

**View a curriculum report by item**

You can view a curriculum report by item, by selecting the item and selecting the type of report you want to view.

You can filter the report by summary, users, slides, questions, or answers.

1 If you're not already on the Curriculum Info page for the curriculum, go to the Training tab in Connect Enterprise Manager and browse to the curriculum. Click the curriculum name to open the Curriculum Info page.

2 Click the Reports link, toward the top of the Connect Enterprise Manager window.

3 Click By Item.

A list appears of all items in the curriculum. The Reports column indicates the type of report that you can generate for each item.

4 Click the link for the type of report that you want to view.

The steps for viewing, downloading, and setting report filters for each item are identical to the procedures for viewing reports in each library. External training, however, is an exception because it does not appear in a Connect Enterprise Server library.

<table>
<thead>
<tr>
<th>Item Type</th>
<th>Report Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Course</td>
<td>Summary</td>
</tr>
<tr>
<td></td>
<td>By Users</td>
</tr>
<tr>
<td></td>
<td>By Slides</td>
</tr>
<tr>
<td></td>
<td>By Questions</td>
</tr>
<tr>
<td></td>
<td>By Answers</td>
</tr>
<tr>
<td>Meeting</td>
<td>Summary</td>
</tr>
<tr>
<td></td>
<td>By Attendees</td>
</tr>
<tr>
<td></td>
<td>By Sessions</td>
</tr>
<tr>
<td></td>
<td>By Questions</td>
</tr>
<tr>
<td>External Training</td>
<td>Summary</td>
</tr>
<tr>
<td></td>
<td>By Users</td>
</tr>
</tbody>
</table>
View a summary report for external training

Before generating a summary report for external training, you must update the user status or score for users who have completed the training.

1. If you’re not already on the Curriculum Info page for the curriculum, go to the Training tab in Connect Enterprise Manager and browse to the curriculum. Click the curriculum name to open the Curriculum Info page.
2. Click the Reports link, toward the top of the Connect Enterprise Manager window.
3. Click By Item.

A list appears of all items in the curriculum. The Reports column indicates the type of report that you can generate for each item.

4. For external training in the Names column, click the Summary link to view information for each enrollee.

View an external training curriculum report by users

Before generating a report for external training by users, you must update the user status or score for users who have completed the training.

1. If you’re not already on the Curriculum Info page for the curriculum, go to the Training tab in Connect Enterprise Manager and browse to the curriculum. Click the curriculum name to open the Curriculum Info page.
2. Click the Reports link, toward the top of the Connect Enterprise Manager window.
3. Click By Item.

A list appears of all items in the curriculum. The Reports column indicates the type of report that you can generate for each item.

4. For an external training in the Names column, click the By Users link to view the following information for each enrollee:
   - **Name**: The name of the enrollee.
   - **Status**: The progress the user made toward completing the item.
   - **Score**: The total score.
   - **Date Completed**: The date on which the enrollee completed the item.
   - **Certificate #**: A system-generated number that proves the user completed the curriculum and provides the user with a unique ID.

Export reports

You can export curriculum By Item reports to an Excel file by clicking the Download Report Data button on the Reports page. You have the option of saving or opening the report.

1. Click the Training tab at the top of the Connect Enterprise Manager window.
2. Navigate to the folder that contains the curriculum.
3. Select the name of the curriculum in the course list.
4. Click Reports.
5. Click By Item.

In the list of report types for each item, you can download report data for all reports on the list except the Summary report.
6  Click the report type for which you’ll download data.

7  Complete one of the following steps:

• To download the report, click Download Report Data and either save or open the file.
• To view a report by slides or by questions in a browser window, click Printable Version.

**Using report filters**
As with other applications in Connect Enterprise Manager, you can further define the information you see on a particular report by setting report filters. Keep in mind that filters that you set apply to all reports that you create, both for curriculums and for any other Connect Enterprise Server applications. See “Set content report filters and generate reports” on page 27.
Chapter 5: Adobe Acrobat Connect Professional Seminars

About Adobe Acrobat Connect Professional Seminars

About seminars
You use Adobe Acrobat Connect Professional Seminars to create a special kind of meeting in Acrobat Connect Professional. Seminars are separate from meetings, but, like a meeting, a seminar is conducted online in real time and occurs in a virtual room in which a presenter can show slides or multimedia presentations, share screens, chat, and broadcast live audio and video.

Unlike a meeting, which normally has ten people or fewer and can recur, a seminar has a minimum of 50 participants, is often a one-time or infrequent event, and involves little audience participation. The default seminar room looks different from the default meeting room. Also, seminars can be created only in a shared seminars folder, whereas meetings can be created either in a shared folder or a user folder. In addition, there are differences in the library structure that reflect different pricing and licensing policies for these two.

You can use Adobe Connect Enterprise Manager for all activities relating to seminars, except conducting a live seminar. From Enterprise Manager, you can perform the following activities:

• Obtain information about a seminar.
• Join a seminar as a participant.
• Create a seminar, which involves setting up your seminar room and inviting guests.
• Create and review seminar reports.
• Manage the files in the Seminar library, if you have the proper permissions.

See also
"About Acrobat Connect Professional meetings" on page 29

About seminar terminology and attributes
A seminar is a gathering of people and resources in a particular place on a particular day between certain start and end times. The seminar itself exists only for that period of time.

By contrast, the meeting room in which the seminar occurs exists before, during, and after the seminar. The meeting room location is a URL, assigned by the system when the seminar is created. When you click the URL, you start the Adobe Flash application in your browser. Then you enter a virtual meeting room that Flash constructs for you; here, you can perform online all those activities that you would do in a physical meeting room. Depending on the permissions that the host has assigned to the seminar, attendees can visit the meeting room after the seminar ends to view content, follow up on action items, and so on.
When hosts create a seminar, they can add users of Connect Enterprise Server to its list of attendees and specify each attendee’s role for the seminar as one of the following:

**Host** A host sets up the meeting, invites the guests, chooses the content, and assigns both presenter and participant roles to the appropriate attendees. The host can also perform all the tasks that presenters can perform.

**Presenter** A presenter can share the screen, chat, broadcast live audio and video, customize the meeting room layout, and show content to the participants. The content can be presentations made in Adobe Presenter, PDF files, slides (PPT files), Flash files and Adobe Captivate simulations (SWF files), Flash Video files (FLV files), and images (JPEG files).

**Participant** A participant can view the content that the presenter is showing or sharing, and hear and see the presenter’s audio and video broadcast.

There are two types of access within the participant category for seminars:

**Registered users and accepted guests only** Accessible to users who share the same Acrobat Connect Enterprise account with the seminar host. Registered means having a valid Acrobat Connect Enterprise account; it does not refer to the registration process that applies to an event.

Invitees who share the same Acrobat Connect Enterprise account as the host see the seminar listed under My Scheduled Meetings on the Home tab after they log in to Connect Enterprise Manager. (If the seminar has been scheduled as an event, it is listed under My Scheduled Events.) In addition, invitees who used Microsoft Outlook to accept an invitation to this seminar see the seminar in their Outlook Calendar and can join from Outlook.

**See also**
“Connect Enterprise terms and concepts” on page 6

**Pre-seminar tasks**
Careful pre-seminar planning helps a seminar run smoothly and streamlines follow-up activities.

1. **Determine how many seminar licenses you have**
When your organization purchased Seminars, it contracted for a specific number of seminar licenses. The number of seminar attendees should never exceed the number of concurrent users allowed for your seminar license. Your Seminars administrator has information about how many licenses your organization purchased. If you think you may need more licenses, let the administrator know early.

*Note: The Seminar license also restricts the number of concurrent seminars you can conduct at a time.*

2. **Access the Seminar library**
Seminar files and folders are stored in the Seminar library. Users who have the correct permissions can manage and organize these files and folders. You reach the Seminar library through the Seminar Rooms tab. When you click the Seminar Rooms tab, the Seminar List page displays the contents of the Shared Seminars folder. Depending on your permissions, you can create these seminars or modify them.

*Note: The seminars you are scheduled to attend appear on the Home tab of your Enterprise Manager application under “My Scheduled Meetings,” not the Seminar Rooms tab.*
3. Establish permissions

Attendance permissions (sometimes called role permissions) define attendee roles in a seminar, such as participant, presenter, and host. You assign these permissions when you create a seminar. However, the seminar host can also modify them during the seminar and after the seminar is over by editing the participant list.

Seminar library permissions determine who can manage the library folders. Of the six built-in groups, only administrators have Manage permissions for the Shared Seminar folder. Authors, training managers, meeting hosts, seminar hosts, and event managers are assigned Denied permissions by default. The administrator can override those default permissions and allow others fuller access to the Shared Seminar folder. (There are no Publish or View permission types as there are for the Content library.) To manage folders other than the Shared Seminar folder, you must have Manage permissions for that folder in the Seminar library.

4. Register and approve attendees

Depending on the type and purpose of a given seminar, the seminar host may want to have the guests register. If so, the host must have Adobe Connect Events as part of the Enterprise Manager application, because registration for any meeting, training, presentation, or seminar can only be done through the Event Management tab. If the host has this tab, they must first create the seminar from the Seminar Rooms tab using the Seminar wizard. Then, they create an event and select the seminar they have created as the event. If the seminar is presented as an event, all guests, regardless of whether they have an Acrobat Connect Enterprise account or whether the URL is public, must provide registration information prior to the seminar.

Creating a seminar

You create seminars using the Seminar wizard. Use this wizard following the procedure below to create a seminar that does not require registration. (To create a seminar that requires participant registration, you must have purchased the Events application.)

Also, when you create a seminar, you select an existing meeting room template that provides you with a design layout you can use or customize. (You customize the seminar meeting room from within the room itself.)

Note: Before creating a seminar, check with your system administrator to ensure that you have the correct permissions to create a seminar.

1. Start the Seminar wizard

You can create or browse to a folder in the Seminar library that will contain the seminar (you must have permission to access the folder). When you determine a location, you click the New Seminar button to open the New Seminar wizard and create your seminar in the selected location.

2. Enter seminar information

On the first page of the Seminar wizard you enter background details about the seminar, such as a name and summary, and select a template to use. (Only the seminar name is required; all other fields are optional.) You can edit this information after the seminar is created.

3. Select seminar participants

If you limited your seminar to invited guests only, the next step is to select the seminar participants.

For a seminar limited to registered guests and accepted users, you can select users and groups to be participants or presenters in your seminar. These users will be able to log in to the seminar directly. Uninvited users who have the URL to the seminar meeting room can attempt to log in as guests. In this case, as a host, you can grant admission to guests on an individual basis.
4. Send invitations

The final step in the Seminar wizard is to send participants e-mail invitations containing the date, time, duration, and location of the seminar. You can send invitations as you create the seminar, or you can create and send the invitations at a later time.

See also

“About events” on page 126

Send invitations

You can send invitations as you create the seminar, or you can create and send the invitations at a later time.

Invite registered users and accepted guests to a new seminar

1. On the Seminar Information page, select Invitations.
2. Select an invitee category from the To pop-up menu: all hosts, presenters and participants, hosts only, presenters only, or participants only.
   
   Note: The system can generate an individual attendance report for registered users. Accepted guests are represented in the total number of attendees, but no individual attendance report is available for accepted guests.
3. Edit the subject and the message body as appropriate.
4. To attach an Outlook calendar event to the e-mail, select the check box next to Attach Microsoft Outlook Calendar Event (vCal) To E-mail Message; otherwise, clear the box.
5. Click Finish.

Send an open invitation to a new seminar

1. On the Seminar Information page, click Send Email Invitations.
2. Select invitees from your address book or enter their e-mail addresses manually in the To text box.
3. Edit the e-mail subject and message, if necessary.
4. Click Send.
5. Return to Enterprise Manager, and click Finish.

Invite registered guests to an existing seminar

1. Click the Seminar Room tab at the top of the Enterprise Manager window.
2. Navigate to the folder that contains the seminar and select the seminar name.
3. Click the Invitations link.
4. Select an invitee category from the To pop-up menu: hosts, participants and presenters, presenters only, or participants only.
5. Edit the subject and the message body if appropriate.
6. To attach an Outlook calendar event to the e-mail, select the check box next to Attach Microsoft Outlook Calendar Event (vCal) To E-mail Message; otherwise, clear the box.
7. Click Send.
Send invitations to an existing, open seminar

1. Click the Seminar Room tab at the top of the Enterprise Manager window.
2. Navigate to the folder that contains the seminar and select the seminar name.
3. Click the Invitations link.
4. In the To line, use the pop-up menu to select who you want to receive the invitation.
5. Edit the e-mail subject and message, if necessary.
6. Click Send to send the e-mail invitation.

View seminar information

To view or modify an existing seminar, you must have both of the following permission types:

File management permissions  You must have Manage permissions for the seminar folder or file, because when you make any change to a seminar that you created, you are effectively changing the file or folder in the Seminar library.

Attendance permissions  You must be the host for the seminar, because you are also changing the parameters of the seminar itself.

View a seminar profile

To view a seminar profile from the Seminar Rooms tab, use this procedure:

Note: You can also get to a seminar profile from the Home tab.

1. Click the Seminar Rooms tab at the top of the Enterprise Manager window.
2. Navigate to the folder that contains the seminar and select the seminar name.

The Seminar Information page appears, listing time, summary, access, and other seminar details.
You can view all the details about a seminar on the Seminar Information page.

View a seminar participants list
If you have Manage permissions for a seminar, you can view a list of all invited participants for each seminar room.

Note: If this seminar is presented as an event, you must view the information in the Event Management tab. For information, see “Adobe Connect Events” on page 126.

1. Click the Seminar Rooms tab at the top of the Enterprise Manager window.
2. Navigate to the folder that contains the seminar and select the seminar name.
3. Click the Edit Participants link.

View a list of content uploaded from a seminar
If you have Manage permissions for a seminar folder, you can view a list of all content that has been uploaded to the Adobe Connect Enterprise Server from a seminar room within that folder.

1. Click the Seminar Rooms tab at the top of the Enterprise Manager window.
2. Navigate to the folder that contains the seminar and select the seminar name.
3. Click the Uploaded Content link. A list of uploaded content appears.
4. To view information about an item, click its name.
5. To change the title or summary of the piece of uploaded content, click Edit, make your changes on the Edit page, and click Save.
6. To return to the uploaded content list, click Return To Uploaded Content.

View a seminar recordings list
You can view a list of any seminars that have been recorded.

1. Click the Seminar Rooms tab at the top of the Enterprise Manager window.
2. Navigate to the folder that contains the seminar and select the seminar name.
3 Click the Recordings link. A list of recordings appears.
4 To view information about an item, click its name.
5 To change the title or summary of a specific recording, click Edit, make your changes on the Edit page, and click save.

View seminar folder license information
You can view information about how many seminar licenses your organization purchased. This can be helpful when planning the number of people to invite to a seminar.
1 Click the Seminar Rooms tab at the top of the Enterprise Manager window.
2 Navigate to the folder.
3 Click License Info.

Note: If you create a seminar under a seminar license folder that has a start date in the future, no one will be able to enter the Seminar room.

Edit seminars
If you are an administrator or have Manage permissions for a seminar folder, you can add participants, remove them, and change participant permission roles (host, presenter or participant).

See also
“About audio in meetings” on page 31

Edit seminar information
If you are an administrator or a host, you can modify seminar properties at any time after you create a seminar.
1 Click the Seminar Rooms tab at the top of the Enterprise Manager window.
2 Navigate to the folder that contains the seminar and select the seminar name.
3 Click the Edit Information link.
4 Edit the fields and options.

Name A required field that appears in the seminar list and reports.
Summary A description that appears on the Information page. A seminar summary can have a maximum of 750 characters.
Start Time The month, day, year, and time that the seminar starts
Duration The approximate time (in hours and minutes) that the seminar will last.
Language The language for the seminar. Customarily you select the language used by the presenter or the language used by the majority of seminar attendees.
Access There are two options:
• Only Registered Users And Accepted Guests May Enter the Room Individuals who share the same Connect Enterprise Server account with the seminar host. In this case, registered means having a valid Connect Enterprise Server account; it does not refer to the registration process that applies to an event. Registered users must enter their user name and password to enter the seminar room, and the system can generate an individual attendance report for the seminar.
An accepted guest has been accepted into the room by the host. In reports, the total number of attendees includes those who attend as accepted guests. However, individual attendance reports are not available for them.

- Anyone Who Has The URL For The Meeting Can Enter The Room In this case, no attendance report is available.

Do Not Include Any Audio Conference With This Meeting Select this option if no one will call in to the seminar.

Include Audio Conference Details with This Meeting Audio conference users can select this option to include the following telephony information:

- Conference Number The telephone number dialed by attendees who call in to the seminar. This information is included in the e-mail seminar invitation.

- Moderator Code The code that identifies the seminar host to the telephone-conferencing system. This code does not appear on the e-mail invitations, but the seminar host sees it when logging in to the web application.

- Participant Code The code that identifies participants to the telephone-conferencing system.

5 Click Save.

Add seminar participants
You can add seminar participants at any time. When adding participants you can also set permissions.

1 Click the Seminar Rooms tab at the top of the Enterprise Manager window.

2 Navigate to the folder that contains the seminar and select the seminar name.

3 Click the Edit Participants link.

4 In the Available Users And Groups list, do one of the following to select users or groups:

- To select multiple users or groups, Control-click or Shift-click.

- To expand a group to select individual members, double-click the group name.

- To search for a name in the list, click Search at the bottom of the window, enter the name to display it in the list, and then select it.

5 Click Add. (If you expanded a group to select individual members, you can double-click Up One Level in the list to restore the original list.)

6 From the Set User Role menu at the bottom of the Current Participants list, assign a permission type (participant, host, or presenter) for each user or group you added.

7 Click a link in the navigation bar to perform another task or click Seminar Information to view details about the seminar.

Remove seminar participants
You can remove seminar participants at any time.

1 Click the Seminar Rooms tab at the top of the Enterprise Manager window.

2 Navigate to the folder that contains the seminar and select the seminar name.

3 Click the Edit Participants link.

4 In the Current Participants list, do one of the following to select users or groups:

- To select multiple users or groups, Control-click or Shift-click.

- To expand a group to select individual members, double-click the group name.
• To search for a name in the list, click Search at the bottom of the window, enter the name to display it in the list, and then select it.

5 Click Remove. (If you expanded a group to select individual members, you can double-click Up One Level in the list to restore the original list.)

6 Click a link in the navigation bar to perform another task or click Seminar Information to view details about the seminar.

**Change a participant’s role**
Seminar participants can be assigned the following roles: presenter, participant, or host.

1 Click the Seminar Rooms tab at the top of the Enterprise Manager window.

2 Navigate to the folder that contains the seminar and select the seminar name.

3 Click Edit Participants.

4 In the Current Participants list, do one of the following to select the users or groups whose seminar permissions you want to change:
   • To select multiple users or groups, Control-click or Shift-click.
   • To search for a name in the list, click the Search button at the bottom of the window, enter the name to display it in the list, and then select it.

5 For each name, select the new user role (presenter, participant, or host) from the pop-up Set User Role menu at the bottom of the Current Participants list.

6 Click a link in the navigation bar to perform another task or click Seminar Information to view details about the seminar.

**Viewing the Seminar Dashboard**
The Seminar Dashboard provides a graphical representation of statistical data about your seminars.

Click the Seminar Dashboard link under the tab bar, at the top of the Seminar’s window.

The data, which reflects all the seminars you have created, appears in three bar graphs; click any of these to view the Summary Report for this seminar.

**Most Active Seminars Over Last 30 Days** Determined by the number of sessions.

**Most Participants Seminars Over Last 30 Days** Determined by the number of participants.

**Most Viewed Seminars Over Last 30 Days** Determined by the number of viewings (that is, the number of times each archived seminar has been viewed).

You can click any individual seminar in any of the three bar graphs to view more detailed information about the seminar.
The Seminar Dashboard provides useful statistical information about your seminars.

**Seminar reports**
Use the Reports feature of Enterprise Manager to create reports that summarize seminar information from different perspectives. Reports are created from the Reports link on the Seminar Information page.

**See also**
“View seminar information” on page 120
“Account reports” on page 225

**Join a seminar from Enterprise Manager**
If you are scheduled to attend a seminar, the seminar name appears in the My Scheduled Meetings list on the Home tab in the Enterprise Manager window. In addition, if you have Outlook and have accepted the invitation to the seminar, the seminar appears on your Outlook Calendar.

The seminar may be in progress when you join; you can determine this from the date and time shown for the seminar. If the date is in the past, the seminar appears on your meeting list under expired meetings, but you can still enter the room to view content.

Participants in a seminar may or may not have Acrobat Connect Enterprise accounts. Participant status depends on parameters set by the seminar host when the seminar is created.

**Note**: The seminars you are scheduled to attend appear on the Home tab of your Enterprise Manager application under “My Scheduled Meetings,” not under the Seminar Rooms tab.

1. Click My Scheduled Meetings.
2. Next to the seminar you want to attend, click Enter.

A browser window displays the meeting room for this seminar.

**See also**
“Join a meeting” on page 45
“Join a conference call or mute your phone” on page 69
Chapter 6: Adobe Connect Events

Adobe Connect Events 6 lets users manage the full life cycle of large or small events, including registration, invitations, reminders, and reports. Connect Events can be used with meetings, seminars, presentations, or training. An event generally involves many participants, so it requires careful pre-event planning and post-event management.

About events

Events overview
Any of the following can be an event: a meeting, seminar, presentation, course, or curriculum. An important distinction is that Connect Events supports pre-event and post-event management, while meetings, seminars, presentations, courses, and curriculums are the events.

Consider creating an event in the following situations:

• You want participants to register. You also want the option to screen participants for the event based on their registration information.
• You want to create branded event pages, such as listing and description pages that publicize the event as well as branded registration and login pages.
• You want to customize the collected participant data for your reports. Because this data is based on registration information, it supplements the reports that relate to event content, such as the responses to quiz questions given in a course or polling questions for a meeting.
• You want people outside your organization to participate. Events are often listed on your organization’s public website, so many participants will find your event there and register at the site.
• You want to send automatically generated e-mail messages, such as invitations, reminders, registration confirmations, and thank you notes.
• You want to track individual campaigns, such as e-mail offers, search engine campaigns, or banner ad campaigns.

An event has three phases:

• Pre-event tasks include determining the number of licenses available, creating content, establishing permissions, and inviting, registering, and reminding event participants.
• In-event activity requires the attendance of participants and sometimes presenters (if the event includes a meeting or seminar).
• Post-event tasks include redirecting the participant’s browser to a specific URL, answering outstanding questions from participants, and monitoring various event-tracking activities through surveys and reports.

See also
“Best practices for events” on page 128
“Creating an event” on page 129
Pre-event tasks
Careful pre-event planning and task maintenance can ensure that events run smoothly and that post-event activities can be completed quickly.

1. Determine how many licenses you have
Before you set up an event, you should know how many licenses you have. If more people register for the event than you have licenses for, potential participants cannot join the event when they try to log in. Check with your Connect Enterprise administrator for licensing issues.

2. Specify content for the event
Before you create an event, the content for the event must already exist in Connect Enterprise. (When you are setting up the event with the Event wizard, you must specify the content, meeting, course, curriculum, or seminar on which to base your event.) The following list shows several examples:

- To create a training event using a course or curriculum, the course or curriculum must already exist in the Training library.
- To present content as an event, the content should be stored in the Content library.
- To use a meeting or a seminar as an event, the meeting or seminar must already exist in the Meetings or Seminar library.

3. Establish event permissions
Permissions are important because they determine who can participate in, view, and manage events. Attendance permissions determine the roles and functions of attendees. The event manager assigns the attendees’ roles when setting up the event.

*Note: Attendees’ roles appear in the Role column of the My Scheduled Events list in Manager.*

Attendees can have the following roles and permissions:

- **Invited** People who are sent an invitation to the event and are invited to register for the event.
- **Denied** A person who has registered, but is not given access to the event by the host.
- **Participant** People who attend the event as guests or as registered users from your organization. They have limited permissions.
- **Presenter** A person who shows content to attendees. Presenters are assigned Presenter permissions.
- **Host** The person who has full control of a meeting or seminar room used for an event. The host has full Presenter and Manage permissions and can assign permissions to others.

*Note: The Presenter and Host roles are used for live events (meetings and seminars) only. For all nonlive events, only the Participant, Invited, and Denied roles are used.*

Event library permissions define who can create events, modify events, and perform the tasks associated with the Event library files and folders, such as adding and deleting files. The file management permissions are Manage and Denied.
4. Register and approve attendees
Events require registration but don’t always require approval. By default, an event does not require approval, but you can change this when you create the event. If you do not require approval, anyone who registers is approved automatically and can attend the event, providing you have a sufficient number of licenses. (As the event host, you can always deny approval to anyone before the event occurs.) Requiring approval lets you control who attends the event.

In-event tasks
Much of the work involved in creating an event occurs during the content creation and pre-event stages. If the correct content exists and you have completed the pre-event tasks, the actual event should go smoothly. But you may need to complete a few tasks during an event, especially if it is live.

Nonlive on-demand events Events that do not happen in real time. Participants click a link to view a presentation or take self-paced course or curriculum. You can notify potential participants of the event through an e-mail invitation or by publishing the event on the public events listing page of the organization website. Both the e-mail invitation and the website listing contain a link that opens a registration form for the event. In many cases, no in-event tasks take place during nonlive events.

Live events Scheduled, real-time events. During the event, it may be necessary to coordinate multiple presenters or approve attendees.

Post-event tasks
After an event, there are several tasks and administrative activities to perform.

Thank attendees Send a thank you e-mail message to attendees. Also, consider sending an e-mail message to those who were not able to attend.

Create a post-event URL Direct attendees’ browsers to a post-event URL where they can view product information and complete surveys. You can customize both the absentee and thank you follow-up e-mail messages so that they include the post-event URL.

Read reports View event reports to obtain statistical data and participant information. Reports enable you to assess the success of the event and make needed adjustments to future events.

View the Event dashboard Look at the Event dashboard to see a graphical representation of statistical data about all of your events. The dashboard data reflects all of the events in your My Events folder.

Check the library Organize the event files in your library.

Best practices for events
Here are some tips and tricks that you can use for your own events:

- Create a lobby. The lobby can be a chat pod where participants meet and greet each other before the event begins.
- Use PowerPoint animations. Appropriate use of PowerPoint animations can bring an event to life with motion and sound. Don’t add so many, however, that the animations become distracting.
- Incorporate polls into your event. Polls give you instant feedback so you know if your message is getting through and provide an easy way for your audience to actively participate in the event.
- Leverage video assets. If you have appropriate video files, add them to your events. You can publish the video file as FLV from Adobe Premiere or After Effects, open the video in Flash authoring, Sorenson Squeeze, or Flix Pro, and convert to Flash 6 or 7 (Flash 8 cannot be used yet).
Coordinate carefully between co-presenters. You can create a presenter-only area, including such items as an agenda with notes and moderated Q & A with no chat among attendees. Consider giving presenters “enhanced participants rights” versus “presenter rights.”

With all content preloaded, do a dry run before the event, at the same time of day you intend to give the event (network traffic differs by time of day). Use the exact hardware and network connections you plan to use for the real event.

Creating and editing events

Creating an event

You create an event using the Event wizard, which guides you through the tasks of creating a name and summary, selecting an image to associate with the event, selecting the content, determining participants, and defining the different phases in your event in which e-mails are sent to participants.

Events are built around content, such as a course or curriculum, a meeting, or a seminar. This means that the content must already exist in the appropriate library before you create the event; you cannot create the content when you create the event. You can use any single file stored in your Content, Meetings, Training, or Seminar library.

1. Start the Event wizard

You start the Event wizard by Clicking the Event Management tab in Enterprise Manager, navigating to the folder that will contain the event, and clicking New Event.

2. Enter event information

On the first page of the Event wizard you enter background details about the event, such as a name and summary. (The event name, a time zone, and language are required; all other fields are optional.) You can edit this information after the event is created.

Note: If you change the event start date to a date in the future, participants and presenters can still enter the meeting room at any time.

3. Select content

Content for an event must exist before you create an event. After you select a type of content, you cannot change the content type. You can, however, substitute different content of the same type. For example, if you create an event based on a seminar, you can later substitute a different seminar for the one you originally used when creating the event.

4. Create registration

You determine the questions that participants must answer on the registration form. The information creates a guest profile for tracking the participant. There are four required questions, which are preselected on the Create Registration form: E-mail address, Password, Retype password, and Name. You can select any of the other questions. For events that include guests outside your organization (those who find your event listing on your organization’s public website), it’s a good idea to get the company name and URL for screening purposes. For example, if the applicant works for a competitor, you might want to deny access.
5. Customize registration
You have a great deal of flexibility in designing a registration page for an event, including custom multiple-choice, short-answer, and yes/no questions. You can also change the order of questions and delete questions at any time.

6. Select event participants
For an event limited to registered guests and accepted users, you can select users and groups to be participants or presenters in your event. These users will be able to log in to the event directly. Uninvited users who have the URL to the event meeting room can attempt to log in as guests. In this case, as a host, you can grant admission to guests on an individual basis.

7. E-mail options
The final step in the Event wizard is to send participants e-mail invitations containing the date, time, duration, and URL of the event. You can send invitations as you create the event, or you can create and send the invitations at a later time.

See also
“Change an existing event” on page 133

Preview and modify registration and event pages
You can preview registration and event pages, modify them (for instance, by changing their logos), make them public, and edit them in Adobe Contribute®.

Preview a registration or event page
1 Click the Events Management tab in Enterprise Manager.
2 Navigate to the event and click its name in the list.
3 Next to Participant View, select which page to preview:
   • Click Preview event information, login, and registration pages.
   • Click Preview event listing page.
4 Click the desired item to preview it.

Event 1
Welcome, please enter the following to continue.
If you have previously registered with us, click here.

Email Address: *
Password: *
Retype Password: *
First Name: *
Last Name: *
Company Name:
Have you participated in this type of Event before?: *
  [ ] Yes
  [ ] No

* indicates required question

Preview a registration page before making it visible to event attendees.
Make a folder and event listing page public

The event listing page, which can be branded for your organization, displays a list of all upcoming events and displays the following for each one:

- Event logo
- Event name
- Description (the Event Information text)
- A Register Now button, which takes the user to a registration form
- A More Information button, which takes the user to the event information page; it includes the Detailed Information text

All events in a single folder appear on one listing page. For example, you can create a folder that contains events your organization is hosting and then make that folder public so that users can browse the event listings to learn about upcoming seminars. To create multiple event listing pages, simply create multiple folders.

You can create public or private folders containing events. A public event listing page is one that anyone can view from the hosted public pages. A private event listing page cannot be viewed publicly; a user must have login rights to view it. By default, event listing pages are private, but you can make them public.

1. Click the Event Management tab in Enterprise Manager.
2. Navigate to the desired folder.
3. Click Make This Folder Public.

The folder is now public and a URL is listed. The URL can be made available and the event listing page can be viewed by anyone from the hosted public pages.

Preview an event listing page for a specific folder

1. Click the Event Management tab in Enterprise Manager.
2. Navigate to the folder containing the events whose listing page you want to view.
3. Make the folder public, if necessary. The button above the list of folders and events is a toggle between private and public. If the button says Make This Folder Public, click the button.
4. Click the URL below Public Event Listing URL For This Folder.

The event information appears exactly as it will appear on the event listing page.

5. To close the preview window, click the Close button in the upper-right corner.

Note: Remember to make this folder private again after you preview the page if you do not want the folder to be publicly available yet.
Preview the event listing for a single event
1 Click the Event Management tab in Enterprise Manager.
2 Navigate to the event and click on its name.
3 Next to Participant View, click Preview event listing page.

The event information appears exactly as it will appear on the event listing page.
4 To close the preview window, click the Close button in the upper-right corner.

Change the logo associated with the event
1 Click the Event Management tab in Enterprise Manager.
2 Navigate to the event and click its name.
3 Go to the Edit Event Information page by doing either of these:
   • Click the Edit Information link above the title bar
   • Click the Edit link inside the title bar.
4 Click Browse to find a new image file for the event.
5 Select the image file, and click Open.

The Event Information page appears, showing the name of the image file in the text field next to Event Logo.
6 Click Save.

Edit event pages using Adobe Contribute 3
If you are an Adobe Contribute 3 user, you can use Contribute to change the text and other components of Event pages.

You can use Contribute to modify the following items:
• Registration login (banner logo, banner background color, event logo, text below event logo, and footer)
• Registration form (banner logo, banner background color, event logo, text below event logo, and footer)
• Registration confirmation (banner logo, banner background color, event logo, text below event logo, footer, and Thank You text)
• Event login (banner logo, banner background color, event logo, text below event logo, and footer)
• Event information (banner logo, banner background color, event logo, text below event logo, and footer)

Note: To edit the Registration login page, go to the Registration form page (you can make changes on this page), and click the Login link.
1 Click the Event Management tab in Enterprise Manager.
2 Navigate to the event and click its name in the list.

Note: The URL link is listed as Edit URL.
3 Start Contribute 3.
4 In the Contribute address bar, enter the address for your Connect Enterprise Manager and click Go.
5 Enter your login and password. Click Login.
6 Paste the Edit URL for the event into the Contribute address bar, and go to that URL.
7 Click the Create Connection button, and enter your settings (**Webdav / username = webapp login / password = webapp password**). Set up your WebDAV connection to the Edit URL link in step 2, which will let you easily browse to the other event and registration pages.

8 Click Next.

9 Follow the on-screen instructions to complete the Connection wizard.

10 Edit and publish the pages, as desired.

**Publish events**
When you publish an event, the following events occur:

- All selected e-mail message options become active. For example, if you selected the first option, send e-mail invitations, the invitations are automatically sent and you can no longer customize them. You can, however, still customize any other selected e-mail messages. You can also edit the invitation text and then invite more people—the new text is used.

- The registration form with its associated URL becomes available, and prospective attendees can begin registering for your event.

1 Click the Events Management tab in Enterprise Manager.

2 Navigate to the event and click its name in the list.

The Event Information page appears. Next to Status the following message appears: “This event has not been published and listed on your site. E-mails have not been sent.”

3 Click Publish.

A confirmation message appears: “Publishing this event will send e-mail based on your selected mail options.”

4 Click Publish again.

The Event Information page appears with this status message: “This event has been published. E-mail options are active.” The Publish button disappears.

**Change an existing event**
Before an event occurs, you may want to change its beginning time, change participant permissions, or make other modifications.
Check the Current Participants list periodically to check that you have enough licenses for the number of attendees listed there and that all attendees meet approval criteria.

Also check the most current registration reports, which show the names and status of your attendees and invitees. If you selected or customized questions to help identify potential participants, you can also view the responses to questions.

**To notify users of a change**

If you modify an existing event, for instance, by setting a new start time, you can easily notify users by e-mail.

1. Open the E-mail Options page and select Show Reminder When Updates Need To Be Sent.
2. Open the Event Information page and scroll to the Status field.
3. Click Edit/Send Notifications, make any necessary changes, and click Send.

**Change event information**

You can edit the text on the Event Information page for event participants. If you select the e-mail option “Notify users when event has been updated,” any invitee whom you have previously notified about the event will automatically receive updated information.

*Note: If you have sent invitations but did not select the “Notify users when event has been updated” option, you should do so before changing the profile information, so that potential attendees can be aware of your changes.*

1. Click the Events Management tab in Enterprise Manager.
2. Navigate to the desired folder.
3. Click on the name of the event you want to change.
4. Go to the Edit Event Information page by doing either of these:
   - Click the Edit link next to Event Information.
   - Click the Edit Information link.
5. Make changes to any of the following:
   - Edit the event name. The name appears in the event list and in reports. This is a required field.
   - Edit the event summary. The summary can be up to 750 characters in length. This information appears on the Event Information page and in event reports.
   - Edit detailed information about the event (up to 1000 characters in length).
   - Edit the start time or end time of the event.
   - Edit the logo information. The logo file can be in BMP, GIF, JPG, or PNG format. The best size to use is 100x135 pixels.
   - Change the language for the event. Conventionally you select the language used by the presenter or the language used by the majority of event attendees.
   - Change the event user policy to add new users as guests or full Connect Enterprise users.
   - Change the option to approve participants after they register for the event. (You should generally have this option selected because it allows you to control who has access to the event.)
6. Save your changes in one of two ways:
   - Click Save.
   - Click Save And Rebuild. This option rebuilds HTML pages if you use Contribute to build pages.
Change registration questions
You can change any registration question, except the required questions (first name, last name, e-mail, and password), which the system uses to validate a user.

1. Click the Events Management tab in Enterprise Manager.
2. Navigate to the desired folder.
3. Click the event you want to change.
4. Click Registration Questions.
5. Modify the registration questions:
   - To add a question to the registration page, select the check box to the left of the question and click Save.
   - To remove a question from the registration page, deselect the check box to the left of the question and click Save.
6. To modify, delete, or add custom questions, click Customize.
   - To change the order of questions in the list, select the check box to the left of the question, and click Shift Up or Shift Down.
   - To delete a question, select the check box to the left of the question and click Remove.
   - To modify a custom question, click the question text in the Customize window.
   - To add a question, click the button that corresponds to the type of custom question you want to add: New Multiple Choice, New Short Answer, or New Yes/No.

7. When you finish, click Return To Registration Menu.

Add a multiple-choice question
1. Click the Events Management tab in Enterprise Manager.
2. Navigate to the desired folder.
3. Click the event you want to change.
4. Click Registration Questions.
5 Click Customize.
6 Click New Multiple Choice.
7 In the New Question window, type a question in the text box.
8 Type a possible answer for Answer 1. You can delete an answer at any time by clicking the Delete button next to it.
9 Click the Add Above or Add Below buttons to add another answer above or below Answer 1; if you click Add Above, Answer 1 becomes Answer 2.
10 Type another possible answer.
11 Repeat step 4 and step 5 for a maximum of four answers.
12 To require that users answer the question, select Response Is Required.
13 Click Save. The Customize Registration window appears, showing your new question.
14 To add another multiple-choice question, repeat steps 1 through 8.
15 (Optional) To move any question (except the required questions) up or down in the list, select the check box to the left of the question, and click Shift Up or Shift Down.
16 (Optional) To delete a question, select the check box to the left of the question, and click Remove.
17 Click Next.

Add a short-answer question
1 Click the Events Management tab in Enterprise Manager.
2 Navigate to the desired folder.
3 Click the event you want to change.
4 Click Registration Questions.
5 Click Customize.
6 Click New Short Answer.
7 Type a question in the text box.
8 To require that users answer the question, select Response Is Required.
9 Click Save. The Customize Registration window appears, showing your new question.
10 (Optional) To move any question (except the required questions) up or down in the list, select the check box to the left of the question, and click Shift Up or Shift Down.
11 (Optional) To delete a question, select the check box to the left of the question, and click Remove.
12 Click Next.

Add a yes/no question
1 Click the Events Management tab in Enterprise Manager.
2 Navigate to the desired folder.
3 Click the event you want to change.
4 Click Registration Questions.
5 Click Customize.
6 Click New Yes/No.
7 Type a question in the text box, and click Save.

8 To require that users answer the question, select Response Is Required.

9 (Optional) To move any question (except the required questions) up or down in the list, select the check box to
the left of the question, and click Shift Up or Shift Down.

10 (Optional) To delete a question, select the check box to the left of the question, and click Remove.

11 Click Next.

Change event content
You can replace event content only with content of the same type, for instance, you can replace one meeting with
another. You cannot add any new content to the Content library from here; you can select only existing content for
your event.

In addition, if you purchased Adobe Presenter, you can publish presentations from PowerPoint to the Content library
for your event. If you plan to use an existing presentation for an event, you must republish the PowerPoint presen-
tation to a Content library folder other than the one containing the original presentation. If you do not, the reporting
information for the original presentation will be merged with the event-specific report data, and any event-specific
data will be carried over into any future reports for the original presentation.

Note: For content other than courses and curriculum, the system tracks only whether the user has viewed the event. For
everyone who view only the first slide in a presentation are reported as having attended the event. In contrast, users
who view only a few of the slides in a course or curriculum are not reported as having attended; that is, users must
customize an event by viewing the event By Attendee report.

1 Click the Events Management tab in Enterprise Manager.

2 Navigate to the desired folder.

3 Click the event you want to change.

4 At the top of the Event Information page, click the Select Content link.

5 If the content you want does not appear in the list, navigate to the file or folder where the content that you want
resides:

   • Click the appropriate link at the top of the tab (for example, Shared User Content if you are replacing content).

   • Scroll to the folder or file that you want and either select the check box to the left of it or click the folder or file, as
     appropriate; if you are in the Content library and need to go to a higher folder directory, click Up One Level.

6 Click Save.

Change event e-mail options
You can change e-mail options for any of the e-mail notification, reminders, or follow-up messages before they are
sent. (Some messages are selected by default.)

You can customize an e-mail message. In several types of messages, you can attach a Microsoft Outlook Calendar
(iCal) entry that adds the event to the recipient's Outlook Calendar.
When you customize an e-mail form, you will see several fields in braces ({} in the Message Body area. In general, do not change any of the fields, unless you have a specific reason for doing so. The braces contain variables that the system replaces with actual values that are specific to your event. For example, the event-time field will display the beginning time you specified. If you want to change that time in the e-mail message, perhaps making it 15 minutes earlier to ensure that the actual event can begin on time, you can manually type in a new time in the event-time field.

1. Click the Events Management tab in Enterprise Manager.
2. Navigate to the desired folder.
3. Click the event.
4. Click the Email Options link at top of the Events tab. Do any of the following:
   • Select the check box to the left of the e-mail messages you want to send.
   • Deselect any e-mail messages you do not want to send.
   • Click Customize next to any messages that you want to edit. For instance, you may want to change the name of the creator to the name of the host, or the time to Greenwich Mean Time. (You can edit messages, but do not change any of the items in braces ({} on the Edit E-mail page.)

Note: You can change the items the braces for certain reasons. For example, you might want to replace {event-registration-url} with a customized URL containing a campaign ID for tracking an e-mail promotion or other campaign.

5. Click Save to save your changes or Cancel to exit the e-mail form.
6. Click Save.

Edit the mailing list

1. Click the Events Management tab in Enterprise Manager.
2. Navigate to the desired folder.
3. Click the event.
4. Click Participant Management.
5. Edit users or guests:
   • Click Add Guest and type or paste in e-mail addresses for all your invitees; use commas to separate the addresses.
   • Click Add User/Group and, in the Available Users And Groups list, select each user and/or group that you want to invite.
   • Click Registration Groups and, in the Possible Groups list, select each group you want to invite. (You must be an account administrator to select event registration groups.)
   • Click Import/Export List and then click Browse to navigate to a comma separated value (CSV) file.
   • Click Edit/Send Invitations to customize and send the event invitation. (You can edit the invitation, but do not change any of the items in braces ({} in the message body.)

Note: Each time you create an event, the system creates a group named after the event and populates it with the invited users. This makes it easy to invite the same people to a follow-up event: in the Users And Groups list, simply select the group from the previous event.
Tips for creating event mailing lists
Keep the following information in mind when you create mailing lists:

- A guest is a Connect Enterprise user with limited access. Guests can attend only those events for which they are approved. Also, guests cannot log in to Connect Manager.
- A user is a Connect Enterprise user with a Connect Enterprise account in your organization.

Note: Before sending out invitations, check with your Connect Enterprise Administrator for licensing issues. If more people register for the event than you have licenses for, attendees may not be able to join the event when they try to log in.

If the number of guests you are planning to invite is limited, you can type or copy and paste their e-mail addresses using the Add Guest function. If the number is larger, in the hundreds or thousands, you can import a comma-separated values (CSV) file of users.

If you are inviting Connect Enterprise users, you can use the Select Participants page to add users to the event invitation list and assign them permissions.

Finally, after you create the list, you can send out the invitations using default text or a customized invitation.

See also
"Using CSV files to add participants" on page 141

Add and manage event participants
You can add or remove participants for an event and change participant or presenter permission settings if you are an administrator or a presenter for the event. You can add participants to an event at any time after creating an event. Participants can be added as guests, users, or groups.

Add guests
1. Click the Event Management tab in Enterprise Manager.
2. Navigate to the desired event and select it.
3. In the Event Information page, click Participant Management in the navigation bar.
4. Click Add Guest.
5. In the text box, type or paste the e-mail addresses of the people you want to invite. (Separate e-mail addresses with commas.)
6. When you finish, click Save.

Add participants
1. Click the Event Management tab in Enterprise Manager.
2. Navigate to the desired event and select it.
3. In the Event Information page, click Participant Management in the navigation bar.
4. Click Add User/Group.
5. In the Available Users And Groups list, select a user or group and click Add. You can also click Search to find a user or group that is not listed.

As you add users and groups, the Current Participants list on the right is updated to reflect your changes.
Note: Each time you create an event, the system creates a group named after the event and populates it with the invited users. This makes it easy to invite the same people to a follow-up event: in the Users And Groups list, simply select the group from the previous event.

6 When you finish, click OK.

Remove participants from an event
1 Click the Event Management tab in Enterprise Manager.
2 Navigate to the desired event and select it.
3 In the Event Information page, click Participant Management in the navigation bar.
4 Select the groups or users that you want to delete from the participants list.
5 Click Remove.

Note: Participants who are removed from the event do not receive an invitation, and they cannot access the event unless event access is changed to Anyone.

Change permissions of event participants
1 Select the Event Management tab in Enterprise Manager.
2 Navigate to the desired event and select it.
3 In the Event Information page, click the Participant Management link in the navigation bar.
4 In the Users And Groups list, select the user or group whose permission you want to change.
5 Click Set User Role and, from the pop-up menu, select the new permission type to assign. The permission types are: Denied, Invited, Pending Approval, Participant, Presenter, and Host. (Presenter and Host are available only if the event is a meeting or seminar.)

Designate a group for approved event registrants
You can designate a group that event registrants are automatically assigned to when they are approved for the event. This is useful if you want to conduct a follow-up event because you’ll have all the registered attendees organized into one group.

Note: You must be an account administrator to select event registration groups.
1 Select the Event Management tab in Enterprise Manager.
2 Navigate to the desired event and select it.
3 Click the Participant Management link in the navigation bar.
4 Click Registration Groups.
5 In the Possible Groups list, select a group and click Add. The selected group name appears in the Current Group Membership list.

Convert guests to full users
If you are an Administrator, you can convert existing guests to full users. This distinction can be important because only full users, not guests, can log into the Connect Enterprise administration site. Full users also appear on enrollment and permission lists.
1 Select the Administration tab in Enterprise Manager.
2 Select Users And Groups.
3 Select Manage Guests.

4 In the Current Guests list, select a guest.

5 Click Convert To User.

Conversely, if you wanted to change a full user into a guest, in step 5 you would select a user in the Current Users list and then click Convert To Guest.

**Using CSV files to add participants**

If you have a comma-separated values (CSV) file that contains names and e-mail addresses, you can import the CSV file to add participants to an event. Keep these requirements in mind when you import a CSV file:

- The file should not contain empty lines. If the CSV file contains empty lines, the import operation fails.
- Names that contain a comma need to be in quotes. For example, the name John Doe, Jr., must appear in the CSV file as “John Doe, Jr.” for the file to import correctly.
- The supported CSV file column headers are first name, last name, and e-mail address. For example, you can import a CSV file that has one column listing first names, a second column listing last names, and a third column listing corresponding e-mail addresses (with all columns separated by commas). For example, jane, doe, jdoe@mycompany.com.
- If you want to specify a custom field, the header format in the CSV file is x-<field-id> (for example, x-45704960). You can obtain the field ID from the CXML API calls [custom-fields](#) or [acl-field-list](#), or you can click the field in Enterprise Manager and check the ID in the URL.

*Note:* Guest users that were imported into a CSV file in Connect Enterprise 5.1 (Breeze 5.1) do not have first and last name columns, just one name column, so they are exported with the full name in the first name column and a blank in the last name column.

**Add event participants using a CSV file**

1 Click the Event Management tab in Enterprise Manager.

2 Navigate to the desired event and select it.

3 In the Event Information page, click Participant Management in the navigation bar.

4 Click Import/Export List.

5 Click Browse, and navigate to the desired CSV file.

6 Click Upload.

**Send event invitations**

If you are an administrator, an event host, or a user with permissions to manage a specific Event library folder, you can send event invitations.

An event invitation is an e-mail message that is sent to event attendees, informing them of the date, time, duration, and URL of the event. The way that invitations are sent depends on the type of event:

**Invitees Only** If your event is for registered users only, you create a custom e-mail message in Enterprise Manager. You can send the e-mail to all registered participants and presenters, presenters only, or participants only. You can customize the subject and message body. You also have the option to attach a Microsoft Outlook Calendar iCal so that participants can add the event to their Outlook Calendar.
Anyone  If your event is open to anyone who receives the event URL, you can create a new e-mail message in your default e-mail program. This message contains a prepopulated subject and a prepopulated message (event date, time, duration, location, and summary), but you can edit the text.

1 Select the Event Management tab in Enterprise Manager.
2 Navigate to the desired event and select it.
3 In the Event Information page, click the Participant Management link in the navigation bar.
4 Click Edit/Send Invitations in the navigation bar.
5 (Optional) If you want to send a blind copy of the invitation to anyone, add the e-mail address in the BCC Recipients text box. This can be useful if, for example, you want co-workers to know that you sent the invitation.
6 Edit the subject and the message body.
7 To attach an iCal, select the check box next to the Attach Microsoft Outlook Calendar Event (iCal) To E-mail Message option.
8 Click Send.

Use campaign tracking with an event

Use the campaign tracking option to track registered users by campaign source. The Events registration and attendance reports list campaign sources alongside user names. Common campaigns include e-mail offerings, search engine campaigns, and banner ad campaigns. To track campaigns, you manually modify the automatically provided registration URL.

One method of adding campaign tracking is to select the campaign tracking option on the Create Registration page when creating a new event. You can also add campaign tracking to an existing event if you have not published the event or sent out invitations. (If you select the campaign tracking option after publishing the event and sending out invitations, any invitees who already registered using the registration URL sent in your original e-mail invitation will not be tracked.)

Note: To track a campaign, you must modify the registration URL for the event. Remember that you can't change the registration URL for the Event Listings page and the Event Information page. If you want to use the Event Listing page or the Event Information page, you won't be able to track a campaign.

See also

“Creating an event” on page 129

Add campaign tracking to an existing event

1 Open Enterprise Manager and click the Event Management tab.
2 Select the event.
3 Click the Registration Questions link.
4 Select the Enable Campaign Tracking option.
5 Click Save.

Add the campaign ID parameter and ID number

1 Open Enterprise Manager and click the Event Management tab.
2 Select the event to display the Event Information page.
3 Click the “Preview event information, login and registration pages” link.
5 Open a word-processing application, such as Notepad or Wordpad, and paste the registration URL.
6 In the word-processing application, place your cursor at the end of the URL and type ?campaign-id= (for example, http://adobe.Enterprise-central.com/primetimeevent/event/registration.html?campaign-id=).
7 At the end of the new event registration URL, add a campaign tracking ID. The ID is a unique identifier for your campaign and may be any alphanumeric value. For example, http://adobe.Enterprise-central.com/primetimeevent/event/registration.html?campaign-id=email1234 contains the valid campaign tracking ID “email1234.”
8 Save the text file and leave the text file open in the word-processing application.

Test the URL with campaign tracking ID
To test the new URL, you disable e-mail invitations, publish the event, register for the event, and then check the registration report.
1 Open Enterprise Manager and click the Event Management tab.
2 Select the event to display the Event Information page.
3 Select E-mail Options.
4 Deselect the Send Event Invitations option.
5 Click Save.
6 At the bottom of the Event Information page, the status message reads, “This event has not been published and listed on your site. E-mails have not been sent.” Click Publish.
7 A confirmation message appears. Click Publish again. The Event page displays and the status message now reads, “This event has been published. E-mail options are active.”
8 To test your modified registration URL, you need to register for the event. Open a web browser in a new window.
9 In the word-processing application, copy the modified registration URL (with the campaign ID parameter and custom campaign ID added). Paste the URL into the new web browser window and press Enter or Return.
10 In the registration form, fill out the required fields using your name and e-mail address.
11 Click Submit.
12 Check your e-mail program for an event confirmation message.
13 Now that you have registered for the event, you can see your name and the campaign tracking ID in the registration reports. Open Enterprise Manager and click the Event Management tab.
14 Select the event to display the Event Information page.
15 Select Reports.
16 Select By Registrants.
17 In Registration Report, click Download Report Data. In the Excel spreadsheet that opens, check that the correct ID number appears in the Campaign Tracking ID column next to your name.

Send event invitations with correct registration URL
If you are using Enterprise Manager to send event invitations, you must manually replace the registration URL automatically generated in Enterprise Manager with the modified URL.
**Note:** If you are sending e-mail invitations using third-party software, ensure that you send invitees the new, modified event registration URL.

1. Open Enterprise Manager and click the Event Management tab.
2. Select the event to display the Event Information page.
3. Select E-mail Options.
4. Select Send Event Invitations.
5. Next to Send Event Invitations, click Customize.
6. In the message body, replace the words “event-registration-url” in the run-time field {event-registration-url} with the modified registration URL you created. (You can cut and paste the URL from the word-processing program you used to modify the URL.)
7. Specify a date and time to send the event invitation e-mail.
8. Select Save.
9. If you are also using the Remind participants closer to event e-mail option, you will need to click Customize next to the option and follow the instructions in step 6 above to replace the registration URL in the message body.

## Managing events

**View information about an event**

If you are an administrator, an event host, or a user with permissions to manage a specific Event library folder, you can view different kinds of information about an event from the Enterprise Manager application.

**View a participants list**

1. Click the Event Management tab in Enterprise Manager.
2. Navigate to the folder that contains the desired event and select it.
3. In the Event Information page, click the Participant Management link.

The names of registered participants and groups appear.

**View an uploaded content list**

You can view a list of all content that has been uploaded to the Connect Enterprise Server. To view the content list, you must be an administrator, an event host, or a user with permissions to manage a specific Event library folder.

1. Click the Event Management tab in Enterprise Manager.
2. Navigate to the folder that contains the desired event and select it.
3. Click the Select Content link.

A list of all uploaded content appears.

**Viewing the Event Dashboard**

The Event Dashboard provides a graphical representation of statistical data about your events. To see the Dashboard, click the Event Dashboard link under the tab bar, at the top of the Event's window.
The data reflects all of the events in your My Events folder and appears in one bar graph showing the most active events over the last six months (determined by the number of sessions). You can click any individual event in the graph to view more detailed information about the event.

**Event reports**

The Reports feature of Enterprise Manager lets you create reports that show event statistics from different perspectives.

Event reports use the following definitions:

- **Registered** The number of people who completed the registration form and were approved by the event host.
- **Denied** The number of people who completed the registration form but were denied registration. For example, this might happen if the registration URL is made public on a website or through e-mail and people register for the event by mistake.
- **Approved** The number of people approved to attend the event. This number includes people who completed the registration form and were approved. It also includes people who are approved directly, such as event presenters, and do not need to register.

**See also**

“Setting and removing report filters” on page 99

**Joining events**

Any Connect Event that you are permitted to join appears in the event list. (To view the event list, navigate to the Enterprise Manager Home tab, and click My Scheduled Events.)

All Connect Events require registration, although not all require approval. There are two ways to register for an event:

- From a link in the e-mail invitation, which applies only if you are invited by the event host.
- From a link in the event listing on the public pages of a company's website; this applies if the event is open to the public.

After you click the registration link, a form appears. You can use this form to register for the event. (Registered Connect Enterprise users must log in before registering for the event.) During registration, you create a guest profile by entering a password and answering questions. Then, depending on the way the event was created, you might receive a notification e-mail that provides your status (pending, approved, or denied). If you are approved, the e-mail message includes the following information:

- URL
- Dial-in telephone number and participant code that you use to phone in, if appropriate

In addition, if you received an e-mail invitation with an iCal attached and you have Microsoft Outlook, you can add the event to your Outlook Calendar.

If you are a Connect Enterprise user and the event was created in the same Connect Enterprise account as yours, the event also appears in your Enterprise Manager under My Scheduled Events.

**Note:** The event registration form cannot be used to create a new user if you are already logged in as a user. For example, if you are logged in to a Connect Enterprise session, you cannot register for an event as a different user.
Enter a scheduled event from Enterprise Manager

1. Click the My Scheduled Events link at the top of the Home tab.

The My Scheduled Events list appears with your role identified in the Role column.

2. Click Enter next to the event you want to attend.

If you have not registered yet or need approval, you may need to log in, enter your password, and complete the registration form.
Chapter 7: Adobe Presenter

Creating Presentations

About Adobe Presenter 6
Adobe Presenter 6 is a software tool for creating e-learning content and high-quality multimedia presentations rapidly. Presenter uses Microsoft PowerPoint, a popular application that is part of the Microsoft Office suite, as a base. Finished presentations are in Flash format (SWF file). Content created with Presenter is SCORM 1.2 and SCORM 2004 certified and AICC compliant.

After you install Adobe Presenter, you can access the application from within Microsoft PowerPoint. You can access all Presenter authoring functions in PowerPoint by using the Adobe Presenter menu.

Presenter complements Adobe Connect Enterprise Server 6. You can create content that includes interactive quizzing and surveys, audio, and a customizable viewer with Presenter. Presenter sends the PPT (PowerPoint) and PPC files, as well as presentation data, to Connect Enterprise Server.

You can add straightforward or sophisticated quizzes to presentations. Presenter supports six different types of questions that can either be graded or used as surveys. You can use branching to guide users through different paths in the presentation based on their answers to quizzes.

Presenter provides a simple interface for using a microphone to add audio narration to your presentation. In addition, you can easily synchronize your PowerPoint animations with your audio narration.

The Presenter intuitive interface and its complete integration with PowerPoint eliminates the need for additional training or Flash programming. In minutes, you can transform static PowerPoint files into dynamic web experiences by adding audio, video, multimedia, interactive quizzes and surveys, and extensive branding. When you have created your content, simply publish it to Connect Enterprise Server. (You can also publish to your computer to test a presentation.)

After you have installed Presenter, you access the program from within PowerPoint. When you open PowerPoint, a new menu named Adobe Presenter appears in the menu bar.

Presenter How To Topics
- “Create a Presenter presentation” on page 151
- “Record audio” on page 168
- “Add audio files to a presentation” on page 164
- “Adding quizzes and questions” on page 174
- “Add and edit attachments” on page 159
- “Create and edit themes” on page 197
- “Change slide properties” on page 154
- “Preview a presentation” on page 152
- “Publish to a Connect Enterprise server” on page 207
- “Add and edit presenters” on page 156
Installing Adobe Presenter
After you install Adobe Presenter, you can access all of its features in PowerPoint from the newly added Adobe Presenter menu.

**Note:** The latest version of the Flash Player (Flash Player 9) is installed when you install Adobe Presenter.

1. After you have downloaded the application, double-click the Presenter EXE file to install the software.
2. Follow the onscreen instructions.

A Getting Started presentation guides you through the steps required to publish your first presentation.

Upgrading to Adobe Connect Enterprise Server 6
The following information is helpful if you upgrading from a previous version of Breeze and Presenter to Adobe Connect Enterprise Server 6 and Adobe Presenter 6.

- If you have Presenter presentations created with any version of Presenter released before Presenter 6 you may want to update your presentations. Because of changes to the latest versions of Internet Explorer, users who view presentations created with Breeze versions prior to Adobe Connect Enterprise Server 6 will need to click the content area in the browser once before any controls are clickable. To update your presentation so users will not need to click in the content area, open the presentation in Presenter 6 and republish the presentation. (Full information about the EOLAS changes to Internet Explorer are available on the Microsoft website.)
- The latest version of the Flash Player (Flash Player 9) is installed when you install Presenter.
- When you install/upgrade Presenter, the old version of Presenter is uninstalled and no longer available for you to use.

Creating presentations with Presenter
Presenter lets you create sophisticated, high-impact presentations and e-learning content quickly and easily in three steps:

1. **Design your presentation.**
   From within PowerPoint, Presenter can help you do the following tasks:
   - Use an existing PowerPoint presentation as a base for a Presenter presentation. This can save you the time and effort of creating a new presentation.
   - Perform accurate PowerPoint conversions quickly, including full support for PowerPoint animations.
   - Customize the look and feel of the presentation viewer interface with company logos, colors, and presenter biographies and photos.

2. **Edit your presentation.**
   Presenter can help you change presentations to suit your needs in the following ways:
   - You can enhance PowerPoint presentations with multimedia. Add multimedia including audio (such as voice-over narration), quizzes and surveys, or Flash files and Flash video without leaving PowerPoint.
   - You can import prerecorded audio into a presentation and match the audio to PowerPoint slide animations.
3. Publish your presentation.

You publish your presentations so that users can view them. Presenter offers the following features:

- Presenter is deeply integrated with all Connect Enterprise applications including Connect Training, Connect Events, and Acrobat Connect Professional, as well as Adobe Captivate, Flash content, and Flash Video (FLV) files.
- You can view presentations in the interactive Presenter viewer.
- You can use Presenter content with learning management systems (LMS). Presenter creates SCORM- and AICC-compliant content.

See also

"Add animation, image, and Flash (SWF) files" on page 161

“Create and edit themes” on page 197

“Publish to a Connect Enterprise server” on page 207

Presenter workspace

Presenter has the following two components that work together to help authors create and deliver content for users:

**Presenter** Enables authors to create content.

**Presenter viewer** Allows users to view and interact with converted Presenter presentations.

For content authors, all Presenter features are accessible from the Adobe Presenter menu in PowerPoint.

![All options for designing a presentation are in the Adobe Presenter menu in PowerPoint.](image)

Elements of presentations

When planning, consider adding the following elements to your presentation:

**Title slides** Title slides are usually the first or second slide in a presentation and state the subject of the content.

**Presenter information** Include the name, title, photo, contact information, and a short biography of the presenter or presenters.
**Custom logos**  Add a company or organization logo to brand and personalize a presentation.

**Copyright information**  Depending on the length of the information, include copyright text on the first or last slide in a presentation, or add a separate slide containing only copyright information.

**Opening and closing slides**  Create a distinctive start and finish to clearly show users the beginning, middle, and end of the presentation. You can use the same opening and closing slide across a series of presentations for a unifying professional look.

**Section divider slides**  Use slides that delineate sections within a presentation. This is especially useful in long presentations.

**Sounds**  Voice-over narration, music, or sound effects can add a new dimension to presentations.

**Quizzing**  Let users interact with the presentation, while you track their learning progress or obtain information (surveys).

**Attachments**  Add existing information as supporting content for presentations. You can include documents, spreadsheets, links to web pages, and images as attachments.

**Planning a presentation**

No matter what kind of presentation you want to create, it is helpful to do some planning before you start. Consider first what you want the user to learn from your presentation. Defining this goal at the beginning lets you create a comprehensive plan for success. After you have defined the goal of the presentation, you can use an existing PowerPoint presentation and enhance it with the most effective Presenter options.

1. **Plan your presentation.**

   Use storyboards, scripts, or whatever organizational materials are appropriate. Consider what elements you may want to include (see "Elements of presentations" on page 149.)

2. **Start PowerPoint.**

   You can open an existing PowerPoint presentation or create a new presentation.

3. **Include narration and other special elements.**

   In PowerPoint, from the Adobe Presenter menu, you can add audio narration, quizzes, presenter information, and other options to your presentation. You can include attachments such as web pages or documents and you can customize themes (the look and feel of the presentation viewer) for each presentation.

4. **Preview your presentation.**

   You can view the presentation on your machine by publishing locally to test the timing and the features you have added.

5. **Publish the presentation.**

   You can publish the presentation to Connect Enterprise Server. You can also burn the presentation to a CD or upload the presentation to the web using a third-party FTP software program.
Presenter best practices
Adobe recommends these best practices for creating presentations:

• Design your online presentation based on the bandwidth capabilities of your audience. If your audience has fast, broadband connections, you can create a graphic-intensive presentation that includes many animations. However, if your audience has slower connection speeds, you should consider using graphic images only (no animations) or no graphics at all, to ensure that your audience has a good viewing experience.

• Consider creating a written script before recording audio for your presentation. Speaking into a microphone can be more difficult than giving a presentation to a live audience. To ensure a smooth delivery that covers all of your important points, consider creating a script for the entire presentation before recording audio for it. (If you have slide notes written in PowerPoint, you can easily import them into Presenter to use as a script or as the basis of a script.)

• Add animations to enhance the overall presentation, if your audience has fast connections. Presenter supports PowerPoint animations so that you can create powerful, animated, multimedia presentations. Animations add impact to your message and improve the user’s overall viewing experience. (Animations must be set to On Click.)

• Create presentations that are a manageable size. A single PowerPoint presentation typically corresponds to a single module or course. Usually a module contains 20-40 slides and results in a 15-45 minute sessions for users. If single PPT files become larger than 40 slides, the time it takes Presenter to convert the presentation to Flash format can increase by several minutes.

• Preview the presentation by publishing it locally before publishing to a Connect Enterprise Server. This lets you view the converted presentation to be sure that it meets your requirements.

• Create slide titles to give users easy access to any slide. Check that titles appear in the PowerPoint outline for all slides, including graphic-only slides, before publishing your presentation.

Create a Presenter presentation
Presenter presentations are always based on PowerPoint presentations. To create a new presentation, you open an existing PowerPoint presentation (or create a new one) and then add all of the features available in Presenter. For more information about how to add these features, see the appropriate section.

1 In PowerPoint, open a presentation (PPT) file or create a new one by selecting File menu > New.

2 From the Adobe Presenter menu, select the Presenter features you want to add to your presentation. You are not required to make any changes before publishing, but adding Presenter features such as audio narration, SWF files, quizzes, attachments, and a theme will enhance your presentation and give you the opportunity to experiment with the functionality available in Presenter.

3 Preview the presentation by publishing it locally (to your computer). (For instructions on how to do this, see the next section).

4 If necessary after previewing, return to step 2 and make any changes required.

5 When you are finished, publish the presentation to Connect Enterprise Server.

See also
“Publish to a Connect Enterprise server” on page 207
Preview a presentation

If you want to check your work, you can preview presentations at any time by publishing to your local computer. This is a fast way to see how the presentation will look to users.

When you preview a presentation, it appears in your default web browser. All of the functionality in the presentation, such as audio and quizzes, works exactly the way it will in the Presenter viewer. The presentation appears with all of the theme settings and colors you have chosen.

1. In PowerPoint, open a presentation (PPT file).
2. From the Adobe Presenter menu, select Publish.
3. Select My Computer on the left side.
4. (Optional) Select Zip files to add all presentation files to a zip file. This is useful if you need to give or send the files to someone else to preview.
5. (Optional) Select Generate Autorun For CD if you are going to distribute the presentation on a CD-ROM after previewing. (If you select this option, you can burn the presentation on a CD-ROM and when it is opened, the presentation automatically begins playing.)
6. Click Publish.

When you publish, a new folder with the same name as the presentation is created and placed in your My Documents\My Adobe Presentations folder. The new folder contains all of the presentation files, copies of attachments, and any audio, video, and image files that are part of the presentation.

7. When the conversion is finished, click View Output. (If you selected the Select Zip files option, you will not see the View Output option. To view the presentation, go to the location where you saved the zip file, unzip the file, and double-click the index.htm file.) The presentation appears in your default web browser.

Published presentation with sidebar shown
A. Slide preview  B. Viewer sidebar  C. Panes  D. Toolbar  E. Show/Hide sidebar
Editing Presenter Presentations

Change the presentation title
You can change the presentation title at any time. The title appears in the Presenter viewer.

1. In PowerPoint, open a presentation (PPT file).
2. From the Adobe Presenter menu, select Presentation Settings.
3. Select the Settings tab.
4. In the Title text box, enter a new name for the presentation and click OK.

Add a presentation summary
A presentation summary is usually a short description of the presentation contents. This optional presentation summary is a useful organizational tool for authors. The summary appears only in the settings; it does not appear in the published presentation and is not visible to users.

Note: The presentation summary does appear in Connect Enterprise Server after a presentation is published to the server. Summaries can be edited through Connect Enterprise Manager. Presentation authors can search summaries and see the summary when viewing content information.

1. In PowerPoint, open a presentation (PPT file).
2 From the Adobe Presenter menu, select Presentation Settings.
3 Select the Settings tab.
4 In the Summary text box, enter a description of the presentation contents and click OK.

**Change slide properties**

You can easily view and change the properties of any slide in a presentation at any time. Slide properties include the title, navigation name, navigation options, and presenter name. The slide properties dialog box also enables you to make changes to a group of slides quickly and easily. For example, suppose you have assigned a presenter to all the slides, but another presenter is providing audio narration for a few of them. To assign the new presenter to those few slides, you can use slide properties.

**Note:** You can select multiple slides and easily update their Presenter and Advance By User settings. Simply select a slide, hold down Shift or Control, and select additional slides. (You can't change the Navigation name, Go To Slide, or Video properties of more than one slide at a time.)

---

**Using slide properties, you can change options for individual slides or a group of slides.**

**A.** Select one slide or multiple slides in the list.  
**B.** Click to edit the selected slides

---

**See also**

"Preview a presentation" on page 152

**View slide properties for all slides**

You can view a short description of all slides in a presentation in one central location. For example, you can see which presenters are associated with each slide, whether navigation names have been assigned, and whether the user must advance any slides.

1 In PowerPoint, open a presentation (PPT file).
2 From the Adobe Presenter menu, select Slide Properties.
3 The Slide Properties dialog box appears.
4 Use the scroll bar on the right side to view all of the slides in the presentation.
Set a navigation name

You can set a navigation name for a slide that is different from the slide title. A clear and descriptive navigation name can help users navigate through the published presentation. The navigation name appears in the sidebar (Outline and Thumb panes) in the published presentation.

A navigation name can be useful if your slide titles are long or if you want to display a more descriptive name than the slide title in the final presentation for users. For example, the first slide in the presentation may have the title “Introduction,” but you can assign a navigation name such as “About Product X.”

1. In PowerPoint, open a presentation (PPT file).
2. From the Adobe Presenter menu, select Slide Properties.
3. Select a slide and click Edit or double-click a slide.
4. In the Navigation Name text box, enter the text you want to use.
5. Click OK twice.

Set Go To Slide options

Presentations usually progress linearly through the slides, but you can change the order by using the Go To Slide option. This option lets you skip slides in the presentation without having to remove them.

The Go To Slide option can be useful if you are creating a presentation for several audiences. For example, you can create one benefits presentation for both full-time and part-time employees. Part-time employees can skip slides pertaining only to full-time employees. The Go To Slide option works the same whether the presentation is used within Acrobat Connect Professional or viewed locally in a web browser.

Note: If you are going to use a presentation as a Connect Training course, it is better to not use the Go To Slide option.

1. In PowerPoint, open a presentation (PPT file).
2. From the Adobe Presenter menu, select Slide Properties.
3. Select a slide as the starting point and click Edit or double-click a slide.
4. In the Go To Slide pop-up menu, select the slide to which you want the presentation to jump.
5. Click OK twice to close all dialog boxes.

Add speaker video

You can include video files in a presentation, which appear in the viewer sidebar. This can be especially useful if you have a video of a speaker, sometimes called a “talking head” video. Presenter supports the Flash (SWF) and Flash Video (FLV) file formats. Video added to a presentation appears in the location used for presenter photographs.
**Note:** Video is added to each slide individually. If you use one “talking head” video file for multiple slides, split the video into separate files.

![Edit Slide Properties](image)

Video files appear in the viewer in the same location as the presenter photograph.

1. In PowerPoint, open a presentation (PPT file).
2. From the Adobe Presenter menu, select Slide Properties.
3. Select a slide and click Edit or double-click a slide.
4. Next to the Video text box, click Browse.
5. Navigate to a SWF or FLV file, select the file, and click Open.
6. Click OK twice to close all dialog boxes.
7. To test the file, preview the presentation. (For more information, see “Preview a presentation” on page 152).

**Set slide advance behavior**

By default, slides in a presentation advance automatically. You can, however, set individual slides to advance only when users click the Next button. This is useful, for example, for a slide containing an interactive Adobe Captivate simulation that has no set play duration.

1. In PowerPoint, open a presentation (PPT file).
2. From the Adobe Presenter menu, select Slide Properties.
3. Select a slide and click Edit or double-click a slide.
4. Select Advance By User.
5. Click OK twice.

**Add and edit presenters**

A presenter is a person who provides information during a presentation. For example, if the subject is software training, the presenter may be an instructor, trainer, or product manager. A single presenter can be assigned to all slides in a presentation, or different presenters can be assigned to individual slides.

You can display information about the presenter: name, job title, short biographical notes, a company logo, and contact information. This information can make a presentation more credible, personal, and interesting.
Add a new presenter profile
In Presenter, you store presenter profiles in one central location. You can then use them in any presentations you create.

1 In PowerPoint, open a presentation (PPT file).
2 From the Adobe Presenter menu, select Preferences.
3 Select the Presenters tab.
4 Click Add.
5 Enter the name of the new presenter.

Note: The Name text box is the only text box that you must fill in to create a new presenter.

6 (Optional) Enter a job title, such as Vice President.

7 (Optional) Next to the Photo text box, click Browse and navigate to an image file in JPEG or PNG format. The recommended size for a presenter photo is 88 x 118 pixels. After you select an image file, the image appears in the Presenter Photo area on the right. During the presentation, the image is displayed at this exact size in the Presenter viewer.

8 (Optional) Next to the Logo text box, click Browse and navigate to a logo file in JPEG or PNG format. The recommended size for a logo is 148 x 52 pixels. After you select an image file, the image appears in the Logo preview on the right. During the presentation, the logo is displayed at this exact size in the Presenter viewer.

Note: If you added a video file, such as a “talking head” video file of a person speaking, that video is displayed in the logo area. If you add a logo file, the video file takes precedence and the logo will not be displayed.

9 (Optional) Enter an e-mail address.

10 (Optional) In the Biography text box, enter information about the presenter, such as professional and educational credentials, employment history, phone number, or job description.

11 If you want to make this person the default presenter for all presentations, select the Default option.

12 Click OK.

13 Click Close.

Set the presenter for an entire presentation
1 In PowerPoint, open a presentation (PPT file).
2 From the Adobe Presenter menu, select Slide Properties.
3 Press CTRL-A to select all of the slides.
4 Click Edit.
5 In the Presenter pop-up menu, select a name from the list.
6 Click OK. The presenter is now associated with all slides in the presentation.
7 Click OK to apply your changes and close the Slide Properties dialog box.

Set the presenter for an individual slide
1 In PowerPoint, open a presentation (PPT file).
2 From the Adobe Presenter menu, select Slide Properties.
3 Select a slide and click Edit or double-click a slide.
4 In the Presenter pop-up menu, select a name from the list.
5 Click OK. The presenter is now associated with the slide.
6 Click OK to apply your changes and close the Slide Properties dialog box.

**Edit an existing presenter**
1 In PowerPoint, open a presentation (PPT file).
2 From the Adobe Presenter menu, select Preferences.
3 Select the Presenters tab.
4 Select a presenter from the list and click Edit or double-click a presenter.
5 Change properties such as the job title, e-mail address, or biography.
6 Click OK to close the Presenter dialog box.
7 Click Close to close the Presenter Preferences dialog box.

**Delete a presenter**
You can delete a presenter and all corresponding information, such as the biography and e-mail address, at any time.
1 In PowerPoint, open a presentation (PPT file).
2 From the Adobe Presenter menu, select Preferences.
3 Select the Presenters tab.
4 Select a presenter from the list and click Delete. (If the presenter you delete is associated with any slides in the presentation, the presenter for that slide becomes “None.”)
5 Click Close to close the Presenter Preferences dialog box.

**About attachments**
Attachments are files or links that give viewers of the presentation supplemental information. Use attachments to incorporate existing content, such as web pages, documents, PDF files, FlashPaper documents, Flash (SWF) files, or spreadsheets, into your presentation. You can also add links to websites or documents hosted by Connect Enterprise Server or a third-party system.

If a presentation contains attachments, an Attachments button appears at the bottom of the Presenter viewer. The user can click this button to see a list of attachments associated with the presentation and then click any listed attachment to open it.

*Note: Depending on the user’s web browser, they may have to save an attachment to their local machine in order to open and view the attachment.*
Attachments open either in an application or in the default browser, according to their type:

<table>
<thead>
<tr>
<th>Attachment type</th>
<th>Opens in</th>
</tr>
</thead>
<tbody>
<tr>
<td>FlashPaper</td>
<td>Default web browser</td>
</tr>
<tr>
<td>Microsoft Word document</td>
<td>Microsoft Word, if installed</td>
</tr>
<tr>
<td>Microsoft Excel spreadsheet</td>
<td>Microsoft Excel, if installed</td>
</tr>
<tr>
<td>Microsoft PowerPoint presentation</td>
<td>Microsoft PowerPoint</td>
</tr>
<tr>
<td>Text (TXT) file</td>
<td>Default text editor, such as Notepad or Wordpad</td>
</tr>
<tr>
<td>PDF file</td>
<td>Adobe Acrobat Reader, if installed</td>
</tr>
<tr>
<td>Flash (SWF) file</td>
<td>Default web browser, such as Internet Explorer or Mozilla Firefox</td>
</tr>
<tr>
<td>Image or graphic file</td>
<td>Default web browser, such as Internet Explorer or Mozilla Firefox</td>
</tr>
<tr>
<td>URL</td>
<td>Default web browser, such as Internet Explorer or Mozilla Firefox</td>
</tr>
</tbody>
</table>

**Add and edit attachments**

You can attach web pages, documents, PDF files, FlashPaper documents, Flash (SWF) files, or spreadsheets to your presentation. You can also add links to websites or documents hosted by Connect Enterprise Server or a third-party system.

**Important:** Due to security features added by Microsoft, attachments to presentations that are published locally instead of to Connect Enterprise Server may not be displayed properly in Internet Explorer. This happens because Internet Explorer does not allow an Internet page to access or run any file on a local system. In Adobe Presenter, a presentation that has been published locally runs in the Flash player, and Internet Explorer considers it unsafe to download a file from the Flash Player. You can work around this issue two ways: use Connect Enterprise Server (or another Learning Management System) to publish the presentation, or make the attached file available for download through a web browser or network drive accessible by users and use the hyperlink feature of PowerPoint to allow users to view the attachments.

**Add an attachment to a presentation**

1. In PowerPoint, open a presentation (PPT file).
2. From the Adobe Presenter menu, select Presentation Settings.
3. Select the Attachments tab.
4. Click Add.
5 Enter a unique name for the attachment.
6 In the Type pop-up menu, select File or Link.
   • To attach a file, click Browse and navigate to the file.
   • To attach a link, enter the full path in the URL text box.
7 Click OK.
8 Continue adding attachments as needed and click OK when you finish.

Add and test links to documents
Links to documents on Connect Enterprise Server or a third-party system are a type of attachment. For example, you could create a link from a text on a PowerPoint slide to a SWF file.

When linking to a document, it may be necessary to copy the document to the resource folder for the document to appear properly in the presentation.

1 In PowerPoint, open a presentation (PPT file).
2 Navigate to the slide to which you want to add the link.
3 Select the text you want to use as the link.
4 From the Insert menu, select Hyperlink.
5 Navigate to the file to which you want to link and click OK.
6 To test the link, preview the presentation. From the Adobe Presenter menu, select Publish.
7 Select My Computer and click Publish. (If a message appears stating that all files will be deleted, click Yes. Each time you generate your presentation, the files in your current output folder are deleted and replaced by the newly generated files.)
8 When the conversion is complete, click View Output. The presentation appears in your default web browser.
9 Navigate to the slide containing the link and click the link.
10 If a message appears stating something similar to “Cannot find 'file://c:\Documents and Settings\ssmith\My Documents\My Adobe Presentations\PresentationName\data\resources\sample.swf,” you need to copy the file to the resources folder. Note the path specified in the message and close the presentation in your web browser.
11 Open Windows Explorer. Navigate to the current location of the file.
12 Right-click the file and select Copy.
13 Navigate to the location specified in the error message, For example, an address similar to the example in step 10.
14 Right-click the resources folder and select Paste.
15 Follow steps 6-8 to preview the presentation and test the link again.

Creating links to files
If you are creating links from a presentation to a file and the link path is relative to the location of the presentation, you may need to take a few steps to ensure that the links work properly. This issue occurs because of the method PowerPoint uses to manage relative links. (PowerPoint does, however, resolve all links to files in the same drive as the PPT file.)

1 In Windows Explorer, locate the folder containing the presentation PPT file. For example, C:\Folder A\test.ppt.
2 Create a subfolder under the folder containing the presentation PPT file. For example, C:\Folder A\Links.
3 Copy all files that will be linked to from within the presentation to the new subfolder.
4 Create the links in the presentation to the files.
5 Publish the presentation. Note the location of the published content folder.
6 Copy the subfolder created in step 2 containing the links to the Date\Resources subfolder of the published content folder from step 5. For example, copy the links folder from C:\Folder A\Links to C:\Preso\Data\Resources\Links.

**Note:** You can use attachments instead of links. By using attachments, the files are automatically included with the published content.

**Change the name, type, or location of a presentation attachment**
After adding an attachment to a presentation, you can edit information about the attachment.

**Note:** If you need to edit the attachment contents, open the file in the application in which it was created. After editing, add the attachment again in Presenter.

1 In PowerPoint, open a presentation (PPT file).
2 From the Adobe Presenter menu, select Presentation Settings.
3 Select the Attachments tab.
4 Select an attachment and click Edit or double-click an attachment.
5 Make changes to the name, type (file or link), or location and click OK.
6 Click Close.

**Delete a presentation attachment**
1 In PowerPoint, open a presentation (PPT file).
2 From the Adobe Presenter menu, select Presentation Settings.
3 Select the Attachments tab.
4 Select an attachment and click Delete.
5 Click OK.

If a folder containing attachments is inadvertently deleted, the next time the presentation (PPT) file is opened and saved, a dialog box appears for each deleted attachment stating that the attachment is missing. The dialog box contains three options: browse to the attachment using Windows Explorer, delete the attachment from the presentation, and ignore. If ignore is selected, the dialog box will not appear again unless the presentation is closed, reopened, and then Save is selected.

**Add animation, image, and Flash (SWF) files**
You can incorporate animations and Flash (SWF) files into your Presenter presentations.

If you already have PowerPoint animations, such as flying or dissolving text, Presenter converts them seamlessly and displays them in the final presentation exactly as they appear in PowerPoint. (For the most current list of supported PowerPoint animations, see the Adobe Knowledgebase.)

**Note:** In order for Presenter to gain control of animations, they must be set to OnClick. Animations located on the Slide Master cannot be controlled; remove the animations from the Slide Master and place them on individual slides.

You can also incorporate SWF files into your presentation, including SWF files containing animation and SWF files containing simulations and demonstrations created with Adobe Captivate.
Synchronize audio and animation timings
After previewing your presentation, you might want to edit the timing of PowerPoint animations to better synchronize with added audio files. For example, if you have a slide with bulleted text items that appear one by one, you can adjust the timing so that the audio track matches the action of the text.

1. In PowerPoint, open a presentation (PPT file).
2. From the Adobe Presenter menu, select Synchronize Audio.
3. In the Synchronize Audio dialog box, click Previous or Next, if necessary, to navigate to the slide containing the timing that you want to adjust.
4. Select Change Timings to play the audio.
5. As the audio plays, click Next Animation to synchronize the timing of the first animation with the audio. Select Next Animation again to synchronize the timing of the next animation. Repeat this step for all animations on the slide.
6. When you finish, click Stop Editing.
7. Click OK.

Note: The Synchronize Audio dialog box synchronizes PowerPoint “On mouse click” animations only. In contrast, timed animations use the timing set in the Custom Animation dialog box in PowerPoint.

Pause the presentation after an animation plays
If your presentation includes PowerPoint animations, you can pause the presentation automatically after the animations play. This is useful if you want to clearly define where the animation ends and the presentation begins again.

1. In PowerPoint, open a presentation (PPT file).
2. From the Adobe Presenter menu, select Presentation Settings.
3. Click the Settings tab.
4. Select Pause After Each Animation.
5. Click OK.

When this option is selected, users must click the Play button in the toolbar to start the presentation again after a pause.

Insert a SWF file into a presentation
A Flash (SWF) file is a compiled, view-only Flash file that delivers graphics and animation over the Internet. You can use a SWF file to add content or visual interest (for instance, an animated pointer) to a presentation.

Note: If you have created animated simulations and demonstrations in Adobe Captivate, you can easily add them to your presentations. Certain Adobe Captivate projects, such as training demonstrations or software simulations, can be particularly useful in presentations.

1. Make sure that the file you want to insert meets these specifications:
   • The Flash SWF file has been authored at 30 frames per second. Presenter presentations are created at 30 frames per second, so Flash files with the same setting can be integrated into the presentation smoothly.
• The maximum canvas size is set to 720 x 540 pixels.
• The file uses relative paths to movie clip references, not _root.
• The embedded SWF file does not attempt to make any changes outside its own file; that is, the code does refer to the following variables: _level#, _global, or stage.

2 In PowerPoint, open a presentation (PPT file).
3 Navigate to the slide to which you want to add the SWF file.
4 From the Adobe Presenter menu, select Insert Flash.
5 Navigate to the location of your SWF file. Select the SWF file and click Open. Presenter adds the SWF file to the slide.
6 (Optional) If necessary, select the file and drag it to a new location on the slide.

Note: You can use PowerPoint to preview how the SWF content will appear in your presentation. In PowerPoint, from the View menu, select Slide Show.

Control an inserted SWF through the Presenter playbar
When you add a SWF file to a presentation, you can choose whether to control the SWF file through the Presenter playbar or the playbar in the original SWF file. For example, if you add a Adobe Captivate demonstration SWF file to the presentation, you can control the demonstration through the Presenter playbar in the viewer or the playbar in the Adobe Captivate demonstration.

Ordinarily, you want to control the SWF file through the Presenter playbar, because Presenter buffers the two slides that will be presented next. If you don't control the file through the Presenter playbar, the SWF file could begin playing too early.

1 In PowerPoint, open a presentation (PPT file) containing an added SWF file.
2 From the Adobe Presenter menu, select Presentation Settings.
3 Click the Flash Files tab.
4 Select one of the Flash files in the list.
5 Select the Controlled By Presentation Playbar option to control the SWF file through the Presenter playbar.
6 Click OK.

Set image quality for a presentation
The higher the image quality, the greater the file size. Test different settings to find the best compromise between the two. High quality is best for users with no bandwidth limitations; for users with limited bandwidth, regular or low quality may be better.

1 In PowerPoint, open a presentation (PPT file).
2 From the Adobe Presenter menu, select Preferences.
3 Select the Quality tab.
4 Select an image-quality option:
   • High The largest file size and highest quality image.
   • Medium The best balance between file size and image quality.
   • Low The smallest file size and lowest quality image.
5 (Optional) If you think users might view your presentation on computers with slow connections speeds, select Require Slides To Download Completely Before Playback. If this option is enabled, it will take longer for the presentation to start, but the slides will play smoothly after the presentation begins.

6 (Optional) If your presentation contains Flash movies (for example, Adobe Captivate content), select Disable preloading of embedded Flash movies. This option enables single and multiple SWF files to play properly in the presentation. For example, the option prevents a second SWF file from beginning to play before a first SWF file is finished.

7 Click Close.

Audio in Presentations

Using audio in presentations
Adobe Presenter lets you add narration, music, step-by-step instructions, or almost any sound to your projects. You can use audio to provide instructions or to emphasize key points in the presentation. In general, sound can be as individual and flexible as any other presentation component.

You can use audio in Presenter presentations in a variety of ways. For example, Presenter can help you with the following tasks:

- Adding sound to an individual slide
- Adding special sounds to quizzes for correct and incorrect answers

Presenter lets you record your own audio files (using some simple equipment) or import existing files. Imported files can be in WAV or MP3 format. (If you add a WAV file to a presentation, Presenter automatically converts the WAV file to MP3 format in the generated presentation.)

After you add audio to a presentation, you can synchronize the timing with other content, such as animations. For example, if your presentation contains PowerPoint animations such as text that “flies in,” you can synchronize the animations with the audio. (For more information, see “Add animation, image, and Flash (SWF) files” on page 161.) Presenter also contains features that enable you to add silent periods to audio files and to normalize audio for all slides so that the sound level is consistent.

Add audio files to a presentation
You can quickly add existing WAV or MP3 format audio files to a presentation. Simply import the files and use them as opening music, narration, instructions, or for any other purposes.

1 In PowerPoint, open a presentation (PPT file).
2 From the Adobe Presenter menu, select Import Audio.
3 Select the slide to which you want to add the audio file.
4 Click Browse and navigate to the audio file (WAV or MP3) you want to add to the slide.
5 Select the audio file and click Open. (You can add multiple files. If you select more than one, the first audio file is added to the slide you selected in step 3, the next file to the slide immediately following, and so on.)

Presenter adds the audio file to the selected slide. The name of the audio file appears in the File column, and the length of the audio file appears in the Time column.
**Note:** You can add as many audio files as you want, but they cannot exceed more than 90 minutes of audio per slide in a presentation.

6 (Optional) Select the Ignore Markers option to ignore any sound markers placed in the audio file.

7 (Optional) Select the Compress option to reduce the size of the imported audio file. We recommend compressing audio files when possible. Audio files that are not compressed require significantly more storage space than compressed audio. However, if you have an audio file created with high-quality settings and you want to retain the quality level, consider leaving this option unselected. (Please note that selecting the Compress option will compress all audio in the presentation, not just imported audio. For example, if you use the record audio feature to record some voiceover narration for a slide, that audio file will also be compressed.)

**Recording audio**

In addition to adding existing audio files, you can also record your own audio files to use in Presenter presentations. Follow these tips to ensure that you are recording the highest quality audio possible.

**Setting up audio equipment**

When you have acquired the necessary audio recording equipment, you must set it up properly. First, plug the microphone into the mixer or stand-alone preamplifier, and then plug the output of that device into your computer sound card’s “line in.” Plug the headphones into your computer. Then, set the volume on the mixer or preamplifier. Begin speaking to test the volume levels, and carefully raise the volume until it shows just under zero.

**Setting sound card options**

You can open the software application that controls the sound card. (In most Windows operating systems, you can find sound settings by clicking Start in the lower-left corner and selecting Settings > Control Panel > Sounds.) When you select the recording source (line in), you can adjust the volume to 100%. If you are using a mixer or stand-alone preamplifier, the actual recording level can be controlled from there.

**Note:** Realtek codecs are not compatible with Presenter.

**Changing audio recording settings**

After starting your audio recording software, you can change the settings as necessary. Mixers and preamplifiers don't have sound-level controls, so you rely on the meters when recording. While recording, you should ensure that you don't exceed zero on the meters, or the sound will be distorted.

**Placing the microphone**

Positioning your microphone correctly can make a big difference in the finished audio file. First, get as close as possible to the microphone (within 4 to 6 inches) so that you avoid recording any other nearby sounds. Don’t speak down to the microphone; instead, position it above your nose and pointed down at your mouth. Finally, position the microphone slightly to the side of your mouth, because this can help soften the sound of the letters s and p.

**Improving microphone techniques**

Have a glass of water nearby so you can avoid “dry mouth.” Before recording, turn away from the microphone, take a deep breath, exhale, take another deep breath, open your mouth, turn back toward the microphone, and start speaking. This can eliminate breathing and lip-smacking sounds frequently recorded at the beginning of audio tracks. Speak slowly and carefully. You may feel that you are speaking artificially slowly, but you can adjust the speed later by using your audio recording software. Finally, keep in mind that you don’t have to get everything right the first time. You can listen and evaluate each recording and re-record if necessary.
Editing sound
Editing sound is similar to editing text. You should listen carefully to your recording, delete any extraneous sounds, and then use the options available in your software to polish the sound. You can add any music or sound effects you require, but make sure to save your audio track in the correct format (MP3 or WAV files).

Reviewing the presentation
After you have added the audio to the presentation, listen to it again. You should view the presentation as users normally would. Finally, it helps to ask others to preview the presentation file. If necessary, you can edit the audio again, on a per-slide basis.

About audio recording equipment
Having the right audio equipment makes a big difference in the quality of recorded audio. Surprisingly, basic audio equipment can be relatively inexpensive; your equipment should include some if not all of the following:

**Computer with a sound card** The sound card installed in your computer acts as a digital recorder for audio.

**Microphone** If possible, avoid using the USB microphone packaged with your computer. Use a professional-quality microphone cable and a stand to hold the microphone while you are recording.

**Microphone preamplifier** A preamplifier boosts the signal of the microphone. The microphone input of your computer's sound card probably includes a preamplifier, but it's most likely a poor quality one. When purchasing a preamplifier, you can choose a small mixer or a stand-alone version. Mixers let you connect several microphones and devices to one location, and you can adjust their volumes independently. Stand-alone preamplifiers can be better than mixers at filtering out unwanted noises.

**Speakers** The speakers that came with your computer are probably good enough for listening to any audio you record. For best results, check the specifications of your speakers and use the highest quality speakers possible.

In Microsoft Windows operating systems, you can usually find speaker (sound) settings by clicking Start in the lower-left corner and selecting Settings > Control Panel > Sounds.

**Recording software** A wide range of recording software is available. Important software features include editing capabilities (to fix mistakes), music and sound-effect options, and the capability to create the file format you require (such as MP3 or WAV).

**Recording area** You need a quiet place to record. Try closing doors, turning off any unnecessary computer equipment, turning off or lowering lights that might be making noise, turning off phone ringers, beepers, and pagers. Also, tell coworkers that recording is in progress.

Set audio recording quality
Audio files present the common challenge of balancing quality against size. The higher the sound quality, the larger the file size. The more you compress a sound and the lower the sampling rate, the smaller the file size and the lower the quality. Presenter lets you control the way sound is recorded and compressed based upon your input and output requirements.

Creating audio in Presenter is essentially a two-part process: you record audio in WAV format and then Presenter converts the WAV file into an MP3 file.
Of course, when working with audio, you must keep your users’ connection speed in mind. If a user is likely to access the Presenter presentation by using a dial-up modem, use a higher compression and lower sampling rate, such as 56 Kbps. However, if you are distributing the presentation on a CD-ROM, you can use a lower compression and higher sampling rate, such as 144 Kbps. In the best development case, you should experiment to find the optimal balance between sound quality and file size for your users.

1. In PowerPoint, open a presentation (PPT file).
2. From the Adobe Presenter menu, select Preferences.
3. Select the Quality tab.
4. Select an audio quality level. Remember that a higher quality level results in a larger audio file size. (To publish the presentation without including any audio files, select Publish without audio.)
5. (Optional) If you think users might view your presentation on computers with slow connections speeds, select Require Slides To Download Completely Before Playback. If this option is enabled, it will take longer for the presentation to start, but the slides will play smoothly after the presentation begins.
6. (Optional) If your presentation contains Flash movies (for example, Adobe Captivate content) on consecutive slides, select Disable preloading of embedded Flash movies. This option prevents a second SWF file from beginning to play before a first SWF file is finished.
7. Click OK.

**Change the audio input source**

If you are recording audio for a presentation, you can either use a microphone or the line-in option that is usually included with an external audio device such as a tape deck or stereo amplifier.

1. In PowerPoint, open a presentation (PPT file).
2. From the Adobe Presenter menu, select Preferences.
3. Select the Audio Source tab.
4. In the Audio Input Source area, select either Microphone or Line in.
5. (Optional) Select the Always Prompt to Set Microphone Level Before Recording option if you want to calibrate the microphone before each recording session. This is useful if you use different microphones or if you record in different environments (for instance, a quiet room versus an area with background noise).
6. Click Close.

**Calibrate microphones for recording**

If you are recording audio for a presentation, you must set the microphone or recording device to the correct recording level. This process is called calibrating the recording device. Presenter can detect optimal microphone and recording sensitivity levels automatically.

Presenter must detect your recording device before calibrating it. Before you calibrate, check that your recording device is connected to your computer properly and is turned on.

**Note:** Realtek codecs are not compatible with Presenter.

1. In PowerPoint, open a presentation (PPT file).
2. From the Adobe Presenter menu, select Record Audio.

The Set Microphone Recording Level dialog box appears.
3 To set the correct recording device level, speak the following sentence into the microphone until the red recording window becomes green: “I am setting my microphone recording level for use with Presenter.”

4 When you finish, click OK.

**Record audio**

If you have a microphone connected to your computer, you can record audio for inclusion in a slide. You can use audio for many types of narration or instruction.

![Record audio buttons]

A. Record  B. Play  C. Pause  D. Stop

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Record Audio.

3 Calibrate your microphone by following the instructions in the Set Microphone Recording Level dialog box.

4 Click OK.

5 Click Record Audio to begin recording.

6 Speak into the microphone or recording device.

7 When you finish, click Stop.

Presenter converts the audio to MP3 format.

8 Click Play to listen to the recording.

9 (Optional) Click Previous or Next to record audio for another slide.

10 When you finish, click OK.

**Record audio for a specific location in a presentation**

At times, you may need to record and add some audio to a specific location within a presentation. (To record audio, you must have a microphone or recording device plugged into your computer.)

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Audio Editor.

3 Click the location within the waveform to which you want to add new, recorded audio. For example, if you have an audio file playing on slide 1 and you need to add audio at the start, click the beginning of the audio file on slide 1. You can add audio to any location on the waveform, even a location that does not currently have audio.

4 From the Insert menu, select Recording.

5 Set the type of recording device you are using by clicking the drop-down menu under Input Source and selecting either microphone or line in.
6 Set the Volume level at which the recording should be made. The default setting is 100%. To change the setting, slide the volume slider bar to the left or right.

7 To set the optimal recording level and sensitivity for your input source (microphone or line in), click Calibrate.

8 To begin recording, click the Start Recording button and begin talking.

Length The length of the recording as you record.

Stop Click this Stop button to end recording.

9 To listen to the recording, click the Play button.

10 Click OK. The audio you just recorded is added to the location you specified on the waveform.

Import slide notes
If you have created slide notes in PowerPoint, you can import the notes into the script window in the Record Audio dialog box or the Synchronize Audio dialog box. This is useful if you want to use the slide notes as a script when recording an audio file as voice-over narration.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Record Audio or Synchronize Audio.

3 If necessary, select the View script option.

4 Click Import Notes.

5 Select the slide notes to import:

Current Slide Imports notes from the slide that is currently displayed.

All Slides Imports notes from all slides in the presentation.

Slides Lets you select slides in the presentation. To select multiple slides, hold down Shift or Control and select the slide numbers in the list.

6 Select the import options:

Append Imported Notes To Current Scripts Adds imported notes to the end of existing scripts.

Replace Current Scripts With Imported Notes Removes existing scripts before importing the notes selected on this dialog box.

7 Click OK.
Export scripts into PowerPoint
You may have used the Record Audio dialog box or Synchronize Audio dialog box to create or modify a script in Presenter. If so, you can export the script to PowerPoint as slide notes.

1. In PowerPoint, open a presentation (PPT file).
2. From the Adobe Presenter menu, select Record Audio or Synchronize Audio.
3. If necessary, select the View script option.
4. Click Export Script.
5. Select the scripts to export. You can choose the current script, all scripts, or scripts on specific slides.
6. Select an export option. You can append scripts to existing PowerPoint notes (adding script text to the end of any existing PowerPoint slide notes text) or replace existing PowerPoint notes with scripts.
7. Click OK.

Add silence to an audio file
You can add a period of silence to any audio file that is part of a Presenter presentation. This feature is particularly useful in the following situations:

- If you import an audio file and need to synchronize the audio with slides
- If you need to make an existing audio file work in a presentation without having to edit the audio extensively
- If you have inserted a Flash file with audio, such as a “talking head” video of a speaker, into a presentation and want to synchronize the Flash file audio with slides

1. In PowerPoint, open a presentation (PPT file) containing audio files.
2. From the Adobe Presenter menu, select Audio Editor.
3. Use the Audio Editor to add silence anywhere in a presentation, including a specific location within an audio file. Click the location in the presentation, or the exact location within an audio file, on the waveform to which you want to add the silent period.
4. From the Insert menu, select Silence.
5. In the Insert text box, enter a number specifying the duration of silence (in seconds).
6. In the Seconds at text box, specify where to add silence:
   - **Cursor Position (default)** This option adds silence at the point in the waveform you selected in step 3.
   - **Start of Slide** This option adds the silent period to the beginning of the slide containing the location selected in step 3.
   - **End of Slide** This option adds the silent period to the end of the slide containing the location selected in step 3.
7. Click OK.
Presenter adds the silent period to the audio file and displays it as a waveform.
8. To test the audio file with the silence added, click Play in the lower-left corner of the Audio Editor dialog box.
Adjust audio volume
You can adjust the volume of audio files included in your presentations. After adjusting the volume, preview the presentation to see if the sound level is acceptable.

1. In PowerPoint, open a presentation (PPT file) containing audio files.
2. From the Adobe Presenter menu, select Audio Editor.
3. From the Tools menu, select Volume.

The Adjust Volume dialog box appears.

4. Click the volume slider on the left, and drag it up to increase volume, or down to decrease volume.
5. You can change the audio processing options, as follows:

**Normalize** Adjusts the sound volume automatically. Normalizing audio helps keep the sound level consistent between slides.

**Dynamics** Amplifies quiet sections of the audio to help compensate for variations in audio volume.

6. (Optional) Click Advanced Controls.

**Ratio** Specifies the maximum amplification that Presenter will use. The default setting of 2.0 sets the quietest sections of the audio to be amplified by a factor of 2. A higher setting can improve a project that has large disparities between quiet and loud sections, but can also amplify background noise.

**Noise Threshold** Controls the amplification of background noise. Presenter doesn't amplify any sound below the threshold. If background noise is amplified too much, try a higher noise threshold. (Note that the Dynamics option does not work well with high noise levels.)

7. When you finish, click OK twice to close all the dialog boxes.

Edit audio files
You can edit the audio in your presentation at any time. Using Audio Editor, you can listen to an audio file, insert silence, adjust volume, and change a number of other options.

1. In PowerPoint, open a presentation (PPT file) containing audio files.
2. From the Adobe Presenter menu, select Audio Editor.

![Diagram of Audio Editor window with labels A to I]

*Use the Audio Editor to edit audio files you record for a presentation or import into a presentation.*

A. Select a slide from the pop-up menu  B. Slide divider and Red marker line  C. Time  D. Waveform  E. Audio files  F. Place cursor or drag to select for editing  G. Playhead  H. Total or selected playing time  I. Scale
Use the buttons and menu options to make any necessary edits. You can cut and paste sections of the audio file, insert periods of silence to lengthen the audio file, adjust volume, import a different audio file, and more.

**Cut** Cuts the selected portion of the audio file.

**Copy** Copies the selected portion of the audio file.

**Paste** Pastes information from the Clipboard. (For example, if you select a section of the audio file, and then click Cut or Copy, Presenter places the selected audio on the Clipboard. You can then click Paste to place the audio back into any location within the audio file.)

**Delete** Removes the selected portion of the audio file.

**Undo** Undoes the previous action.

**Redo** Redoes the previous action.

**Zoom In** Enlarges the waveform.

**Zoom Out** Shrinks the waveform.

**Record/Insert New Audio** Begins recording audio. (You will need a microphone.)

**Play** Starts the audio file.

**Pause** Temporarily stops the slide from playing. (Click Play to resume playing the audio file.)

**Stop** Ends playback of the audio file.

**Slide Number** Specifies the slide selected in the waveform. For example, slide 4 or 12.

**Playhead** Specifies the selected location, in seconds, within an individual slide on the waveform. For example, if you are working with a slide that is 5 seconds long and you click in the middle of the slide on the waveform, this playhead area displays approximately 00:00:02.500.

**Selected** Specifies the total playing time of the presentation, if no span of time is selected on the waveform. If you have selected a span of time on the waveform, this area displays the amount of time selected.

**Scale** Specifies the scale at which the waveform is displayed. (To change the scale, click Zoom In or Zoom Out.)

When you finish editing the audio file, click OK.

---

**Manage audio files with the Audio Editor**

Presenter lets you edit the timing of audio files after you record or import them. Having control over the timing of audio files gives you the ability to use audio files of different lengths and incorporate them smoothly into presentations.

After you record or import an audio file, the file appears as a waveform in the Audio Editor dialog box. If your presentation contains multiple audio files, you can see which audio files are assigned to specific slides.

**Edit audio timing**

1. In PowerPoint, open a presentation (PPT file) containing audio files.

2. From the Adobe Presenter menu, select Audio Editor.

In the Audio Editor dialog box, Presenter displays any audio files incorporated into the presentation as waveforms. Slide numbers along the top of the waveform show exactly how the audio files are currently distributed across the slides. Presenter lets you import or create an audio file and then distribute that audio file across multiple slides.
Change how audio files are distributed across slides
❖ In the Audio Editor, click a slide divider at the top of a red slide marker line and slide the divider to the left or right.

The waveform remains static, but you can change where the audio file begins to play within the presentation. This option is particularly useful if you have a long audio file and need to experiment with assigning the file to one slide or having it play over multiple slides.

Listen to an audio file
❖ In the Audio Editor, click a location within the waveform and then click Play in the lower-left corner of the Audio Editor dialog box or press the spacebar on your keyboard.

The audio plays from the location you selected to the end of all audio in the presentation. (You can stop the playback at any time by clicking Stop in the lower-left corner of the Audio Editor dialog box or pressing the spacebar on your keyboard.)

Zoom in on an area of the waveform
❖ In the Audio Editor, click the waveform and then click the Zoom In or Zoom Out icon in the toolbar. (Alternatively, click in the waveform and roll your mouse wheel to zoom in and out).

The scale at which you are viewing the waveform is shown in the Scale information box in the lower-right corner of the dialog box.

After you have added audio files to your presentation, you can use the Audio Editor to cut or copy entire audio files or portions of audio files and paste them in a new location.

Cut or copy and paste audio
❖ In the Audio Editor, select a section of an audio file directly on the waveform, click Cut or Copy, click a different location on the waveform, and click Paste.

Delete an entire audio file or portion of an audio file
❖ In the Audio Editor, select a section of an audio file directly on the waveform and click Delete.

Set audio quality for a presentation
Because higher audio quality results in a larger file size, experiment to achieve the correct balance between quality and file size. (The default setting is Medium.)

1 In PowerPoint, open a presentation (PPT file).
2 From the Adobe Presenter menu, select Preferences.
3 Select the Quality tab.
4 Under Audio quality, select one of the following options:
   - **High** The largest file size and highest quality audio.
   - **Medium** The best balance between file size and audio quality.
   - **Low** The smallest file size and lowest audio quality.
   - **Publish Without Audio** Removes audio files from the presentation before publishing.
5 Click Close.

**Preplay audio**
A quick way to listen to the audio you added to a presentation is to play the slide show directly from within the Audio Editor.
1 In PowerPoint, open a presentation (PPT file) containing audio files.
2 From the Adobe Presenter menu, select Audio Editor
3 From the View menu, select Slide Show.
4 When you finish, click Close.

**Adding quizzes and questions**

**Creating quizzes and questions**
You can use Adobe Presenter to create interactive e-learning presentations that are SCORM or AICC compliant for use with a learning management system. When you create e-learning content for presentations, you can create a combination of quizzes and questions.

Quizzes are the “containers” that hold questions. You can use the Quiz Manager to create a single quiz for a presentation or multiple quizzes in a single presentation. Then you add questions to the quiz or quizzes. You can add graded questions, survey questions, or a combination of both to each quiz. Quizzes are assigned an Objective ID, a number that specifies an objective set in your learning management system or Connect Enterprise Server. Using quizzes and their default Objective IDs is the best way to coordinate Presenter presentations with Connect Enterprise Server and content that already exists.
The Quiz Manager lets you organize all of the quizzes and questions in a presentation.  
A. A quiz  B. Different types of questions

When you create a question, a new slide is added to your presentation. The new slide's design is based on the master slide template (a PowerPoint feature), so the question slide will look like the other slides in your presentation.

You can design six types of questions in Presenter: multiple-choice, short-answer, matching, true-or-false, rating scale (Likert), and fill-in-the-blank questions. You can grade the questions or use them in surveys to gather information.

Branching in quizzes
Branching is an important concept in creating effective e-learning materials and a useful way to customize presentations. In branched presentations (sometimes called “contingency branching”), the path that users take through a quiz or survey is determined by their responses to questions. For instance, you can create branches based on correct answers, incorrect answers, options selected by the user, or the user's experience, job description, level, or any other category. Depending on these factors, you can continue the presentation, jump to a specific slide, open a URL, and so on.

Through branching, you can specify what happens when users answer questions correctly or incorrectly. For example, you can associate one action (such as “Go to the next slide”) to a correct answer and another (such as “Open URL”) to an incorrect answer.

Reporting
Reporting lets you track student performance with any type of quiz. You can track the number of attempts, log correct and incorrect responses, and send pass/fail data to Connect Enterprise Server. You can also choose to provide students with feedback based upon correct or incorrect responses.
Tips for creating quizzes and questions
Here are a few tricks and tips to try when adding quizzes to your presentation:

• When creating a matching question, drag items between the two columns to establish the correct matches.
• Try customizing feedback messages to accurately communicate with presentation users.
• Experiment with branching to customize presentations for different types of users.
• Consider adding custom audio feedback based on how users answer questions. You can select different audio for a correct answer and an incorrect answer.
• Try editing the settings in the Show Score at End of Quiz option. You can write custom pass and fail messages, design the slide using background colors, and choose how to display the score.
• Always create questions in the Quiz Manager. For example, while in PowerPoint, do not copy a quiz slide in the left pane and paste to create a “new” quiz slide. This results in two slides with the same interaction ID, which is not supported by learning management systems.
• If a change is made in the question by editing the slide contents, open the Quiz Manager once before publishing the presentation. Quiz validation and updating is done only when the Quiz Manager is opened.
• Change the text formatting of quiz questions after the entire quiz is generated. For example, you can create and generate the quiz, and then use the PowerPoint Format menu to change the font size. If question text is formatted and then the Quiz Manager is opened, the formatting may be lost because the Quiz Manager usually renders the question again if there have been any changes.

Create a quiz
When you open the Quiz Manager for the first time, a default quiz is displayed. You can use the default quiz or add more quizzes as necessary. Follow these steps to add a quiz:

Note: If you are creating a quiz that consists of only survey questions, the user has only one chance to take the quiz. Try to keep the length of survey-only quizzes fairly short, for example, 15-20 questions, so users can complete the survey easily.

1 In PowerPoint, open a presentation (PPT file).
2 From the Adobe Presenter menu, select Quiz Manager. (If this is a new presentation, you must save it first before you can add a quiz.)
3 In the Quiz Manager, click Add New Quiz.
4 In the New Quiz dialog box, accept the default name or enter a new name in the Name text box.
5 From the pop-up menu next to Required, select an option to determine if users must take or pass the quiz. When selecting an option, consider how the quiz fits in with your e-learning strategy for the presentation. For example, you can require users to pass the quiz or allow them to skip the quiz.

Optional The learner may attempt the quiz, but is not required to take the quiz.
**Required** The learner is required to at least attempt the quiz. A quiz attempt is defined as answering (selecting or typing an answer and pressing Submit) at least 1 question in the quiz. Simply viewing a question is not considered an attempt. Until the learners answer at least 1 question in the quiz, they are not permitted to move forward in the presentation beyond the last question slide in that quiz. The required option does not, however, limit the learner from navigating among slides within a given quiz.

**Pass Required** The learner must pass this quiz to continue. If you select this option, all navigation to any slide past the end of the quiz is prohibited until the learner achieves a passing score. This restriction affects both learner-initiated navigation (for example, clicking forward or back buttons on the playbar or clicking on a slide in the Outline pane), and author-initiated branching (for example, immediate question and quiz feedback). If you select the Pass Required option, you must show a scoring slide. The scoring slide tells learners why they cannot move past the quiz. If no scoring slide is chosen, the Pass Required option behaves the same as Optional and no navigation restrictions exist.

**Answer All** The learner must answer every question. The questions must be answered in order and no questions can be skipped.

6 Select the options you want to incorporate into the quiz:

- **Allow backward movement** (Optional) Enables learners to click the Back button on the playbar to move backward. If you leave this option unchecked, learners cannot move backward when taking a quiz. (This prevents learners from seeing quiz questions and then going back to earlier slides to look up correct answers.)

- **Allow user to review quiz** (Optional) Displays a Review Quiz button on the scoring slide. Learners can click the button and be taken back to the first question slide in the quiz. The learner can see their answer to each question, whether their answer is correct, and, if the selected answer was not correct, which is the correct answer. Reviewing a quiz is strictly informational; learners cannot change their answers while reviewing.

- **Show score at end of quiz** (Optional) Displays a scoring slide at the end of the quiz. You can write custom pass and fail messages, design the slide using background colors, and choose how to display the score.

- **Show questions in outline** (Optional) Displays the name of the question slide in the outline when users see the presentation in the Presenter viewer.

7 Click the Pass or Fail Options tab.

8 Select an option in the Pass/Fail scoring area. Specify a passing score either as a percentage (for instance, 80% correct) or a number of correct answers (for instance, 8 out of 10).

9 Select the actions that take place when users receive a passing grade or a failing grade. For example, use the pop-up menu next to Action and select Go To Slide to display a specific slide in response to passing or failing.

10 Click OK.

The quiz is added to the presentation.

**Note:** If you are using the “allow backward movement” option, it is important to set the correct answering options. If “allow backward movement” is not selected (unchecked), set the Quiz Options to “answer all” and set the number of allowable quiz attempts to 1. If a quiz is set to any option other than “answer all,” select (check) the “allow backward movement” option. This prevents the situation where, if a learner is allowed to skip over a question, and the “allow backward movement” option is not selected, the learner cannot go back and answer questions they may have skipped. In most cases it is better to not select the “allow backward movement” option.

11 Click OK again.
Add questions to presentations
In Presenter, you can add six different types of questions to presentations. Each type of question contains different options. Click the links below for details about adding each of the six types.

See also
“Add a fill-in-the-blank question to a presentation” on page 182
“Add a matching question to a presentation” on page 187
“Add a multiple-choice question to a presentation” on page 178
“Add a rating scale question to a presentation” on page 189
“Add a short-answer question to a presentation” on page 185
“Add a true-or-false question to a presentation” on page 180

Add a multiple-choice question to a presentation
In Presenter, you can have multiple-choice questions branch according to the user's response. For example, in a question with three possible answers, you can set up branching in this way: If the user selects the first answer, go to the next slide; if the second, jump to a slide later in the quiz; if the third, open a web page.

1 In PowerPoint, open a presentation (PPT file).
2 Select the slide before the one in which you want to insert a question. For example, if you want the new question to be slide 7 in the presentation, click slide 6.
3 From the Adobe Presenter menu, select Quiz Manager.
4 Select the quiz to which you want to add a question and click Add New Question.
5 In the Question Types dialog box, select Multiple Choice and specify whether to grade the question:

Create Graded Question The question will be graded.
Create Survey Question The question will not be graded.

6 On the Question tab, accept the default text for the name or enter a new name in the Name text box. The name appears on the question slide in the presentation.

If you are creating more than one question of the same type (for example, multiple-choice, short answer, etc.) in a single presentation, type a unique name for each so that you distinguish between them.

7 In the Question text box, type the multiple-choice question exactly as you want it to appear on the slide. (The question text box cannot be left blank.)

8 In the Points text box, type in (or use the up and down arrows to specify) the number of points allocated to this question. Assigning points signifies the relative importance of a question. By assigning different point values to different questions, you can give introductory questions a lower value than advanced questions, for example. You can enter any whole number value. If all questions have the same value (for example, 10 points), they are scored equally.

9 In the Answers area, click Add and enter possible answers. (A multiple-choice question requires at least 2 answers.) If necessary, click Delete to remove an answer from the list.
10 (Optional) Click Advanced to set options for individual answers, such as a custom feedback message, a specific action, or audio. (If you have a particularly long answer, the Advanced Answer Options dialog box gives you more space to type in the answer.)

11 Select the radio button next to the correct answer.

12 In the Type pop-up menu, select whether there are multiple correct responses or a single correct response. If you select multiple correct responses, be sure to return to step 11 and select the radio buttons next to all correct responses. Also, the Advanced features described in step 10 are enabled only if you select single correct response.

13 In Numbering, use the pop-up menu to specify how answers are listed on the slide. You can choose from uppercase letters, lowercase letters, or numbers.

14 Select the Options tab.

15 (Optional) From the Type pop-up menu, select question type: Graded or Survey.

16 Select Show Clear Button to display a button on the question slide that users can click to clear their answers and start over.

17 In the If Correct Answer area, set the following options:

- **Action**: Select which action should follow a correct response. You can advance to the next slide (Go To Next Slide, the default action), jump to another slide in the presentation (Go To Slide), or display a web page (Open URL). If you display a web page, type its address in the Open URL text box and then specify where to display the web page (choose Current to have the web page replace the presentation or New to display the web page in another window).

- **Go To Next Slide**: Depending on the option you selected for Action, this text box lets you specify an exact destination.

- **Play Audio Clip**: Select this option to import an audio file or record a new audio file that should play when the question is answered correctly. Use the Record, Stop, Remove, and Import buttons as necessary. (If you have already recorded audio, a Play button replaces the Record button. To re-record audio, you must first remove the audio, and then select Record.)

**Note**: If a question has an audio clip and an action, the audio clip plays before the action takes place.

- **Show Correct Message**: Select this option to provide a text message for users when they supply a correct answer. Clear this check box if you don’t want to give any feedback for a correct answer.

18 In the If Wrong Answer area, set the following options:

- **Allow User [#] Attempts**: Use the arrows or type directly into the text box to specify how many guesses the user can make before another action takes place. An attempt is defined as anytime a user opens and views the question slide. (Setting the number of attempts to 1 prevents the presentation from proceeding if the user exits and then attempts to enter the quiz again. Do not set attempts to 1 if you plan to use your presentation in a meeting or place in an archive.)

- **Infinite attempts**: Select this option to give users an unlimited number of attempts.

- **Action**: Click the desired action/destination after the last attempt. You can advance to the next slide (Go To Next Slide, the default action), jump to another slide in the presentation (Go To Slide), or display a web page (Open URL). In the Open URL text box, type the address of the web page and then specify where to display the web page (choose Current to have the web page replace the presentation or New to display the web page in another window).

- **Go to Next Slide**: Depending on the option you selected for Action, this text box lets you specify an exact destination.

- **Play Audio Clip**: Select this option to import an audio file or record a new audio file that should play when the question is answered incorrectly. Use the Record, Stop, Remove, and Import buttons as necessary.
**Show Error Message** Select this option to provide a text message for users when they supply an incorrect answer. Clear this check box if you don’t want to give any feedback for an incorrect answer.

**Show Retry Message** Select this option to provide a text message for users who give an incorrect answer but have remaining attempts (for instance, “Please try again”).

**Show Incomplete Message** Select this option to provide a text message for users who don’t supply an answer (for instance, “Please select an answer before continuing”).

*Note:* You can edit the default text in the correct, error, retry, and incomplete messages in the Quiz Manager. From the Adobe Presenter menu, select Quiz Manager and click the Default Labels tab.

19 Select the Reporting tab. You can accept the default settings or, if necessary, modify the following options:

**Report Answers** Sends answer information to Connect Enterprise Server or a learning management system.

**Quiz** Name of the quiz to which this question is assigned. You can select a different quiz from the pop-up menu.

**Objective ID** This is a number automatically created when you create a quiz. This number is used to report scores from Presenter presentations that will be tracked in Connect Enterprise Server or a learning management system.

**Interaction ID** Accept the default number or type a new number directly into the text box. The maximum length of an interaction ID is 64 characters. If you want the Presenter presentation to send tracking information to Connect Enterprise Server, you must use the Interaction ID specified by Connect Enterprise Server.

*Note:* If you create a new question by copying and pasting an existing question slide, you must enter a new, unique, Interaction ID so that each individual question is reported properly to Connect Enterprise Server. We do not recommend creating new questions by copying and pasting; always create new questions using the Quiz Manager.

20 When you finish, click OK.

21 Click OK again to close the Quiz Manager.

The new multiple-choice question slide appears in the designated location in the presentation.

---

**Add a true-or-false question to a presentation**

Users answer true-or-false questions by selecting either True or False (or Yes or No) as an answer.

1 In PowerPoint, open a presentation (PPT file).

2 Select the slide before the one where you want to insert a question. For example, if you want the new question slide to be slide 7 in the presentation, click slide 6.

3 From the Adobe Presenter menu, select Quiz Manager.

4 Select the quiz to which you want to add a question and click Add New Question.

5 In the Question Types dialog box, select True/False and specify whether the question will be graded:

- **Create Graded Question** The question will be graded.
- **Create Survey Question** The question will not be graded.

6 On the Question tab, accept the default text for the name or enter a new name in the Name text box. The name appears on the question slide in the presentation.

   *If you are creating more than one question of the same type (for example, multiple-choice, short answer, etc.) in a single presentation, type a unique name for each so that you distinguish between them.*

7 In the Question text box, type the true-or-false question exactly as you want it to appear on the slide. (The question text box cannot be left blank.)
In the Points text box, type in (or use the up and down arrows to specify) the number of points allocated to this question. Assigning points signifies the relative importance of a question. Assigning different point values to different questions lets you, for example, give introductory questions a lower value and advanced questions a higher value. You can enter any whole number value. If all questions have the same value (for example, 10 points), they are scored equally.

In the Answers area, establish which answer is correct by selecting either True or False.

In the Type pop-up menu, select True or False, or Yes or No. You can also write your own phrases to use such as “Valid” and “Invalid.”

In Numbering, use the pop-up menu to select an option for how answers are listed on the quiz slide. You can choose from uppercase letters, lowercase letters, or numbers.

Select the Options tab.

(Optional) From the Type pop-up menu, select the question type: Graded or Survey.

Select Show Clear Button to insert a button on the slide that users can click to clear their answers and start over.

In the If Correct Answer area, set the following options:

**Action** Select which action should follow a correct response. You can advance to the next slide (Go To Next Slide, the default action), jump to another slide in the presentation (Go To Slide), or display a web page (Open URL). If you display a web page, type its address in the open URL text box and then specify where to display the web page (choose Current to have the web page replace the presentation or New to display the web page in another window).

**Go to Next Slide** Depending on the option you selected for Action, this text box lets you specify an exact destination.

**Play Audio Clip** Select this option to import an audio file or record a new audio file that should play when the question is answered correctly. Use the Record, Stop, Remove, and Import buttons as necessary. (If you have already recorded audio, a Play button replaces the Record button. To re-record audio, you must first remove the audio, and then select Record.)

**Note:** If a question has an audio clip and an action, the audio clip plays and then the specified action takes place.

**Show Correct Message** Select this option to provide a text message for users when they supply a correct answer. Clear this check box if you don’t want to give any feedback for a correct answer.

In the If Wrong Answer area, set the following options:

**Allow User [#] Attempts** Use the arrows or type directly into the text box to specify how many guesses the user can make before another action takes place. An attempt is defined as anytime a user opens and views the question slide. (Setting the number of attempts to 1 prevents the presentation from proceeding if the user exits and then attempts to enter the quiz again. Do not set attempts to 1 if you plan to use your presentation in a meeting or place in an archive.)

**Infinite Attempts** Select this option to give users an unlimited number of attempts.

**Action** Click the desired action/destination after the last attempt. You can advance to the next slide (Go To Next Slide, the default action), jump to another slide in the presentation (Go To Slide), or display a web page (Open URL). If you display a web page, type its address in the Open URL text box and then specify where to display the web page (choose Current to have the web page replace the presentation or New to display the web page in another window).

**Go to Next Slide** Depending on the option you selected for Action, this text box lets you specify an exact destination.

**Play Audio Clip** Select this option to import an audio file or record a new audio file that should play when the question is answered incorrectly. Use the Record, Stop, Remove, and Import buttons as necessary.
**Show Error Message**  Select this option to provide a text message for users when they supply an incorrect answer. Clear this check box if you don't want to give any feedback for an incorrect answer.

**Show Retry Message**  Select this option to provide a text message for users who give an incorrect answer but have remaining attempts (for example, “Please try again”).

**Show Incomplete Message**  Select this option to provide a text message for users who don't supply an answer (for example, “Please select an answer before continuing”).

*Note:* You can edit the default text in the correct, error, retry, and incomplete messages in the Quiz Manager. From the Adobe Presenter menu, select Quiz Manager and click the Default Labels tab.

17  Select the Reporting tab. You can accept the default settings or, if necessary, modify the following options:

**Report Answers**  This option sends answer information to Connect Enterprise Server or a learning management system.

**Quiz**  Name of the quiz to which this question is assigned. You can select a different quiz from the pop-up menu.

**Objective ID**  This is a number automatically created when you create a quiz. This number is used to report scores from Presenter presentations that will be tracked in Connect Enterprise Server or a learning management system.

**Interaction ID**  Accept the default number or type a new number directly into the text box. The maximum length of an interaction ID is 64 characters. If you want the Presenter presentation to send tracking information to Connect Enterprise Server, you must use the Interaction ID specified by Connect Enterprise Server.

*Note:* If you create a new question by copying and pasting an existing question slide, you must enter a new, unique, Interaction ID so that each individual question is reported properly to Connect Enterprise Server. We do not recommend creating new questions by copying and pasting; always create new questions using the Quiz Manager.

18  When you finish, click OK.

19  Click OK again to close the Quiz Manager.

The new true-or-false question slide appears in the designated location in the presentation.

### Add a fill-in-the-blank question to a presentation

Fill-in-the-blank questions contain a blank space that users fill in by entering text (such as a word or phrase) or selecting from a list of possible answers.

1  In PowerPoint, open a presentation (PPT file).

2  Select the slide before the one where you want to insert a question. For example, if you want the new question slide to be slide 7 in the presentation, click slide 6.

3  From the Adobe Presenter menu, select Quiz Manager.

4  Select the quiz to which you want to add a question and click Add New Question.

5  In the Question Types dialog box, select Fill-in-the-blank and specify whether to grade the question:

- **Create Graded Question**  The question will be graded.
- **Create Survey Question**  The question will not be graded.

6  On the Question tab, accept the default text for the name or enter a new name in the Name text box. The name appears on the question slide in the presentation.

*If you are creating more than one question of the same type (for example, multiple-choice and short answer) in a single presentation, type a unique name for each so that you distinguish between them.*
In the Description text box, accept the default text for Description or enter a new description. The description appears on the questions slide in the presentation and should give users instructions about how to answer the question. (The Description field cannot be left blank.)

In the Points text box, type in (or use the up and down arrows to specify) the number of points allocated to this question. Assigning points signifies the relative importance of a question. Assigning different point values to different questions lets you, for example, give introductory questions a lower value and advanced questions a higher value. You can enter any whole number value. If all questions have the same value (for example, 10 points), they are scored equally.

In the Phrase text box, type in the entire sentence or phrase that will contain a blank space to be completed by users or will contain a blank space with a drop-down list of possible answers for users to select from.

Select the word or phrase that you intend to be the blank area and click Add Blank. You can have a maximum of 8 blanks in a question. (When a blank is created, the blank is represented by "<i>" in the dialog box with the ”i” representing the number assigned to the blank. Do not edit the text ”<i>” manually. Use the Add blank and Delete blanks buttons to achieve the desired results.)

In the Blank Answer dialog box, specify how users will choose the correct answer:
- The User Will Type in the Answer, Which Will Be Compared to the List Below
- The User Will Select an Answer from the List Below

If necessary, click Add and enter more words or phrases that correctly fill in the blank space in the question. Click Add and Delete as necessary to create a list of correct answers.

(Optional) Select The answer is case-sensitive to require that users type in the correct combination of lowercase and uppercase letters when filling in the blank. For example, if the answer to the question is "Windows" and you select the case-sensitive option, an answer of "windows" is incorrect.

Click OK.

Select the Options tab.

(Optional) In Type, use the pop-up menu to change the question type to Graded or Survey.

Select Show Clear Button to display a button on the question slide that users can click to clear their answers and start over.

In the If Correct Answer area, set the following options:
- Action Select which action should follow a correct response. You can advance to the next slide (Go To Next Slide, the default action), jump to another slide in the presentation (Go To Slide), or display a web page (Open URL). If you display a web page, type its address in the Open URL text box and then specify where to display the web page (choose Current to have the web page replace the presentation or New to display the web page in another window).
- Play Audio Clip Select this option to import an audio file or record a new audio file that should play when the question is answered correctly. Use the Record, Stop, Remove, and Import buttons as necessary. (If you have already recorded audio, the record button will be a Play button. To re-record audio, you must first remove the audio, and then select Record.)

Note: If a question has an audio clip and an action, the audio clip plays and then the specified action takes place.

- Show Correct Message Select this option to provide a text message for users when they supply a correct answer. Clear this check box if you don't want to give any feedback for a correct answer.
In the If Wrong Answer area, set the following options:

**Allow User [#] Attempts** Use the arrows or type directly into the text box to specify how many guesses the user can make before another action takes place. An attempt is defined as anytime a user opens and views the question slide. (Setting the number of attempts to 1 prevents the presentation from proceeding if the user exits and then attempts to enter the quiz again. Do not set attempts to 1 if you plan to use your presentation in a meeting or place in an archive.)

**Infinite Attempts** Select this option to give users an unlimited number of attempts.

**Action** Click the desired action/destination after the last attempt. You can advance to the next slide (Go To Next Slide, the default action), jump to another slide in the presentation (Go To Slide), or display a web page (Open URL). If you display a web page, type its address in the Open URL text box and then specify where to display the web page (choose Current to have the web page replace the presentation or New to display the web page in another window).

**Go To Next Slide** Depending on the option you selected for Action, this text box lets you specify an exact destination.

**Play Audio Clip** Select this option to import an audio file or record a new audio file that should play when the question is answered incorrectly. Use the Record, Stop, Remove, and Import buttons as necessary.

**Show Error Message** Select this option to provide a text message for users when they supply an incorrect answer. Clear this check box if you don't want to give any feedback for an incorrect answer.

**Show Retry Message** Select this option to provide a text message for users when they supply an incorrect answer but there are remaining attempts available (for example, Please try again).

**Show Incomplete Message** Select this option to provide a text message for users who don't supply an answer (for instance, “Please select an answer before continuing”).

*Note:* You can edit the default text in the correct, error, retry, and incomplete messages in the Quiz Manager. From the Adobe Presenter menu, select Quiz Manager and click the Default Labels tab.

Select the Reporting tab. You can accept the default settings or, if necessary, modify the following options:

**Report Answers** This option sends answer information to Connect Enterprise Server or a learning management system.

**Quiz** Name of the quiz to which this question is assigned. You can select a different quiz from the pop-up menu.

**Objective ID** This is a number automatically created when you create a quiz. This number is used to report scores from Presenter presentations that will be tracked in Connect Enterprise Server or a learning management system.

**Interaction ID** Accept the default number or type a new number directly into the text box. The maximum length of an interaction ID is 64 characters. If you want the Presenter presentation to send tracking information to Connect Enterprise Server, you must use the Interaction ID specified by Connect Enterprise Server.

*Note:* If you create a new question by copying and pasting an existing question slide, you must enter a new, unique, Interaction ID so that each individual question is reported properly to Connect Enterprise Server. We do not recommend creating new questions by copying and pasting; always create new questions using the Quiz Manager.

When you finish, click OK.

Click OK again to close the Quiz Manager.

The new fill-in-the-blank question slide appears in the designated location in the presentation.
Add a short-answer question to a presentation

Users answer short-answer questions by providing a word, phrase, or complete sentence as an answer. You can also use this as an essay question and grade it or gather extended feedback as a survey question.

1. In PowerPoint, open a presentation (PPT file).
2. Select the slide before the one where you want to insert a question. For example, if you want the new question slide to be slide 7 in the presentation, click slide 6.
3. From the Adobe Presenter menu, select Quiz Manager.
4. Select the quiz to which you want to add a question and click Add New Question.
5. In the Question Types dialog box, select Short Answer and specify whether to grade the question:
   - Create Graded Question: The question will be graded.
   - Create Survey Question: The question will not be graded.
6. On the Question tab, accept the default text for Name or type a new name directly into the text box. The name appears on the question slide in the presentation.
   - If you are creating more than one question of the same type (for example, multiple-choice and short answer) in a single presentation, type a unique name for each so that you distinguish between them.
7. In the Question text box, type the short-answer question, exactly as you want it to appear on the slide. (The question text box cannot be left blank.)
8. In the Points text box, type in (or use the up and down arrows to specify) the number of points allocated to this question. Assigning points signifies the relative importance of a question. Assigning different point values to different questions lets you, for example, give introductory questions a lower value and advanced questions a higher value. You can enter any whole number value. If all questions have the same value (for example, 10 points), they are scored equally.
9. In the Acceptable Answers area, click an empty row or click Add and enter words or phrases that are correct answers to the question. Click Add and Delete as necessary to write an appropriate list.
10. (Optional) Select The answer Is Case-sensitive to require that users type in the correct combination of lowercase and uppercase letters when providing a short answer. For example, if the answer to the question is Windows and you select the case-sensitive option, an answer of windows would be incorrect.
11. Select the Options tab.
12. (Optional) In Type, use the pop-up menu to change the question type to Graded or Survey.
13. Select Show clear button to display a button on the question slide that users can click to clear their answers and start over.
14. In the If Correct Answer area, set the following options:
   - Action: Select which action should follow a correct response. You can advance to the next slide (Go To Next Slide, the default action), jump to another slide in the presentation (Go To Slide), or display a web page (Open URL). If you display a web page, type its address in the Open URL text box and then specify where to display the web page (choose Current to have the web page replace the presentation or New to display the web page in another window).
   - Go To Next Slide: Depending on the option you selected for Action, this text box lets you specify an exact destination.
   - Play Audio Clip: Select this option to import an audio file or record a new audio file that should play when the question is answered correctly. Use the Record, Stop, Remove, and Import buttons as necessary. (If you have already recorded audio, a Play button replaces the Record button. To re-record audio, you must first remove the audio, and then select Record.)
Note: If a question has an audio clip and an action, the audio clip plays and then the specified action takes place.

**Show Correct Message** Select this option to provide a text message for users when they supply a correct answer. Clear this check box if you don't want to give any feedback for a correct answer.

**15** In the If Wrong Answer area, set the following options:

**Allow User [#] Attempts** Use the arrows or type directly into the text box to specify how many guesses the user can make before another action takes place. An attempt is defined as anytime a user opens and views the question slide. (Setting the number of attempts to 1 prevents the presentation from proceeding if the user exits and then attempts to enter the quiz again. Do not set attempts to 1 if you plan to use your presentation in a meeting or place in an archive.)

**Infinite Attempts** Select this option to give users an unlimited number of attempts.

**Action** Click the desired action/destination after the last attempt. You can advance to the next slide (Go To Next Slide, the default action), jump to another slide in the presentation (Go To Slide), or display a web page (Open URL). If you display a web page, type its address in the Open URL text box and then specify where to display the web page (choose Current to have the web page replace the presentation or New to display the web page in another window).

**Go To Next Slide** Depending on the option you selected for Action, this text box lets you specify an exact destination.

**Play Audio Clip** Select this option to import an audio file or record a new audio file that should play when the question is answered incorrectly. Use the Record, Stop, Remove, and Import buttons as necessary.

**Show Error Message** Select this option to provide a text message for users when they supply an incorrect answer. Clear this check box if you don't want to give any feedback for an incorrect answer.

**Show Retry Message** Select this option to provide a text message for users when they supply an incorrect answer but there are remaining attempts available (for example, Please try again).

**Show Incomplete Message** Select this option to provide a text message for users who don't supply an answer (for instance, "Please select an answer before continuing").

Note: You can edit the default text in the correct, error, retry, and incomplete messages in the Quiz Manager. From the Adobe Presenter menu, select Quiz Manager and click the Default Labels tab.

**16** Select the Reporting tab. You can accept the default settings or, if necessary, modify the following options:

**Report Answers** This option sends answer information to Connect Enterprise Server or a learning management system.

**Quiz** Name of the quiz to which this question is assigned. You can select a different quiz from the pop-up menu.

**Objective ID** This is a number automatically created when you create a quiz. This number is used to report scores from Presenter presentations that will be tracked in Connect Enterprise Server or a learning management system.

**Interaction ID** Accept the default number or type a new number directly into the text box. The maximum length of an interaction ID is 64 characters. If you want the Presenter presentation to send tracking information to Connect Enterprise Server, you must use the Interaction ID specified by Connect Enterprise Server.

Note: If you create a new question by copying and pasting an existing question slide, you must enter a new, unique, Interaction ID so that each individual question is reported properly to Connect Enterprise Server. We do not recommend creating new questions by copying and pasting; always create new questions using the Quiz Manager.

**17** When you finish, click OK.

**18** Click OK again to close the Quiz Manager.
The new short-answer question slide appears in the designated location in the presentation. If you are using the short-answer question as a graded essay question, you can grade the answer using the Connect Enterprise Manager override option. For more information, see the *Connect Enterprise Manager User Guide*.

### Add a matching question to a presentation

Users answer matching questions by matching items in two different lists.

1. In PowerPoint, open a presentation (PPT file).
2. Select the slide before the one where you want to insert a question. For example, if you want the new question slide to be slide 7 in the presentation, click slide 6.
3. From the Adobe Presenter menu, select Quiz Manager.
4. Select the quiz to which you want to add a question and click Add New Question.
5. In the Question Types dialog box, select Matching and specify whether to grade the question:
   - **Create Graded Question** The question will be graded.
   - **Create Survey Question** The question will not be graded.
6. On the Question tab, accept the default text for the Name or type new text directly into the text box. The name appears on the question slide in the presentation.
   - *If you are creating more than one question of the same type (for example, multiple-choice and short answer) in a single presentation, type a unique name for each so that you distinguish between them.*
7. In the Question text box, type the matching question, exactly as you want it to appear on the slide. For example, “Match the job titles in column 1 with the correct departments in column 2.” (The question text box cannot be left blank.)
8. In the Points text box, type in (or use the up and down arrows to specify) the number of points allocated to this question. Assigning points signifies the relative importance of a question. Assigning different point values to different questions lets you, for example, give introductory questions a lower value and advanced questions a higher value. You can enter any whole number value. If all questions have the same value (for example, 10 points), they are scored equally.
9. In Answers, click Add under each column and type in the words or phrases to match. (You can also click directly in each column to type in words or phrases.) If necessary, click Delete to remove any answers or click the up and down arrows to move answers up or down a position in the column.
10. (Optional) To change the names of the columns, click the default names (“Column 1” and “Column 2”) and type in new names.
11. To establish the correct matches between answers, click an item in one column, then click an item in the other column, and click Match. (You can also drag items between the two columns to create correct matches.) A line is drawn between the two items to show the relationship. All items in Column 1 must have a match in Column 2.
12. If you need to change the order of items in a column, select an item and then click the up or down arrow below the column to move the item up or down in the list.
13. If you make an error while establishing the correct matches between column items, click Clear matches and start over.
14. In Numbering, use the pop-up menu and select an option for how answers are listed on the quiz slide. You can choose from uppercase letters, lowercase letters, or numbers.
15. Select the Options tab.
16. (Optional) In Type, use the pop-up menu to change the question type to Graded or Survey.
17 Select Show Clear Button to display a button on the question slide that users can click to clear their answers and start over.

18 In the If Correct Answer area, set the following options:

- **Action**: Select which action should follow a correct response. You can advance to the next slide (Go To Next Slide, the default action), jump to another slide in the presentation (Go To Slide), or display a web page (Open URL). If you display a web page, type its address in the Open URL text box and then specify where to display the web page (choose Current to have the web page replace the presentation or New to display the web page in another window).

- **Go To Next Slide**: Depending on the option you selected for Action, this text box lets you specify an exact destination.

- **Play Audio Clip**: Select this option to import an audio file or record a new audio file that should play when the question is answered correctly. Use the Record, Stop, Remove, and Import buttons as necessary. (If you have already recorded audio, the record button will be a Play button. To re-record audio, you must first remove the audio, and then select Record.)

  *Note:* If a question has an audio clip and an action, the audio clip plays and then the specified action takes place.

- **Show Correct Message**: Select this option to provide a text message for users when they supply a correct answer. Clear this check box if you don't want to give any feedback for a correct answer.

19 In the If Wrong Answer area, set the following options:

- **Allow User [#] Attempts**: Use the arrows or type directly into the text box to specify how many guesses the user can make before another action takes place. An attempt is defined as anytime a user opens and views the question slide. (Setting the number of attempts to 1 prevents the presentation from proceeding if the user exits and then attempts to enter the quiz again. Do not set attempts to 1 if you plan to use your presentation in a meeting or place in an archive.)

- **Infinite Attempts**: Select this option to give users an unlimited number of attempts.

- **Action**: Select the desired action/destination after the last attempt. You can advance to the next slide (Go To Next Slide, the default action), jump to another slide in the presentation (Go To Slide), or display a web page (Open URL). If you display a web page, type its address in the Open URL text box and then specify where to display the web page (choose Current to have the web page replace the presentation or New to display the web page in another window).

- **Go To Next Slide**: Depending on the option you selected for Action, this text box lets you specify an exact destination.

- **Play Audio Clip**: Select this option to import an audio file or record a new audio file that should play when the question is answered incorrectly. Use the Record, Stop, Remove, and Import buttons as necessary.

- **Show Error Message**: Select this option to provide a text message for users when they supply an incorrect answer. Clear this check box if you don't want to give any feedback for an incorrect answer.

- **Show Retry Message**: Select this option to provide a text message for users when they supply an incorrect answer but there are remaining attempts available (for example, Please try again).

- **Show Incomplete Message**: Select this option to provide a text message for users who don't supply an answer (for instance, "Please select an answer before continuing").

  *Note:* You can edit the default text in the correct, error, retry, and incomplete messages in the Quiz Manager. From the Adobe Presenter menu, select Quiz Manager and click the Default Labels tab.

20 Select the Reporting tab. You can accept the default settings or, if necessary, modify the following options:

- **Report Answers**: This option sends answer information to Connect Enterprise Server or a learning management system.

- **Quiz**: Name of the quiz to which this question is assigned. You can select a different quiz from the pop-up menu.
**Objective ID**  This is a number automatically created when you create a quiz. This number is used to report scores from Presenter presentations that will be tracked in Connect Enterprise Server or a learning management system.

**Interaction ID**  Accept the default number or type a new number directly into the text box. The maximum length of an interaction ID is 64 characters. If you want the Presenter presentation to send tracking information to Connect Enterprise Server, you must use the Interaction ID specified by Connect Enterprise Server.

*Note: If you create a new question by copying and pasting an existing question slide, you must enter a new, unique, Interaction ID so that each individual question is reported properly to Connect Enterprise Server. We do not recommend creating new questions by copying and pasting; always create new questions using the Quiz Manager.*

21  When you finish, click OK.

22  Click OK again to close the Quiz Manager.

The new matching question slide appears in the designated location in the presentation.

### Add a rating scale question to a presentation

Users answer rating scale questions by specifying their level of agreement to a statement. For example, a user may be given the question, “This presentation provided me with valuable information.” and asked if they disagree, somewhat disagree, are neutral, somewhat agree, or agree.

Rating scale questions are always survey questions and are therefore not graded. You cannot assign a rating scale question with a point value, nor can you creating branching for a correct or incorrect answer (since it’s a survey question and does not have a correct or incorrect answer). You can, however, decide what happens after the user completes the rating scale question, such as continuing to the next slide or displaying a URL.

1  In PowerPoint, open a presentation (PPT file).

2  Select the slide before the one where you want to insert a question slide. For example, if you want the new question slide to be slide 7 in the presentation, click slide 6.

3  From the Adobe Presenter menu, select Quiz Manager.

4  Select the quiz to which you want to add a question and click Add New Question.

5  In the Question Types dialog box, select Rating Scale (Likert).

6  Click Create Survey Question.

7  On the Question tab, accept the default text for the Name or type new text directly into the text box. The name appears on the question slide in the presentation.

   *If you are creating more than one question of the same type (for example, multiple-choice and short answer) in a single presentation, type a unique name for each so that you distinguish between them.*

8  Accept the default text for Description or type a new description directly into the text box. The description appears on the question slide in the presentation and should provide users with instructions about how to answer the question. (The description text box cannot be left blank.)

9  In the Questions area, click in the first row or click Add and type a Likert question directly into the text box. (You can add up to five separate Likert questions on a single slide.)

10  In the Answers area, you can accept the default answer text, edit the text, delete a type, and add a new answer types. To edit the text, double-click existing text such as “Neutral” and type new text. To delete an answer type, select a type and click Delete. To add an answer type, click Add and type new text. (You can have a total of five answer types.)

11  Select the Options tab.
12 Select Show clear button to display a button on the question slide that users can click to clear their answers and start over.

13 In the After Survey question area, set the following options:

- **Action**: Click the desired action/destination after the survey is taken. You can advance to the next slide (Go To Next Slide, the default action), jump to another slide in the presentation (Go To Slide), or display a web page (Open URL). If you display a web page, type its address in the Open URL text box and then specify where to display the web page (choose Current to have the web page replace the presentation or New to display the web page in another window).

- **Go to Next Slide**: Depending on the option you selected for Action, this text box lets you specify an exact destination.

- **Play Audio Clip**: Select this option to import an audio file or record a new audio file that should play when the question is answered. Use the Record, Stop, Remove, and Import buttons as necessary. (If you have already recorded audio, the record button will be a Play button. To re-record audio, you must first remove the audio, and then select Record.)

**Note**: If a question has an audio clip and an action, the audio clip plays and then the specified action takes place.

14 Select the Reporting tab. You can accept the default settings or, if necessary, modify the following options:

- **Report Answers**: This option sends answer information to Connect Enterprise Server or a learning management system.

- **Quiz**: Name of the quiz to which this question is assigned. You can select a different quiz from the pop-up menu.

- **Objective ID**: This is a number automatically created when you create a quiz. This number is used to report scores from Presenter presentations that will be tracked in Connect Enterprise Server or a learning management system.

- **Interaction ID**: Accept the default number or type a new number directly into the text box. The maximum length of an interaction ID is 64 characters. If you want the Presenter presentation to send tracking information to Connect Enterprise Server, you must use the Interaction ID specified by Connect Enterprise Server.

**Note**: If you create a new question by copying and pasting an existing question slide, you must enter a new, unique, Interaction ID so that each individual question is reported properly to Connect Enterprise Server. We do not recommend creating new questions by copying and pasting; always create new questions using the Quiz Manager.

15 When you finish, click OK.

16 Click OK again to close the Quiz Manager.

The new rating scale question slide appears in the designated location in the presentation.

**Edit quizzes and questions**

After you have created question slides in a presentation, you can edit them as required.

**See also**

“Preview a presentation” on page 152

**Change question slide order**

After you have created question slides in a presentation, you can change their order. The easiest method is to move the slides in PowerPoint.

1 In PowerPoint, open a presentation (PPT file).

2 In the Outline pane, drag the slide icon to a new location.
The next time you open the Quiz Manager (from the Adobe Presenter menu), the new question order is displayed.

**Delete a question slide**
You can delete a question slide at any time. The easiest method is to delete the slide in PowerPoint.

1. In PowerPoint, open a presentation (PPT file).
2. In the Outline pane, select a slide and click Delete.

The next time you open the Quiz Manager (from the Adobe Presenter menu), the question slide will not be listed.

**Add a feedback message to a question**
Because quizzes are interactive, it's important to guide users through any question slides you place in projects. An easy way to communicate with users is through feedback messages. These are messages that display, for example, when a user selects a correct answer or incorrect answer. Feedback messages are set for individual questions, so you can choose to include messages in some questions or all questions within a quiz.

1. In PowerPoint, open a presentation (PPT file).
2. From the Adobe Presenter menu, select Quiz Manager.
3. Select a question and click Edit Question.
4. Click the Options tab.
5. In the If Correct Answer area, select the Show Correct Message option to display a message for users confirming that they selected the correct answer. Deselect the Show Correct Message option if you do not want to display a message for users when they select the correct answer.
6. In the If Wrong Answer area, select the Show Error Message option to display a message for users stating that they selected the incorrect answer. Deselect the Show Error Message option if you do not want to display a message for users when they select the incorrect answer.
7. In the If Wrong Answer area, select the Show Retry Message option to display a message for users when they select the incorrect answer, but have remaining answer attempts available. Deselect the Show Retry Message option if you do not want to display a message for users when they select the incorrect answer, but have remaining answer attempts available.
8. In the If Wrong Answer area, select the Show Incomplete Message option to display a message to users who do not supply an answer to a required question.

Click OK two times to close all of the dialog boxes.

**Edit feedback message text in a quiz**
Presenter provides default text for feedback messages that are displayed for users, but you can edit the text at any time. The text is set at the quiz level so that all questions within a quiz display the same feedback messages.

1. In PowerPoint, open a presentation (PPT file).
2. From the Adobe Presenter menu, select Quiz Manager.
3. On any quiz, click Edit Quiz Settings.
5. Accept the default text or type new text directly into the text boxes for Correct, Incomplete, and Incorrect feedback messages.
6. Click OK three times to close all of the dialog boxes.
Note: If you change the default labels, the question feedback messages also change for questions that have already been created.

Change default labels
You can change the default labels on question buttons and question feedback messages. This is an easy way to customize communications with users taking quizzes.

1. In PowerPoint, open a presentation (PPT file).
2. From the Adobe Presenter menu, select Quiz Manager.
3. Click Default Labels.
4. Under Default question button labels, change any of the following options:
   - Submit button text: Enter the text that should appear on the question Submit button. (For example, you could change the text to OK or Enter.)
   - Clear button text: Enter the text that should appear on the question Clear button. (For example, you could change the text to Start Over or Restart.)
5. Under Default question feedback, change any of the following options:
   - Correct message: Enter the text message that should appear when users select the correct answer.
   - Incorrect message: Enter the text message that should appear when users select an incorrect answer.
   - Retry message: Enter the text message that should appear if users enter an incorrect answer and they have more question attempts available.
   - Incomplete message: Enter the text message that should appear if users fail to answer a required question.
6. Click OK.

Set reporting options
Presenter offers output options for presentations with e-learning elements. For example, you can create presentations that are SCORM or AICC compliant for use within a learning management system.

Reporting options such as what kind of data to collect and how the data is reported are set for a quiz. You can, however, select whether to report interaction data to a learning management system at the quiz level or the question level. If the two settings are different, the setting for the question is used. For example, a quiz is set to report interactions, but a question within the quiz is not set to report interactions. In this case, the question does not get reported. The question will, however, be included in the overall numerical score for the quiz if the question is a graded question. (Because the question was not set to report interactions, the exact answer the user selected does not get reported.)

1. In PowerPoint, open a presentation (PPT file).
2. From the Adobe Presenter menu, select Quiz Manager.
3. In the Quiz Manager dialog box, select a quiz and click the Reporting tab.
4. Select Enable Reporting for This Presentation.
5. Select the main learning management system standard you want to use:
   - Connect Enterprise Server
   - AICC. If you select AICC, four course structure files are created.
• SCORM. If you select SCORM, click Manifest to set options for creating a manifest file, required by many third-party learning management systems.

6 Choose how to report data:

**Report to Connect Enterprise Server**  Reports quiz reporting data to the Connect Enterprise Server. For example, in a presentation containing quizzes, a passing grade is reported to Connect Enterprise Server if all questions in all quizzes were answered completely and the user achieved a passing score. Or, if a presentation does not contain quizzes, a grade of complete is sent to Connect Enterprise Server when the user has viewed all slides.

**Report Quiz Results Only**  Reports quiz results only in the presentation itself. (No data will be sent to a learning management system.) For example, if a presentation contains quizzes, and any quiz is assigned a passing score that is greater than 0, when a user completes all quizzes with a passing score, a passing grade is reported. Or, if a presentation does not contain quizzes, a grade of complete is reported when the user has viewed all slides.

**Report User Access Only**  Reports if users have opened the presentation and viewed one slide.

**Report Quiz Results and Slide Views**  Reports quiz results only in the presentation itself (no data will be sent to a learning management system) and how many individual slides users viewed. For example, if a presentation contains quizzes, two items are reported. First, if any quiz is assigned a passing score that is greater than 0, when a user completes all quizzes with a passing score, a passing grade is reported. Second, a grade of complete is sent to Connect Enterprise Server when the user has viewed all (100%) of the slides. Or, if a presentation does not contain quizzes, send a grade of complete when the user has viewed all (100%) of the slides.

**Report Slide Views Only**  Reports how many individual slides users viewed. The number is given as a percentage. For example, if a user opens a presentation and views 8 out of 10 slides, a slide view of 80% is reported.

**Slide View Completion %**  Lets you set the percentage of slides that must be viewed by a user for them to complete the presentation. For example, if you have a presentation that contains 10 slides and you set the Slide View Completion percentage to 80, users who view 8 out of the 10 slides will have “completed” the presentation. (This option is only available if you select the Report Quiz Results and Slide Views or Report Slide Views Only option.)

7 Select how pass and fail information is reported. (If you selected the Report to Connect Enterprise Server option in step 6, settings in this Report Pass or Fail area are ignored, and all information is sent to Connect Enterprise Server.)

**Report Complete/Incomplete**  Reports results as either complete or incomplete. Users must view every slide and, if there are quiz slides, must take the quizzes (and receive either a passing or failing score) to receive Complete status.

*Note:* If you are creating a quiz that consists of only survey questions, the user has only one chance to take the quiz. Try to keep the length of survey-only quizzes fairly short, for example, 15-20 questions, so users can complete the survey easily.

**Report Pass/Fail**  Reports results as either pass or fail. Users must view every slide and, if there are quiz slides, must take the quizzes (and receive either a passing or failing score) to receive Pass status.

**Report Status as Defined by Report Data**  Reports status using the selections made in the Choose Report Data area of this dialog box.

8 Select how scores are reported to your learning management system. (If you selected the Report to Connect Enterprise Server option in step 6, settings in this Report score to LMS as area are ignored and all information is sent to Connect Enterprise Server.)

**Score**  Scores are reported as a numerical score. For example, 8 out of 10 correct.

**Percent**  Scores are reported as a percentage. For example, 85% correct.
Select a reporting level. (If you selected the Report to Connect Enterprise Server option in step 6, settings in this Reporting level area are ignored and all information is sent to Connect Enterprise Server.)

Only Report the Score Only scores are reported to the learning management system.

Report Interactions and the Score Scores and interactions are reported to the learning management system.

(Optional) Click Settings to customize how data is sent and formatted to a learning management system.

Click OK.

See also
“Creating quizzes and questions” on page 174

Set a pass rate for a quiz
When you place quizzes in a presentation, you set a pass rate for users. The pass rate is a percentage or numeric value that users must reach in order to pass the quizzes. For example, setting a pass of 80% requires users to get 80% of questions correct in order to pass.

1 In PowerPoint, open a presentation (PPT file).
2 From the Adobe Presenter menu, select Quiz Manager.
3 In the Quiz Manager, select a quiz and click Edit Quiz Settings.
4 Click the Pass or Fail Options tab.
5 Select a Pass/Fail option:
   “#” % or more of total score to pass Enter a percentage value that students must meet in order to pass. For example, if you enter a value of 80, students must provide correct answers to 80% of the questions. (In a quiz containing 10 questions, at least 8 must be answered correctly).
   “#” or more of total score to pass Enter a numeric value that students must meet in order to pass. For example, if you enter a value of 8, students must provide correct answers to 8 questions in the quiz.
6 Click OK.

Set score display
You can set the way the quiz score is reported to users.

1 In PowerPoint, open a presentation (PPT file).
2 From the Adobe Presenter menu, select Quiz Manager.
3 In the Quiz Manager dialog box, select a quiz and click Edit Quiz Settings.
4 Click the Quiz Settings tab.
5 Select Show Score at End of Quiz.
6 Click Quiz Result Messages.
7 Select a score option:
   Display Score specifies that the numerical score is displayed.
   Display Percent Score specifies that a score as a percentage of total is displayed.
   Tally Correct specifies that a score in tally form (for example, “7 out of 10 correct”) is displayed.
8 Click OK three times to close all of the dialog boxes.

Use presentations with a learning management system

Presentations created with Presenter integrate especially well with the Connect Enterprise Server learning management system (LMS), but you can use Presenter presentations with any LMS. If you are going use a presentation with a third-party LMS, the following sections explain how to create a manifest file and how to customize LMS settings.

**Note:** *If you select the Connect Enterprise Server or AICC option when setting reporting options, four AICC course structure files are created: presenter.au, presenter.crs, presenter.cst, and presenter.des. The files are created with default values, but the values can be edited manually. For more information, see the AICC website at [www.aicc.org](http://www.aicc.org).*

**See also**

“Creating quizzes and questions” on page 174

Creating a SCORM manifest file

If you want to package a Presenter presentation as an e-learning course that can be administered and launched from a SCORM 1.2 or 2004 conformant learning management system, you may need a manifest file.

**Note:** *If you are publishing to Connect Enterprise Server, a manifest file is automatically created named breeze-manifest.xml. This XML file is used to upload the presentation into the Connect Enterprise Server. You do not need to follow the procedure below to create a SCORM manifest file.*

The manifest file that Presenter creates is named imsmanifest.xml and contains references to all content resources. The XML file uses predefined XML tags to describe the package components, structure, and special behaviors. The file works behind the scenes to properly integrate presentations with your learning management system and track quiz data.

1 In PowerPoint, open a presentation (PPT file).
2 From the Adobe Presenter menu, select Quiz Manager.
3 Click the Reporting tab.
4 Select Enable Reporting for This Presentation.
5 Under Learning Management System (LMS), select SCORM.
6 Click Manifest.
7 Set the SCORM Version by selecting 1.2 or 2004 from the pop-up menu.
8 Set the following manifest options:

**Identifier** *(Required)* The identifier is used by the LMS to identify different manifests. A default identifier based on the name of your Presenter presentation is automatically added to this text box. You can change the identifier at any time by selecting the text and typing in new text.

**Title** *(Required)* The title can be viewed by students using the LMS. A default title based on the name of your Presenter presentation is automatically added to this text box. You can change the title at any time by selecting the text and typing in new text.

**Description** *(Required)* Text used by the LMS to describe different courses to users. A default description based on the name of your Presenter presentation is automatically added to this text box. You can edit the description at any time.
Version (Optional) The version specifies a number that can be used to differentiate manifests with the same identifier.

Duration (Optional) Select this option to specify the approximate time it takes to work with this particular Presenter presentation. Set the time in the following format: hh:mm:ss.

Subject (Optional) Select this option to write a short description of the Presenter presentation using keywords or phrases.

SCO Identifier (Required) The identifier is used by the LMS to identify different Shareable Content Objects (SCO). A default identifier based on the name of your Presenter presentation is automatically added to this text box. You can change the identifier at any time by selecting the text and typing in new text. (If you type the name of a new identifier, do not use any spaces in the name.)

Title (Required) A default title based on the name of your Presenter presentation is automatically added to this text box. You can change the title at any time by selecting the text and typing in new text.

Mastery Score (Optional) Select this option to specify a passing score for the Presenter presentation. The score should be a number between 0 and 100. Only Presenter presentations containing score-reporting objects such as quiz slides, text entry boxes, click boxes, or buttons, need to include a mastery score.

Time Allowed (Optional) Select this option to specify the maximum amount of time allowed to complete the Presenter presentation.

Time Limit Action (Optional) Select this option to specify the action that should be taken when the maximum time allowed to complete the presentation has been exceeded. From the pop-up menu, select one of the four options: Exit with Message, Exit Without Message, Continue with Message, or Continue Without Message.

Launch Data (Optional) Select this option to specify initialization data expected by the resource.

9 Click OK.

To see the manifest file, you should publish your Presenter presentation locally to create a Flash SWF file and a manifest file. If you used the default save location, you can use Windows Explorer to navigate to the SWF file and imsmanifest.xml file in My Documents\My Presentations\Name of Presentation folder. If you published the presentation to a different folder, navigate to that location to see the manifest file.

Set advanced learning management system settings
Presenter offers several advanced settings for how presentations integrate with learning management systems (LMS). The settings let you specify what data is sent to the LMS and how the data is formatted. Typically, these settings are used by advanced LMS users or requested by LMS administrators.

Note: The settings are used by third-party learning management systems; they do not affect the data sent from Presenter to Connect Enterprise Server.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Quiz Manager.

3 Click the Reporting tab.

4 Click Settings.

5 In the LMS Customization Settings area, set the following options:

Never Send Resume Data Select this option if you do not want resume data to be sent to your LMS. This might be useful if your LMS does not support resume data or another mechanism to prevent users from returning to a quiz they started, but did not finish, across multiple sessions. For example, a user completes 4 questions out of 8 and then closes the presentation. If you select this option, when the user opens the presentation again they must provide
answers to all 8 questions—their answers from the first session are not remembered in the Presenter presentation. This option can be used when publishing and playing back content from any AICC or SCORM compliant learning management system.

**Note:** Presentations that are part of a Connect Enterprise Server training course or curriculum are always automatically resumed. If the presentation is viewed using the Content tab, it is never resumed.

**Escape Version and Session ID** This option is selected by default. Keep this option selected if you want Presenter to URL-encode (escape) the version and session ID when sending data to an AICC compliant learning management system. This is useful if your learning management system does not accept URL-encoded information for these fields. Deselect this option if you do not want to URL-encode (escape) the version and session ID.

**Don't Escape Characters** This option lets you specify that Presenter should not URL-encode (escape) the value fields in parameters when data is sent to an AICC compliant learning management system. In the text box, type in the characters (without any delimiters such as spaces or commas) that the learning management system does not want escaped. For example, if the LMS does not want any numbers escaped, type in 0123456789.

**Send Interval** This option lets you specify how often slide data should be sent to the LMS. As a user views a presentation, information is sent to the LMS. For regular slides, the LMS is notified that the user viewed the slide and for question slides, information about the user response is sent to the LMS. Also, each time any kind of slide is viewed, the LMS records the slide number so that if a user quits and then opens the presentation later, they will return to the last slide they viewed. If you do not want information sent to the LMS for every slide in the presentation, you can change the Send Interval. For example, if you change the interval to 10, information will be sent to the LMS every 10 slides.

**Note:** If you change the Send Interval to a number higher than one, users who quit before finishing the presentation may not be able to resume where they left off. For example, if the Send Interval is changed to 10 and a user quits after viewing 9 slides, when they open the presentation again, they start over at slide 1.

6 Click OK to finish setting the custom LMS settings and close the Quiz Manager.

---

**Designing presentations**

**Create and edit themes**

The primary way to design how presentations appear in the Presenter viewer is through the use of themes. Themes serve as the “container” for your presentation, and let you add static images, colors, and sound to create dynamic and interactive presentations. You can add a theme at any time. Try using different themes until you achieve the right look you want. You can reuse the same theme for each presentation you create or design new themes.

Presenter gives you many options for customizing colors, tabs, functionality, graphics, font style, and other design elements of a theme.
Examples of customizable themes

See also
“Preview a presentation” on page 152

Select a presentation theme
The default theme assigned to presentations is Sage, but you can change the theme at any time.

1. In PowerPoint, open a presentation (PPT file).
2. From the Adobe Presenter menu, select Theme Editor.
   The Theme Editor dialog box appears.
3. From the Theme Name pop-up menu, select a theme.
   The preview window displays the new theme.
4. Change theme options as desired.
5. Click OK to close the Theme Editor.

Create a custom theme
You can create a custom theme by selecting one of the default themes, making changes, and saving the new theme with a different name. For example, you can start with the theme, Sage, change the font color to dark green, and then save the new theme as Sage Modified. After you create a custom theme, it appears in the Theme name pop-up menu and can be used with other presentations.

1. In PowerPoint, open a presentation (PPT file).
2. From the Adobe Presenter menu, select Theme Editor.
   The Theme Editor dialog box appears.
3. Make changes as desired. For instance, click Text Labels to change the text in different areas of the theme, or click Change Theme Colors to select custom colors for the font and background.
4. Click the Save as button and specify a name for the new theme.
5. Click OK.
   The new theme appears in the Theme Name pop-up menu in the Theme Editor and can be used when publishing presentations.
Change text labels in a theme

Text labels are the words that appear in a theme, such as button text and tab names. You can edit text labels in a theme at any time.

Note: The column heading text “Slide Title” and “Duration” cannot be changed.

1. In PowerPoint, open a presentation (PPT file).
2. From the Adobe Presenter menu, select Theme Editor.
The Theme Editor dialog box appears.
3. Click the Text Labels button.
4. Click the Language pop-up menu and select a language for the text labels.
Note: Presentations detect the language of a user’s operating system and automatically display the text labels in the user’s native language if their computer’s language is set to German, French, Korean, or Japanese. Otherwise, English text labels appear.
5. As necessary, change the text labels for any element of the presentation theme. For example, you can change the text that displays on buttons or panes.
6. Click OK.
The theme preview on the right side of the Theme Editor dialog box is updated to reflect your choices.
7. Click OK.

Change theme colors

You can change the colors that appear in a theme, including the background color and glow color. You can also specify a background image to use in a theme.

1. In PowerPoint, open a presentation (PPT file).
2. From the Adobe Presenter menu, select Theme Editor.
The Theme Editor dialog box appears.
3. Click the Change Theme Colors button. To change a color, click once on any of the color bars. You can change any of the following color options:
   - **Theme Color** Click this color bar to change the color of the theme sidebar and toolbar.
   - **Glow Color** Click this color bar to change the color that appears when users hover their mouse over slides in the Outline pane and thumbnail images in the Thumb pane.
   - **Font Color** Click this color bar to change the color of the text in the theme.
   - **Background Color** Click this color bar to change the color of the background area that appears behind the slides, sidebar, and toolbar.
   - **Background Image** Click the Browse button to navigate to an image file (in JPG format) to use as the background. The background is the area that appears behind the slides, sidebar, and toolbar.
4. Click OK.
The theme preview on the right side of the Theme Editor dialog box is updated to reflect your choices.
5. Click OK.
Delete a theme
You can delete a custom theme at any time, however, the default themes included with Presenter, such as Sage and Sapphire, cannot be removed.

1. In PowerPoint, open a presentation (PPT file).
2. From the Adobe Presenter menu, select Theme Editor.
   The Theme Editor dialog box appears.
3. From the Theme Name pop-up menu, select the theme you want to remove.
4. Click Delete.
5. A confirmation dialog box appears. Click Yes.
6. Click OK.

Show and hide theme panes
Panes appear in the sidebar of a theme. The default location of the sidebar is on the right side, but the location can be changed. You can select which panes appear in the theme and which are hidden. For example, you might want to include the Outline and Search panes, but hide the Thumbnail and Notes panes.

1. In PowerPoint, open a presentation (PPT file).
2. From the Adobe Presenter menu, select Theme Editor.
   The Theme Editor dialog box appears.
3. In the General Options area on the left, select the panes that should appear and deselect the panes you want to hide.
   The theme preview on the right side updates to reflect your choices.
4. Click OK.

Set a default theme pane
Panes are part of a theme and appear in the sidebar. If you have more than one pane in a theme, the panes are layered on top of one another with a tab at the top containing the name of the pane. You can select the pane that appears in front of the others. If you are displaying all of the panes, select from Outline, Thumbnail, Notes, and Search.

1. In PowerPoint, open a presentation (PPT file).
2. From the Adobe Presenter menu, select Theme Editor.
   The Theme Editor dialog box appears.
3. From the Panes pop-up menu, select the pane that should appear by default when the presentation appears.
   The theme preview on the right side is updated to reflect your choices.
4. Click OK.

Choose a location for the sidebar
The sidebar in a theme contains presenter information, panes such as Outline and Search, and presentation timing information. You can position the sidebar on the right (default) or left side of the theme.

1. In PowerPoint, open a presentation (PPT file).
2. From the Adobe Presenter menu, select Theme Editor.
   The Theme Editor dialog box appears.
From the Location of Layout pop-up menu, select Left or Right. The theme preview on the right side is updated to reflect your choices.

4 Click OK.

**Set presenter options for a theme**

You can select exactly which presenter options appear in a theme. For example, you might want the presenter name and photo to appear, but not a biography (bio) or contact information.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Theme Editor. The Theme Editor dialog box appears.

3 In the Presenter Options area, select the options to include in your theme:

- **Presenter Photo** Select to include a presenter photo in the published presentation.
- **Presenter Name** Select to include the presenter’s name in the published presentation.
- **Presenter Logo** Select to include a logo in the published presentation.
- **Presenter Bio** Select to include a link to a presenter biography.
- **Presenter Contact Information** Select to include a link to presenter contact information such as a phone number or e-mail address.
- **Presenter Title** Select to include the presenter’s title, such as Director of Human Resources.

The theme preview on the right side is updated to reflect your choices.

4 Click OK.

**Use PowerPoint templates with Presenter**

In Presenter presentations, the slide background is determined by settings in PowerPoint. You can customize the background of the slides in a presentation by using PowerPoint design templates. When you apply a design template, all slides in the presentation are assigned the design template background.

For example, you might create a presentation in PowerPoint using the design template named Technology, add the theme named Arctic in the Presenter Theme Editor, publish the presentation to Connect Enterprise Server, and view the presentation. You notice that the theme clashes with the slide background of the Technology design template.

Follow the procedure below that corresponds to the version of PowerPoint installed on your computer. (To check which version of PowerPoint you have, open PowerPoint, click the Help menu, and select About Microsoft PowerPoint.)

**See also**

“Create and edit themes” on page 197

“Preview a presentation” on page 152

**Use PowerPoint 2000 templates as slide backgrounds**

1 In PowerPoint, open a presentation (PPT file).

2 From the Format menu, select Apply Design Template.
Note: If the Apply Design Template dialog box does not open to the Presentation Designs location on your computer, browse to the location at Program Files\Microsoft Office\ Templates\Presentation Designs.

3 Select an appropriate template that matches the theme you have chosen for your presentation and click Apply.

4 To test the design template background with the presentation theme, publish your presentation locally and view the results. (In PowerPoint, select Adobe Presenter menu > Publish. Select My Computer and click Publish.)

Use PowerPoint 2003 templates as slide backgrounds
1 In PowerPoint, open a presentation (PPT file).
2 From the Format menu, select Slide Design.
3 Select an appropriate template that matches the theme you have chosen for your presentation and click Apply.
4 To test the design template background with the presentation theme, publish your presentation locally and view the results. (In PowerPoint, select Adobe Presenter menu > Publish. Select My Computer and click Publish.)

Use PowerPoint XP templates as slide backgrounds
1 In PowerPoint, open a presentation (PPT file).
2 From the Format menu, select Slide Design.
3 Select an appropriate template that matches the theme you have chosen for your presentation and click Apply.
4 To test the design template background with the presentation theme, publish your presentation locally and view the results. (In PowerPoint, select Adobe Presenter menu > Publish. Select My Computer and click Publish.)

Add a logo
Note: If you added a video file, such as a “talking head” video file of a person speaking, that video is displayed in the logo area. If you add a logo file, the video file takes precedence and the logo will not be displayed.

You can add a custom logo to display in the Presenter viewer. This is a way to customize your presentations so that they look like other multimedia and publications your organization produces.

1 In PowerPoint, open a presentation (PPT file).
2 From the Adobe Presenter menu, select Preferences.
3 Click the Presenter tab and do one of the following:
   • Add a new presenter by clicking Add.
   • Select an existing presenter and click Edit.
4 Next to the Logo text box, click Browse.
5 Navigate to the location of the logo file you want to use (JPG or PNG format).
   Note: A logo size of 148 x 52 (pixels) is recommended so that the logo appears properly in the theme and the Presenter viewer.
6 Select the file and click Open.
The name of the file is displayed in the Logo text box and a preview of the logo appears on the right side.
7 Click OK.
8 To preview the custom logo, publish your presentation locally and view the results. (In PowerPoint, select Adobe Presenter menu > Publish. Select My Computer and click Publish.)
Include slide notes in presentations

You can include extra notes about a slide in your final presentation. Users view the notes by clicking on the Notes pane in the viewer sidebar. Slide notes are a good location for extra information about a slide such as numerical details, supporting materials, or footnote text. You can also use slide notes to communicate with users who do not have audio capabilities or are hearing impaired. You create slide notes in PowerPoint.

Note: The notes appear in the Presenter viewer as unformatted text. Any formatting applied to notes in the PowerPoint note pane is ignored.

1 In PowerPoint, open a presentation (PPT file).
2 Navigate to a slide for which you want to add a note.
3 Ensure that you are in Normal or Notes Page view.
4 Type note text directly into the notes area under the slide. (If you are in Normal view, but cannot see the notes area, it might be collapsed. Click the separator bar until the pointer changes to allow you to drag the separator bar. Drag up to display the notes area.)

To view the notes area, move the mouse pointer over the separator bar until an equal sign with two arrows appears, then drag up.

5 You can preview the notes by publishing your presentation locally, viewing the results, and clicking on the Slide Notes pane in the sidebar. (To publish locally, in PowerPoint, select Adobe Presenter menu > Publish. Select My Computer and click Publish.)

Change presentation settings

You can change settings, such as the title and summary, and some presentation behavior, such as pausing and looping, using the presentation settings dialog box.

1 In PowerPoint, open a presentation (PPT file).
2 From the Adobe Presenter menu, select Presentation Settings.
3 Click the Settings tab.

Title  Type in a name for the presentation. The title appears in the Presenter viewer.

Summary Type in a summary for the presentation. A summary is usually a short description of the presentation contents. This optional presentation summary is a useful organizational tool for authors. The summary appears only in the settings; it does not appear in the published presentation and is not visible to users.
Note: The presentation summary does appear in Connect Enterprise Server after a presentation is published to the server. Summaries can be edited through Connect Enterprise Manager. Presentation authors can search summaries and see the summary when viewing content information.

Auto play presentation on start Select to have the presentation automatically begin playing when it is opened. (If this option is not selected, a presenter or users must click the Play button in the toolbar to start the presentation.)

Include slide numbers in outline Select to include the slide number within the Outline pane when the presentation is displayed.

Pause after each animation If your presentation contains PowerPoint animations, select this option to pause the presentation automatically after the animations play. This is useful if you want to clearly define where the animation ends and the presentation begins again. (After clicking through each animation, you will need to click the Play button on the playbar to start the presentation again.)

Loop presentation Select to have the presentation loop and replay continuously when opened.

Time to wait for slides without audio Select an amount of time (in seconds) for slides without audio to appear. (By default, slides with audio play for the length of the associated audio file.)

4 Click OK to close the Presentation Settings dialog box. Your changes will be incorporated into the published presentation.

Automatically play a presentation
You can set an option so that a presentation automatically plays when it’s opened, or you can require that a presenter or user click the Play button in the toolbar to start the presentation.

1 In PowerPoint, open a presentation (PPT file).
2 From the Adobe Presenter menu, select Presentation Settings.
3 Click the Settings tab.
4 Select Auto Play Presentation on Start. (By default, this option is selected.)
If this option is not selected, a presenter or users must click the Play button in the toolbar to start the presentation.
5 Click OK to close the Presentation Settings dialog box. Your changes will be incorporated into the published presentation.

Loop a presentation
You can set your presentation to play once and then stop (the default setting), or to loop and replay continuously.

1 In PowerPoint, open a presentation (PPT file).
2 From the Adobe Presenter menu, select Presentation Settings.
3 Click the Settings tab.
4 Select Loop Presentation.
5 Click OK to close the Presentation Settings dialog box. Your changes will be incorporated into the published presentation.
Change slide display timing
You can change the display time for slides without audio. (By default, slides with audio play for the length of the associated audio file.) This is useful for controlling the overall speed at which presentations without audio play.  
1 In PowerPoint, open a presentation (PPT file).
2 From the Adobe Presenter menu, select Presentation Settings.
3 Click the Settings tab.
4 In the Time to Wait for Slides Without Audio text box, enter a new number (in seconds) or use the up and down arrows to set a new number.
5 Click OK to close the Presentation Settings dialog box. Your changes will be incorporated into the published presentation.

Set a presentation to open in full-screen mode
You can choose to have your presentation open normally or in full-screen mode. Normally, the presentation appears with the toolbar and the sidebar. As an alternative, you can have the presentation open in full-screen mode with only a small, modified toolbar appearing in the bottom right corner.
1 In PowerPoint, open a presentation (PPT file).
2 From the Adobe Presenter menu, select Theme Editor.
3 The Theme Editor dialog box appears.
4 From the Default Mode on Startup pop-up menu, select Default or Fullscreen.
5 Click OK.

Publishing and viewing in Connect Enterprise Server

About Adobe Connect Enterprise Server 6
For others to view your presentation, you must publish the presentation to Connect Enterprise Server. Users can see your presentation in the viewer within Connect Enterprise, as part of a course or curriculum in Connect Training, or with a URL provided by the Content library. The Presenter viewer delivers rich-media content in a powerful, interactive format.

Connect Enterprise is a web communication system that lets you quickly and easily view presentations, attend meetings, and receive training over the Internet using the familiar PowerPoint application, web browsers, and Flash Player.

Note: Users do not need to have PowerPoint installed in order to view a presentation created with Presenter. Only the person creating presentations needs to have PowerPoint installed.

Connect Enterprise includes a set of components that provides an integrated solution. Connect Enterprise can be deployed with some or all of these components:

Adobe Acrobat Connect Professional lets you view and participate in a meeting over the Internet in real time.

Connect Training lets you participate in online training systems including integrated surveys, tracking, analysis, and course management.
**Connect Events** provides tools to manage the full cycle of an event, from registration and qualification of users to post-event follow-up.

**Access your Connect Enterprise Server account**
You can access your Connect Enterprise Server account quickly and easily from Presenter.

❖ From the Adobe Presenter menu, select Manage Account.

Your default web browser opens and the Connect Enterprise Server login page appears.

**Note:** You can change which Connect Enterprise server appears when Manage Account is selected by clicking Adobe Presenter menu > Preferences, and in the Connect Enterprise Server tab, selecting a different server in the publishing list, and clicking Close.

**Manage the Connect Enterprise Server publishing list**
Presenter provides you with an easy way to maintain a list of Connect Enterprise servers that you publish to regularly. You can add one or several Connect Enterprise servers to the publishing list. After a server has been added to the list, it's easy and quick to publish to that server.

**Add a Connect Enterprise server to the publishing list**
Before you can publish to a Connect Enterprise server, you need to add information, such as a name and URL address, to the publishing list. You can add as many Connect Enterprise servers to the list as necessary.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Preferences.

3 Click the Servers tab.

4 Click the Add button.

5 In the Name text box, enter a unique name for the server. (This is only used locally to help you distinguish between multiple servers easily.)

6 In the URL text box, enter the exact URL address of the server.

**Note:** The URL you enter here is the same URL you use to log in to Connect Enterprise Manager. If you do not know this URL, consult your Connect Enterprise administrator.

7 Click OK.

The server now appears in the publishing list and you can select it in the Publish dialog box.

**Note:** The server that is highlighted in the publishing list is the one that will be used when you publish to Connect Enterprise Server.

8 Click Close.

**Edit a Connect Enterprise server in the publishing list**
After you have added a Connect Enterprise server to the publishing list, you can edit the server name or URL at any time.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Preferences.

3 Click the Servers tab.

4 Select a server in the list and click Edit.
Make any necessary changes to the server name or URL.
Click OK.
Click Close.

Remove a Connect Enterprise server from the publishing list
You can remove a Connect Enterprise server from the publishing list.

1. In PowerPoint, open a presentation (PPT file).
2. From the Adobe Presenter menu, select Preferences.
3. Click the Connect Enterprise Server tab.
4. Select a server from the list and click Delete.
5. Click OK.
6. Click Close.

Publish to a Connect Enterprise server
After creating and previewing your presentation, you can publish the presentation directly to a Connect Enterprise server in your publishing list. You can fully integrate Presenter presentations with Connect Enterprise so that, for example, presentations containing quizzes can have quiz results automatically sent to and managed by a Connect Enterprise server.

Note: To publish to a Connect Enterprise server, you must be connected to the Internet and have a Connect Enterprise account.

When you publish to Connect Enterprise, the presentation is published to the Content library. The presentation can be taken from the Content library, and pulled into Acrobat Connect Professional or Connect Training.

Note: A Presenter presentation must be 100 MB or smaller in size to publish to a Connect Enterprise server. (You can create a Presenter presentation that is greater than 100 MB in size, but it cannot be published to a Connect Enterprise server.)

To publish to a Connect Enterprise server, you follow this general workflow: Select a Connect Enterprise server, log in to Connect Enterprise, select a location for your presentation, enter information about the presentation, and finally set permissions specifying who can view it.

Select a Connect Enterprise server
The first step in publishing a presentation to a Connect Enterprise server is to select the server from the publishing list to which you want to publish.

1. In PowerPoint, open a presentation (PPT file).
2. From the Adobe Presenter menu, select Publish.
3. On the left side of the Publish dialog box, select Adobe Connect.
4. Check that the Name and URL information is correct. If the information is not correct or if you need to publish to a different server, click Server Settings.
5. (Optional) Check the Presentation Information area on the right side. If you want to edit any of the options, such as Presenter Name or Loop Presentation, click Settings.
6. (Optional) If you want to publish the presentation source files (PPT and PPC) along with the SWF file, select Upload Source Files to the Server. This option is useful if multiple authors are working on a presentation or if you think the presentation will need to be updated later and you want to keep all of the files stored in one location.

7. (Optional) You can change the theme by clicking on the Theme pop-up menu and selecting a different theme. (The preview is updated to reflect your choices.)

8. Click Publish.

The presentation is created and the Connect Enterprise Login screen appears.

The next section describes how to log in to your Connect Enterprise account.

**Log in to Connect Enterprise**

The next step in publishing a presentation is to log in to your Connect Enterprise account. You must have an account and the correct security permissions before publishing a presentation. (To obtain permission to create and update presentations, contact your Connect Enterprise administrator.)

1. On the Connect Enterprise Login screen, enter your login name (usually your account e-mail address).

2. Enter your password.

3. Click Login.

The next section explains how to select a location in which to save a presentation.

**Select a location for the presentation**

The third step in publishing a presentation is to select a location in your Connect Enterprise account in which to store the presentation. After you log in to Connect Enterprise, your personal user folder in the Content library appears. Select a location in your Connect Enterprise Account library for the presentation.

*Note: The Content library displays only your presentations. Other Connect Enterprise content, including SWF files, FLA files, and JPG files, are not displayed when you view the Content library.*

*Note: If you have already published the presentation to the server, you are prompted to save over the previous version or to save the presentation to a new location.*

1. In the Adobe Connect Publish screen, navigate to a folder within your Connect Enterprise Account library in which to store the presentation.

   • To open a folder and display its contents, click the name of a folder. The folders and files within that folder are displayed. The navigation path for links near the top of the browser window is updated to indicate the directory path to the selected folder.

   • To publish changes to a presentation already located in the folder, click Update Existing Presentation. The new version of the presentation overwrites the existing presentation.

   • To create a new folder, navigate to the location where you want to add a new folder, click the New Folder button, enter a name for the new folder, and click Save.

   *Note: You can create folders only if you have manage permissions for the parent folder.*

   • To move up to the parent folder (the folder one level above the current folder), click the Up One Level button in the navigation bar above the content list.

2. Click Publish to This Folder.

The next section explains how to enter descriptive information for the presentation.
Enter presentation information
The fourth step in publishing a presentation is to provide identification information about the presentation. You must specify a title for the presentation. You also have the option of adding a custom URL to view the presentation and a brief description.

1. In the Content Information dialog box, enter a unique name for the presentation in the Title text box.

2. (Optional) In the Custom URL text box, you can create your own URL to view the presentation. This option is useful if you want to create a URL to view the presentation that can be remembered easily. If you leave this text box blank, Connect Enterprise automatically creates a generic, but unique, URL for the presentation.

3. (Optional) In the Summary text box, type in a short description of the presentation. (Maximum length of the summary is 750 characters.)

4. Click Next.

The final step in the publishing process is to set permissions for who can view the presentation.

Set permissions
The final step in the publishing process is to set permissions for the presentation. This establishes who is able to view the presentation. You have several options available.

1. On the Set Permissions screen, select a permission setting.
   - The default permission setting is Same as Parent Folder. If you select this option, the presentation automatically inherits the same permission profile as the parent folder in which it’s published. For example, if the parent folder has permission for public viewing, the presentation will also have permission for public viewing.
   - To change the permission setting, click Customize. To create a public presentation, select Yes next to the Allow Public Viewing option. To create a private presentation with a custom permission profile that is different from that of its parent folder, make sure the Allow Public Viewing option is not selected. Then, create a list of users and groups with specific permission types. In the Available Users and Groups list on the left, select a group or individual and click Add. The new user or group now appears in the Current Permissions list on the right. Continue adding or removing users or groups as necessary.

2. Click Finish.

3. A dialog box appears and confirms that the project was successfully published to the specified Connect Enterprise server. Click OK.

The Content Information dialog box appears. This screen lists important information about the presentation, including the URL for viewing. If you click the URL, the presentation is displayed and begins to play. To share the presentation with others, you can send them the URL by clicking E-mail Link, or by cutting and pasting the URL into an e-mail. (For users to view the presentation, the published presentation or the folder containing the presentation must have the correct permissions set.)

4. Click OK to complete the publishing process.

Add a Presenter presentation to an Acrobat Connect Professional meeting
Adobe Presenter lets you create e-learning content and high-quality multimedia presentations containing slides, streaming audio, synchronized animation, and navigation controls rapidly using Microsoft PowerPoint as a base.

After you have published a Presenter presentation to Connect Enterprise, you can add the presentation to an Acrobat Connect Professional meeting by bringing the presentation file into the meeting from the Content library or directly from your computer. When viewing the presentation in Acrobat Connect Professional, you have complete control over the screen side, slide navigation, and audio.
Note: Adobe recommends adding presentations to an Acrobat Connect Professional meeting from the Content library. Presentations uploaded directly from your computer and into an Acrobat Connect Professional meeting do not support some Presenter features. For example, if you share the presentation PowerPoint (PPT) file, presenter photos, presenter logos, and the Thumbnail pane are not displayed.

Add a presentation from the Content library to an Acrobat Connect Professional meeting
Adding a presentation to an Acrobat Connect Professional meeting from the Content library is a good method to use if you publish all of your presentations to the library and manage them from that location. (You also have the option to add a presentation to an Acrobat Connect Professional meeting directly from your computer.)

1 Open your web browser and navigate to your Connect Enterprise server.
2 Log in using your login name and password.
3 Click the Meetings tab.
4 Select a meeting from the list.
5 Click Enter Meeting Room.
The Acrobat Connect Professional Meeting appears.
6 Select Pods menu > Share > Select from Content library.
7 Select the presentation and click Open.
8 The Presenter presentation appears in the Acrobat Connect Professional meeting.

Add a zipped presentation from your computer to an Acrobat Connect Professional meeting
If you have a Presenter presentation stored on your computer, you can add the presentation directly from that location into an Acrobat Connect Professional meeting. This is a good method to use if you need to place a presentation into an Acrobat Connect Professional meeting, but the presentation has not been published to the Content library. For example, you might have a presentation that you have not published because it is incomplete, but you want to show a preliminary version in an Acrobat Connect Professional meeting.

Note: Adobe recommends adding presentations to Acrobat Connect Professional Meeting from the Content library. Presentations uploaded directly from your computer and into an Acrobat Connect Professional meeting do not support some Presenter features. For example, if you share the presentation PowerPoint (PPT) file, presenter photos, presenter logos, and the Thumbnail pane are not displayed.

1 In Presenter, publish your presentation locally and select the Zip files Output Option. (To do this, click the Adobe Presenter menu, select Publish, click My Computer, select the Zip file option, and click Publish.)
2 Open your web browser and navigate to your Connect Enterprise server.
3 Log in using your login name and password.
4 Click the Meetings tab.
5 Select a meeting.
6 Click Enter Meeting Room.
The Acrobat Connect Professional meeting appears.
7 From the Share pod, select Documents > Select from My Computer. (If a Share pod is not open, click the Pods menu and select Share > Share.)
8 Navigate to the presentation folder on your computer.
9 Select the presentation zip file and click Open.
10 The Presenter presentation appears in the Acrobat Connect Professional meeting.

**Add a presentation PowerPoint (PPT) file from your computer to an Acrobat Connect Professional meeting**

1 Open your web browser and navigate to your Connect Enterprise server.
2 Log in using your login name and password.
3 Click the Meetings tab.
4 Select a meeting.
5 Click Enter Meeting Room.

The Acrobat Connect Professional meeting appears.

6 From Share pod, select Documents > Select from My Computer. (If a Share pod is not open, click the Pods menu and select Share > Share.)
7 Navigate to the presentation PowerPoint (PPT) file.
8 Select the PPT file and click Open.
9 The Presenter presentation appears in the Acrobat Connect Professional meeting.

**View a presentation in an Acrobat Connect Professional meeting**

After you publish a presentation to a Connect Enterprise server and then add the presentation to an Acrobat Connect Professional meeting, the presentation is ready to view. All of the features in the presentation, such as audio, synchronized animation, quizzes, and presenter information, appear.

**Note:** If you upload your presentations directly from your computer and into an Acrobat Connect Professional meeting, some Presenter presentation features, such as presenter photos and presenter logos, are not supported. Adobe recommends adding presentations to Acrobat Connect Professional meetings from the Content library.

If the presentation contains quiz or survey questions, user interactions with the questions are fully tracked by the Connect Enterprise server as part of the meeting's reports.

The layout of a Presentation consists of the following parts:

- **Presentation** The main part of the window, which displays the presentation slides.
- **Presentation sidebar** An area on the right side (default location) of the browser window that shows the name of the presentation, the presenter information, and the Outline, Thumb, Notes, and Search panes (if you have added the panes to your theme) The Presentation sidebar is shown in Normal view; it is hidden in Full Screen view.
- **Presentation toolbar** A control bar at the bottom of the presentation, which gives you control over the presentation playback, audio, attachments, and screen size.

**See also**

“Preview a presentation” on page 152

**Viewing the Outline pane**

Most presentations have an Outline pane on the sidebar. The Outline pane lists the title and duration of each slide. Use the Outline pane to display information and to enable users to move to individual slides in the presentation. You can omit the Outline pane from the sidebar. At this time, it is not possible to show the slide outline in a read-only format; if the outline is showing, users will be able to click the slides listed.
**Note:** Quiz slides are not, by default, listed in the Outline pane. If you want quiz slides to appear in the Outline, open the Quiz Manager, click Edit Quiz Settings, and select the Show questions in outline option.

**Note:** If you have a Windows XP English PC and need to view double-byte unicode characters (for example, Japanese characters) in the outline pane, you should have the Arial Unicode MS font installed on your computer.

- Click the Outline pane in the sidebar on the right side.

The Outline pane contains the following features:

- The current slide is highlighted with a glow color. (This color can be changed in the theme.)
- The entire slide title appears when the pointer is held over the title.
- The duration of the slide is shown next to each slide.
- You can move to any slide in the presentation by clicking the slide title in the Outline pane.

The Outline pane

A. Selected slide currently previews  B. Hover cursor over title to see the entire title

**View the Thumb pane**

Presentations can have a Thumb pane on the sidebar. The Thumb pane shows a small picture of each slide, the slide title, and the slide duration. You can use the Thumb pane to see the contents each slide quickly and to move to a specific slide in the presentation.

**Note:** If you upload your presentations directly from your computer and into an Acrobat Connect Professional meeting, the Thumb pane is not displayed. Adobe recommends adding presentations to Acrobat Connect Professional meetings from the Content library.

- Click the Thumb pane in the sidebar on the right side.

The Thumb pane contains the following features:

- The current slide is highlighted with a glow color. (This color can be changed in the theme.)
- The entire slide title appears when the pointer is held over the title.
- You can move to any slide in the presentation by clicking the slide title in the Thumb pane.

**View slide notes**

When creating a presentation in PowerPoint, you can enter notes for individual slides. If any slide notes exist, they can be displayed in the Presentation.

**Note:** Using slide notes is optional.

When slide notes appear, they are located on the right side of the presentation window. You cannot change the size of the slide Notes pane.

- Click the Notes pane in the sidebar on the right side.
The Notes pane contains the following features:

- The complete notes text is displayed. (The text is unformatted and cannot be edited directly on the pane.)

**Search for text in a presentation**

Users can use the Search pane (if you have included it in your theme) to find specific text in a presentation. For example, in a presentation that serves as a company human resources handbook, a user might search for the word *vacation* to find text about vacation leave policies.

1. Click the Search pane in the sidebar on the right side.
2. Type the text to search for directly into the text box. (Search is not case-sensitive.)
3. Click the Search button.

Search results are displayed below the text box. Click any slide title in the results list to display that slide.

![Using the Search pane](image)

A. Text box  B. Search button  C. Results

**Use the presentation toolbar**

You can control the presentation appearance and playback by using the toolbar located at the bottom of the presentation.

![Toolbar](image)

The toolbar that appears in the published presentation contains useful buttons, controls, and messages.

- **A. Play**  B. Back  C. Forward  D. Position marker in slide progress bar  E. Current slide time  F. Total slide time  G. Audio volume  H. Attachments  I. Show/Hide sidebar

- Click any of the following buttons and features on the toolbar.

**Play/Pause button**  Pauses and then resumes play of the current slide.

**Back button**  Moves to the previous slide in the presentation.

**Forward button**  Moves to the next slide in the presentation.

**Slide progress bar**  Shows and controls the playback location within the current slide. The position marker moves as the slide plays. You can drag the marker arrow forward or back in the current slide to change your location within the slide playback. You can also click a specific location on the progress bar to move the slide marker position and slide playback to that position. (If you added a video file, such as a "talking head" video file of a person speaking, the slide progress bar also controls the video.)

**Current slide number**  Shows the number of the currently displayed slide and the total number of slides (for example, Slide 2 out of 10).

**Status**  Shows the status of the current slide, such as Playing, Stopped, No audio, or Presentation complete.
Time  Shows the current slide time and the total slide time as the slide plays (for example, 00.02/00.05).

Audio volume  Shows the volume level that is set for the slide.

Attachments  Displays a small window showing any attachments (for example, documents, spreadsheets, images, URL addresses, and so on) that have been added.

Show/Hide sidebar and toolbar  Shows or hides the sidebar and toolbar.

Note: The behavior of the Forward button, Back button, and slide outline can be affected by settings in the Quiz Manager. For example, if a learner must pass a quiz before continuing, clicking the forward button or a slide in the outline that is beyond the quiz slide will have no effect unless the learner has passed the quiz.

Switch between viewing modes
You can view Presentations in two modes:

Normal  The default viewing mode. It includes the presentation toolbar at the bottom of the browser window and the presentation sidebar.

Full-screen  An optional viewing mode in which the presentation toolbar is removed and the size of the presentation slides increases to fill your browser window.

1  Click the Full Screen button at the bottom (lower right) of the Presenter viewer.

If the presentation outline was originally visible, the Presentation switches to full-screen mode without a presentation sidebar. If a presentation outline is not originally visible, the Presentation switches to full-screen mode with no toolbar.

2  Click the Full Screen button again to change viewing modes.

If presentation controls are originally visible, the presentation switches to full-screen mode without a presentation outline or presentation toolbar. If a presentation toolbar is not originally visible, the presentation switches to normal viewing mode with or without a presentation outline.

Navigate between slides
You can navigate between slides during playback by using the search pane, the presentation toolbar, or the presentation Outline or Thumb pane.

Note: The Outline pane and Thumb pane are optional. Set panes for presentations using the Theme Editor in Presenter.

❖  Do one or more of the following:
•  Click the Previous slide button  in the presentation toolbar to move to the previous slide.
•  Click the Next slide button  in the presentation toolbar to move to the next slide.
•  Click the title of a slide in the presentation Outline or Thumb pane to move to any individual slide in the presentation.
•  Use the Search pane to find specific slides.

Navigate within the current slide
❖  Do one or more of the following:
•  Click the Pause button  on the presentation toolbar to pause slide playback.
•  Click the Play button  on the presentation toolbar to resume slide playback.
•  Drag the position marker arrow on the slide progress bar forward or backward to change your location within the slide's playback.
Adjust the presentation audio
You can turn the presentation audio on and off or control the volume by using the audio button on the presentation toolbar. Examples of presentation audio that the audio button can control include audio imported into a slide and audio in an embedded SWF file (for example, a “talking head video”).

Note: Not all slides or presentations contain audio.

If a slide does not have any audio, the text No audio appears as the slide status on the slide progress bar. The slide still has an audio length and appears for that period of time before the next slide appears. This time is set by the presentation speaker.

❖ To change the audio level, click the Audio button in the presentation toolbar and move the volume bar up or down. Moving the volume bar all the way to the bottom mutes the audio completely.

Viewing a presentation in Connect Training
You can use Presenter presentations within Connect Training courses. This enables you to quickly create e-Learning courses for formal assessments, compliance training, or information sharing. The new curriculum feature allows you to make your presentations part of a learning path. Quiz and survey results are tracked on a user-by-user and question-by-question basis. The results data can be viewed in Connect Training reports.

Using presentations with Connect Events
Connect Events is a new application that provides tools to manage the full cycle of an event, from registration and qualification of users to post event follow-up. The Connect Event dashboard and reports include user demographic information, registration, and tracking at the individual user level. Connect Enterprise generates exportable files in CSV format for import into CRM and other systems.

Note: If you want to use an existing Presenter presentation as an event, it is important to rename the presentation and republish the presentation to a different location and different folder in the Connect Enterprise Content library. This ensures that reporting information for the event does not include reporting information from prior events.

Using presentations with third-party learning management systems
Presenter lets you use presentations with any SCORM or AICC compliant learning management system (LMS). Use the Reporting tab in the Presenter Quiz Manager to choose the correct reporting settings for the LMS and to create a content package that can be uploaded to the LMS.

Troubleshooting presentations
Optimizing Flash (SWF) files
Each slide in a presentation is loaded as an individual external Flash asset and can be augmented with any SWF file. When working with embedded SWF files, follow these guidelines:

• Author the Flash SWF file at 30 frames per second. Presenter presentations are created at 30 frames per second, so Flash files with the same setting can be integrated into the presentation smoothly.
• In Flash, set the maximum canvas size to 720 x 540 pixels.
• Don’t use _root or absolute movie clip references. Use relative paths in the MovieClip object references, not _root.
• The SWF file you want to embed must not attempt to make any changes outside its own file. Therefore, the code cannot refer to the following variables: _level#, _global, or stage.

**Control inserted SWF files**

If you added a SWF file to a presentation, but are having trouble using the Presenter playbar (Stop, Pause, Play, or other buttons) to control the SWF file in the viewer, you may need to change a setting.

*Note: SWF files authored at 30fps work best in presentations.*

**Specify how an inserted SWF file is controlled**

1. In PowerPoint, open a presentation (PPT file) that contains an added SWF file.
2. From the Adobe Presenter menu, select Presentation Settings.
3. Click the Flash Files tab.
4. Select one of the Flash files in the list.
5. Select the Controlled by Presentation Playbar option.

You will now be able to control the selected Flash file by using the Presenter playbar in the published presentation.

6. Click OK.
Chapter 8: Managing the Adobe Connect Enterprise Account

The Adobe Connect Enterprise account

About account administration
Adobe Connect Enterprise Server 6 administrators are users who manage the Connect Enterprise Server application for their entire organization. Typically, administrators control all aspects of accounts and perform such tasks as creating custom user groups and assigning users to groups. If you are an administrator, use the following links at the top of the Administration tab in Connect Enterprise Manager to do your work:

Account  Manage the account settings that are unique to your organization and generate reports using the Report link.

Users And Groups  Manage new and existing users, groups, and guests.

Customization  Customize Connect Enterprise Server for your organization. This link is available only if your organization purchased Customization features.

Service Plan  Access more information, if your organization signed up for its Adobe Connect Enterprise account on the web.

Administration Dashboard  Monitor quota usage of your organization’s Adobe Connect Enterprise account.

About the administration workflow
To get the best results when administering your account, follow this workflow:

1. Define parameters for Connect Enterprise Server users and customize the look of Connect Enterprise Server.
First, use the account management features to specify information about your Connect Enterprise Server account such as a default language and time zone. If your organization purchased Customization features, you can also use the account management features to change the look of the Connect Enterprise Server user interface.

2. Define attributes of user profiles.
Define the attributes, such as custom fields, of your organization’s Connect Enterprise Server account user profiles, as well as the login and password rules that Connect Enterprise Server users must follow.

3. Add users and groups.
After you define the user profile, login, and password attributes and rules, you can add users and groups to the Connect Enterprise account.

4. Use the Connect Enterprise account maintenance tools.
After Connect Enterprise is operational and you have set up users and groups in your organization’s account, you can use the Account Summary, Reports, and Administration Dashboard features to monitor system usage.
About your organization’s Connect Enterprise Server account

The Account Summary page appears when you click the Administration tab. It gives information about your organization’s Connect Enterprise Server account, and it provides feature information, such as descriptions of the applications and products that are enabled for this account.

General account information

The Account Information section shows profile details for the entire Connect Enterprise Server account. It contains the following information:

Name  The name of your Connect Enterprise Server account.

Domain  The domain where your Connect Enterprise Server account resides.

Default Language  The language in which you manage your account.

Default Time Zone  The time zone set for your account.

Event User Policy  (If Events is part of your Connect Enterprise Server account.) The rules you follow when registering guests and full users for Events.

Expiry Date  The expiration date for your account.

Primary Contact  The individual who was named as the primary contact when the Connect Enterprise Server account was established for your organization.

Primary Contact E-mail  The primary contact’s e-mail address.

System and application feature information

Under the Features heading, you see information about your organization’s Connect Enterprise Server account. The check mark by the application name means it is enabled. The information displayed relates to the pricing model and quotas that your organization uses for this application.

System Features  In Bandwidth Per Month shows the amount of data transmitted to or from your Connect Enterprise Server account monthly compared to the amount of bandwidth you are allowed to use. Disk Usage (MB) shows the amount of hard disk space consumed by your Connect Enterprise Server account compared to the amount of disk space you are allowed to use.

Presentation  The number of authors in your installation compared to the number that is permitted.

Training  The pricing model that your organization uses for training. Training managers lists the number of managers in your installation compared to the number that is permitted. Named Training Learners lists the number of learners that have been added to the learners group compared to the number that is permitted. (Only members of this group can view training content.) Training Concurrent Learner License Limit lists the number of users who can simultaneously view training content.

Meeting  The pricing model that your organization uses for attendees. Meeting Administrators lists the number of administrators in your installation compared to the number that is permitted. Meeting Peak Concurrent Users lists the number of users who can simultaneously attend meetings. (The Soft Limit is the amount of quota that was purchased and the Hard Limit is the amount of quota that is enforced.) The Concurrent Users Per Meeting is the number of users who can simultaneously attend a single meeting.

Seminar Rooms  The number of administrators in your installation compared to the number that is permitted.

Event Management  The number of administrators in your installation compared to the number that is permitted.

Under the Advanced Features heading, you see advanced features that your organization has purchased, such as the following:
FlashPaper  An Adobe product that enables you to convert HTML, Microsoft Word, and PowerPoint files into Flash documents for the web.

Customization and Rebranding  A feature that allows you to customize and brand your Connect Enterprise Server installation for your organization.

Secure Connection/Non-secure Connection  A feature that determines whether your Connect Enterprise Server installation uses SSL to encrypt all communication between the server and connected users.

Connect Enterprise pricing models and quotas
When you click the Administration tab and the Account Summary page appears, the information under the Features heading shows which Connect Enterprise applications are enabled for your organization’s Connect Enterprise account, as well as the pricing model, quota, and usage information for each. The pricing model determines how your organization pays for its Connect Enterprise usage and is associated with the quota and usage information that you see under System Features. There are different models for training and meetings.

Training pricing models
There are two pricing models for training, the concurrent learner model and the named learner model:

Named learners  This applies a limit, which is based on how many users can have a valid user account on the system. Only users with valid accounts may be active in courses or curriculums.

Concurrent learners  This limits how many learners can be active in all courses or curriculums at the same time.

Meeting pricing models
As with training, there are two pricing models for meetings; you see the information appropriate for the model that your organization purchased:

Concurrent attendee  This model applies a limit that determines how many participants can be active in a meeting at the same time. Attendees in a seminar are not affected by this limit.

Named organizer  This model applies a limit that determines how many users can initiate meetings. Each named organizer can initiate only one active meeting at a time, and each meeting is limited to the number of participants specified in the license file. A named organizer must be present to start a meeting, and a meeting ends if all named organizers leave the meeting.

Pricing model rules
Concurrent and named users cannot mix. That is, you cannot have quotas for named organizers and concurrent users in the Meeting application at the same time, nor can you have named learners and concurrent learners in the Training application.

However, you can have named organizers in the Meeting application and concurrent learners in the Training application at the same time, or you can have concurrent users in the Meeting application and named learners in the Training application at the same time. In other words, the Meeting and Training applications are treated separately.

Seminar room quotas
Seminar rooms are treated individually and do not affect any other quotas. There is a seminar attendee limit, which determines how many participants can be active in a particular seminar at the same time. The limits apply to each seminar room independently.
At least one Connect Enterprise user with presenter or host rights for the seminar must be in the room in order for others to enter, even if the seminar is a public meeting. A seminar ends if all meeting users with presenter or host rights leave the meeting.

**See also**

“About seminars” on page 116

**Edit Connect Enterprise Server account information**

Most of the account information on the Account Summary page derives from your organization’s Connect Enterprise Server installation and cannot be changed through Connect Enterprise Manager. As the administrator, you can modify the following for your Connect Enterprise Server account: the default time zone, the default language, the Event user policy (if Events is part of your Connect Enterprise Server account), and the primary contact information.

The information that you modify here applies to the entire Connect Enterprise Server account. (To change your own user account profile information, click My Profile in the upper-right corner and use the Edit My Preferences option.)

1. Click the Administration tab at the top of the Connect Enterprise Manager window.
2. Click Edit Information.
3. Do any of the following, as appropriate:
   - To change the default language, select a language (English, French, German, Korean, or Japanese) from the Default Language pop-up menu.
   - To change the default time zone, select a time zone from the Default Time Zone pop-up menu.
   - To change the rule for event registrants, select an option from the Event User Policy pop-up menu.

   **Note:** The Event user policy can be set account-wide here on the Account Information page or set on a per-Event basis. If the two settings conflict, the account-wide setting takes precedence over the individual Event setting (this gives Administrators control over what options are available to Event managers). If you want to give Event managers the flexibility to change the setting for individual Events, on the Account Information page select the option to allow Event manager to choose whether registrants are guests or full users.
   - To change the contact information, enter a first name, last name, and e-mail address in the Primary Contact text boxes.
4. Click Save.

**Viewing the Administration Dashboard**

The Administration Dashboard link on the Administration tab lets you see a graphical representation of your usage information. Five bar graphs display the following information:

- Authors quota (the number of authors your Connect Enterprise Server account allows)
- Learners quota
- Meeting administrators (hosts) quota
- Monthly bandwidth (in kilobytes)
- Disk space per month (in kilobytes)

The grey bar represents your current usage, and the dark green bar represents your limit. You can use both these bars to obtain the following information:
• The height of each bar falls within a specific range, but you can move the pointer over either bar to see the precise maximum figure for that bar.

• If you click either bar in a group quota graph, a group information page appears. The page lists the name and a description of the group and contains a View Group Members button that you can click to view current members and add new members.

• The monthly bandwidth and disk space graphs reflect the information shown under the Features header on the Account Summary page.

**Customize Connect Enterprise**

If your organization purchased the Connect Enterprise Customization features, the Customization link is enabled on the Administration tab. The Customization features let you adapt the appearance of your Connect Enterprise Server installation to match your organization's identity.

**See also**

"About Acrobat Connect Professional meetings" on page 29

**Customize the Connect Enterprise Manager UI**

Use the Customize Banner link to customize the following elements of the Connect Enterprise Manager user interface (UI):

• Background color.

• Top links text color (for the My Profile, Help, and Logout links in the upper-right corner).

• Navigation text color (for the links below the tab bar).

• Selection highlight color.

• Table header color (for the bars that identify page titles or columns on list pages).

• Banner logo, the image that appears in the upper-left corner of Connect Enterprise Manager. This image is clickable, and takes the user to the web address you specify. The image must be a JPEG, PNG, GIF, or BMP file and must be 275 x 50 pixels.
Customize Banner settings
A. Banner logo  B. Navigation text  C. Selection highlight  D. Table header

1. Click the Administration tab.
2. Click Customization.
3. To change the color of the background, top links text, navigation text, selection highlight, or table header, click the item name in the list to the right of the color grid; then click a color in the grid or type a color code, such as #33CC66, directly into the text field. The color swatch at the top of the grid changes to the color you clicked in the grid or specified in the text field.

To change the color swatch to the previous setting, click Clear. To restore all colors and the banner logo to the Connect Enterprise Server defaults, click Reset To Default.

4. To select a banner logo, click Browse below the Banner Logo heading and browse for the logo image (JPEG, PNG, GIF, or BMP file). If you don’t select a logo, the Connect Enterprise logo appears in the banner.

5. Click Apply to save your changes.

Your changes appear in five to ten seconds; alternatively, you can refresh the page.

**Note:** After selecting a new banner logo, the logo is displayed in the preview area. When you click Apply to save your changes, the banner preview area may change and once again display the default banner. This behavior is a result of cache settings, particularly how the cache is set to check for and update new items, in your web browser. Users, however, will see the new banner logo.
Customize the Connect Enterprise login page

Use the Customize Login link to customize the Connect Enterprise login page. You can modify any of the following attributes:

- Meeting title color
- Login text color
- Background color (login area color)
- Main logo image, which must be a 410 x 310 pixel JPEG, PNG, GIF, or BMP file

**Customize Login settings**

A. Main logo  B. Meeting title  C. Login text  D. Background

1. Click the Administration tab.
2. Click Customization.
3. Click Customize Login.
4. To change the color of the meeting title text, login text color, or background color, click the item name in the list to the right of the color grid; then click the color in the grid. The color swatch at the top of the grid changes to the color you clicked.

   To change the color swatch to the previous setting, click Clear. To restore the original setting, click Reset To Default.

5. To select a main logo, click Browse below the Main Logo heading and browse for the logo image (JPG, PNG, GIF, or BMP file). If you don't select a logo, the Connect Enterprise logo is used as the main logo.
6. Click Apply to save your changes.

Your changes appear in five to ten seconds; alternatively, you can refresh the page.
Note: After selecting a new main logo, the logo is displayed in the preview area. When you click Apply to save your changes, the main logo preview area may change and once again display the default logo. This behavior is a result of cache settings, particularly how the cache is set to check for and update new items, in your web browser. Users, however, will see the new main logo.

Customize the appearance of an Acrobat Connect Professional Meeting

You can use the Customize Meeting option to modify the appearance of Acrobat Connect Professional Meeting. The settings you apply here appear in every meeting created in your organization's account. (However, these settings do not affect the meeting layout, which the host designs to accommodate the meeting's function.) The Customize Meeting option allows you to change the following:

• Highlight color of the item selected in a primary menu
• Highlight color of the item selected in a secondary menu (the cascading menu that appears after the user selects an item in the primary menu)
• Button rollover color (the color outline that appears around a button when you move the pointer over it)
• Background color
• Title bar color (the color of the pod title)
• Meeting logo (a 50 x 20 pixel JPG, PNG, BMP, or GIF file to use for your organization's meetings)
• Meeting URL (a website to which users are directed when they click the meeting logo)

1. Click the Administration tab.
2. Click Customization.
3. Click Customize Meeting.
To change the color of the menu highlights, button rollover, background, or title bar, click the item name in the list to the right of the color grid; then click a color in the grid. The color swatch at the top of the grid changes to the color you clicked. To change the color swatch to the previous setting, click Clear. To restore the original setting, click Reset To Default.

To select a meeting logo, click Browse below the Meeting Logo heading and browse for the logo image (JPEG, PNG, GIF, or BMP file). If you do not select a logo, the Connect Enterprise logo is used.

To specify a URL for the meeting logo, enter the URL in the Logo URL text box. (This is the URL of the website users go to when they click the logo.)

Click Apply to save your changes. Your changes appear in 5 to 10 seconds; alternatively, you can refresh the page.

**Account reports**

**About account reports**
When you click the Administration tab, the Account Summary page appears. On this page, you can click the Reports link to access several reports.

**Training Reports**
This feature summarizes learner quota information (number of learners compared with the number allowed). Training reports are not downloadable.

**Meeting Reports**
This feature shows the maximum number of attendees supported by Acrobat Connect Professional at one time (concurrent peak) for the current month compared with the allowable quota, and the number of users currently participating in active meetings, both live and non-live.

This information is followed by a list of active meetings (that is, meetings currently in progress). You can use this list to monitor meetings, and you can click a meeting name to intervene. For example, if you must free up spaces for another meeting, you can enter an active meeting and send the host a message saying that some people must exit from the meeting.

Meeting reports are not downloadable.

**Event Reports**
This feature shows the number of active (current) events for the Connect Enterprise account, and a list of these. For each, the report shows the event name, number of registered users, event start date, and event completion date. You can click the name of a specific event to open the Event Information page for this event and see more information. Some Event reports, such as the attendee/absentee reports, are downloadable.

**Downloadable Reports**
This feature provides the ability to download five different kinds of reports as CSV files that you can export to external systems, such as spreadsheets. You can download the following reports:

- Interactions report
- Users report
• Assets report
• Questions report
• Slide Views report

You can also apply report filters that show data for specified time periods or users.

When you download a CSV file, you have the option of saving or opening the report. If you are running Connect Enterprise Manager in an Internet Explorer browser and choose to open the report, Windows automatically opens it in Excel. In this case, the information is difficult to read because you must double-click each cell to see its information.

Another option is to save the CSV file to your desktop and open the file from Notepad, which makes it easier to read. (To open Notepad, select Start > Accessories > Notepad.)

See also
“Setting and removing report filters” on page 99

Download a report
1 Click the Administration tab.
2 Click Reports.
3 Click Downloadable Reports.
4 Click one of the Download Report Data buttons.
5 Click Open or Save, as appropriate.

Note: Each downloaded report that you save is named "data.csv" by default. When you save the file, give it a unique identifying name; for example, “interactionsMarch05.csv.”

Where appropriate, you can further define the information for a particular downloadable report by using report filters.

See also
“Setting and removing report filters” on page 99

About the Interactions report
This report summarizes user access. A unique transaction ID is generated each time a user attends a meeting, attends a seminar, views content, takes a course, or accesses a curriculum. The Interactions report presents the following data:

<table>
<thead>
<tr>
<th>Column name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>transaction-id</td>
<td>Unique ID for this transaction</td>
</tr>
<tr>
<td>sco-id</td>
<td>Unique ID used by Learning Management System (LMS) to identify different Shareable Content Objects (SCO)</td>
</tr>
<tr>
<td>type</td>
<td>Type of object accessed, such as content, meeting, or event</td>
</tr>
<tr>
<td>name</td>
<td>Object name as it appears in the content listing</td>
</tr>
<tr>
<td>url</td>
<td>Object that the user accessed</td>
</tr>
</tbody>
</table>
The Interaction report excludes certification numbers and max scores.

**About the Users report**

This downloadable report lists users and associated profile attributes using data listed in the following table:

<table>
<thead>
<tr>
<th>Column name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>principal-id</td>
<td>Unique ID for the user</td>
</tr>
<tr>
<td>login</td>
<td>Name of user who accessed this transaction</td>
</tr>
<tr>
<td>user-name</td>
<td>Unique user name</td>
</tr>
<tr>
<td>score</td>
<td>The user’s score</td>
</tr>
<tr>
<td>status</td>
<td>Status of transaction: passed, failed, complete, or in-progress</td>
</tr>
<tr>
<td>date-created</td>
<td>Date this transaction occurred</td>
</tr>
<tr>
<td>date-closed</td>
<td>Date this transaction ended</td>
</tr>
</tbody>
</table>

Data is generated in this view whenever a user creates, updates, or deletes a user.

If you select the Include Custom Fields option, custom information from user profiles is added to the report. When customizing user profiles, there are three mandatory fields (first name, last name, and e-mail) and you may include up to 8 additional custom fields to be included in the Users report.

The Users report excludes the following information:

- Password, which is not stored in plain text.
- Time zone and language, which are not available in human readable form; for example, PST is 323.

*Note: Deleted users do not appear in the Users report. Deleted users continue to exist in the Interactions report.*

**About the Assets report**

Data is generated in an Assets report whenever a user creates a meeting, event, seminar, curriculum, or course, or uploads content. The report lists the following data on system objects (such as meetings, content, courses, and so on):
About the Questions report
The Questions report lists responses to questions and quizzes from all the Connect Enterprise applications. Data is generated in this report whenever a user answers a quiz question in a course or curriculum, answers a registration question, responds to a poll in a meeting or seminar, or adds a custom form to a meeting, seminar, course, or curriculum. The report provides the following information:

<table>
<thead>
<tr>
<th>Column name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>transaction-id</td>
<td>Unique ID for this transaction</td>
</tr>
<tr>
<td>question</td>
<td>Text of the question</td>
</tr>
<tr>
<td>response</td>
<td>User's response to the question</td>
</tr>
<tr>
<td>score</td>
<td>Number of points awarded for the response</td>
</tr>
<tr>
<td>principal-id</td>
<td>Unique ID for the user</td>
</tr>
<tr>
<td>date-created</td>
<td>Date the record was created</td>
</tr>
</tbody>
</table>

If a question has multiple answers, each answer is presented in its own row.

The Question report excludes the following information:

- Correct or Incorrect, which can be determined by checking for a non-zero score
- Date answered, which does not exist in the version 410 schema

About the Slide Views report
The Slide Views report describes the slides or pages viewed by Connect Enterprise users. Report data is generated whenever a user views content, a course, or a curriculum. The report provides the following data:

<table>
<thead>
<tr>
<th>Column name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sco-id</td>
<td>Unique ID used by Learning Management System (LMS) to identify different Shareable Content Objects (SCO)</td>
</tr>
<tr>
<td>url</td>
<td>Unique identifier for the object</td>
</tr>
<tr>
<td>type</td>
<td>Either a presentation, course, FLV file, SWF file, image, archive, meeting, curriculum, folder, or event</td>
</tr>
<tr>
<td>name</td>
<td>Object name as it appears in the content listing</td>
</tr>
<tr>
<td>date-created</td>
<td>Date on which the object is scheduled to begin</td>
</tr>
<tr>
<td>date-end</td>
<td>Date on which the object is scheduled to end</td>
</tr>
<tr>
<td>date-modified</td>
<td>Date this object was modified</td>
</tr>
<tr>
<td>description</td>
<td>Object summary information entered when a new meeting, content, course, or other object type is created</td>
</tr>
</tbody>
</table>
Generate a Custom URL Management report

Connect Enterprise lets you create custom URLs for meetings, training, events, or seminars. A custom URL is a name that is easy to remember, and it is appended to the domain name of your Connect Enterprise server. Users can create a custom URL when they set up a Connect Enterprise function (a meeting, an event, and so on). If the function to which the custom URL was initially assigned is subsequently deleted, the custom URL can be used for another Connect Enterprise function by another user.

You can use the Custom URL Management report to obtain information about the owner and attributes of a specific custom URL.

1. Click the Administration tab.
2. Click Reports.
3. Click Custom URL Management.
4. In the Search For text box, enter the custom URL you are searching for, and click Search. You must type in the exact custom URL text for the report to display. (The text is not case-sensitive, though, so typing in “meeting123” is the same as “Meeting123.”)

The page displays the Content Information report, which provides the following information:

- **Title**: The title of the meeting, content, course, curriculum, seminar, or event that is using this URL.
- **Type**: The type of function this URL is being used for (meeting, content, training, and so on).
- **User**: The individual who is using the URL.
- **URL**: The full path of this custom URL.
- **Date Created**: The date and time the function using this custom URL was created.
- **Date Modified**: The date and time the function using this custom URL was modified. If it was never modified, the creation date is shown.

### Connect Enterprise permissions

#### About Connect Enterprise permissions

The permissions structure of Connect Enterprise protects the integrity of data. In Connect Enterprise, every user account has specific access permissions to the application’s information repositories and features. The Connect Enterprise administrator’s job is to create, add, remove, and manage user accounts and their permissions, for both individual users and groups. The administrator performs these tasks using the Administration tab, which is not available to other Connect Enterprise users.
To manage user accounts and permissions for users and groups, click the Administration tab at the top of the Connect Enterprise Manager window, and then click the Users And Groups link below the tab names.

Connect Enterprise information is stored in libraries, each of which is associated with a different activity and application, and each application is represented by its own tab in Connect Enterprise Manager. The libraries are Content, Training, Meetings, Seminar, and Event but you see only the tabs for the applications that your organization purchased.

Each file and folder in the Connect Enterprise libraries has different access permissions for different users. These folder and file permissions are set in one of the following ways:

• By the creator of the folder or file
• By the Connect Enterprise administrator
• According to membership in a Built-in group (for example, the Administrators group, the Authors group, and so on)

The permissions associated with a specific file or folder are called its permission profile.

Although there are four permission settings (Manage, Publish, View, Denied) that apply across all the Connect Enterprise libraries, not all the libraries have the same combination of these permissions, so you must be aware of the permissions that apply to each library.

In addition, there is another set of permissions that can be assigned to a file or folder: attendance permissions, which designate the access permissions and the role of each attendee in a meeting, training, event, or seminar. Whereas Connect Enterprise library permission types address who can manage library files, attendance permissions designate what role an attendee plays in a specific meeting, training, event, or seminar, and who can view Connect Enterprise library content. (For example, the Meetings application provides the attendance roles Host, Participant, and Presenter.) Attendance roles are defined by the user who creates the meeting, training, event, seminar, or content. As an administrator, you might be less involved with attendance permissions.

See also

“About Built-in groups” on page 233
“About library permissions” on page 14

Multiple permissions precedence

If a user belongs to one or more groups, it is possible that multiple permissions apply to a single file or folder. In such a case, the user's permissions are resolved as follows (higher numbered levels take precedence):

Level 1 If the user has View, Publish, or Manage permissions through group-acquired permissions, the permission granting the greatest access to features applies. These three group permissions are additive.

Level 2 If the user has any Denied permission through group-acquired permissions, all group-acquired View, Publish, or Manage permissions are removed and the user is not allowed access.

Level 3 If the user has View, Publish, or Manage permissions through user-specific permissions, these are additive to the corresponding group-acquired permissions. In addition, these override any group-acquired Denied permission.

Level 4 If the user is specifically assigned the Denied permission setting through user-specific permissions, the user is denied access regardless of any group-acquired permissions.

Level 5 If the user is a member of the Administrator group, the administrator permission applies, regardless of any other individual or group setting.
**Level 6** If there are no permissions applied by either user or group (and none is inherited from a parent folder), the user cannot access or perform any actions on the folder or file.

The following table illustrates the way that group and user permissions apply:

<table>
<thead>
<tr>
<th>Group G1 permissions</th>
<th>Group G2 permissions</th>
<th>Union (G1, G2) permissions</th>
<th>User permissions</th>
<th>Resulting permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>Publish</td>
<td>Publish</td>
<td>Manage</td>
<td>Publish+Manage</td>
</tr>
<tr>
<td>Manage</td>
<td>None</td>
<td>Manage</td>
<td>Publish</td>
<td>Publish+Manage</td>
</tr>
<tr>
<td>Denied</td>
<td>Publish</td>
<td>Denied</td>
<td>Manage</td>
<td>Manage</td>
</tr>
<tr>
<td>View</td>
<td>Manage</td>
<td>Manage</td>
<td>View</td>
<td>Manage</td>
</tr>
<tr>
<td>Manage</td>
<td>None</td>
<td>Manage</td>
<td>Denied</td>
<td>Denied</td>
</tr>
<tr>
<td>None</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
</tbody>
</table>

Here are some facts to keep in mind about permission precedence:

- **Setting user permissions** Keep in mind that user-specific permissions are additive to the corresponding group-acquired permissions and override any group-acquired Denied permissions. Individual Denied permissions also override any group-acquired permissions.

User permissions take precedence over all group-acquired permissions. For example, to ensure that a specific user gets Manage permission for a content presentation, you can set the Manage permission for that specific user. This permission always applies, regardless of any other group permissions that are set.

- **Setting group permissions** Use group permissions to set rules for groups of users.

  - **Ensuring that access is denied** To ensure that access is denied, set the Denied permission for the specific user. This permission overrides any group-acquired permissions.

  - **Ensuring that access is allowed** To ensure that a specific user is given at least Publish permission for a given content presentation, set their user-specific permission to Publish. Any group-acquired permissions are only additive; they cannot deny access.

- **Tips on working with permissions** By assigning groups or users certain permission types for a file or folder, you can control which users or groups can access certain features for that folder. For example, you can set a folder's permissions so that only certain users or groups can publish content to the folder. You can also set a folder to have the same permission as its parent folder. If the parent folder's permissions change, all folder contents inherit those permissions. To create or assign permissions for a file or folder, you must first navigate to the library's tab and open the file or folder from there.

  To avoid listing and managing large numbers of users on the permission profile for a file or folder, use a group-based permission system. Create your system as follows:

  - **Design a folder and group system** You can give certain groups access to parts of the system as appropriate.

  - **Create folders using descriptive names** Use names that describe the folder's contents—for example, Human Resource Content, Product Support Content, and so on.

  - **Create custom groups using descriptive names** Use names that describe the group's permissions—for example, Human Resource Content Managers, Shared Content Viewers, and so on.
Assign permission types for your groups to specific folders or files  For example, assign the Human Resource Content Managers group permission to manage the Human Resources folder in the Shared Content folder.

Create users after you create groups  It's easier to create groups first, then add users to the group.

Add users to groups  Add users to whichever groups are necessary for them to obtain appropriate permissions.

If you must set up exceptions such as denying a user access to certain folders, you can assign a user-based permission setting that takes precedence over the group permission, ensuring that access is prevented. User-assigned permissions always take precedence over group-assigned permissions (except for members of the administrators group).

Connect Enterprise attendance permissions
In each Connect Enterprise library there are separate roles for the individuals who are presenting information and for those who are receiving it. Attendance permissions are associated with these roles, and are different for each application.

Meetings application attendance permissions
The following attendance permissions are associated with the Meetings application:

Host  A host sets up meetings, invites guests, adds content from the Content library, customizes the meeting room layout, and assigns presenter and participant roles to the appropriate attendees. The host can also perform all the tasks that presenters can. (Administrators have host permissions for all meetings by default.)

Presenter  A presenter can share the desktop, windows, and applications, use text chat, broadcast live audio and video, and show content to the participants. However, the presenter does not have access to the Content library.

Participant  A participant can view the content that the presenter is showing or sharing, hear and see the presenter's audio and video broadcast, use text chat, and, if given permission, broadcast audio and video.

Content application attendance permissions
The Content application does not have a separate set of attendance permissions. For the Content library, permissions are assigned for the file or folder (such as Manage, Publish, View, and Denied).

Training application attendance permissions
The Training application has two components: courses and curriculums. Both components have two attendance permissions, Enrolled and Denied. Enrolled indicates a learner whom a training manager placed in a course or curriculum; Denied indicates a user who is denied access to that course or curriculum. Usually a training manager uses the Denied permission to exclude one user from a group course (for example, if that user already took the course).

Seminars application attendance permissions
Attendance permissions are the same as those for meetings.

Events application attendance permissions
Attendance permissions are the same as those for meetings. Because events require registration, events also have status permissions, which apply to the status of the registration:

Invited  Applies to an individual who was invited by the event manager but who has not yet registered.

Denied  Applies to an individual whose registration was denied by the event manager.

Pending Approval  Applies to an individual whose registration is not yet approved by the event manager.
See also
“About library permissions” on page 14
“Multiple permissions precedence” on page 230

Group permissions

About groups
As an administrator, you are responsible for setting up users with Connect Enterprise user accounts, and assigning them to groups.

Whenever possible, assign users to groups, and then assign permissions at the group level instead of the individual level. This means that you must create groups, but user account administration is simpler when you are managing groups rather than individuals.

You can use groups to do the following:

• Assign groups of users Manage permissions for various folders in the Content, Training, Meetings, Event, and Seminar libraries.
• Assign groups of users View permissions for folders in the Content library.
• Assign groups of users, who are also authors, Publish permissions for folders in the Content library.

There are two kinds of groups: Built-in and custom groups.

See also
“About custom groups” on page 237

About Built-in groups
Connect Enterprise is installed with seven Built-in groups: administrators, authors, learners, training managers, event managers, meeting hosts, and seminar hosts. (The exact groups that are installed is determined by the purchased account features. For example, the Event Manager group only exists if Events is part of the Connect Enterprise account.) Each group reflects a specific set of access needs across all the Connect Enterprise libraries.

The administrator, at the company level, assigns users and groups to the appropriate Built-in groups. Membership in a specific Built-in group enables you to create new instances of the function associated with that library; that is, new files. For example, if you are a meeting host, you can create new meetings.

The permissions set for Built-in groups cannot be changed. If the administrator assigns users to more than one of these groups, a conflict between permission types might arise. For example, a user might be assigned to a group that has no access to a specific folder, and that same user might be assigned to another group that has Manage permissions for that folder. To address this conflict, there are rules for permission precedence.

Built-in group members cannot access the Shared folder directory of the library they’re associated with unless you assign them Manage permissions. If you do, they can also create new instances of their associated function: meetings, courses, events, and so on, depending on the group they belong to. You can also assign Manage permissions for a folder in the Shared folder directory to other users who are not part of that library's Built-in group. But whereas they can manage folders, they cannot create anything in that library, because they are not part of that library's Built-in group.
The following table summarizes the permissions for each group's access to each of the Connect Enterprise libraries:

<table>
<thead>
<tr>
<th>Group</th>
<th>Content library</th>
<th>Training library</th>
<th>Meetings library</th>
<th>Seminar library</th>
<th>Events library</th>
<th>Additional permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>Everything but Publish</td>
<td>Manage</td>
<td>Manage</td>
<td>Manage</td>
<td>Manage</td>
<td>Manage users, groups, and user accounts; view all users' content folders</td>
</tr>
<tr>
<td>Author</td>
<td>Publish/Manage Manage</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Learner</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Training Manager</td>
<td>Publish/Manage personal folder</td>
<td>Manage</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Meeting Host</td>
<td>Publish/Manage personal folder</td>
<td>None</td>
<td>Manage</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Event Manager</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>Manage</td>
<td>None</td>
</tr>
<tr>
<td>Seminar Host</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>Manage</td>
<td>None</td>
<td>None</td>
</tr>
</tbody>
</table>

**See also**

“About custom groups” on page 237

“Add or remove group members” on page 249

**Administrators group**

Administrators have complete control of the entire Connect Enterprise system. You can make any user an administrator by adding them to the Administrator group.

Administrators can perform the following actions:

- Manage the users and groups in the Connect Enterprise account, including creating, deleting, and editing them.
- Manage the Content library, including viewing, deleting, moving, and editing files or folders; viewing reports for files; setting permissions for files or folders; and creating new subfolders.
- Manage the Training library, including viewing, deleting, moving, and editing files or folders; viewing reports for files; setting permissions for files or folders; and creating new subfolders, as well as enrolling users, sending enrollee notifications, and setting up course and curriculum reminders.
- Manage the Meetings library, including viewing, deleting, moving, and editing files or folders; viewing reports for files; setting permissions for files or folders; and creating new subfolders, as well as adding participants.
• Manage the Event library, including viewing, deleting, moving, and editing files or folders; viewing reports for files; setting permissions for files or folders; and creating new subfolders within folders, as well as adding participants, sending invitations, and changing content and e-mail options.

• Manage the Seminar library, including viewing, deleting, moving, and editing files or folders; viewing reports for files; setting permissions for files or folders; and creating new subfolders, as well as adding participants.

• View account information, account features, account quotas, and account reports, and, if your organization has purchased this option, customize the look of Connect Enterprise for your organization.

In addition, the administrator has Host permissions for every meeting.

Members of the Administrator group have permission to do everything. Permissions for members of the Administrator group cannot be overridden by individual or other group permissions.

Authors group
To publish or upload content (including presentations) to the Content library, a user must be a member of the Authors group. To publish presentations to a specific folder, a user must be a member of the Authors group and have Publish permissions for that folder.

If you assign a user to this group, Connect Enterprise creates a folder for this user in the User folder of the Content library. (The shortcut called My Content points to this folder.) By default, a member of the Authors group has Publish and Manage permissions only for his or her own My Content folder.

Your Connect Enterprise account limits the number of users that you can add to the Authors group.

Members of the Authors group can perform all of the following actions if they have Publish permissions on the specified folder:

• View content and content folders.
• Publish and update content.
• Send e-mail messages containing links that send a notification to the author as soon as the recipient accesses the link.

Training Managers group
Members of the Training Managers group are users who are responsible for organizing and coordinating training.

If you assign a user to this group, Connect Enterprise creates a folder for this user in the User folder of the Training library. (The shortcut My Training points to this folder.) By default, a training manager can manage only his or her folder in the User Training folder.

A training manager can perform the following actions:

• Manage his or her own user folder in the Training library, performing all file-management functions, as well as create and manage courses and curriculums, enroll users, send enrollee notifications, and set up reminders.
• Have access to folders in the Content library.
• View training reports for the courses or curriculums that he or she created.

If you don’t want to give a user all the permissions associated with the Training Managers group, you can assign more restrictive permissions to the user or to a group to which the user belongs.

Event Managers group
Members of the Event Managers group can create events and manage their own folders in the Event library.
If you assign a user to this group, Connect Enterprise creates a folder for this user in the User folder of the Event library. Event managers can manage only their individual My Events folders in the User Events folder. They also can manage events in the Shared folders of the Events library, if they are hosting the event and have Manage permissions for the folder that contains the event.

An event manager can perform the following actions:

• Manage his or her own Event library user folder, performing all file-management functions, and create and manage all aspects of an event in this folder.

• View event reports.

If you don't want to give a user all the permissions associated with the Event Managers group, you can assign more restrictive permissions to the user or to a group to which the user belongs.

**Meeting Hosts group**

Members of the Meeting Hosts group create meetings.

If you assign a user to this group, Connect Enterprise creates a folder for this user in the User folder of the Meetings library. Meeting hosts can manage only their individual My Meetings folders in the User Meetings folder. In addition, they can manage meetings in the Shared folders of the Meetings library, if they are hosting the meeting and have Manage permissions for the folder that contains the meeting.

A meeting host can perform the following actions:

• Manage his or her User Meetings folder, performing all file-management functions, and create and manage meetings, which involves adding, deleting, and assigning attendance permissions to presenters and participants; creating and organizing meeting rooms; and editing a meeting or changing its participant list.

• View meeting reports.

• Create content.

• View content files and folders for which they have access permissions.

• Publish and update content.

If you don't want to give a user all the permissions associated with the Meeting Hosts group, you can assign more restrictive permissions to the user or to a group to which the user belongs.

**Seminar Hosts group**

Because of the way seminars are licensed, the permissions for seminar hosts are different from those of other groups.

Unlike other libraries, the Seminar library does not have a high-level User folder prepopulated with folders for the individual hosts. Instead, the Seminar library consists only of the Shared folder directory, and each folder in this directory corresponds to a seminar license that your organization purchased. Only seminar hosts and administrators can manage these folders. This is different from other libraries' Shared folder permissions, where the administrator can assign Manage permissions to users who are not part of the Built-in group associated with the library. Another difference is that a seminar host can manage all the folders in the Seminar library.

Seminar hosts can perform the following actions:

• Manage all Seminar library folders, performing all file-management functions, and create and manage seminars, which involves adding, deleting, and assigning attendance permissions to presenters and participants; creating and organizing seminar rooms; and editing a seminar or changing its participant list.

• View seminar reports.
About custom groups

Custom groups are groups that you create yourself. You can define specific folder and file permissions for the group in the different Connect Enterprise libraries. In addition, because a group can contain both users and other groups, you can assign permissions to a custom group by assigning it to the appropriate Built-in groups.

For example, suppose you create a custom group called Global that contains a group for each country in which your company has an office (for instance, United States, Germany, and so on). Each country group could contain a group for each office in that country (for example, San Francisco, Boston, and so on). Within each of these offices, you could define more groups by job function, and then assign each of these groups the appropriate Built-in group designations.

In this example, you created a hierarchical set of groups called nested groups, because each group is contained by the one above it in the hierarchy. By default, the nested groups have the permissions of the parent group, but you can expand or restrict these permissions by setting custom permissions for these groups in the relevant libraries.

See also
“About Built-in groups” on page 233

Creating and managing users and groups

Creating users and groups

To set up new user accounts, you must already be familiar with the permissions system. Then you can set up various user account parameters, create groups, and add users. The following overview summarizes the workflow involved in setting up user accounts.

1. **Customize user profile fields, if necessary.**
   A user profile is an attribute of your organization’s Connect Enterprise user profile. The fields for First Name, Last Name, and E-mail are required and cannot be modified. However, you can add other predefined fields, create new fields, and change their order in the user profile.

2. **Customize login and password policies, if necessary.**
   You can set login and password policies, password expiration, password format, and password length.

3. **Add users and groups.**
   You can add users and groups to Connect Enterprise by using the Lightweight Directory Access Protocol (LDAP), by using comma-separated values (CSV) files, or by creating users and groups manually.

   **Working with LDAP-acquired users and groups** In LDAP-enabled organizations, Connect Enterprise acquires all its user data directly from the company's user directory. This includes information such as login, name, and phone number. You would probably not be involved in adding new users or groups to the system, because this occurs outside Connect Enterprise Manager. However, you must still manually assign LDAP-acquired users or groups to the Built-in group appropriate for their job functions.

   **Importing users and groups through CSV files** You can import large numbers of users and groups through a CSV file. Your organization’s directory may have a utility for exporting users and groups to CSV files, or you can create CSV files yourself. Your CSV files must be in a specific format. You can modify the imported users and groups in exactly the same way you would any user or group that was manually created.
**Adding users and groups manually** You can assign new users to a Built-in group, or you can create custom groups that are specific to your organization. It is best to create these groups before creating users manually.

4. **Set permissions.**

Once you have imported or created users and groups, you must set permissions. If you add users to the Built-in groups, those groups already have default permissions, which apply specifically to the folders and files within each library.

**Customize user profile fields**

When you customize user profile fields, you can add basic fields, add other predefined fields, create custom fields, and remove fields. When you modify fields, you can change any of its attributes; you can also designate a field as required, or add a comment describing a field.

The information in the user profile fields is used to create the downloadable Custom Fields User Report. This report displays the three mandatory fields (first name, last name, and e-mail) and the next 8 fields listed under the mandatory fields in the Customize User Profile screen. Use the Shift Up and Shift Down buttons to move fields into the correct position so they will or will not display in the Custom Fields User Report.

**Add basic user profile fields**

1. Click the Administration tab at the top of the Connect Enterprise Manager window.
2. Click Users And Groups.
3. Click the Customize User Profile link above the Users And Groups list.

The list of the user profile fields appears; First Name, Last Name, and E-mail are flagged with red asterisks (*) to indicate that they are required.

4. Select the check box for any field on this page that you want to include as part of the Connect Enterprise user account profile.
5. To move an item up or down in the list, select its check box and click the Shift Up or Shift Down button.

**Add other predefined fields**

1. Click the Administration tab at the top of the Connect Enterprise Manager window.
2. Click Users And Groups.
3. Click the Customize User Profile link above the Users And Groups list.
4. Click the Add Predefined Field button.
5. Click the check box for any fields that you want to add.
6. Click Save.
7. To move an item up or down in the list, select its check box and click the Shift Up or Shift Down button.

**Create a custom field**

1. Click the Administration tab at the top of the Connect Enterprise Manager window.
2. Click Users And Groups.
3. Click the Customize User Profile link above the Users And Groups list.
4. Click the New Field button.
5 Type a name for this field.

If you want, you can type a comment in the Comment text input box. You can also select the Required check box for the Field Type if you want this field to be required.

6 Click Save.

7 To move an item up or down in the list, select its check box and click the Shift Up or Shift Down button.

Modify a user profile field
1 Click the Administration tab at the top of the Connect Enterprise Manager window.
2 Click Users And Groups.
3 Click the Customize User Profile link above the Users And Groups list.
4 Click the name of the field that you want to modify to open it.
5 Do any of the following:
   • Change the field name. (Although you can change it, you cannot delete it.)
   • Type, change, or delete a comment in the Comment text input box.
   • Select or deselect the Required check box for the Field Type.
6 Click Save.

Remove a user profile field
1 Click the Administration tab at the top of the Connect Enterprise Manager window.
2 Click Users And Groups.
3 Click the Customize User Profile link above the Users And Groups list.
4 Select the check boxes for the fields that you want to remove.
5 Click Remove.
6 On the remove confirmation page, click Remove to delete these fields, or click Cancel to cancel the operation.

Convert guests to full Connect Enterprise users or full users to guests
You can convert guests to full Connect Enterprise users or full users to guests. This is helpful if, for example, you held a Connect Event in which many guests registered that you would now like to turn into full users.

The distinction between guests and full users can be important because only full users, not guests, can log into the Connect Enterprise administration site. Full users also appear on enrollment and permission lists.

Note: Previously in Connect Enterprise, guests could be added by simply entering an e-mail address. Now, guests must enter a first name, last name, and e-mail address. Also, when importing a list of guests (usually using a CSV file), a first name, last name, and e-mail address must now be included.

1 Select the Administration tab in Connect Enterprise Manager.
2 Select Users and Groups.
3 Click Manage Guests.
4 In the Current Guests list select a guest or in the Current Users list select a user.
5 Click Convert to User or Convert to Guest.
You can convert guests to full Connect Enterprise users or convert users to guests.

**Manage login and password parameters**

The Edit Login and Password Policies link on the Administration tab lets you customize your login and password policies to conform to those of your company. Any policies you establish are unique across the entire Connect Enterprise application.

1. Click the Administration tab at the top of the Connect Enterprise Manager window.
2. Click Users And Groups.
3. Click Edit Login And Password Policies.
4. Type your changes.

**Login policy** (Optional) Specify whether the Connect Enterprise login should be the same as the user’s e-mail address. The login must be unique for each user.

**Password expiration** (Optional) Specify how long a password is valid. If you do not enter a value, passwords do not expire.

**Password character** (Optional) Specify a character that must be included in all passwords.

**Password number** (Optional) Specify whether the password must contain a number.

**Password capital letter** (Optional) Specify whether the password must contain a capital letter.

**Password length** (Required) Specify a minimum and maximum password length. (The lowest minimum that can be selected is 4 and the highest maximum that can be selected is 32.)

5. Click Save.

**Using CSV files to add users**

You can use CSV files if you have users in your company that you don’t want to add to a group, or if you want to manually create a custom group later for these users.

Before you can perform this procedure, you must create a user CSV file for the individual users whom you want to add to your Connect Enterprise system. The CSV file you create must include user information in the following format:
Here are some additional tips for using CSV files:

- Because of browser limitations, Adobe recommends that if you have a large number of users to add, that you create several smaller CSV files instead of one large CSV file.

- The file should not contain empty lines. If the CSV file contains empty lines, the import operation fails.

- Names that contain a comma need to be in quotes. For example, the name John Doe, Jr., must appear in the CSV file as "John Doe, Jr." for the file to import correctly.

- If you want to specify a custom field, the header format in the CSV file is x-field-id (for example, x-45704960). You can obtain the field ID from the CXML API calls custom-fields or acl-field-list, or you can click the Custom User field in Enterprise Manager and check the ID in the URL.

- The user information in the CSV file needs to take login and password policies into consideration. For example, if login is set as e-mail, the CSV file should have the login and e-mail columns set the same. Or, if there are password policies (certain length, format, special characters, etc.) these policies should also be applied in the CSV file. If policies are not followed, an error may appear that prevents the CSV file from importing properly.

### Import a user CSV file

1. Click the Administration tab at the top of the Connect Enterprise Manager window.
2. Click Users And Groups.
3. Click the Import link above the list of users and groups.
4. Select Create New Users.
5. Under the Select File To Import bar, browse to the CSV file you want to import.
6. Click the Upload button.

If any errors occur, the first 10 errors are displayed in red text. (Note that errors on duplicate user login/email are not reported.) Make any necessary corrections and re-import the file; then repeat steps 3-6.

7. Set permissions for these users.

### See also

“Create a custom group manually” on page 244

“Setting custom permissions for the Connect Enterprise libraries” on page 246
Import a user CSV file using non UTF-8 encoded files

You can import a user CSV file using non UTF-8 encoded files. When importing a non UTF-8 encoded file, append the appropriate encoding parameter to the import URL.

1. Click the Administration tab at the top of the Connect Enterprise Manager window.
2. Click Users And Groups.
3. Click the Import link above the list of users and groups.
4. Check the URL in the browser address line. It should look similar to http://<Connect Server>/admin/administration/user/import.
5. Click at the end of the URL in the browser address line and add "?encoding=<encode>" to the address. It should look similar to http://<Connect Server>/admin/administration/user/import?encoding=<encode>. Specific examples include the following:
   • http://<Connect Server>/admin/administration/user/import?encoding=sjis
   • http://<Connect Server>/admin/administration/user/import?encoding=euc_kr
6. After modifying the URL address, click Enter.
7. Select Create New Users.
8. Under the Select File To Import bar, browse to the CSV file you want to import.
9. Click the Upload button.

If any errors occur, the first 10 errors are displayed in red text. (Note that errors on duplicate user login/e-mail are not reported.) Make any necessary corrections and re-import the file.

10. Set permissions for these users. For more information, see “Setting custom permissions for the Connect Enterprise libraries” on page 246.

Import a group CSV file

Use the group import option to import groups into the Connect Enterprise database. After you import the group CSV file, you can assign new users to the groups. You do not have to import any of the Built-in groups, because these are pre-installed and automatically appear in the list.

When you create the CSV file, ensure that it is in a format that Connect Enterprise can use. The required column headers in the CSV file are name and description. The following is an example of a group CSV file that is adaptable for Connect Enterprise:

data: name, description
group1, test1
group2, test2

1. Click the Administration tab at the top of the Connect Enterprise Manager window.
2. Click Users And Groups.
3. Click the Import link above the list.
4. Under the Select Import Type bar, select the Create New Groups option.
5. Under the Select File To Import bar, browse to the CSV file that you want to import.
6. Click the Upload button.

If any errors occur, the first 10 errors are displayed in red text. Make any necessary corrections and re-import the file; then repeat steps 3-6.
7 Proceed to “Import a user CSV file” on page 241 or “Add or remove group members” on page 249.
8 After you add groups and assign users to the groups, you must set permissions for the groups for the Connect Enterprise libraries. For more information, see “Setting custom permissions for the Connect Enterprise libraries” on page 246.

**Import a user CSV file and add users to groups**

Use this option to import new users and add them to a Built-in or previously created group. The Built-in group names appear in the menu for group selection as default groups. After you create a group manually, its name also appears in the menu, so you can use the import option to assign large numbers of users to multiple groups. However, you can select only one group for the users whom you imported from one CSV file. This means that you should create a different CSV file for each set of users that you want to add to a specific group.

After you import these users, you can do the following:

- Assign these users to additional groups, or assign the whole group to another group. Since you can add groups, as well as users, to an existing group, you can use this procedure to assign the group with the newly imported users to another group. For example, you may import new users in a single department in your organization and assign them to the Sales and Promotion group. If you now also want to give them Publish permissions for the Content library, you can assign the entire Sales and Promotion group to the Authors group.

- To expand or restrict permissions for the group or any of the people within it, you can set the appropriate permissions in the specific libraries. For example, if you do not want to grant certain people in the Sales and Promotion department Publish permissions for a specific set of folders the Content library, you can assign these individuals Denied permissions for these folders.

The following example shows the minimum user information required for the CSV file. You can add other information in the CSV file to prepopulate other user properties. The CSV file you create must include user information in the following format:

<table>
<thead>
<tr>
<th>first-name,</th>
<th>last-name,</th>
<th>login,</th>
<th>email,</th>
<th>password</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mary,</td>
<td>Betts,</td>
<td><a href="mailto:mbetts1@mycompany.com">mbetts1@mycompany.com</a>,</td>
<td><a href="mailto:mbetts1@mycompany.com">mbetts1@mycompany.com</a>,</td>
<td>private1</td>
</tr>
<tr>
<td>Robert,</td>
<td>Blatt,</td>
<td><a href="mailto:rblatt2@mycompany.com">rblatt2@mycompany.com</a>,</td>
<td><a href="mailto:rblatt2@mycompany.com">rblatt2@mycompany.com</a>,</td>
<td>private1</td>
</tr>
<tr>
<td>Ron,</td>
<td>Bloom,</td>
<td><a href="mailto:rbloom3@mycompany.com">rbloom3@mycompany.com</a>,</td>
<td><a href="mailto:rbloom3@mycompany.com">rbloom3@mycompany.com</a>,</td>
<td>private1</td>
</tr>
<tr>
<td>Charles,</td>
<td>Bond,</td>
<td><a href="mailto:cbond4@mycompany.com">cbond4@mycompany.com</a>,</td>
<td><a href="mailto:cbond4@mycompany.com">cbond4@mycompany.com</a>,</td>
<td>private1</td>
</tr>
<tr>
<td>Jennifer,</td>
<td>Cau,</td>
<td><a href="mailto:jcau5@mycompany.com">jcau5@mycompany.com</a>,</td>
<td><a href="mailto:jcau5@mycompany.com">jcau5@mycompany.com</a>,</td>
<td>private1</td>
</tr>
</tbody>
</table>

1 Click the Administration tab at the top of the Connect Enterprise Manager window.
2 Click Users And Groups.
3 Click the Import link above the list of users and groups.
4 Under the Select Import Type bar, select Create New Users And Add Them To A Group.
5 Under the Select File To Import bar, browse to the CSV file that you want to import.
6 Click the Upload button.

If the CSV file contains the names of groups that are already in the system, the system ignores them but logs a message stating that duplicate groups were encountered.

7 Add the new users to a group. For more information, see “Add or remove group members” on page 249.
Set permissions for these users. For more information, see “Setting custom permissions for the Connect Enterprise libraries” on page 246.

Create a custom group manually

Groups that you create manually are referred to as custom groups.

A group can contain both users and other groups. This means that you can add Built-in groups and other custom groups, as well as users, to the custom group.

After you create a custom group, you can simply add users to them as you set up each new user account, or use the CSV import option to import large numbers of users into the group.

1 Click the Administration tab at the top of the Connect Enterprise Manager window.
2 Click Users And Groups.
3 (Optional) To check that this group does not already exist, enter its name in the Search text input box at the bottom of the list.

If such a group does exist, it will appear; otherwise a blank list appears. Click Clear to return to the list page.
4 Click the New Group button at the bottom of the list.
5 Enter the new group’s name and description.
6 To add members, click Next.

To add this group without adding members, go to step 10.

7 In the Possible Groups list, select each user and group that you want to assign to this group, as follows:
   • To select multiple users or groups, press Control-click or Shift-click.
   • To expand a group so you can select individual names, double-click the group name; when you are done, double-click Up One Level in the list to return to the original list.
   • To search for a name in the list, click Search at the bottom of the list and enter the name to display it in the list, and then select it in the window.

8 Click Add.

To remove a name that you have added, select it and click Remove.
9 Repeat step 3 through step 8 for each group to be added.
10 Click Finish.
11 Click the View Group Membership button to review the group members and make any adjustments.

See also
“Import a user CSV file” on page 241

Create a user manually

When you add new users, you must enter a new password that they will use to log in to Connect Enterprise. This password is sent to the user by e-mail. (There is an option you can select to prompt the user to change the password after they login in for the first time.) You can also add audio conference settings for users.
After you create a user, you can select a manager for the user. (A user can have only one manager.) If the user you created is a manager, you can assign team members to him or her. The manager can view report data for team members using the Manager Reports option on the Home tab.

**See also**

“Import a user CSV file” on page 241

**Create a new user**

1. Click the Administration tab at the top of the Connect Enterprise Manager window.
2. Click Users And Groups.
3. Click the New User button at the bottom of the list.
4. Enter the new user's last name, first name, and e-mail address. Add any optional information, such as company name or address.
5. In the New Password text box, type a new password to mail to this user, and then retype it for confirmation. If the user has an e-mail address, leave the E-mail The New User Account Information, Login And Password box selected. If the user does not have e-mail, deselect it.
6. (Optional) In step 5 you provide a password for users to login for the first time. To require users to change their password after their first login, select the Prompt user to change password after next login option.
7. (Optional) Enter any audio conference settings in the appropriate text boxes.
8. To assign this user to one or more groups, click Next.
   If you don't want to assign this user to any groups, go to step 11.
9. In the Possible Groups list, select each group to which you want to assign this user as follows:
   - To select multiple groups, press Control-click or Shift-click.
   - To expand a group so you can select individual names, double-click the group name; when you are done, double-click Up One Level in the list to return to the original list.
   - To search for a name in the list, click Search at the bottom of the window and enter the name to display it in the list, and then select it.
10. Click Add.
11. Click Finish.

**Add team members for a user**

1. Click the Administration tab at the top of the Connect Enterprise Manager window.
2. Click Users And Groups.
3. Select the user's name and click Information at the bottom of the list.
   If necessary, click Search and enter the user's name in the Search text box to locate the name in the list.
4. Click the Edit Team Members link to select team members for this user.
5. In the Possible Users list, select each team member you want to assign to this user as follows:
   - To select multiple users, press Control-click or Shift-click.
   - To search for a name in the list, click Search at the bottom of the window and enter the name to display it in the list, and then select it.
6 Click Add.
To remove a team member you have added, select it and click Remove; to add more team members, repeat step 5 and step 6.

**Setting custom permissions for the Connect Enterprise libraries**

After creating or importing users in a custom group, the administrator assigns the group’s permissions. If you create the users manually or use the CSV import function, you can do this by assigning the users to one or more of the Built-in groups.

Regardless of how you add these users to Built-in groups, you might also want to add or restrict access for this group to a specific library. You do this by going to the tab where you want to add the group (Content, Meetings, Training, Event Management, or Seminar Rooms) and adding the group to the appropriate folders on that tab.

Whereas individuals with Manage permissions in the Connect Enterprise libraries can assign permissions for their own folders or files, the administrator is responsible for assigning permissions to the Shared folder.

**See also**

“About library permissions” on page 14

“About Built-in groups” on page 233

**Account modification**

**Modifying users and groups**

It is the administrator’s responsibility to maintain all aspects of Connect Enterprise user accounts. This involves changing user details, manager, team members, and group memberships. Administrators also delete user accounts.

You can also modify information for existing groups. You can change a group’s name, description, permissions, and membership, and you can delete groups.

In addition, you can change the names of Built-in groups; however, this makes support more difficult, and Adobe does not recommend this practice. You can also change the descriptions and the group membership of Built-in groups, but you cannot change permissions for these groups.

To change permissions for an existing user or group, you must be in the library for which these permissions exist. In addition, because permissions are assigned to files and folders, if related files are in different libraries, you must change the permissions for all the relevant folders in those libraries. For example, if you are changing a group’s permissions for a specific meeting folder in the Meetings library, and the meeting uses a presentation in a folder in the Content library, you must also change the group’s permissions for that Content library folder.

You can set individual permissions for every folder in Connect Enterprise Manager. To view or change permissions for a file or folder, you must open it. To do so, click the tab for the library whose file or folder permissions you want to change.

**Edit user information**

If you are an administrator, you can modify the components of a Connect Enterprise user’s account. You can change a user’s e-mail address, name, login, audio conferencing information, group membership, manager, team members, and any other information you added in custom user profile fields.
However, you cannot change this user's password. Although you can assign a temporary password to a new user when you create this user's account, you cannot subsequently change this password. This is true even if a user forgets the password; the user must click the “Forgot your password? Click here” link when logging in to Connect Enterprise. No one can change another user's password; you can only change your own password.

**Change user information**

1. Click the Administration tab at the top of the Connect Enterprise Manager window.
2. Click Users And Groups.
3. Select the user's name and click Information at the bottom of the list.
   If necessary, click Search and enter the user's name in the Search text box to locate the name in the list.
4. In the Login and Password area, you can use these options:
   - To send a link to the user so that they can reset their password, click Send a link to reset this user's password. A message appears informing you that the e-mail was sent. Click OK to return to the User Information page.
   - To set a temporary password for this user that you can provide directly (for example, by telephone), click the Set a Temporary Password for this user. The temporary password page appears with a system-generated password for this user. Click Save to return to the User Information page.
5. Click the Edit Information link.
6. Edit any of the fields that you want to change.
7. Click Save.

**Change a user's manager**

1. Click the Administration tab at the top of the Connect Enterprise Manager window.
2. Click Users And Groups.
3. Select the user's name and click Information at the bottom of the list.
   If necessary, click Search and enter the user's name in the Search text box to locate the name in the list.
4. Click the Select Manager link.
5. In the Possible Managers list, select the manager to whom you want to assign this user.
   To search for a name in the list, click Search at the bottom of the window and enter the name to display it in the list, and then select it.
6. Click the Set Manager button.
   To remove this manager from list, select the name and click Remove Manager; to replace the manager, repeat step 5 and step 6.

**Assign a user to a group**

1. Click the Administration tab at the top of the Connect Enterprise Manager window.
2. Click Users And Groups.
3. Select the user's name and click Information at the bottom of the list.
   If necessary, click Search and enter the user's name in the Search text box to locate the name in the list.
4. Click the Edit Group Membership link.
5 In the Possible Groups list, select each group to which you want to assign this user as follows:

• To select multiple groups, press Control-click or Shift-click.
• To expand a group so you can select individual names, double-click the group name; when you finish, double-click Up One Level in the list to return to the original list.
• To search for a name in the list, click Search at the bottom of the window and enter the name to display it in the list, and then select it.

6 Click Add.

To remove a group from this window, select it and click Remove.

**Remove a user from a group**

1 Click the Administration tab at the top of the Connect Enterprise Manager window.
2 Click Users And Groups.
3 Select the user’s name and click Information at the bottom of the list.

If necessary, click Search and enter the user’s name in the Search text box to locate the name in the list.
4 Click the Edit Group Membership link.
5 In the Current Group Membership window, select the group from which you want to remove this user as follows:

• To select multiple groups, press Control-click or Shift-click.
• To search for a name in the list, click Search at the bottom of the window and enter the name to display it in the list, and then select it.

6 Click Remove.

**Delete a user account**

If you are an administrator, you can delete any Connect Enterprise user account. Once the user account has been deleted, this user is permanently deleted from the system and the following occurs:

• The user is removed from all group lists.
• The user is removed from the enrollee lists for all courses.
• Reports for the user are no longer available.
• All users for whom the user being deleted was listed as their manager will now have a blank manager field.
• If the user being deleted created any content, another user should be assigned to manage the content.

If the user is a member of a built-in group, then the group is credited back one member. For example, if User A is a member of the Authors group and then User A is deleted, the Authors group receives credit for one more member and can add a new user.

1 Click the Administration tab at the top of the Connect Enterprise Manager window.
2 Click Users And Groups.
3 If necessary, click Search and enter the user’s name in the Search text box to locate the name in the list.
4 Select the user’s name. (You can select multiple users by pressing Control-click or Shift-click to delete more than one user simultaneously.)
5 Click Delete at the bottom of the list.
6 On the confirmation page, click Delete to delete the user, or click Cancel to cancel the operation.
See also
“Delete a group” on page 250

View group information
1 Click the Administration tab at the top of the Connect Enterprise Manager window.
2 Click Users And Groups.
3 Select the group’s name and click Information at the bottom of the list.
If necessary, click Search and enter the group’s name in the Search text box to locate the name in the list.
4 To view the group’s membership, click the View Group Members button.

See also
“Change a group name or description” on page 249
“Add or remove group members” on page 249

Change a group name or description
If you are an administrator, you can edit the name or description for any group, even Built-in groups, although Adobe does not recommend this practice. If necessary, you can also use this procedure to change the name of a particular seminar license group to associate it with a group in your organization.
1 Click the Administration tab at the top of the Connect Enterprise Manager window.
2 Click Users And Groups.
3 Select the group’s name and click Information at the bottom of the list.
If necessary, click Search and enter the group’s name in the Search text box to locate the group’s name and click Info at the bottom of the list.
4 Click the Edit Information link.
5 Edit the fields you want to change.
6 Click the Save button.

Add or remove group members
If you are an administrator, you can add both users and groups to a group. You can also remove them.

Add members to a group
1 Click the Administration tab at the top of the Connect Enterprise Manager window.
2 Click Users And Groups.
3 Select the group’s name and click Information at the bottom of the list.
If necessary, click Search and enter the group’s name in the Search text box to locate the name in the list.
4 Click the View Group Members button.
5 In the Possible Group Members list, select each user or group that you want to add to this group as follows:
   • To select multiple groups, press Control-click or Shift-click.
• To expand a group so that you can select individual names, double-click the group name; when you finish, double-click Up One Level in the list to return to the original list.

• To search for a name in the list, click Search at the bottom of the window and enter the name to display it in the list, and then select it.

6 Click Add.

To remove a user or group from this window, select it and click Remove.

**Remove members from a group**

1 Click the Administration tab at the top of the Connect Enterprise Manager window.

2 Click Users And Groups.

3 Select the group’s name and click Information at the bottom of the list.

If necessary, click Search and enter the group’s name in the Search text box to locate the name in the list.

4 Click the View Group Members button.

5 In the Current Group Membership window, select each user and group that you want to remove from this group, as follows:

• To select multiple users or groups, press Control-click or Shift-click.

• To search for a name in the list, click Search at the bottom of the window and enter the name to display it in the list, and then select it.

6 Click Remove.

**Delete a group**

If you are an administrator, you can delete any group except a Built-in group. Note that deleting a group does not delete individual members of the group.

Before deleting a group, consider the impact on the permissions of the members and other groups. If the group was added to the permissions profile for any file or folder in any library, deleting the group affects the permissions of its members because they no longer have permissions for those files or folders (unless the members also belong to other groups with permissions for those files or folders).

1 Click the Administration tab at the top of the Connect Enterprise Manager window.

2 Click Users And Groups.

3 Select the group’s name. (You can select multiple groups by pressing Control-click or Shift-click to delete more than one group simultaneously.)

If necessary, click Search and enter the group’s name in the Search text box to locate the name in the list.

4 Click Delete at the bottom of the list.

5 On the confirmation page, click Delete to delete the group; click Cancel to cancel the operation.

**See also**

“Delete a user account” on page 248
Index

A
account reports 225
See also reports
Account Summary page 218
accounts
Adobe Acrobat Connect Enterprise 220
user 248
Administration Dashboard 220
administrators 217
Administrators group 234
Adobe Acrobat Connect Enterprise
about 5, 12
Account Summary page 218
accounts, administering 217
customizing 220, 221
permissions 229
pricing models 219
terminology 6
Adobe Acrobat Connect Enterprise Manager
customizing 221
finding version number of 8
managing seminars with 116, 125
profile 12
starting 8
workspace 9
Adobe Captivate 90
Adobe Contribute 130, 132
Adobe Presenter
See also presentations
about 147
audio 164
best practices 151
creating presentations with 148, 151
installing 148
learning management systems 195, 196, 215
panes 211
planning presentations for 149
playbar 163
themes 197
upgrading 148
using video in 155
workspace 149
AIICC content
compliance in presentations 147
in courses 90
in learning management systems 174, 192
uploading to Content library 22
AIICC course structure files 195
animation 161, 162
Assets report 227
attachments to presentations 158
Attendee List pod
about 63
status indicators in 64
attendees
audio conference, status of 67
blocking 37
changing status of 64
clearing status of 64
names of in Attendee List pod 64
removing from meeting 65
roles of 30
seminar 118
status indicators of 64
viewing or changing roles of 65
audio
See also broadcasting audio and video
See also voice
aspect ratio of display 84
attendee roles 81
changing settings 84
controls for 85
enabling participants 85
live video and voice 85
preventing attendees from 85
selecting what to receive 86
setup 81, 83
unblocking 86
built-in groups
about 233
permissions 15

B
bandwidth, and meeting performance 32
branching, in quizzes 174
broadcasting audio and video
See also audio, voice
 See also broadcasting audio and video, voice
broadcasting 81, 85
timing 162
unblocking 86

C
Camera And Voice pod 81
campaign tracking in Adobe Events 142
Captivate 90
Chat pod 75, 77
Clear tool 61
client-side training review mode 94, 95
colors of presentation themes 199
comma separated values files. See CSV files conferencing, audio 2 Connect Enterprise Manager. See Adobe Acrobat Connect Enterprise Manager Connect Enterprise servers, publishing to in Presenter 206 Connect Enterprise. See Adobe Acrobat Connect Enterprise connection speed, choosing 45 connection status indicator, in Attendee List pod 64 content about training 88 AICC 22 changing training 94 customizing permissions for 16 event 137, 144 reports 25 training course 96 viewing 15 Content Dashboard 25 content files, URLs of 24 Content library 13 Contribute 130, 132 course notifications 93, 97 course reports 98 course summary graphs 90 courses in Connect Training about 88, 99 adding content to 104 adding courses to 104 adding enrollees to 109 adding external content to 105 adding folders to 103 adding items to 103 adding meetings to 104 creating 100 deleting 106 deleting items in 103 editing 105, 106 editing external content in 106 including test-outs 108 notifying enrollees 110 permissions of enrollees in 109 prerequisites 107 registering guests 89 removing enrollees 109 sending reminders 110 setting completion requirements 108 tips for creating 90 viewing details of 102 viewing status information of 102 Custom URL Management report 229 custom URLs 23 customizing, Connect Enterprise 221 D documents, attaching 158 E Ellipse tool 61 End Meeting message 38 enhanced participant rights 66 Event Managers group 235 event notifications 134 event pages 130 event reports 145 event statistics 144 events about 126 acquiring licenses before 127 adding guests to 139 adding participants to 139 assigning permissions for 127, 140 attending 145, 146 best practices 128 campaign tracking 142 creating 129 creating mailing lists for 138, 139 designating registrant group for 140 editing 133 editing in Contribute 130, 132 e-mail messages for 137 follow-up tasks 128 importing CSV participant file 141 planning 127 previewing 130 public 131 publishing 133 registering users 128, 135 removing participants from 139 replacing content of 137 sending invitations to 141 viewing content of 144 F feedback messages for questions 191 File Share pod 53, 61 file sharing 53 files library 17 uploading to library 22 fill-in-the-blank questions 182 filters, report 26 Flash files 158, 161, 162, 215 FlashPaper 158 full-screen presentations 205 G graphics in presentations 161 groups about 233 adding members to 249 Administrators group 234 Authors group 235 built-in 233 creating 237 creating manually 244 custom 237 deleting 250 Event Managers group 235
importing with CSV files 242
Meeting Hosts group 236
modifying 246
removing members from 249
Seminar Hosts group 236
Training Managers group 235
user 247
viewing 249
guests
  converting to users 239
  event 139
  seminar 117, 119

H
Help menu 37
Home tab 43, 45
host role 30

I
images 161
installing Adobe Presenter 148
interated audio conferencing 2
Interactions report 226
Internet broadcasting (VoIP) 2
invitations
  event 141
  seminar 119

L
Layout menu 37
layouts 35
learning management systems 195, 196, 215
libraries
  about 13
  downloading files from 19
downloading presentations from 19
files 17
folder structure 13
folders 17
permissions 14, 16, 246
uploading files to 22
viewing content files in 24
licenses
  event 127
  seminar 117, 122
Likert questions 189
Line tool 60
logins, user 240
logos in presentations 202
looping presentations 204
M
mailing lists, event 138, 139
Marker tool 60
matching questions 187
Meeting Hosts group 236
Meeting Information page 43, 49
Meeting menu 36
meeting room menu bar 36
meeting room status indicator 36, 37
meeting rooms
  about 30
  converting to templates 40
  creating from templates 40
  ending meetings from 38
  leaving 32
  registering guests for 32
  setting up 37
meetings
  about 29
  creating 42
  customizing 224
  ending 38
  inviting attendees to 37
  pricing models 219
  putting on hold 38
  recording 69, 70
  restarting 38
  sending invitations to 50
  setting room bandwidth 44
  viewing and updating information 46
  viewing attendees 46
  viewing recordings 49
messages, text 77
microphones 167
multiple-choice questions 178
Mute control for audio conference 68
My Scheduled Meetings link 43, 45

N
Note pod 73
  adding notes 74
  creating multiple notes 74
  creating new pods 73
  deleting notes 75
  editing notes 74
email notes 75
renaming notes 74
notifications
course 92, 93, 97
curriculum 110
event 134
O
On Hold control for audio conference 68
Outlook invitations, for meetings 45
P
panes in Presenter 211
participants
  about 30
  event 139, 144
  polling 86
  seminar 117, 121, 123
passwords, user 240
PDF files 158
Pencil tool 60
permissions
  attendance 232
  built-in group 15
  Connect Enterprise account 229
  content file and folder 16
  event 127, 140
  library 14, 246
  meeting participant 47
  precedence of 230
  seminar 120
tips 231
  Training library 89
playbar, in Presenter 163
pods
  about 34
  adding 39
  Attendee List pod 63
  Camera And Voice pod 81
  Chat pod 75
displaying 39
  File Share pod 53, 61
  moving 39
  Note pod 73
  organizing 39
  Poll pod 86
  Share pod 61
showing and hiding 39
Web Links pod 62
working with 39
Pods menu 37
Poll pod 86
navigating 87
options 87
polls, editing 86
PowerPoint templates 201
Present menu 37
presentation logos 202
presentation slide notes 203, 212
presentation summaries 153
presentation themes 197
presentation toolbar 57
presentations
See also Adobe Presenter
adding to meetings 209, 211
automatically starting 204
changing theme colors of 199
Connect Events 215
Connect Training 215
creating 148, 151
downloading from library 19
downloading source files 20
editing 153
elements of 149
full-screen 205
image quality 163
including attachments 158
learning management systems 195, 196, 215
looping 204
planning 150
previewing 152
publishing 207
replaying continuously 204
settings 203
SWF files 158, 162, 215
Thumb tab 56
timing slides in 205
viewing 214
zipping 152, 210
Presenter Only area 35
Presenter. See Adobe Presenter
presenters 156
pricing models for Connect
Enterprise 219
Print tool 61
profiles
customizing user 238
Enterprise Manager 12
seminar 120
public events 131
publishing
events 133
presentations 206, 207
Q
Q & A pod 75
questions in Adobe Presenter
about 174
adding feedback messages to 191
default labels 192
editing 190
fill-in-the-blank 182
matching 187
multiple-choice 178
rating scale 189
reporting options 192
short answer 185
survey 189
tips for creating 176
type of 178
Questions report 228
quizzes in Adobe Presenter
about 174
creating 176
displaying scores 194
editing 190
editing feedback messages 191
reporting options 192
reports for 175
setting pass rate 194
tips for creating 176
quizzes, branching 174
R
rating scale questions 189
recording meetings 69, 70
recordings
filtering meeting events 72
finding meeting events 73
navigating meeting 71
playing back meeting 71
seminar 121
starting for meetings 70
stopping for meetings 70
Rectangle tool 60
Redo tool 61
registration
event 128, 130, 135, 140
training courses 89
training curriculums 89
reminders
course 93, 97
curriculum 110
reports
account 225
Assets report 227
content 25
course 98
curriculum 111
Custom URL Management report 229
downloading 28, 225
event 145, 225
filtering 26
generating 27
Interactions report 226
meeting 225
Questions report 228
quiz 175
seminar 125
Slide Views report 228
training 225
Users report 227
review modes in Connect Training
client-side 94
server-side 94
roles, changing
of meeting attendees 65
of seminar participants 124
S
SCORM 147, 192, 195, 196
SCORM compliance 174
screen sharing 53
full screen mode 55
previewing 54
redisplaying closed content 55
requesting control 54
selecting content to share 55
sharing control of screen 53
sharing documents 37, 58
starting 54
using pointer 55
using whiteboards 58
scripts, audio 170
Seminar Dashboard 124
Seminar Hosts group 236
Seminar library 117
seminar licenses 117, 122
seminar recordings list 121
seminar reports 125

templates 39
content in 40
converting meeting rooms to 41
default event 40
default meeting 40
default training 40
PowerPoint 201
selecting for a new meeting 41
seminar 122
test-outs in curriculums 108
text messages 77
Text tool 61
themes in presentations 197
timing slides in presentations 205

training
content 88
courses 88, 90, 91
curriculums 88, 90, 99
pricing models 219
review modes 94
Training Dashboard 90
Training library 88, 89
Training Managers group 235
test-out questions 108

talking head video 155
telephony 44

V
version number of Connect Enterprise Manager 8
video
broadcasting live 85
of speaker 155
using SWF files in 162, 215
voice, broadcasting live 85
See also audio, broadcasting audio and video
VoIP, Internet broadcasting 2
Volume control for audio conference 68

W
Web Links pod 62
whiteboard tools
Clear 61
Ellipse 61
Line 60
Marker 60
Pencil 60
Print 61
Rectangle 60
Redo 61
Stamper 61
Text 61
Undo 61
users
adding team members for 245
assigning to groups 247
creating to guests 239
creating 237
creating manually 244
customizing profiles of 238
deleting 248
modifying 246

U
unblocking broadcasts 86
Undo tool 61
upgrading Adobe Presenter 148
URLs
content 24
creating custom 23
user accounts, administering 233
user logins 240
user passwords 240
users
adding team members for 245
assigning to groups 247
converting to guests 239
creating 237
creating manually 244
customizing profiles of 238
deleting 248
modifying 246
Users report 227

T

talking head video 155

whiteboards 58
adding as overlay 59
creating 59
displaying 60
navigating 60